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Preface

Introduction
This implementation guide provides information and instructions to help you 
implement the marketing family of Oracle eBusiness Suite applications, Release 11i.

This includes

� Oracle Marketing Online

� Oracle Marketing Intelligence

This preface explains how the guide is organized and introduces other sources of 
information that can help you.

Intended Audience
This guide is to be used by experienced system administrators and Oracle 
implementation consultants who understand Oracle CRM (Customer Relationship 
Management) and ERP (Enterprise Resource Planning) applications. You must have 
an understanding of Oracle CRM and ERP applications before proceeding.

How This Guide is Organized
The first two chapters are an introduction to Oracle Marketing Online and its 
technology requirements. The third chapter consists of an overview of the entire 
implementation process. The fourth and fifth chapters cover the basic 
implementation and the implementation of specific business functions. These are 
followed by chapters on administration settings, user setups and post 
implementation steps.
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Following the chapters of this guide are a number of appendices summarizing the 
options and settings used in the guide as well as useful reference information.

This guide is optimized for online viewing as related topics and steps are 
hyperlinked for convenience. It is best viewed in PDF or HTML formats. 

How to Use This Guide
This Guide is designed as a start to finish set of steps for implementing Oracle 
Marketing Online. Please read the Implementation Overview chapter to familiarize 
yourself with general concepts that will be used throughout the Guide. Follow the 
steps for Basic Implementation in general and then proceed to the steps for Business 
Function Implementation. Additional information is contained in Administration 
Setups, User Setup, and Post Implementation chapters.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Which Steps are Required and Which are Optional
The summary table at the beginning of each section of this Guide lists the steps to 
be taken in that section. This table indicates whether a particular step is required or 
optional. Oracle recommends the implementation of the required products and 
modules of the CRM eBusiness suite to ensure the full functionality of your 
xiv                                                                                



product. However, you may omit steps in the Business Function Implementation if 
you do not need to implement a particular functionality at your site or are 
configuring your product to work with third party products. 

Related Documentation and Resources
The following documents provide additional information on installing and 
implementing Oracle CRM products. 

Installing Oracle Applications, Release 11i
This manual documents the Rapid Install installation process.

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. 

Oracle Applications Flexfield Guide
This guide contains information about using Oracle Flexfield features. It also offers 
flexfield implementation suggestions.

Oracle Applications Product Update Notes, Release 11i
This document contains information about new product features and functions for 
various Oracle applications.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage processing. 

Oracle Applications User’s Guide
This guide explains how to customize lists of values (LOVs) in the system, enter 
data, and introduces other basic features of the GUI available with Oracle 
Applications Release 11i.
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Additional Product-Related Documentation

Implementing CRM Applications
This document provides instructions for completing installation of Oracle Customer 
Relationship Management (CRM) products.

Implementing Oracle HRMS
This document provides the information necessary to implement Oracle HRMS.

Oracle CRM Foundation Implementation Guide
This guide describes set up and configuration tasks for all the foundation 
components.

Oracle CRM Foundation Technical Reference Manual
This manual contains table and view descriptions for all the Oracle CRM 
foundation components.

Oracle Inventory and User’s Guides
These guides contain information about product features, functions, and 
implementation for Oracle Inventory.

Oracle Sales Online Concepts and Procedures
This document is a printed compilation of the Oracle Sales online help system. It 
may be helpful in setting up and using the Customer and Partner subtabs of the 
Audience tab.

Oracle Marketing Encyclopedia Concepts and Procedures
This document is a printed compilation of the Oracle Marketing Encyclopedia 
online help system.

Oracle Advanced Pricing Implementation and User’s Guides
These guides provide information about product features, functions, and 
implementation for Oracle Advanced Pricing.

Oracle Advanced Outbound Concepts and Procedures Guide
This guide describes the use of Oracle Advanced Outbound for telemarketing 
campaign schedules.
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Oracle One to One Fulfillment Concepts and Procedures Guide
This guide describes the user of Oracle One to One Fulfillment for email direct 
marketing campaign schedules.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Marketing 
Online and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University's online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Marketing Online 
working for you. This team includes your Technical Representative, Account 
Manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from Top Tech Documents and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Top Tech Documents/ERP Applications/Applications Installation and 
Upgrade/Alerts.
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Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Top Tech Documents/ERP 
Applications/Applications Installation and Upgrade.
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Technology Requirements, Dependencies, and Integration P
1

Technology Requirements, Dependencies,

and Integration Points

The implementation of Oracle Marketing Online requires certain technologies to be 
implemented. This chapter lists those technology requirements, required and 
optional dependencies.

1.1 Technology Requirements
The following table lists the technology requirements for Oracle Marketing Online. 
.

Note: For Technological Requirements that overlap with 
Technological Requirements specified in the Oracle Applications 
Installation Guide, the Oracle Applications Installation Guide shall 
take precedence.

Technology

Oracle 8 Enterprise Edition Release, version 8.1.7.2

Oracle WebDB, version 2.2.2.1

Apache, version 1.3.9

Java Developer Kit Server Side, version 1.2

WorkFlow, version 2.6

Oracle Discoverer, version 4.1.38.16

Oracle Database Server, version 9.0.1.1 (required for Data Mining)

Oracle9i Data Mining, version 9.0.1 (required for Data Mining)
oints 1-1



Required Dependencies
1.2 Required Dependencies
The following table lists the dependencies for the Oracle marketing family of 
eBusiness Suite applications. Application A, Oracle Marketing Online, is said to be 
dependent on application or module B, if A will not operate properly without the 
implementation of B.

CRM foundation modules must be implemented in full. Any dependent 
applications must be set up in full if you have purchased a license for that 
application. If you have not purchased a license, then you need only to set the 
application up to the extent allowed by the shared license which comes free of 
charge with Oracle Marketing Online.

InterMedia, version 8.1.6

JInitiator, version 1.1.8.13

BI Beans, version 1.6.0.36

MS Internet Explorer, version 5.5 or later

This is the recommended browser for all HTML-based applications.

Application or Module

Human Resources (HRMS)

CRM Foundation Resource Manager

CRM Foundation Task Manager

CRM Foundation Notes

CRM Foundation Tasks

General Ledger

One to One Fulfillment

Advanced Pricing 

Oracle Inventory

Technology
1-2 Oracle Marketing Online Implementation Guide  



Integration Points
1.3 Conditional Dependencies, required for Trade Management
The following table lists the dependencies for the Oracle Trade Management. 
Application A is said to be dependent on application or module B, if A will not run 
without the implementation of B.

CRM foundation modules must be implemented. Any dependent applications must 
be set up in full if you have purchased a license for that application. If you have not 
purchased a license, then you need only to set the application up to the extent 
allowed by the shared license which comes free of charge with Oracle Marketing 
Online.

1.4 Integration Points
The following table shows the integration points for Oracle marketing applications. 
Application A is said to be integrated with application B if non-critical features of A 
will not work without the implementation of B.

Application or Module

Accounts Receivable

Accounts Payable

Oracle Territory Manager

Oracle Order Management

Application or Module

Accounts Payable

Accounts Receivable

Advanced Pricing

General Ledger

Human Resources

Inventory

iStore

Marketing Encyclopedia

Partners Online

Scripting
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Integration Points
Interaction History

CRM Foundation Territory Manager

Call Center/Advanced Outbound

Install Base

Application or Module
1-4 Oracle Marketing Online Implementation Guide  



   Introd
2

Introduction

2.1 Oracle Marketing Online 11i Release 7
Oracle Marketing Online enables an enterprise to achieve Single Marketing Reality 
the ability to plan and execute marketing programs from campaign to order to cash. 
Oracle Marketing Online also leverages Single Customer Reality, Oracle’s exclusive 
Trading Community Architecture (TCA) that stores all customer, partner, prospect 
and other related information in a single repository, to deliver consistent messages 
and offers across all channels. In short, Oracle Marketing Online takes you beyond 
simple campaign planning and execution; it empowers you to measure and achieve 
true marketing ROI.

Oracle Marketing Online is a part of the Oracle eBusiness Suite, an integrated suite 
of applications for the enterprise, including both ERP and CRM. The Oracle 
eBusiness Suite is designed to transform traditional businesses into e-businesses.

2.2 Key Benefits
As a key application of the Oracle eBusiness Suite, Oracle Marketing Online offers 
the following benefits:

� Automate processes – By providing centralized processes and approval 
management, Oracle Marketing Online enables an organization to focus more 
on marketing and less on logistics.

� Enable multi-channel execution – Via seamless integration with other Oracle 
CRM products, a marketer can use Oracle Marketing Online to plan and 
execute campaigns across all channels and marketing media.

� Increase velocity – Oracle Marketing Online increases personal productivity 
while facilitating team collaboration and information sharing. Marketers can 
uction 2-1



Key Benefits
plan and execute campaigns in an accelerated time frame to gain a first mover 
advantage.

� Become a profit center – Because campaigns and offers are tracked across the 
E-Business Suite, Oracle Marketing Online enables marketers to pinpoint the 
revenue generated by each marketing effort.

� Maximize ROI – Since costs and revenue can be tracked on a real-time basis, 
marketers can tweak or even stop a campaign in midcourse to maximize the 
marketing ROI.

2.2.1 New in this release

Analytics
� Out-of-the-Box Performance Metrics
� Home Page Analytical Reports

Segmentation and List Management
� List Import
� List Export
� Suppression Filters
� Manually Added Employee List
� Discoverer Business Areas
� Control Group vs. Contact Group
� List and Segment Selection Criteria
� Segment Hierarchy

Budget and Costs Management
� Budget Categories
� Budget Allocation
� Budget Threshold
� Checkbook

Product Creation and Maintenance
� Inventory Attributes
� Inventory Category Support
� Product Revision History
2-2 Oracle Marketing Online Implementation Guide 



Key Benefits
� Product Collateral

Pricing and Offer Management
� Pricing for Product Category
� Comprehensive Promotional Offer Types
� Standalone Offers and Offer Reuse
� Postings to Budget Checkbook and GL

Campaign Planning
� Programs
� Trackable PIN Code
� Campaign/Event Association
� Triggers

Event Planning and Management
� Event Registration

Multi-Channel Execution
� Email Content Composition
� Email Mail Merge
� Email Preview and Testing
� Outbound Telemarketing Execution
� Universal and Rule-Based Web Postings
� Web Recommendation Prioritization
� Web Placement Management
� Extensible Web Posting Framework

Usability Features
� Approval Rules
� Mandatory Fields
� Country Filter
� Personalized Views
� Summary Data Export
� Application Tip Text
� Confirmation Messages
� Advanced Search
    Introduction 2-3



Analytics
� Workflow Management
� Locking Rules
� Function Level Security

2.3 Analytics
Oracle Marketing Online empowers marketers and managers to measure and 
evaluate marketing activities based on a 360-degree view of all customer 
interactions. This robust customer knowledge can be leveraged to calculate true 
marketing ROI.

2.3.1 New – Out-of-the-Box Performance Metrics
Oracle Marketing Online 11iR7 provides out-of-the-box calculations for key 
measures of campaign and event performance. These scalable calculations enable 
marketers to evaluate critical marketing performance indicators without any setup 
customizations. The performance metrics calculations for 11iR7 include the 
following

� Leads, Opportunities, and Orders

� Event Registrants, Attendees, and Cancellations

� Budget Commitments and Utilization

2.3.2 New – Home Page Analytical Reports
In addition to the enhanced metrics, the configurable “Reporting Bins” on the 11iR7 
Home Page enable users to quickly view the knowledge they need to perform their 
jobs. The Reporting Bins contain summary information for key marketing activities, 
including Budget Utilization and Campaign and Event Effectiveness. Each Bin 
provides links to drill down to more granular details.

The Home Page also provides a Chart Area for graphical display of performance 
data, such as Top Campaigns by Leads, and a Report Area for additional analytical 
information. All of the new Home Page display options are customizable at the 
individual user level.

2.4 Segmentation & List Management
Oracle Marketing Online supports sophisticated list management to import, 
generate, compile, and profile customer and prospect data. Marketers can quickly 
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generate campaign-specific target lists from multiple data sources based upon 
user-defined criteria. Oracle Marketing Online enables the creation of simple to 
complex segmentation strategies. A marketer can use the segment hierarchy to 
quickly view the segmentation approach, the size of any segment, as well as match 
any analysis against the various segment branches.

2.4.1 Enhanced – List Import
Oracle Marketing Online offers an enhanced list import process, enabling marketers 
to map an external data source, such as a purchased or rented list, or existing 
customer database, to any destination listed below. Out-of-the-box, this capability 
facilitates the importing of 

� Prospects for marketing campaigns

� Leads for following up by Oracle TeleSales

� Customers into TCA (e.g., from an existing legacy customer database)

� Processing event registrants into Oracle Marketing Online’s Event module

2.4.2 New – Suppression Filters
Oracle Marketing Online helps companies to comply with privacy policies by 
providing pre-defined suppression filters. These filters are applied automatically to 
every target list so that customers who have opted out of receiving promotional 
campaigns are not targeted. Marketers can also create their own user-defined 
suppression filters and apply them to all campaigns, campaigns based on activities 
(for example, email, direct mail, or telemarketing), or only to specific campaigns. 

2.4.3 New – Control Group vs. Contact Group
When creating a target list for a campaign, a marketer can designate a control 
group, people who will not receive any promotional treatment. Their behavior is 
then compared with that of the contact group to determine if the campaign was 
effective. For example, for a given campaign that is intended to generate sales of a 
certain product, what percentage of the control group vs. the target group 
purchased the product anyway without receiving the promotion? This technique 
helps marketers to analyze the effectiveness of their campaigns.
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2.4.4 Enhanced – List and Segment Selection Criteria
Oracle Marketing Online’s already robust list and segment definition capabilities 
are enhanced in 11iR7 with the following additional consumer and business profile 
attributes through Discoverer business areas

� Person age, income, marital status, or household size

� Person interests, languages, citizenship, education, and employment history

� Organization annual revenues, number of employees, or SIC code

� Account information, including Current Balance, Account Activation Date and 
Account Status

� Order history

� Campaign contact history

� Data mining scores, including Campaign Response Probability

2.4.5 Enhanced – Segment Hierarchy
Using Oracle Marketing Online, marketers have been able to define a one-to-many 
parent-child hierarchy of customer segments. In Release 7, this feature is enhanced 
to ensure validation that parent segments are supersets of children segments. 
Marketers can logically group their customers in user-defined hierarchies and 
generate a list at any level in the hierarchy for campaign execution.

The application does not segment validations. When a segment has a parent 
segment, its contents will be the intersection of its original contents and its parent's 
contents. For example, if segment A is defined as: all people with ages between 20 
and 40, and segment B is defined as: all people with ages between 30 and 50; if you 
assign segment A as parent of segment B, then the segment B will only contain 
people whose ages are between 30 and 40. The preview button on the segment 
detail page will show the correct intersected number.

2.5 Budget & Costs Management
Budget and Costs Management enables a marketer to create, allocate, and manage 
budgets and checkbooks. Oracle Marketing Online supports a hierarchy of parent 
and child budgets. Funds may be transferred between different budgets. The 
marketing checkbook tracks actual expenditures as they occur for enhanced cost 
control.
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2.5.1 Enhanced – Budget Categories
Enhanced Budget Management features in Oracle Marketing Online provide 
marketing and sales organizations with the ability to categorize and control usages 
of these budgets for specific activities.

2.5.2 Enhanced – Budget Allocation
Budget Allocation enables distribution of sales funds and marketing budgets down 
the sales territory hierarchy. Using the Holdback feature, a portion of the allocated 
funds can be reserved for future discretionary allocation.

2.5.3 New – Budget Threshold
The Budget Threshold feature monitors budget usage and provides notifications on 
over- or under-utilization of budgets. For example, a company can set up a budget 
threshold to generate a notification to the fund manager if more than a predefined 
portion of the budget is committed in the first month of the fiscal year. 

2.5.4 Enhanced – Checkbook
The budget checkbook is enhanced with drill-down to the details of the budget 
columns such as Planned, Committed, Utilized, and Paid. By providing a more 
granular access to information, Oracle Marketing Online enables quick adaptation 
to changing market conditions. A fund manager can make manual adjustments to 
the budget checkbook to transfer money from the ‘Utilized’ to ‘Committed’ column. 
This may be necessary if a customer has failed to meet the terms of a contract, or if it 
is necessary to free up unutilized funds upon completion or cancellation of a 
campaign.

2.6 Product Creation and Maintenance
Oracle Marketing Online enables you to take products from concept to market in 
hours and days rather than weeks and months. Products, product bundles, and 
product relationships can be defined in one single marketing application. Because 
of E-Business Suite integration, this information is populated in Oracle Inventory 
automatically. With this strategic capability, you will be able to bring new products 
and solutions to market faster. 
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2.6.1 Enhanced – Inventory Attributes
More inventory attributes can be modified with the latest release. Attributes such as 
customer order enabled, costing enabled, and activation required can be easily 
changed within Oracle Marketing Online. You will also be able to assign a product 
to multiple inventory organizations.

2.6.2 New – Inventory Category Support
With inventory item category structure, a user can classify products in a logical 
fashion for order management purposes. Oracle Marketing Online users can easily 
assign any product to specific item categories for various purposes.

2.6.3 New – Product Revision History
The user will be able to enter and view the revisions and effective dates of a 
product, so that each version or revision which the product has gone through can be 
tracked.

2.6.4 New – Product Collateral
This new feature enables the marketer to associate collateral to a product as a 
related item.

2.7 Pricing & Offer Management
Pricing Management completes the canonical 4 Ps in marketing – pricing, product, 
promotion, and placement. With the ability to have control over price lists and 
discount rules using one single marketing application, Oracle Marketing Online 
enables users to respond to market conditions rapidly. A marketer can create a price 
list in Oracle Marketing Online and apply it across ERP and CRM modules. Oracle 
Marketing Online allows a user to view details of existing price lists in Oracle 
Pricing, specify products, prices, and other pricing attributes in a price list, and 
define eligible customer segments for a price list.

2.7.1 New – Pricing for Product Category
In 11iR7 a marketer is able to assign a price category, so that all products in that 
category have the same price. This feature saves the user from having to enter the 
same price multiple times.
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2.7.2 Enhanced – Comprehensive Promotional Offer Types 
Users can create various types of offers which can be applied via all execution 
channels, such as the Web or call center.

� Off-Invoice – amount, percent or lump -sum discount applied on the face of the 
invoice

� Accruals and lump-sum – differed discounts paid to the customer based on 
proof of performance

� Order Value – discounts based on total value of the order

� Terms Upgrade – shipping, freight, and payment upgrades

� Promotional Goods – buy X, Get Y discounts

� Trade Deal – combination of off-invoice and accrual discounts

Oracle Marketing Online also provides the ability to define discounts on multiple 
products and product categories in a single offer.

2.7.3 New – Standalone Offers and Offer Reuse
Marketing users can create standalone offers without creating a supporting 
campaign. Multiple campaigns can promote a single offer through various channels 
at different times.

2.7.4 New – Postings to Budget Checkbook and GL
The appropriate budget checkbook is updated with offer utilization information 
based on the customer and the products sold. For accrual (differed) discounts, 
Oracle Marketing Online also updates the appropriate General Ledger liability 
accounts.

2.8 Campaign Planning
Campaign management facilitates planning, budgeting, and approvals, thereby 
automating marketing processes so that marketers can focus more on marketing 
and less on administrative tasks. 
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2.8.1 New – Programs
Oracle Marketing Online introduces marketing programs as parent folders into 
which a user can group campaigns and events. By having this flexible hierarchy, 
costs and metrics can be rolled up into the parent program.

2.8.2 Enhanced – Trackable PIN Code
For each entry in a list Oracle Marketing Online employs a unique Personal 
Identification Number (PIN) code that allows for precise tracking of each targeted 
individual in a campaign. This PIN code can be used by inbound channels to 
quickly access customer information and campaign details. When creating a 
mailing, a marketer can include the PIN code as a merge field to automatically 
embed the customer’s information within the body of the message.

2.8.3 Enhanced – Campaign/Event Association
One-off events may be created from within campaigns to create a parent child 
relationship. One-off events are single location events most often associated with a 
campaign. All the costs and metrics of this event will roll up to the campaign. 
Alternatively, an event may be related to a campaign for promotional purposes. The 
costs and metrics of this event will not roll up to the campaign.

2.8.4 Enhanced – Triggers
Marketers can automate campaign execution by designating trigger conditions 
under which a campaign schedule executes. For example, a direct mailing is 
automatically followed up by a phone call when the response rate is greater than 
50%. The campaign schedule details such as target lists and email content are set up 
in advance. When the trigger condition is met, the target list is automatically 
generated and the campaign schedule executes. Triggers can be reused across 
multiple schedules. 

2.9 Event Planning and Management
Oracle Marketing Online Event Management includes the key functions to establish 
marketing and sales events, either as part of a marketing campaign or as a revenue 
generating promotion. Marketers and event coordinators can create events with 
budgets, allocate resources such as equipment and collateral, and manage tasks 
required for planning and executing the events.
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2.9.1 Enhanced – Event Registration
Event details and registration information are shared with Oracle TeleSales to 
facilitate easy registration and payment. In 11iR7, event registration is enhanced to 
handle registration in Oracle Marketing Online, enabling sales people, marketers, 
and other internal staff to register individuals for events.

2.10 Multi-Channel Execution
Oracle Marketing Online enables integration across all execution channels to 
provide a consistent campaign message at every customer touch point. Each 
channel conveys the appropriate message and offer while providing real-time 
feedback on customer response for analysis and future actions.

2.10.1 Enhanced – Email Content Composition
With the latest release, a marketer no longer needs complex setup or a separate 
HTML editor to create compelling email content and then use the application to 
execute. Email content is managed as a deliverable, like any other content pieces. 
Both HTML and ASCII text formats are supported.

2.10.2 Enhanced – Email Mail Merge
Using pre-defined mail merge tags, a marketer can insert various customer fields 
into an email with a user-friendly interface within Oracle Marketing Online.

2.10.3 New – Email Preview and Testing
Right before executing an email, the user has the option to preview an email and 
send a test email for validation. Oracle Marketing Online now enables an average 
marketing user to create, mail merge, preview, test, and execute a complete email 
campaign within Oracle Marketing Online.

2.10.4 Enhanced – Outbound Telemarketing Execution
With enhanced integration with Oracle Advanced Outbound, a marketing manager 
and a call center manager will use one single user interface to collaborate on and 
execute an outbound telemarketing campaign. 
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2.10.5 Enhanced – Universal and Rule-Based Web Postings
Oracle Marketing Online now provides online merchants different ways of selecting 
personalized content for display either by writing rules that will apply a different 
strategy to different visitors based on the rules conditions (Rule-based Posting), or 
by applying the same strategy to all the visitors (Universal Posting).

2.10.6 Enhanced – New Web Merchandising Strategies
Campaigns and products can be recommended to online shoppers based on

� Browsing behavior

� Purchases (past)

This new release also enables merchants to extend their conditions, strategies and 
business attributes to match their business needs.

2.10.7 New – Web Recommendation Prioritization
Aside from showing the highest affinity content to a customer, merchants want to 
push content based on business drivers. This trade-off of affinity-based pull vs. 
business driver-based push is achieved by imposing filtering criteria on the 
recommendations returned by the posting.

2.10.8 New – Web Placement Management
Oracle Marketing Online ships out-of-the-box placements for iStore templates. In 
addition, the merchants can define their own placements. With placement 
management, the merchant has control over the content and layout on the templates 
that embed Web placements, before publishing them to the world. Through this 
user interface, the merchant can also modify the postings assigned to the 
placements without writing any code.

2.10.9 New – Extensible Web Posting Framework 
Oracle Marketing Online ships out-of-the-box with seeded strategies and rules 
conditions. The merchants also have the option to extend these by adding their own 
customized criteria.
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2.11 Workflow Management
Out-of-the-box workflows in Oracle Marketing Online streamline approval 
processes for marketers. Campaigns, Events, Deliverables, Offers and claim 
settlement budget requests, are tracked and approved via an automated system of 
notifications and updates to the appropriate manager. In 11iR7 this offering is 
enhanced to provide more configurable workflows so that each customer can 
configure these rules depending on business process. Additional flexibility is 
provided to enable a marketing super user to override these rules when there is an 
exception.

2.11.1 Enhanced – Approval Rules
Approvals for objects created in Oracle Marketing Online are set to a default 
marketing manager or can be configured by creating approval rules based on:

� Business organization

� Priority

� Budget amounts

� Start and end dates

Additionally, each approval rule can have multiple approvers with a rank order to 
specify who needs to approve first before proceeding to the next approver.

2.12 Usability Features
Increased usability drives end user product acceptance. Oracle Marketing Online 
places importance on usability of features, thus reducing training costs and time for 
marketing staff. The browser-based interface and enhanced features improve the 
experience of general marketers and advanced marketing analysts alike.

2.12.1 New – Mandatory Fields
Oracle Marketing Online is designed with default mandatory fields in order to 
create objects. For example, campaign name is mandatory. In this release a 
marketing administrator can specify additional mandatory fields depending on 
business need. If certain information is essential to the marketing process, that 
information can be captured in Oracle Marketing Online.
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2.12.2 New – Locking Rules
Locking Rules within Oracle Marketing Online allow for flexibility in configuring 
which fields are locked at which status. For example, budget lines cannot be edited 
once the campaign is completed. Entire pages associated to an object can also be 
locked (for example, all costs are locked once they have been approved). This 
feature provides security to ensure data integrity.

2.12.3 New – Country Filter
Oracle Marketing Online enables a user to filter by country when selecting from a 
list of values. This applies to marketing objects such as campaigns, events, 
marketing media, event venues, and lists. For example, a user can filter a large list 
of venues to see only those located in the United States.

2.12.4 New – Personalized Views
Each user can personalize the way summary information is presented. A user can 
select search criteria and apply conditions such as “less than,” “greater than or 
equal to,” and “between” to each individual criteria. The search results can be saved 
for future reference and used as filters when viewing summary information, such as 
a list of all campaigns.

2.12.5 New – Summary Data Export
Any tabular summary of information within Oracle Marketing Online can be 
exported to a pre-defined file format, which can then be saved electronically and 
used for custom reports, sharing with partners, or collaboration with team 
members.

2.12.6 New – Application Tip Text
To further increase user-friendliness, Oracle Marketing Online provides useful tips 
and instructions in the application user interface itself, in addition to the online 
iHelp tool.

2.12.7 New – Confirmation Messages
After every update or data submission, the HTML interface provides a confirmation 
message, providing a positive feedback to indicate whether the data has been 
recorded successfully. 
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2.12.8 Enhanced – Advanced Search
Using Oracle Marketing Online’s Advanced Search feature, a user can search on 
campaigns, events, deliverables, or other marketing object. To protect sensitive 
information (for example, budget amounts or costs), you can designate which 
elements are available for viewing in the resulting details. Results are pre-formatted 
for printing, or can be saved as an HTML file.

2.12.9 Enhanced – Function Level Security
Security is enhanced by prohibiting users to access a page in Oracle Marketing 
Online without first logging in to the application. For example, this will prevent 
unauthorized access by a user who tries to type in the exact URL of a page.

2.13 Trade Management – New Features
Oracle Marketing Online Trade Management option provides consumer product 
manufacturers a comprehensive set of tools to measurably improve 
business-to-business return on partner investment through closed-loop planning, 
execution and analysis. 

The Trade Management option is a part of the Oracle E-Business Suite, an 
integrated suite of applications for the enterprise that enables traditional businesses 
to transform into e-businesses. 

The Trade Management option is built on three premises:

Drive profitable growth by providing tools for evaluating partner ROI. It provides 
product and promotion information on targets, critical cost to serve information, 
and planned versus actual results by customer.

Improve account relationships by transforming the traditional sales manager into a 
customer-centric manager. Trade Management provides the sales representative 
with complete access to all corporate information on products, pricing, competitors, 
marketing activities, and sales initiatives thereby enabling more efficient and 
effective customer and promotion planning.

Reduce costs through improved execution across marketing, sales, corporate 
finance, and operations groups. For example, comprehensive back office integration 
gives operations’ groups information about expected promotional volume for 
demand planning so manufacturing and transportation costs can be minimized. It 
also ties promotional agreements to order processing to increase invoice accuracy. 
To insure that finance department is kept informed of the impact that trade 
spending has on the company’s financial statements, Trade Management minimizes 
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unexpected financial liabilities and risks of over- or under-utilizing assets and 
provides the associated reporting. It also facilitates quick resolution of promotional 
deductions, which saves research costs and eliminates payment of invalid claims.

2.13.1 Trade Planning
Trade planning provides sales and marketing managers of consumer product 
manufacturers, a comprehensive set of tools to manage the trade promotion 
planning, execution, and analysis process. Trade Management provides the 
following new features in campaign/trade promotion management:

� Forecasting based on historical data. Marketing and sales personnel can forecast 
expected volume lift for trade promotions using historical sales data by time 
and by product. 

� Manufacturer profit calculator allows sales and marketing departments to 
accurately identify the profitability of trade promotions enabling optimum 
usage of trade funds.

� Campaign Versions. Headquarter sales and marketing personnel can now create 
multiple trade promotion scenarios with different offer values. Forecasting and 
manufacturer profit calculator tools can be used to generate a comparison 
report to identify the best strategy to drive profitable growth.

� Trade Management includes major enhancements in offers/discount 
management such as a comprehensive set of discounts:

� Off-Invoice – amount, percent or lump-sum discount applied on the face of 
the invoice.

� Accruals and lump-sum – Bill-back discounts paid to the customer based on 
proof of performance.

� Order Value – Discounts based on total value of the order.

� Promotional goods – Buy X, Get Y discounts.

� Trade Deal – Combination of off-invoice and accrual discounts.

� Ability to define discounts on multiple products and product category in a 
single offer.

� Standalone offers. User can create standalone offers without requiring to define 
a promoting campaign.

� Offer validation based on target customers and promoted products to ensure 
usage of money from appropriate funds.
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� Postings to budget checkbook and GL. Trade Management updates appropriate 
budget checkbook with offer utilization information based on the customer and 
the products sold. For accrual (bill-back) discounts, Trade Management updates 
appropriate General Ledger liability accounts.

� User can now specify one or more maximum usage limits on an offer. The offer 
is shut down once a limit is reached. Trade Management allows the following 
maximum usage limit types.

� Maximum amount limit at the offer header/line – a limit on total discount 
amount.

� Maximum quantity limit at the offer line – a limit on total units of a product 
sold using the offer.

� Maximum quantity limit per customer – a limit on total units of a product 
sold to a customer using the offer.

� Maximum quantity limit per order – a limit on total units of a product sold 
in one order.

� Maximum orders limit per customer.

� Offer reuse. Multiple campaigns can promote a single offer through various 
channels at different times

2.13.2 Funds and Budget Management
Enhanced budget management features included in Trade Management provide 
marketing and sales organizations with the ability to create and control specific 
fund/budget types using a variety of parameters such as spending, brand, 
products, territories, and customers. Trade Management allows flexible budget 
eligibility rules by product, customer, territory, and time period to control budget 
usage. Trade Management also provides ‘Fully accrued’ or ‘Live’ budgets. Fully 
accrued budgets can be used to support:

� Royalty payments.

� Allocation of future discretionary funds to sales personnel based on their 
current sales figures.

� Capture other costs such as Co-operative advertising and Volume Rebates.

Such budgets start with zero balance and the balance grows based on sales activity.

Enhanced allocation engine enables automatic distribution of sales funds and 
marketing budgets down the sales territory hierarchy. Using the holdback feature, a 
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portion of the allocated money can be reserved for future discretionary allocation. 
The Budget Threshold feature in Trade Management allows the user to monitor 
budget usage and provides notifications on over- or under-utilization of budgets. A 
Company can now establish a budget threshold to generate a notification to the 
fund manager if more than predefined portion of the budget is committed in the 
first month. Trade Management graphically represents budget hierarchies in an 
HTML tree. Users can now expand/collapse the tree to view budget details. 
Campaign /Offer level checkbook along with drill-down feature on the budget 
columns such as planned, committed, utilized, and paid provides users a more 
granular access to the information thereby enabling quick adaptation to changing 
market conditions. 

A manual transfer of money from ‘utilized’ to ‘committed’ column may be 
necessary if a customer has failed to meet terms of the contract. Also, there is a 
necessity to free up un-utilized funds upon completion of a campaign. Trade 
Management now allows users to make manual or automatic adjustments to the 
budget checkbook to handle such scenarios.

2.13.3 Claims Management
Trade Management facilitates management and resolution of promotional claim 
requests as well as any types of deductions, promotional or not. A ‘Deduction’ is a 
short payment on a check remittance which may or may not be related to an 
invoice. Approximately 90% of all deductions are promotional claims. The 
deduction amount typically includes amount of the promotional deal, along with 
other charges such as damages or short shipments. Most often these deductions 
occur on remittances to the vendor with no supporting information, making it 
virtually impossible at times to identify the breakdown on reasons. 

Trade Management offers out of the box integration with Oracle Accounts 
Receivable module. AR automatically routes any deductions (short-payments on 
invoices) to Trade Management for resolution thereby reducing the settlement time. 
Trade Management provides research and validation tools to monitor performance 
and facilitate quick claim resolution. Claims personnel now have real-time access to 
customer promotional deal information along with accrual details through budget 
checkbook. Trade Management provides claims personnel quick access to discount, 
order, and invoice information for a particular customer through its tight 
integration with Order Management, Advanced Pricing, and Accounts Receivables 
modules. 

Trade Management provides robust settlement support for valid claims. Claims 
personnel can initiate:
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� An ‘issue check’ request to AP

� A credit memo/write-off/adjustment request to AR

Upon securing appropriate approval, Trade Management completes the claim 
settlement process by updating appropriate General Ledger accounts.

2.13.4 Specific Enhancements
� Deliverable kits of Inventory items may now be created without creating the kit 

in Inventory.

� Event enrollment may be manually frozen to disallow new enrollees regardless 
of whether space is available. 

� A public API allows event registrations to take place over the web. 

� An event may added to Inventory or attached to an existing Inventory item.

� A denormalization process has been added to resolve offer eligibilities and store 
them.

� Events may now be priced by attaching them to multiple price lists.

� A concurrent program has been added to activate event schedules on their start 
date.

� The Event roster may be exported.

� Links are available on the Campaign and Event summary pages which give 
direct access to schedules associated with the campaign or event.

� Mandatory and Locking Rules have been implemented for Marketing 
Mediums.

� Product types are no longer required for the creation of a product.

� In the category assignment page for products, categories are now displayed 
with their descriptions rather than with their numeric ids.

� A column for source code has been added to the Event summary page.

� The Store page has functionality for product images, walk-in prices and the 
ability to assign products to iStore sections.

� The Roster page for an event has a status field which allows cancellation of a 
registration.

� There is now graphic support for cost and revenue metrics.
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� There is now history support for metrics and costs.

� Personalization is available for metrics on the administration page.

� Segments and lists are now integrated so that a list may be created from a 
segment in one click.

� List import has support for the Party_ID field, ftp support, and an API for 
rented lists.

� There is a new list generation mode with support for Advanced Outbound 
integration.

� There is a new list groups concept between target group and list to support 
Advanced Outbound integration.

� A List Copy API is available.

� List Import ftp support is available enabling the import of an csv file from an 
ftp site.

2.14 Obsolete in this Release

2.14.1 Marketing Online
� The flag "Allow Overflow" in event registration set up is removed. The allow 

overbooking flag provides the necessary functionality.

2.14.2 iMarketing
� Affiliates tab is no longer part of iMarketing/Execution. An affiliate has to be 

created as an organization with an 'Affiliate' relation. Organization can be found 
under 'Audience' tab.

� In a rule definition, the 'Empty shopping cart' condition is now defined as 
'Shopping cart amount = 0'.

� Posting The style sheet associated with the posting is moved to Styles in 
Placement. Postings associated with an affiliate has been moved to placement. 
Affiliates are now associated at the placement level.

� Default posting is no longer supported.

� The system parameter for the server URL is moved to the profile AMS Server 
URL.
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3

Implementation Overview

The following is general information regarding basic concepts used during 
implementation.

3.1 Implementation Description
Each implementation section of this guide covers the settings required to implement 
Oracle Marketing Online. Here is a brief description of each type of setting used in 
the implementation sections. 

3.1.1 Profile Options
The procedure for setting up and changing profile options is the same for all Oracle 
Applications. For a detailed description of the procedures, refer to the Oracle 
Applications System Administrator’s Guide.

Profile options may be set at four different levels:

Site. The site level setting affects the entire e-business suite.

Application. When a profile option is set this level it overrides the site level setting 
for the particular application.

Responsibility. The responsibility level setting affects users of a given 
responsibility. When a profile option is set at this level it overrides the application 
level setting for users of the particular responsibility.

User. Settings at the user level affect the individual user only. When a profile option 
is set at this level it overrides the responsibility level setting for an individual user.
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Profile Options are summarized in Appendix C.

3.1.2 Lookups
There are three types of Lookups:

System. System Lookups may not be modified or deleted, and may not have 
additional values added.

Extensible. Extensible Lookups may have additional values added to the list. 
Seeded extensible Lookups may not be deleted.

User. User Lookups are completely modifiable. They may be modified and/or 
added to. Seeded user Lookups, if any, may be modified or deleted.

Lookups are summarized in Appendix D.

3.1.3 Concurrent Manager Programs
Many of the processes that are involved with the operation of Oracle Marketing 
Online required processes to run periodically or at certain times. These processes 
are referred to as Concurrent Manager Programs. The setting up and running of 
Concurrent Manager Programs is described in each section where a Concurrent 
Manager is required and summarized in Appendix F.

3.1.4 Administration Options
There are a number of administration options that are associated with the 
individual tabs in Oracle Marketing Online. There are also administration options 
which affect multiple tabs. Those administration options are collected under the 
Basic Implementation Chapter.

Note: Profile options belonging to Oracle Marketing Online have 
the prefix of AMS. During implementation, profile options relating 
to dependencies may be set as well. 

Note: All levels of Lookups may have their visible value, the text 
displayed to the user, modified.
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Many administration options choices are used, throughout the application, to 
populate drop-down menu selections with a list of values (LOVs).

Administration options are summarized in Appendix E.

3.2 Working with Multiple Currencies 
The multiple currency capabilities of Oracle Marketing Online allow your 
organization to create Budgets, estimate and source Campaigns, Events, 
Deliverables, and Offers in different currencies. Oracle Marketing Online 
automatically converts all activities, and transactions occurred against them into a 
single currency of your choice when showing up on Bins, Charts and Reports on 
Home Page. User has the ability to choose the default currency into which the 
Reports, Bins, Charts should display by setting up the profile option ‘AMS: Default 
Currency’. The same currency code is used to default all objects like Budgets, 
Campaigns, Events, Deliverables, and Offers. However the user has the choice of 
changing the currency code as he/she intends.

Budgets
Oracle Marketing Online provides the ability to create budgets in different 
currencies. Users can Transfer to different budgets or Request money from budgets 
in any currency. It is not required that the budgets sourcing these requests should be 
in the same currency. When a Requester makes a request for money in one currency, 
he/she would also see the approval notification and money transfer in the same 
currency. Similarly when Budget Owner receives a request, the system will 
automatically convert the requested amount into the currency of the budget. The 
budget owner will then approve the amount in budgets currency. 

Campaigns, Events, Deliverables and Offers
Oracle Marketing Online provides the ability to estimate and request money for 
these activities in different currencies. Users can define these activities and estimate 
in any currency, but could request money from budgets belonging to different 
currencies. Just as mentioned above, the system will automatically convert the 
requested amount into appropriate currencies.

Oracle Marketing Online will calculate the currency conversion for each and every 
individual transaction based on the currency conversion type specified on the 
profile option ‘AMS: Currency Conversion Type’. This profile is set at the site level. 
It is required that one currency conversion type is defined for Marketing Budgetary 
purposes in Oracle General Ledger. This currency conversion type is also used to 
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convert all the transaction currency into functional or accounted currency of the 
Sets of Books specified in Systems parameters screen. 

Claims
Oracle Marketing Online allows you to create Claims in any foreign currency, not 
just the functional currency. Claims can be made in any currency against any 
marketing object such as Campaigns, Offers, or against Invoices. Claims can be 
promotion related or non promotion related. When a claim is settled against the 
promotional accruals referring to Campaigns, Offers, Orders, or Invoices, it is not 
required that the claim currency and the accrual currency has to be same. In such 
situations, Claims will ensure that the accounted amount that is claimed and the 
accounted amount that is settled are equal. 

Claims do not use the currency conversion type specified on the profile option 
AMS: Currency Conversion Type. Instead, Claims uses the Exchange Rate 
information provided in the Amount section of the claim. When a claim is created 
in foreign currency, system automatically defaults the exchange information from 
the systems parameters. However, the system also lets user to change the exchange 
information on the claims screen.

You may also define daily conversion rates. Daily conversion rates enable Claims to 
automatically calculate exchange rate information when you enter foreign currency 
claims. See: Entering Daily Rates in the Oracle General Ledger User’s Guide. 

3.3 Implementation Sequence
Summary of Steps needed to Implement Oracle Marketing Online.

Step Task Required

4.1 Setting up General Ledger Yes

4.1.1 Setting up Accounting Calendar Types Yes

4.1.2 Setting up an Accounting Calendar Yes

4.1.3 Setting up a Marketing Calendar Yes

4.1.4 Enabling Additional Currencies Optional

4.1.5 Set Currency Conversion Rates Yes

4.1.6 Set up Currency Conversion Rate Types Optional

4.1.7 Create a Set of Books Yes
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4.2 Set up HRMS Yes

4.2.1. With Full Oracle HRMS

4.2.2 With Shared Oracle HRMS

4.2.3 Create Lookup Tables for Organization Types Yes

4.2.4 Creating Locations Yes

4.2.5 Business Groups Yes

4.2.6 Creating Organizations Yes

4.2.7 Assigning Attributes to Responsibilities Yes

4.2.8 Creating and Assigning a Legal Entity, Operating Unit 
and HR Organization for a Specified Organization.

Yes

4.2.9 Assign Multi Org Responsibilities Yes

4.3 Implement Oracle Inventory Yes

4.3.1 Creating Units of Measure Yes

4.4 Creation of the Implementation User Yes

4.5 Implementation of Foundation and Dependency 
Components

Yes

4.5.1 Setting up CRM Foundation: Resource Manager Yes

4.5.2 Setting up CRM Foundation: Task Manager Yes

4.5.3 Setting up CRM Foundation Note Types Optional

4.5.4 Setting up Advanced Pricing Yes

4.5.5 Setting up Oracle iStore Optional

4.5.6 Setting up Oracle Accounts Payable Optional

4.5.7 Setting up Oracle Accounts Receivable Optional

4.6 Implement Marketing Common Components Yes

4.7 Implement Home Page Bins and Reports Security Optional

5.1 Implementation Overview

5.2 Implement Campaigns and Programs Optional

5.3 Implement Budgets Optional

Step Task Required
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5.4 Implement Events Optional

5.5 Implement Offers Optional

5.6 Implement List Optional

5.7 Implement List Import Optional

5.8 Implement Data Mining Optional

5.9 Implement Products Optional

5.10 Implement Price Lists Optional

5.11 Implement Deliverables Optional

5.12 Implement Marketing Intelligence Optional

5.13 Implement Web Posting Optional

5.14 Implement Web Placement Optional

5.15 Implement Claims Optional

6.1 Creating Marketing Mediums Optional

6.2 Creating Metrics Optional

6.3 Creating Venues Optional

6.4 Creating Categories Optional

6.5 Creating Custom Setups Yes

6.6 Creating Activities Optional

6.7 Creating User Statuses Optional

6.8 Creating Locking Rules Optional

6.9 Creating Mandatory Rules Optional

6.10 Creating Approval Rules Yes

6.11 Create Web Offer Queries Optional

6.12 Creating Data Sources Optional

6.13 Word Replacement Rules Optional

6.14 Creating Geography Optional

6.15 Creating Budget Adjustment Types Optional

6.16 Creating Budget Thresholds Optional

Step Task Required
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6.17 Creating Claim Actions Optional

6.18 Creating Claim Reasons Optional

6.19 Creating Claims Types Optional

6.20 Creating Claims System Parameters Optional

6.21 Creating Trade Profile Item for Account and 
Organization

Optional

7.1 User Creation Yes

7.1.1 Defining Marketing Groups Yes

7.2 Optional Employee Setups Optional

7.3 User Security Yes

7.4 Security for Sales Online Pages Yes

8.1 Setting up One to One Fulfillment Optional

8.2 Setting up Marketing Encyclopedia Optional

8.3 Setting up Oracle Partners Online Optional

8.4 Setting up Scripting Optional

8.5 Setting up CRM Foundation: Territory Manager Optional

8.6 Setting up Call Center / Advanced Outbound Optional

8.7 Setting up Interaction History Optional

8.8 Setting up Descriptive Flexfields Optional

8.9 Setting up Default Budgets Optional

8.10 Checking Post Implementation Steps Yes

Step Task Required
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Basic Implementation

This chapter covers the set up of various foundation and dependency components 
necessary before the implementation of Oracle Marketing Online may proceed. It 
also covers the basic implementation steps that are common across multiple 
functionalities within Oracle Marketing Online.

In order to begin, it is beneficial to create the Implementation User, with the roles 
and responsibilities necessary to complete the implementation of Oracle Marketing 
Online. Complete user setup is covered in Chapter 7 User Setup.

Steps

Step Required Description

4.1  Setting up General 
Ledger

Yes Create basic accounting information.

4.2  Set up HRMS Yes Create basic human resource information.

4.3  Implement Oracle 
Inventory

Yes Implement basic inventory and create unit of 
measure information.

4.4  Creation of the 
Implementation User

Yes Create an Implementation User with all the 
responsibilities and roles required for the 
implementation of Oracle Marketing Online.

4.5  Implementation of 
Foundation and 
Dependency 
Components

Yes Implement foundation and dependent 
components as required for the organization’s 
implementation.

4.6  Implement Marketing 
Common Components

Yes Implement Components that are common to 
multiple tabs within Oracle Marketing Online.
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4.1 Setting up General Ledger

4.1.1 Setting up Accounting Calendar Types

Steps
1. Log in with General Ledger Super User responsibility.

2. Navigate to Applications > Functions > Setup > Financials > Calendars > Types.

3. Enter standard periods per year and year type (calendar or fiscal) and a 
description. Click in the Period Type column and select View > Find to display 
a list of available Period Types.

4. Save your work.

4.1.2 Setting up an Accounting Calendar
1. Navigate to Applications > Functions > Setup > Financials > Calendars > 

Accounting.

2. Enter the name of the accounting calendar in the Calendar field.

3. Add a description.

4. Enter Prefix, Type, Year, Quarter, Number, From and To dates, and Name in the 
table. Click New on the toolbar to generate additional table rows.

5. Save your work.

4.1.3 Setting up a Marketing Calendar
1. Navigate to Applications > Functions > Setup > Financials > Calendars > 

Accounting.

2. Enter the name of the marketing calendar in the Calendar field.

4.7  Implement Home Page 
Bins and Reports 
Security

Yes Provides security for viewing information on 
the home page.

4.8  Enabling Default 
Responsibilities

Yes Enables the setting of a default responsibility 
in the Profile page.

Step Required Description
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3. Add a description.

4. Enter Prefix, Type, Year, Quarter, Number, From and To dates, and Name in the 
table. Click New on the toolbar to generate additional table rows.

5. Save your work.

4.1.4 Enabling Additional Currencies
Oracle Marketing Online is seeded with most of the world’s currencies. To enable 
currencies follow these steps.

Steps
1. Log in with General Ledger Super User responsibility.

2. Navigate to Applications > Functions > Setup > Currencies > Define.

3. Enter a three digit code for the currency. Select View > Find to display a list of 
available currencies and their codes.

4. The Description, Issuing Territory, Precision and Extended Precision will be 
completed for you, if known.

5. Add the Symbol, Minimum Accountable Unit, Currency Derivation (Type, 
Factor, and Effective Date) and Effective Dates. 

6. Select the Enabled checkbox.

See Working with Multiple Currencies.

4.1.5 Set Currency Conversion Rates

Steps
1. Navigate to Applications > Functions > Setup > Currencies > Rates > Daily.

2. Click Enter By Date Range to enter a range of dates the rate is applicable.

3. Select the From and To currencies.

4. Enter a From date and a To date.

5. Type = corporate or spot. Other types may be defined below.

Note: This Marketing Calendar will be selected for the System 
Profile Option AMS Marketing Calendar, later in this chapter.
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6. Enter the exchange rate for the currencies and period. The inverse exchange rate 
will automatically be calculated.

7. Save your work.

4.1.6 Set up Currency Conversion Rate Types (optional)

Steps
1. Navigate to Applications > Functions > Setup > Currencies > Rates > Types.

2. Enter Rate Type and Description (for example, Corporate, Corporate Exchange 
Rate, Spot, or Spot Exchange Rate).

3. Save your work.

4.1.7 Create a Set of Books

Steps
1. Navigate to Applications > Functions > Setup > Financials > Books > Define.

2. Enter the full name of the Set of Books.

3. Enter a Short Name.

4. Enter a Description.

5. Select a Chart of Accounts. Click the ellipsis to display the available list.

6. Select the Functional Currency.

7. Select an appropriate Calendar.

8. The Period Type will be filled in automatically.

9. Save your work and close the form.

4.2 Set up HRMS
The responsibilities and navigation paths are different for the Oracle HRMS and 
Shared Oracle HRMS. See below for Responsibilities and base Navigation paths for 
each.

This section describes the creation of Organizations, Business Groups and Business 
Units. This is done prior to creating employees to ensure that employees are set up 
in the correct HR Organization.
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4.2.1 With Full Oracle HRMS
Responsibility: HRMS Manager

Navigation: People > Enter and Maintain

4.2.2 With Shared Oracle HRMS
Responsibility: CRM Administrator

Navigation: CRM Foundation > Resource Manager > Maintain Employees > 
Employees

4.2.3 Create Lookup Tables for Organization Types
In this step you are creating suborganization types. For example, if the organization 
is divided into business groups, then create an organization type called Business 
Group. If the organization is divided into subsidiaries, create an organization type 
called Subsidiary.

The next several groups of steps serve to create an organizational hierarchy for the 
organization. Create the lowest level object first and then build up the hierarchy. 

Steps
1. Switch responsibility as noted above.

2. Navigate to Applications > Functions > Other Definitions > Lookup Tables.

3. Select View > Find and enter ORG% to locate ORG_TYPE.

4. Enter a User Name.

5. In the Application field, use the ellipsis to select Oracle Marketing. 

6. Enter a description. 

7. In the table, enter a Code, Meaning, Description, Tag, From and To Dates, and 
select the Enabled checkbox to make the organization type available. Enter as 
many organization types as desired.

Note: If you have the full installation of Oracle HRMS then you 
cannot create employees under CRM Foundation > Resource 
Manager > Maintain Employees > Employees. You will receive an 
error message indicating that you must use HRMS.
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8. Save your work.

4.2.4 Creating Locations

Steps
1. Navigate to Applications > Functions > Work Structures > Location.

2. Enter a Name.

3. Enter a Description.

4. Select an Address Style

5. Enter Address information. Click OK.

6. Save your work.

4.2.5 Business Groups
Set up organizations in Oracle HRMS to record the physical locations where your 
employees work and all the different departments and sections which make up the 
organization. A default business organization has been set up for you, so this step is 
not required for sales applications to be fully operational. However, you must set 
up organizations if you plan to use any financial ERP applications in the future.

Organizations can also help you set up security for the marketing applications. For 
example, you can attach responsibilities with different levels of security to the 
different operating units you set up as organizations. Any individuals employed in 
those units automatically inherit that responsibility.

See the Organization Management chapter in the Using Oracle HRMS -- The 
Fundamentals for detailed setup steps and Multiple Organizations in Oracle 
Applications.

4.2.6 Creating Organizations

Steps
1. Navigate to Applications > Functions > Work Structures > Organization > 

Description.

2. Click New.

3. Enter a Name for the organization.
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4. Select an Organization Type (from the list entered above).

5. Select a Location (from the list entered above). 

6. Select whether the organization is Internal or External.

7. Select an Organization Classification from the LOV by clicking the ellipsis.

8. Select Enabled.

9. Save your work.

10. Click Others.

11. Click the ellipsis to enter and select information for the particular organization.

12. Enable by selecting the checkbox.

13. Repeat Steps 7 through 12 to enter additional classifications.

14. Save your work.

15. Click Add to add additional organizations as necessary.

4.2.7 Assigning Attributes to Responsibilities

Steps
1. Switch responsibility to System Administrator.

2. Navigate to Applications > Functions > Profile > System.

3. Responsibility field: Select the responsibility to be assigned to the profile.

4. In the profile field enter HR% and click Find.

5. Select an organization for the HR: Security Profile.

6. Select an organization for the HR Business Group. (This should be the same 
organization as selected for the HR: Security Profile.)

7. Save your work.

4.2.8 Creating a Legal Entity, Operating Unit, HR Organization, and Business Units

Steps
1. Log on with the appropriate HRMS Manager responsibility.
 Basic Implementation 4-7



Set up HRMS
2. Navigate to Applications > Functions > Work Structures > Organization > 
Description.

3. Select the organization to assign its legal entity, operation unit and HR 
Organization.

4. Adding a GRE / Legal Entity:

a. Under the organization classifications name, add GRE / Legal Entity.

b. Select Enabled.

c. Save your work.

d. Click Others.

e. Select Legal Entity Accounting.

f. Click the ellipsis to enter information.

g. Select a Set of Books (defined above).

h. Click OK.

i. Save your work.

5. Add an Operating Unit:

a. Under Organization Classifications Name, add Operating Unit.

b. Click the ellipsis to select a classification.

c. Select a Legal Entity from those entered in Step 4.

d. Click Others.

e. Select Legal Entity Accounting.

f. Click on the ellipsis to enter information.

g. Select a set of books.

h. Click OK.

i. Enable by selecting the checkbox.

j. Save your work.

6. Adding an HR Organization:

a. Under Organization classifications name, add HR Organization from the 
LOV.

b. Enable by selecting the checkbox.
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c. Save your work.

d. Click Others to enter additional information.

e. Save your work.

7. Close the form

8. Creating Business Units:

a. Click New.

b. Fill in Name of Business Unit.

c. Select Type (Business Unit).

d. Select Internal or External.

e. Save your work.

4.2.9 Assign Multi Org Responsibilities
Oracle Marketing Online expects the implementation of Multiple Organization 
Structure. Please refer to Multiple Organization in Oracle Applications for additional 
information.

Assign Multi Org responsibilities to a selected responsibility to display the Business 
Unit when using that responsibility.

Steps
1. Log on with System Administrator Responsibility.

2. Navigate to Applications > Functions > Profile > System.

3. Select responsibility to assign to the profile.

4. In the profile field enter MO%.

5. Click find and select MO: Operating Unit.

6. Select the appropriate Operating Unit. The organization’s Business Rules will 
determine how Operating Units are structured.

7. Save your work.

4.3 Implement Oracle Inventory
Implement Inventory as described in the Oracle Inventory Implementation Guide.
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4.3.1 Creating Units of Measure
Units of measure must be entered into Inventory to assist in defining items placed 
therein. For purposes of Oracle Marketing Online, events, deliverables, products, 
and offers depend on information held in Oracle Inventory.

Steps
1. Log in using Inventory responsibility.

2. Navigate to Applications > Functions > Setup > Units of Measure > Classes

3. Select an Organization from the displayed list.

4. Click Add on the toolbar to add an additional line in the table if necessary.

5. Define a UOM class by:

a. Entering the class name such a length, time, area or weight.

b. Enter a description

c. Enter a base unit. For example, a base unit of time might be a second (click 
Units of Measure to enter information).

d. Enter a UOM Code (maximum of 3 characters).

e. Save your work.

6. Define a UOM by selecting a class row in the table and then clicking Units of 
Measure and entering the following:

a. Name.

b. Unit of Measure Code (maximum of 3 characters).

c. Description.

d. Repeat for additional Units of Measure in the class.

e. Save your work.

7. Click Conversions to enter conversion information for that Unit of Measure 
Class. Be sure that both Units of Measure have been defined before entering a 
conversion between them.

a. Select or enter a Unit of Measure. Click the ellipsis to display a list if more 
than one UOM is defined for that class.

b. The class column defaults to the same class. Change if converting between 
classes.
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c. Enter a conversion ratio. For example, one liter is 1000 milliliters.

d. The base unit defaults to the base unit for the class.

e. Save your work.

Alternative Steps
1. Alternatively, Units of Measure may be entered by navigating to Applications > 

Functions > Setup > Units of Measure > Units of Measure and completing the 
steps above.

2. Alternatively, Units of Measure Conversions, may be entered by navigating to 
Applications > Functions > Setup > Units of Measure > Units of Measure 
Conversions and completing the steps above.

4.4 Creation of the Implementation User
Creating an Implementation User with all the necessary responsibilities will make 
implementing Marking Online easier as only one user and password will be 
required to complete all steps.

Steps

Note: The Implementation User must be assigned to a group with 
Sales and TeleSales and Oracle Marketing Usages. If this group 
does not exist, please see section 7.1.1 to create this group. The 
Implementation User requires these groups in order to access the 
Audience tab and Administration tab.

Note: You must perform these steps in this order shown. 

Step Required Description

1.  Create the Employee Yes

2.  Create an 
Implementation User

Yes Creates the user with all the responsibilities 
necessary to implement Oracle Marketing 
Online. Users must be matched to employees.

3.  Set Profile Options Yes Set Profile Options for the User.
 Basic Implementation 4-11



Creation of the Implementation User
1. Create the employee:

a. Log into forms.

b. Select appropriate HRMS Manager Responsibility.

c. Navigate to People > Enter & Maintain.

d. In the Find Person box, select New.

e. Enter the following information:

– Last Name and First Name

– Title (courtesy title: Mr., Ms.)

– Gender (will populate based on title, if possible)

– Type = Employee

– Social Security # (will be checked against existing SS#)

– Birth Date

f. Save your work. A confirmation will appear in the lower left corner of the 
window.

g. Click Assignment and enter the following:

– Organization

– Team/Group

– Location 

– Supervisor

h. If a dialog with Update and Correction buttons displays, select Correction 
to revise existing data and Update to create a new record.

4.  Import Employees Yes Import employees into Resource Manager.

5.  Specify Roles and 
Groups

Yes Some roles are required for access to tabs.

6.  Run Concurrent 
Manager Program

Yes Updates denormalized tables with group 
information. Must be run to put the 
Implementation User into Groups.

Step Required Description
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i. Save your work. A confirmation will appear in the lower left corner of the 
window.

j. Select Yes to use the new location

2. Creating an Implementation User:

a. Log into Forms under the System Administrator Responsibility.

b. Navigate to Security > User > Define.

c. Create the Implementation User.

d. Assign the employee created in Step 1 to the Implementation User. 

e. Assign the following responsibilities to the Implementation User:

– General Ledger Super User

– HRMS Manager

– Inventory

– CRM Administrator

– Oracle Marketing Administrator

– Oracle Marketing Super User

– Preferences

– Workflow User Web Applications

– System Administrator

– Oracle Receivables (Trade Management)

– Oracle Payables (Trade Management)

– Advanced Pricing

– Receivables Manager

f. Log out and then back in as the Implementation User.

g. Select the System Administrator responsibility.

3. Set Profile Options:

a. Navigate to Profile > System.

b. Enter user name just created.

c. Search for profile JTF_PRO%.
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d. Set Default Application in the User column. For the Implementation User, 
this responsibility = 530.

e. Set Default Responsibility in the User column. For the implementation 
users, this responsibility = 21706 (Oracle Marketing Super User). 

f. Save your work.

4. Import Employees:

a. Change responsibility to CRM Administrator.

b. Navigate to Resource Manager > Maintain Resources > Import Resources.

c. Locate the employee just created. Enter employee’s name in the name fields 
and click Search.

d. Click Create Resource.

e. Click OK to accept default values.

f. Click Save Resource (record the transaction number).

5. Specify Roles and Groups:

a. Navigate to Resource Manager.

b. Select the user as the resource.

c. Click Details.

d. On the Roles tab, select a role type of Sales and a Role of Sales 
Representative.

e. On the Group tab, select a group with Usages of Sales and TeleSales and 
Oracle Marketing. 

f. Make sure that the Group Member Role Sales Representative is associated 
to the above group on the resource details screen.

6. Run the Concurrent Manager Program, AMS Group Access Refresh. (See Set Up 
and Run Concurrent Manager Programs.)

Note: This step is required to gain access to the Audience and the 
Administration tabs.
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4.5 Implementation of Foundation and Dependency Components
These steps in the basic implementation are those that are common to all 
implementations of Oracle Marketing Online. Regardless of the individual tabs and 
features that are implemented by an organization, these steps must be completed 
before moving on to the implementation steps for individual tabs and features.

4.5.1 Setting up CRM Foundation: Resource Manager
Resource Manager is used to create groups, role and role types and to import 
employees as resources. See the Oracle CRM Foundation Implementation Guide for 
more information.

4.5.2 Setting up CRM Foundation: Task Manager
Optional for basic implementation.

If implementing task transition rules, set the following profile option: Task 
Manager: Default Task Status, after defining a rule and assigning it to an 
appropriate responsibility. If no rules are assigned to a responsibility, all statuses 
will be displayed in the Status LOV and this profile option need not be set.

1. Set System Profiles:

a. Log into Forms as the Implementation User and select the System 
Administrator Responsibility. 

b. Navigate to Functions > Profile > System. 

c. Enter the appropriate profile name in the Profile Field and click Find. See 
the table below for the names of available profiles.

d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

Note: Implement the following dependent components as 
necessary. 
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If using Task Transition Rules, a System profile, Task Manager: Default Task Status, 
must be set to the first status value defined in Task Status Transition Rule for Oracle 
Marketing Applications, and Oracle Marketing Super User Responsibility. Refer to 
the Implementing Tasks section of the Oracle CRM Foundation Implementation Guide 
for information on Tasks.

4.5.3 Setting Up CRM Foundation Note Types
Optional for basic implementation.

Oracle Notes is a CRM Foundation Component. Oracle Notes comes with a set of 
predefined note types. You may choose not to use the predefined note types and 
create customized note types of your own. Or, you can use both the predefined set 
and additional customized note types.

Refer to the Implementing Notes section of the Oracle CRM Foundation 
Implementation Guide for additional information about setting up Oracle Notes.

Use the following procedure to set up note types.

Steps
1. Choose Notes Setup> Note Type Setup under the CRM Administrator 

responsibility.

Option Required Level Setting Effect/Limitation

Task 
Manager: 
Default Task 
Status

Optional Appli
cation

User Defined Required for implementing a task 
transition rule. This profile option 
must be set to the initial status of the 
rule.

Task 
Manager: 
Owner type 
for a task

Optional Appli
cation

User Defined Specifies the default task type when 
creating a task.

Task 
Manager: 
Default 
Priority

Optional Appli
cation

User Defined Specifies the default task priority 
when creating a task.

Task 
Manager: 
Default 
assignee 
status

Optional Appli
cation

User Defined Specifies the default assignee status 
when creating or assigning a task. 
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The Application Object Library: Note Type Lookups window appears.

2. Define the code, meaning, and description as desired. It is only necessary to 
define a tag for a new, customized note type.

3. Save the record when you are finished.

4. If specific Note Types are to be associated only with certain marketing objects, 
complete the following steps to assign a note type to a specific marketing object:

a. Select Notes Setups > Source and Note Type Mappings under the CRM 
Administrator Responsibility.

b. Choose the desired marketing object from the LOV for the Source Object 
field.

c. Select the newly created note type.

d. Save the record.

e. Repeat for additional marketing objects.

4.5.4 Setting up Advanced Pricing
Required for Products.

4.5.5 Setting up Oracle iStore
Required for Product Recommendations through Web Posting and Web Placement.

4.5.6 Setting up Oracle Accounts Payable
Required for Claims Payment in Trade Management.

4.5.7 Setting up Oracle Accounts Receivable
Required for Trade Management.

Note: If a note type is not associated with a specific marketing 
object, it becomes available to all marketing objects.
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4.6 Implement Marketing Common Components
These steps are used to implement common Profile Options, Lookups, Concurrent 
Manager Programs and Administration Options. 

Prerequisites
Admin Groups must be set up and available.

Steps 

1. Set System Profiles:

a. Log into Forms as the Implementation User and select System 
Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.

Step Required Description

1.  Set System Profiles Yes Set up common System Profiles

2.  Set up and Run 
Concurrent Manager 
Programs

Yes Run concurrent programs

3.  Administration Setup Yes

Option Required Level Setting Effect/Limitation

AMS System 
Timezone

Yes Site Select the 
timezone the 
central server 
is in.

Timezones are defined in HZ_
TIMEZONES.
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AMS Admin 
Group

Yes Site Select from 
any group 
defined in JTF 
Resource 
Groups

Resources that are part of this group 
will have full access to all campaigns, 
events, and other marketing objects. 
Note that this should be a single level 
group.

AMS Default 
Currency 
Code

Yes Site Select from 
currencies 
defined in 
FND_ 
CURRENCIES

This becomes the default functional 
currency. All transactions will be 
converted and stored in this currency. 
This will be the default currency for 
Currency LOV.

AMS 
Currency 
Conversion 
Type

Yes Site

The 
User 
level 
should 
not be 
selected.

Corporate, 
Spot or other 
conversion 
type defined in 
GL

If the functional currency of the 
organization and the transactional 
currency of the marketing object are 
different, this conversion will be 
used. 

AMS Source 
Code Date 
Format

Yes Site Any valid date 
format

Used in the generation of source 
codes.

AMS Source 
Code 
Sequence 
Length

Yes Site Maximum 
field length is 
30.

Source Code includes Geography 
code, Month code, Activity code, 
Source code digits and Suffix. See 
Source Codes.

AMS: UOM 
Area

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, area in square feet).

AMS: UOM 
Length

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, length in feet).

AMS: UOM 
Quantity

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, units in each).

AMS: UOM 
Time

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, time in minutes).

AMS Profile 
Search Set 
Size

Yes User Numeric Indicates the number of rows 
displayed in selection windows.

Option Required Level Setting Effect/Limitation
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AMS 
Upgrade 
Complete

Optional Site Yes/No Yes means no upgrade and No means 
will upgrade data. Set this profile to 
No if the upgrade has run once 
already.

AMS: 
Validation

Optional User 0-100 This profile option affects the 
validation severity at the database 
level. A value of 100 (Maximum 
value of 100) would cause the APIs to 
validate the passed data very 
stringently.

OSO: 
Minimum 
search string 
length

Optional Site or 
User

User Defined The default setting is 0. This profile 
determines the number of characters 
that must be entered before 
performing a search. 

OSO: Search 
Lead 
Wildcard

Optional Any Yes/No If Yes, the wildcard (%) will be 
allowed as the first character in a 
search string. If No, and the wildcard 
is entered as the first character, the 
system will give the user an error 
message.

AMS: Grace 
Period in 
Days

Yes User User/Org 
determined 
number of 
days

When automatic reconciliation of 
budgets is performed, this grace 
period is checked. If the marketing 
object is older than the ending date 
plus the grace period, any remaining 
funds associated with the marketing 
object are returned to the budgets 
they were drawn from.

This also sets the number of days 
after the completion of a campaign 
for the concurrent manager to delete 
the target group entries from the 
AMS_LIST_ENTRIES table default is 
30 days.

JTF Home 
Page File 
Name

Optional Site or 
Appli
cation

User Defined. Enter a file name of the jsp file (for 
example, jtfhomepage.jsp). If no 
value is supplied, a generic 
information page is displayed. If a 
file is supplied it will be displayed on 
the home page.

Option Required Level Setting Effect/Limitation
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2. Set up and run Concurrent Manager programs: 

a. Switch to the appropriate responsibility.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent manager programs and their descriptions.

3. Administration Setup:

a. Log into Marketing Online as the Implementation User.

b. Navigate to Administration > Marketing 

Concurrent 
Manager Required Responsibility Description

AMS Group 
Access Refresh

Yes Oracle 
Marketing 
Administrator

Updates denormalized tables with group 
information. Should be run on a periodic 
basis according the organization’s Business 
Rules. Changes made to the resource 
groups will not take effect in the 
application’s security until this program is 
run.

AMS Team 
Access Refresh

Yes Oracle 
Marketing 
Administrator

Updates denormalized tables with team 
information. Should be run on a periodic 
basis according to the organization’s 
Business Rules. Teams added to marketing 
objects will not gain access to the marketing 
objects until program is run.

AMS: Portal 
Cache Daemon

Yes Oracle 
Marketing 
Administrator

Populates the Marketing subtab on the 
Home tab.

Workflow 
Background 
Process

Yes System 
Administrator

Starts the Workflow engine.

Load 
Geographic 
Hierarchies

Yes CRM 
Administrator

This program must be run each time that 
the geographies are changed.

AMS Load 
Inventory 
Categories

Yes Inventory Loads categories from the MTL schema to 
the AMS schema denormalized tables. This 
program should be run if and when a new 
category is created in Inventory.
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c. Make the following selections. See the Administration section for additional 
information.

4.7 Implement Home Page Bins and Reports Security

Use
Security for home page bins and reports is a very useful feature, it lets you control 
the types of bins and reports available to a specific responsibility. A User will not be 
able to see the components until appropriate responsibility is assigned to them. 
Initially when there is no security assigned a message will be displayed in the 
components saying Insufficient Privileges to Access. Only a System administrator 
can change the responsibilities associated with a component. 

Component Item Choices Effect

Setup Custom 
Setup

User created 
and seeded

Create the custom setups that will be used 
for campaigns, events and other objects. 
These choices will populate the setup type 
LOVs.

Setup Activity User created 
and seeded

Create the activities that will be used for 
various marketing objects. These choices will 
populate the activity LOV.

Setup User Status User created 
and seeded

Create the user statuses that will be used for 
various marketing objects.

Setup Locking 
Rule

User created 
and seeded

Create the locking rules that are determined 
by the organization’s Business Rules. Fields 
specified here will be locked for update at 
the statuses specified. 

Setup Mandatory 
Rule

User created 
and seeded

Create the mandatory rules that are 
determined by the organization’s Business 
Rules. Fields specified here are must be 
completed during object creation.

Setup Approval 
Rule

User created Create the approval rules budget and theme 
approvals for campaigns, budgets and other 
objects. 

Geography Geographic 
Area

User created 
and seeded

Create the geographic areas that will be used 
by Marketing Online, if required. After 
creating the Geographic Areas, log into 
Forms and run the concurrent manager 
program Load Geographic Hierarchies. This 
must be done each time the geographic areas 
are updated.
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There are two methodologies for implementing security. The first methodology is 
used when multiple components are associated with the same responsibility. The 
second methodology is used when a particular component is associated with 
multiple responsibilities. 

Steps for Multiple Components to Same Responsibility
1. Logon to the admin console using the ‘SYSADMIN’ account. 

2. Navigate to Design > Declarative Components > Component Security. 

3. Select Responsibility to Components radio button.

4. Click Next to display a page that has a list of Responsibilities based on the 
Application selected.

5. Select the Responsibility that needs to be assigned and click the ‘Next’ button. 
The next page has a drop-down list of Applications and a UI Shuttle that 
contains two columns: Available Components and Selected Components. 

6. Select the application whose components need security assigned to them.

7. Then select the Components from the list and click the ‘Update’ button to save 
the data.

Steps for Single Component to Multiple Responsibilities
1. Logon to the admin console using the ‘SYSADMIN’ account. 

2. Navigate to Design > Declarative Components > Component Security. 

3. Select Component to Responsibility radio button.

4. Click Next to display a page which has the listings for all the Applications and 
the Components. List of components is populated on the basis of Application 
selected.

5. Select the Application and the component and click the ‘Next’ button. This 
takes the user to a page which has the same UI Shuttle but with the list of 
Available and Selected Responsibilities. 

6. Available Responsibilities Column is populated on the basis of application 
selected. To chose the application a drop-down is provided on top of the UI 
shuttle.

7. Now Multiple responsibilities can be selected and assigned to the component. 

8. Click Update to save your changes.
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Create Lookups for Home Page Components
1. Log into Forms and select Oracle Marketing Administrator responsibility.

2. Navigate to Functions > Setups > Lookups. 

3. Use View > Find to locate the individual keys. 

See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AGGREGATE_BY System YEAR

MONTH

QTR

INCREMENT

Year

Month

Quarter

Increment

AMS_YEARS System 1995

1996

1997

1998

1999

2000

2001

2002

1995

1996

1997

1998

1999

2000

2001

2002

AMS_QUARTERS System Q1

Q2

Q3

Q4

Q1

Q2

Q3

Q4
4-24 Oracle Marketing Online Implementation Guide  



Enabling Default Responsibilities
Test Implementation of Home Page Bins and Reports Security
1. Log into the application with a user account which has any of the 

responsibilities, as assigned to the components.

2. On the Home Page there is a ‘Personalize’ link. Click on that link and this will 
take to a page which has two UI Shuttles to allow the personalization of Bins 
and Reports. One shuttle is for Bin components only and the other is for 
Reports and Graphs.

3. Left hand column for both these shuttles display list of all the components, for 
which security has been assigned.

4. If security is not assigned properly, then the left hand side column will not have 
those components as available components.

5. If those components are there in the Available component List, then chose the 
components and click ‘Update’. This will take to the home page rendering the 
new components selected from Personalization page.

6. To Verify it further, now on the home page, the components should display the 
data. If they still have the message ‘Insufficient Privileges to Access’, then the 
security is not assigned properly.

7. Follow the steps described in ‘Steps to Implement Security’ again to check the 
security.

4.8 Enabling Default Responsibilities
Performing these steps will enable users to set a default responsibility within their 
available responsibilities. 

Prerequisites
None

Steps 
1. Log into the admin console using the ’SYSADMIN’ account.

Note: Before testing the implementation of Home Page Bins, 
complete the Implementation of Marketing Intelligence in 
section 5.12
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2. Navigate to Settings > Site Preferences > Interapplication Bar > Navigation 
Group Setup.

3. Enter a Group Name.

4. Enter a Description for the group.

5. Leave Status as Active.

6. Enter a value for the Display Order.

7. Click Update.

8. Click the Details icon to the right of the Group Name or click Navigation Group 
Details from the Side Navigation Menu.

9. Select the Application for the group.

10. Click Update.

11. This will create an application navigation list across the top of the screen. Click 
the application name to switch between two or more applications.

Test Enabling of Default Responsibilities
1. Log into the application with a user account.

2. Navigate to Profile > Personalization > Navigation Preferences.

3. Select a Default responsibility associated with the application chosen for the 
group.

4. Click Update.

5. Log out and back in. The application associated with the new default 
responsibility should display.
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Business Function Implementation

5.1 Implementation Overview
Complete the steps below as necessary for your implementation.

Step Required Description

5.2  Implement Campaigns 
and Programs

Optional Set up the Campaign tab. Required for Trade 
Management.

5.3  Implement Budgets Optional Set up the Budget tab. Required for Trade 
Management.

5.4  Implement Events Optional Set up the Events tab.

5.5  Implement Offers Optional Set up the Offers subtab, available from the 
Campaign and Products tabs. Required for 
Trade Management.

5.6  Implement List Optional Set up the List subtab, available on the 
Audience tab.

5.7  Implement List Import Optional Set up the List Import subtab, available on the 
Audience tab.

5.8  Implement Data 
Mining

Optional Set up the Analytics tab.

5.9  Implement Products Optional Set up the Products tab.

5.10  Implement Price Lists Optional Set up the Price Lists subtab, available on the 
Products tab.

5.11  Implement 
Deliverables

Optional Set up the Deliverables tab.

5.12  Implement Marketing 
Intelligence

Optional Set up Bins, Reports and Graphs for the Home 
Page, including Daily Business Close.
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5.2 Implement Campaigns and Programs
Campaigns are the heart of Marketing Online. Almost every other object within 
Marketing Online is associated with a campaign in some manner. Campaigns are 
the vehicle through which most marketing activities are conducted.

Programs are an umbrella object used to link many different marketing objects 
together, such as an event and the campaign that promotes it. 

Use
Campaigns integrate with Lists through Campaign Schedules, the execution 
component of campaigns. Offers are linked to campaigns for the purposes of 
capturing the campaign linked to the offer that generated the purchase. Budgets, 
deliverables, and messages are linked to campaigns. Campaigns, events, deals, 
trade promotions, partners, event promotions, collections, and programs may be 
linked together under a Program to form a multi-faceted marketing object.

Integration
Campaigns and their related schedules are used to close the marketing loop. The 
campaign codes assigned to direct marketing and other activities are recorded by 
Oracle Sales Online, Oracle TeleSales, Oracle iStore and Oracle Order Management 
to link purchases back to the campaign that inspired them. These campaign codes 
can then be used to quantifiably determine the success of a campaign.

Prerequisites
None

5.13  Implement Web 
Posting

Optional Set up the Web Posting subtab, available on 
the Execution tab.

5.14  Implement Web  
Placement

Optional Set up the Web Placement subtab, available on 
the Execution tab.

5.15  Implement Claims Optional Set up the Claims tab. Required for Trade 
Management.

Step Required Description
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Steps

1. Set System Profiles:

a. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

b. Navigate to Functions > Profile > System. 

c. Enter the profile name in the Profile Field and click Find. 

d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

2. Verify and create Lookups for Campaigns and Programs:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

Step Required Description

1.  Set System Profiles Optional Set System Profile Options for email blast.

2.  Verify and create 
Lookups for Campaigns 
and Programs

Yes Verify system Lookups. Verify and modify 
extensible Lookups as necessary. 

3.  Set up and Run 
Concurrent Manager 
Programs

Yes AMS Activate Schedule

4.  Administration Setup Yes Setup parameters in the Administration tab. 

5.  Test Implementation of 
Campaigns and 
Programs

Yes Perform tests to verify the implementation of 
Campaigns and Programs is correct.

Option Required Level Setting Effect/Limitation

AMS : Email 
Header 
Banner

Optional User Image File and 
Path

Image for the email header of an 
email blast.

AMS : Email 
Footer 
Banner

Optional User Image File and 
Path

Image for the email footer of an email 
blast. 
Business Function Implementation 5-3



Implement Campaigns and Programs
b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_ ACCESS_ TYPE System Group

User

Group

User

AMS_ CAMPAIGN_ 
SCHEDULE_STATUS

System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

New

On_Hold

Submitted_ BA

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

New

Active, but locked

Pending Budget Approval
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AMS_ CAMPAIGN_ 
STATUS

System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Planning

Submitted_Budget 
Approval

Submitted_Theme 
Approval

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Theme Approval

New

Active, but locked

Planned

Submitted for Budget Approval

Submitted for Theme Approval

AMS_ CAMPAIGN_
PURPOSE 

Extensible Awareness

Lead

Lead_ Maturation

Sales_ Readiness

Awareness

Lead Generation

Lead Maturation

Sales Readiness

AMS_ CONTACT_ POINT_
TYPE

Extensible Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Address

Email

Fax

Inbound Script

Outbound Script

Phone

Website

AMS_ CONTENT_ TYPE Extensible HTML

Text

HTML

Text

Used for email schedules

Key Type Values Meanings
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AMS_ MASTER_ OBJECT_ 
TYPE

System Camp

CSCH

EONE

EVEH

Campaign

Campaign Schedule

One-Off Event

Event

AMS_ MEDIA_ TYPE System Broadcast

Deal

Direct_Marketing

Events

Internet

In_Store

Public_Relations

Trade_Promotion

Advertising

Deal

Direct Marketing

Events

Web Marketing

In Store

Press and Analyst Relations

Trade Promotions

AMS_ PRIORITY System Fast_Track

High

Standard

Fast Track

High

Standard

AMS_ PROGRAM_ 
OBJECTIVE

User User Defined

AMS_ PROGRAM_ STATUS System Active

Archived

Cancelled

Completed

New

On_Hold

Active

Archived

Cancelled

Completed

New

Active, but locked

AMS_ ROLLUP_ TYPE Extensible Coll

Deal

ECAM

EVCAM

Partner

RCAM

TRDP

Collection

Deal

Campaign

Event Promotions

Partner

Program

Trade Promotion

AMS_ SCHEDULE_ 
OBJECTIVE

User User Defined

Key Type Values Meanings
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3. Set up and Run Concurrent Manager Programs: 

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent manager programs and their descriptions.

AMS_ TRIGGER_ CHK_ 
METRIC_ TYPE

System Actual

Forecast

Actual Value

Forecast Value

AMS_ TRIGGER_ CHK_
TYPE

System DIWB

Metric

Static_Value

Workbook

Metric

Static Value

AMS_ TRIGGER_ 
FREQUENCY_TYPE

System Daily

Hourly

Monthly

None

Quarterly

Weekly

Yearly

The frequency of trigger checking

AMS_ TRIGGER_ TYPE System Metric_Metric

Metric_Value

Metric_ Workbook

Metric to Metric type trigger

Metric to Value type trigger

Metric to Workbook type trigger

AMS_CAMP_ RELATED_ 
EVENT

System EONE

EVEH

EVEO

One-Off Event

Event

Event Schedule

Concurrent Manager Required Description

AMS Activate Schedule Optional This will pick up all the Campaign Schedules 
which are in Available status and for which the 
start date has passed and its Campaign is active 
and make the Schedule Active.

Key Type Values Meanings
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4. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing.

c. Make the following selections, entering information as it pertains to 
Campaigns and Programs:

5. Test Implementation of Campaigns and Programs:

a. Log into Marketing Online.

b. On create campaign page, verify that LOVs are present and that defaults 
(Currency, Owner’s Name, for example) are displayed.

Workflow Background 
Process

Optional In order to implement triggers, Workflow 
Background Process must be run for the item 
type OMO Triggers. Note that System 
Administrator (or any other user running this 
program), will require the proper JTF resource 
and be added to the Fulfillment Server Group in 
order to send email through triggers.

Component Item Choices Effect

General Marketing 
Medium

User Created Create the marketing mediums that will be 
used in campaign schedules and relate each 
to the appropriate activity.

Depending on the Activity type and the 
Activity used by the campaign schedule, 
these marketing mediums will populate the 
LOV in the campaign schedules page.

General Metric User created 
and seeded

Create the metrics that will be used for 
tracking campaigns and campaign schedules. 
These metrics will be available in the LOV of 
campaigns and campaign schedules. See 
Creating Metrics.

Note: If planning to use event type schedules with Campaigns, 
complete the implementation steps for Events.

Concurrent Manager Required Description
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c. Create a campaign which has all items on the Side Navigation Menu 
available and click through each item verifying that each page displays 
correctly.

5.3 Implement Budgets
Budgets are used extensively within Marketing Online to supply funds for 
campaigns, events, offers, and other marketing objects. When funds are requested, a 
set of approval rules and workflows are set into motion. Budget funds are released 
for marketing objects only after approvals are received.

Implementing Budgets involves four different areas: Budgets, Budget Sourcing,  
Partner Budgets, and Generating Accounts. 

Use
Budgets are integrated with Campaigns and Events and other marketing objects 
that require funding. Approval rules determine the budget approval process and 
direct the approval workflow.

Integration
Budgets, when Trade Management is implemented, are integrated with GL for the 
purposes of Sales Expense accounts and Accrual Liability accounts. 

Prerequisites
None

Note: If the organization is implementing One to One Fulfillment, 
ensure that users: (a) have JTF_FM_ADMIN role assigned to them, 
and (b) are assigned to the Fulfillment Resource Group. See User 
Setup for more information.

Note: Please see Implementing the Fulfillment server to utilize 
Oracle One to One Fulfillment for email direct marketing 
campaigns.
Business Function Implementation 5-9



Implement Budgets
Steps

1. Set System Profiles:

a. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

b. Navigate to Functions > Profile > System. 

c. Enter the profile name in the Profile Field and click Find. 

d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

Step Required Description

1.  Set System Profiles Yes Specify profile information

2.  Verify and create 
Lookups for Budgets

Yes Verify and Create Lookups for Budgets.

3.  Set up and Run 
Concurrent Manager 
Programs

Yes Set up Concurrent Manager Programs for  
Budgets.

4. Administration Setup Yes Set up parameters in the Administration Tab.

5.  Generating Accounts Optional Set up accounts for Budgets and Claims.

5. Test Implementation of 
Budgets

Yes Perform tests to verify the implementation of 
Budgets is correct.

Option Required Level Setting Effect/Limitation

AMS: Show 
GL Accounts 
On Screen

Yes User Yes/No Default is Yes. If Yes is selected the 
Sales/ Expense Account field and the 
Accrual Liability Account field 
appear in the Budget Details page.

AMS: Source 
from Parent 
Object

Yes Site Yes/No Yes indicates that campaign and 
event schedules may only source 
from their parent objects. No 
indicates that schedules may source 
funds directly from a budget.
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2. Verify and Create Lookups for Budgets:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

See the table below for Lookups and their types, values and meanings.

AMS: Allow 
Recalcula-
tion of 
Committed 
Budget

Optional All Yes/No When set to Yes will perform 
recalculation for commitment of 
offers.

AMS: 
Default 
Period in 
Days for 
recalculating 
committed 
budget

Optional All Number of 
Days

The number of days between 
performing committed budget 
calculations.

AMS: Allow 
committed 
budget to 
exceed total 
budget

Optional All Yes/No When set to Yes, the committed 
amount for a budget may exceed its 
total budget amount.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Option Required Level Setting Effect/Limitation
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Key Type Values Meanings

AMS_FUND_ STATUS System Active

Archived

Cancelled

Closed

Draft

On_Hold

Pending

Rejected

Active

Archived

Cancelled

Closed

Draft

On Hold

Pending Approval

Rejected

AMS_FUND_ TYPE System Fixed

Fully_ Accrued

Fixed

Fully Accrued.

AMS_ ACCRUAL_ BASIS System Customer

Sales

Custom

Sales

(Required for Trade Management)

AMS_QP_ ARITHMETIC_ 
OPERATOR

System %

Amt

Lumpsum

Newprice

Percent

Amount

Lumpsum

NewPrice

AMS_ UTILIZATION_ 
TYPE

System Accrual

Adjustment

Sales_ Accrual

Utilized

Accrual

Adjustment

Sales Accrual (refers to the salesperson)

Utilized

AMS_ TRANSFER_ TYPE Extensible Release

Reserve

Transfer

Request

Utilized

Release

Reserve

Transfer

Request

Utilized
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AMS_FUND_ SOURCE System CAMP

EVEH

EVEO

FUND

CSCH

DELV

EONE

OFFR

PTNR

OPTN

VEND

USER

Campaign

Event

Event Schedule

Budget

Campaign Schedule

Deliverable

One Off Event

Offer

Partner

Other Partner

Vendor

Person

AMS_ PARTNER_ 
HOLDING_ TYPE

(Holding Owner)

System PTNR

VEND

Partner

Vendor

Only used when Partners Online is 
implemented.

AMS_ TRANSFER_ 
REASON

User Sourcing Initial Sourcing

AMS_ BUDGET_ SOURCE_ 
STATUS

System Approved

Closed

New

Pending

Rejected

Approved

Closed

Planning

Pending

Rejected

AMS_OBJECT_ CLASS System Order

Order_line

Invoice

Order

Order Line

Invoice

AMS_ PRODUCT_ LEVEL System Product

Family

Product

Product Family

Key Type Values Meanings
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3. Set up Concurrent Manager Programs:

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent managers and descriptions.

AMS_VALUE_ LIMIT Extensible Balance

Committed

Paid

Planned

Utilized

Balance

Committed

Paid

Planned

Utilized

AMS_ ADJUSTMENT_
TYPE

Extensible Decrease_ 
Committed

Decrease_ Comm_ 
Earned

Decrease_ Earned

Standard

Decrease Committed Amount

Decrease Committed and Earned 
Amounts

Decrease Earned Amount

Increase Earned Amount

Concurrent Manager Required Description

AMS-TM: Funds Accrual 
Engine

Yes Ability to calculate budget utilization and 
earnings based on ship confirmed orders 
(provided the offer’s phase is set to ‘Ship’, else 
the accruals will be calculated at the phase the 
offer is applied). 

In case of Fully Accrued type of Budgets with 
accrue to is ‘customer’, Budget, Committed 
and Earned columns are to be updated with the 
accrued amount. But in case of budgets with 
accrue to ‘Sales’, only Budget column will have 
to be updated. Committed and Earned should 
not be populated. This allows users to transfer 
money from Fully accrued budget to any other 
Fixed Budgets. If max cap is specified against 
the Fully accrued budget, the budget can be 
accumulated only to the level of max cap. 

Parameters: None.

Key Type Values Meanings
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AMS-TM Utilize Lumpsum 
Offers

Yes A user initiated background process that will 
account budget utilizations against lumpsum 
offer whenever the offer start date arrives 
rather than on offer approved or created date. 

In case when the Offer is active on the date 
when Offer was created, then the budget 
utilization will be updated immediately.

AMS-TM: Release 
Committed Budget Amount 
After Grace Period

Yes A budget has been committed for an offer or 
any other activity. The Activity or offer date 
has ended or the offer is going to be closed or 
canceled. There might be a situation that the 
budget has not been utilized completely. This 
feature can be implemented through a 
concurrent process that would return back the 
unused committed amount back to the 
sourcing budget. If there is a grace period, 
release of committed amount from a fixed type 
fund would take place whenever a offer is 
closed or canceled after the attainment of the 
grace period. 

Parameters: p_object_type (Object Type, for 
example, CAMP, OFFR, EVEH)

AMS-TM: Validate Budget 
Thresholds

Yes Threshold Alert provides the feature to 
monitor over spending or under spending from 
time to time. The concurrent program performs 
the automatic process of verification and 
notifies the owner of the budget on over & 
under utilization.

Parameters: None

AMS-TM: Import Territory 
Hierarchy

Yes This concurrent program uploads the hierarchy 
data from jtf_territories to AMS schema to be 
able to perform budget allocation to that 
territory hierarchy. The concurrent program 
expects a hierarchy id meaning which 
particular hierarchy the user wants to import.

Parameters: Hierarchy Id

AMS-TM: Perform 
Recalculated Commitment 
for Offers

No Performs recalculation of committed budget for 
offers.

Concurrent Manager Required Description
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4. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing.

c. Make the following selections, entering information as it pertains to 
Budgets.

See the table below for Administration selections and their values.

5. Generation of Accounts.

Oracle Marketing Online provides a Account Generator. If the default processes 
do not satisfy the organization’s  accounting requirements, you can use the 
Oracle Workflow Builder to customize the default Account Generator processes 
or add new processes if desired. 

6. Test Implementation of Budgets:

a. Create a fixed type budget and make it active.

b. From a campaign, request funds from a budget.

5.4 Implement Events
The Event management module within Oracle Marketing provides the marketing 
professional the tools to plan for and execute on a variety of different types of 
events from the very simple to the very complex. 

Note: These concurrent manager programs should be setup to run 
after use of Budgets has commenced. They should not be run at the 
time of implementation.

Component Item Choices Effect

Claim System 
Parameter

Select a Set of 
Books from the 
LOV.

The set of books will be used for all 
functional-transactional currency conversion 
and posting to GL for all marketing objects. 
This should not be changed once 
implemented.

Claim System 
Parameter

Post to GL Yes 
or No

If set to Yes general ledger accounting will be 
done for all budget adjustments and accruals.
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To support the rapid creation, definition and maintenance of a large number of 
similar events, the user can setup Events that define content, message and planning 
information. Against these Events, event schedules can be defined for various 
locations and times. Events can act as templates for event schedules.

An Event can be created as part of a marketing campaign, or be an independent. 

Use
Events are integrated with Campaigns and Lists. Budgets, Deliverables, Messages, 
may be linked to Events. Events, Campaigns, and Programs may be linked together 
under a program to give an overall view of all marketing activities.

Integration
Events are integrated with Oracle TeleSales for the purposes of taking registrations 
and attendance for Event Schedules. Events are also integrated with  Inventory and 
Pricing.

Prerequisites
None

Steps

1. Set System Profiles:

a. Log into Forms as the Implementation User and select the System 
Administrator Responsibility. 

b. Navigate to Functions > Profile > System. 

c. Enter the profile name in the Profile Field and click Find. 

Step Required Description

1.  Set System Profiles Yes Enter various System Profile Options for 
Events.

2.  Verify and Create 
Lookups for Events

Optional Verify Lists of Values for Events.

3.  Administration Setup Yes Set up parameters in the Administration tab. 

4. Test Implementation of 
Events

Yes Perform tests to verify the implementation of 
Events is correct.
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d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

2. Verify and Create Lookups for Events.

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

Option Required Level Setting Effect/Limitation

AMS: Auto 
Register for 
Events upon 
cancellation

Yes Site Yes/No This is used to determine if the 
attendee can be moved from the 
waiting list to registered status if a 
spot is available

AMS: Copy 
Event Details 
to Event 
Schedules

Yes Site Yes/No This is used to allow details of parent 
Event to be copied to the schedule

AMS: Prefix 
to 
Registration 
Confirmation 
Code

Optional Site User Defined Characters for the Event Registration 
Confirmation Code.

AMS HZ 
Dedupe Rule

Optional Site Yes/No Indicates whether to use the TCA 
deduplication rules while performing 
event registration. 

Note: The registration confirmation code holds a maximum of 30 
characters. The code is created from two components: the profile 
AMS: Prefix to Registration Confirmation Code and the sequence 
number generated by the sequence ams_event_reg_confirmations. 
If the code exceeds 30 characters, users will receive an error: 
"character buffer too small" when registering.
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See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_DELIVERY_MEDIA_
TYPE

Extensible I SEMINAR

ON_SITE

SEMINAR

WEB

I Seminar

On Site

Seminar

Web

AMS_EVENT_STATUS System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Submitted_ BA

Submitted_TA

Planning

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Concept Approval

New

Active, but locked

Pending Budget Approval

Pending Concept Approval

Planning

AMS_EVENT_AGENDA_ 
STATUS

System Confirmed

Unconfirmed

Confirmed

Unconfirmed
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AMS_EVENT_TYPE Extensible Briefing

Conference

Exhibition

Hospitality

Internal_Event

Launch

Seminar

Speaking_ 
Engagement

Sponsorship_Event

Trade_Show

Web_Seminar

Workshop

Briefing

Conference

Exhibition

Hospitality

Internal Event

Launch

Seminar

Speaking 
Engagement

Sponsorship

Trade Show

Web Seminar

Workshop

AMS_ CONTACT_ POINT_
TYPE

Extensible Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Address

Email

Fax

In bound Script

Outbound Script

Phone

Website

AMS_ MASTER_ OBJECT_ 
TYPE

System Camp

CSCH

EONE

EVEH

Campaign

Campaign Schedule

One-Off Event

Event

AMS_ PRIORITY System Fast_Track

High

Standard

Fast Track

High

Standard

AMS_EVENT_SPEAKER_ 
STATUS

System Booked

Cancelled

Confirmed

Scheduled

Booked

Cancelled

Confirmed

Scheduled

Key Type Values Meanings
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AMS_EVENT_STREAM_ 
TYPE

System A

B

C

D

A

B

C

D

Track name

AMS_EVENT_WAITLIST_ 
ACTION

System First_Come_First First Come First Served

AMS_EVENT_RESOURCE_ 
TYPE

System AMS_People People

AMS_EVENT_REG_
STATUS

System Cancelled

Enrolled

Registered

Targeted

Waitlisted

Cancelled

Enrolled

Registered

Targeted

Waitlisted

AMS_EVENT_REG_
SOURCE

System Call_Center

External

On_Site

Partner

Web

Call Center

External

On Site

Partner

Web

AMS_EVENT_REG_
CANCEL_REASON

System Agenda_Change

Cost

Personal_Emergency

Price_Change

Sch_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Cost

Personal Emergency

Price Change

Scheduling Conflict

Speaker Change

Venue Change

Work Emergency

AMS_EVENT_PAYMENT_ 
STATUS

System Comp

Free

Invoiced

Paid

Refunded

Complimentary

Free

Invoiced

Paid

Refunded

Key Type Values Meanings
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3. Set up Concurrent Manager Programs:

AMS_EVENT_LEVEL System Main

Sub

Main

Sub

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

AMS_EVENT_DAY System Five

Four

Three

Two

One

5

4

3

2

1

AMS_EVENT_CERT_ 
CREDIT_ TYPE

System General

Seed

General

Seed

AMS_EVENT_CANCEL_ 
REASON

System Disaster

Insufficient_Reg

Postponed

Schedule_Conflict

Speaker_ 
Unavailable

Venue_Unavailable

Natural Disaster

Insufficient Registration

Postponed

Schedule Conflict

Speaker not available

Venue not available

AMS_EVENT_
ATTENDANCE_FAILURE

System Agenda_Change

Disaster

Personal_Emergency

Schedule_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Natural Disaster

Personal Emergency

Schedule Conflict

Speaker Change

Venue Change

Work Emergency

AMS_EVENT_ PURPOSE User Organization 
defined values

Purpose for the event.

AMS_EVENT_ 
SCHEDULE_ OBJECTIVE

User Organization 
defined values

Objective for the event.

Key Type Values Meanings
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a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent managers and descriptions.

4. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing.

c. Make the following selections, entering information as it pertains to Events.

See the table below for Administration selections and their values.

5. Test Implementation of Events.

a. Log into Marketing Online.

b. On the Create Event page, check to see that LOVs are present and that 
defaults (Currency, Owner’s Name) are displayed.

c. Create an Event, Event Schedule and a One-Off Event. Check items on the 
Side Navigation Menu, and click through each item.

Concurrent Manager Required Description

Activate Event Schedules Optional This will pick up all the Event Schedules which 
are in Available status and for which the start 
date has passed and its Event is active and 
make the Schedule Active.

Component Item Choices Effect

General Venues User Created Create the venues that will be used in event 
schedules.

General Metric User created 
and seeded

Create the metrics that will be used for 
tracking events and event schedules. These 
metrics will be available in the LOV for the 
Metrics item on the Side Navigation Menu of 
events and event schedules. See Creating 
Metrics.
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5.5 Implement Offers
Offers come in many different varieties and may be associated with different 
marketing objects as well as existing on their own. 

Use
Offers are generally associated with campaigns and campaign schedules. An offer 
must be associated with campaign in order to be associated with a related campaign 
offer. Claims may be recorded against offers. Offers may be sourced from a budget. 
When an offer is utilized, the sourced budget’s utilization is updated.

Integration
Offers depend on Advanced Pricing, Inventory and utilized by Order 
Quoting-Forms or Order Management. 

Offers are used by Oracle Sales Online and Oracle TeleSales to book opportunities.

Prerequisites
Oracle Advanced Pricing, Oracle Inventory, and either Oracle Quoting-Forms or 
Oracle Order Management must be implemented prior to implementing Offers in 
Oracle Marketing Online. Refer to the individual implementation guides.

Steps

1. Set System Profiles:

a. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

b. Navigate to Functions > Profile > System. 

c. Enter the profile name in the Profile Field and click Find. 

Step Required Description

1.  Set System Profiles Yes Specify profile information.

2.  Verify and create 
Lookups for Offers

Yes Verify and create Lookups.

3.  Test Implementation of 
Offers

Yes Perform tests to verify the implementation of 
Offers is correct.
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d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

Option Required Level Setting Effect/Limitation

AMS: 
Relationship 
Type for 
Buying 
Group

Yes Site Any valid 
relationship 
type created in 
TCA

Used to establish a hierarchical group 
of customers in TCA. For example, if 
value is set to subsidiaries then all 
parties who share this relationship 
will be part of a buying group. These 
are used as qualification criteria for 
offers.

QP: Accrual 
UOM Class

Yes Site UOM Classes 
as set up in 
Inventory

Used by accrual offers. All accrual 
units will fall under this UOM class 
(for example, frequent flyer miles).

QP: Item 
Validation 
Organization

Yes Respon
sibility

Inventory 
Organizations 
as set up in 
Inventory

Offers can be defined only for those 
products which will be available in 
the specified organization. Required 
for all offers.

QP: Source 
System Code

Yes Respon
sibility

Possible 
Source 
Systems that 
can define 
offers

Offers created using this relationship 
are tagged with this system source 
code and will be used to determine 
update privileges of offers within the 
pricing module.

AMS: 
Choose Date 
Qualifier 
Regions

Yes Site Show All

Show Header 
Dates 

Show only 
Date Qualifiers

This profile is used in the Trade Deal 
Offer User Interface.

Based on the setting, the user may 
either enter date qualifiers or Header 
Dates or both.

AMS Default 
Bucket for 
discount 
rules

Yes Site Values from 
Advanced 
Pricing 
Lookup 
PRICING_
GROUP_
SEQUENCE

The value set here will be used as the 
default value for buckets in the 
discount rules.
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2. Verify and Create Lookups for Offers:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

AMS: 
Default 
Phase for 
Line level 
discounts

Yes Site Available 
values are 
derived from 
event phase 
setup in 
Advanced 
Pricing

This value will be used as the default 
value for phase for all discount rules 
with a discount level of Line.

AMS: 
Default 
Phase for 
Line Group 
level 
discounts

Yes Site Available 
values are 
derived from 
event phase 
setup in 
Advanced 
Pricing

This value will be used as the default 
value for phase for all discount rules 
with a discount level of Group of 
Lines.

AMS: 
Default 
Phase for 
Order level 
discounts

Yes Site Available 
values are 
derived from 
event phase 
setup in 
Advanced 
Pricing

This value will be used as the default 
value for phase for all discount rules 
with a discount level of Order.

AMS: 
Default 
value for 
Print on 
Invoice Flag

Yes Site Yes/No Used as a default for all discount 
rules.

AMS: 
Default 
value for 
Product 
Preference

Yes Site User Defined Used as a default for all discount 
rules.

AMS: 
Default 
Offer 
Formula

Optional Site Available 
pricing 
formulas in 
Advanced 
Pricing

This option handles discount rules 
for product categories when the Unit 
of Measure is not specified.

Option Required Level Setting Effect/Limitation
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See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_OFFER_ DEAL_ 
CUSTOMER_ TYPES

Extensible Buyer

Customer

List

Segment

Buyer Group

Customer

List

Segment

AMS_ LUMPSUM_ 
DISTRIBUTION_ TYPE

System %

Amt

Qty

Percent

Amount

Quantity

AMS_OFFER_ LUMPSUM_ 
PAYMENT

System Accrue

Check

Accrue

Issue Check

AMS_OFFER_LUMP_
CUST_ TYPES

System Buyer

Customer

Buyer

Customer

AMS_OFFER_ STATUS System Active

Closed

Draft

Rejected

Closed

Pending

Pending_Active

Archived

Cancelled

Completed

Terminated

Onhold

Active

Closed

Draft

Budget Rejected

Closed

Pending budget approval

Pending Active

Archived

Cancelled

Completed

Terminated

On hold
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3. Test implementation of Offers.

a. Navigate to Products > Offers.

b. Create an Offer. The status field should be populated with a LOV.

c. The Advanced Options item on the Side Navigation Menu should display 
default values for Pricing Bucket, Incompatibility Group, and phase. 

d. Select Market Eligibility on the Side Navigation Menu. Select Customer 
Group in marketing context field and buying group from the context 
attribute field. Click Go from the attribute value field. This should display a 
set of customers.

5.6 Implement List
Lists are used extensively by Oracle Marketing Online and throughout many parts 
of the CRM Suite. Lists contain information on prospects, customers, and event 
registrants. Lists may be sourced internally, from the Trading Community 
Architecture database (TCA) or externally either through list import or by use of 
Oracle Discoverer.

Lists are static in nature. Lists are comprised of the actual information which differs 
from a Segment which is a query definition used to generate a list. Segments are 

AMS_OFFER_ TYPE System OID

Lumpsum

Order

Accrual

Off_Invoice

Deal

Terms

Promotional Goods

Lump sum

Order value

Accruals

Off Invoice

Trade Deal

Terms Upgrade

AMS_QP_ ARITHMETIC _
OPERATOR

System %

Amt

Lumpsum

Newprice

Percent

Amount

Lump sum

New Price

AMS_QP_ VOLUME_ TYPE System Pricing_Attribute10

Pricing_Attribute12

Quantity

Amount

Key Type Values Meanings
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dynamic in that using a Segment can potentially generate a different set of records 
each time it is used.

Use
Lists are used with Campaign Schedules to execute a campaign action on a 
particular set of prospects or customers. They are used with Events to create 
invitation lists. They are used with Offers to limit Offers to a particular marketing 
target. See the Oracle Marketing Online Concepts and Procedures Guide for more 
information of the use and creation of Lists.

Integration
Oracle Discoverer’s integration with Oracle Marketing Online is crucial to working 
with Lists. Lists are generated from both internal and external sources using 
Discoverer. Discoverer also makes it possible to generate very defined lists without 
the knowledge of database commands.

Other CRM products, such as Oracle Partners Online and Oracle TeleSales make use 
of Lists.

Prerequisites
None

Steps

1. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

Step Required Description

1.  Set System Profiles Yes Enter various System Profile Options for List.

2.  Verify and create 
Lookups for List

Yes Verify Lists of Values for List.

3.  Set up Discoverer Yes Sets up Oracle Discoverer for access from 
within Oracle Marketing Online.

4.  Setup and Run 
Concurrent Manager 
Programs

Optional Sets up Concurrent Manager programs 
required by List.

5.  Test Implementation of 
List

Yes Check for successful implementation of List.
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b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.

2. Verify and Create Lookups for List:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

Option Required Level Setting Effect/Limitation

ICX: 
Discoverer 
End User 
Layer

Yes Site User Defined EUL prefix for Discoverer, usually 
EUL4

ICX: 
Discoverer 
Launcher

Yes Site User Defined URL to launch Discoverer Web 
version

ICX: 
Discoverer 
Viewer 
Launcher

Yes Site User Defined URL to launch Discoverer viewer

ICX: 
Discoverer 
Use Viewer

Optional Site Yes/No Whether to use viewer instead Web 
Discoverer. Defaulted to No.

AMS: List 
Workbook 
B2C 
Marketing

Optional Site User Defined Workbook name convention prefix 
for B2C workbooks. The default is 
B2C. A blank convention prefix will 
result in more workbooks than you 
need in the LOV.

AMS: List 
Workbook 
B2B 
Marketing 

Optional Site User Defined Workbook name convention prefix 
for B2B workbooks. The default is 
B2B. A blank convention prefix will 
result in more workbooks than you 
need in the LOV.
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c. Use View > Find to locate the individual keys. 

See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Seeded Values Meanings

AMS_LIST_ ACT_TYPE User Employee List

List

Target group list selection type

AMS_LIST_ DEDUP_ TYPE User List

Import Consumers

Import 
Organizations

Type of Deduplication Rules to be 
applied

AMS_LIST_GENERATION_ 
TYPE

System Incremental

Standard

Update

Update No Purge

New entries added, old entries not 
deleted, entries not updated

All old entries deleted, new entries 
added

New entries added, old entries not 
meeting criteria deleted, entry 
information updated

New entries added, old entries retained, 
entry information updated

AMS_LIST_ ROW_ 
SELECT_ TYPE

System Nth Record

Random

Standard

How to select rows during list 
generation. Standard is top down 
selection.

AMS_LIST_ SEGMENT_ 
STATUS

User Archived

Available

Cancelled

Draft

Expired

Archived

Available

Cancelled

Draft

Expired

AMS_LIST_ SEGMENT_ 
TYPE

System Workbook

SQL

Two types of segments supported. Based 
on a Discoverer workbook or an SQL 
statement.
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AMS_LIST_ SELECTION_ 
ACTION

System Include

Exclude

Intersect

How each selection is added to the list. 
Exclude means that all entries that exist 
in the excluded list are removed from the 
current list. Intersect causes the current 
list to become a list of only those entries 
which are on the intersected list and the 
current list.

AMS_LIST_ SELECTION_ 
TYPE

System Segment

Workbook

Import List

List

SQL

Segment

Workbook

Import List

List

SQL

AMS_LIST_ STATUS System Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

AMS_LIST_ TYPE System Manual List

Standard List

Suppression List

Target Group

List of possible list types. Note where 
these appear in the program.

Key Type Seeded Values Meanings
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3. Set up Discoverer.

Obtain the Oracle iAS9i Installation Guide and the iDS9i Installation Guide. Oracle 
iAS9i must be patched to 1.0.2.2 or higher. Use these guides to perform the 
following. See Appendix L for more information.

a. Create the EUL.

b. Import the EUL.

c. Set up Discoverer ICX.

4. Set up and Run Concurrent Manager Programs: 

a. Switch responsibility to Oracle Marketing Administrator

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent manager programs and their descriptions.

5. Test Implementation of List.

Concurrent Manager Required Description

AMS: Refresh Party Market 
Segments

Optional Generates a list of parties in the segment. This 
program also updates the size information for 
all segments so a history of segment sizes may 
be maintained.

AMS: Generate Suppression 
list

Optional Updates and maintains organization defined 
suppression lists. This is in addition to seeded 
suppression lists.

AMS: Purge Target Group Optional After a target group has been generated and 
used, this program lets a user purge the list 
entries. 

AMS: Purge Imported List Optional During the import process, the user may 
specify an expiration date or number of uses 
for a list. This program removes those entries 
whose expiration date has passed or number of 
uses reached.

Optional Parameter: force_purge_flag. This 
parameter indicates whether to purge a record 
regardless of the associated campaign status. 
The default value is No.
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a. Log into Marketing Online and make sure you can successfully display all 
subtabs under menus.

b. Make sure that Oracle Discoverer launches with a single signon.

Known Issues or Conflicts
If a Discoverer generated workbook SQL statement has a “Group By” parameter in 
it, list generation may fail.

5.7 Implement List Import
List Import is a feature of Oracle Marketing Online which facilitates importing lists 
of prospects and their related information from outside sources. These may include 
rented or purchased mailing lists, mailing lists from merged or acquired 
organizations, or mailing lists provided by internal or external sales people. 

List Import is also a gateway to an organization’s Trading Community Architecture 
(TCA) database. Rented lists are held on a temporary basis while purchased or 
personal lists may be imported and added directly to the TCA tables. See TCA Best 
Practices White Paper, available from Metalink, for a complete description of TCA.

Use
List Import is integral to other list functionality within Oracle Marketing Online. A 
list may be created directly from the records imported by List Import or they may 
be held temporarily in the import tables. See Oracle Marketing Online Concepts and 
Procedures Guide for complete information on List functionality.

Integration
Oracle Marketing Online uses the export process to pass lead information to Oracle 
Sales Online and to TCA. 

Oracle Discoverer may be used during the import process to preview the staged 
data (in a temporary table). The Discoverer server must be set up so that the 
Discoverer single signon may be used to launch the Discoverer viewer. See the 
Oracle Discoverer Implementation Guide for more information.

The TCA word replacement system is used for word replacement while performing 
a deduplication check. Please use the TCA word replacement form to define new 
word replacements. 

Please see Word Replacements in TCA, in the Administration section, for more 
information.
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List Import Types
Oracle Marketing Online can perform three types of imports: Organizations, 
persons or addresses, Event registrations, and Leads import.

Organizations, Persons or Addresses
Imports the B2B or B2C type of data. The data is imported to both marketing and 
TCA tables based on the option selected, like preview or import on the list import 
review page. Preview option loads the data only to the OMO tables (AMS_IMP_
LIST_HEADERS_ALL, AMS_IMP_SOURCE_LINES, AMS_PARTY_SOURCES) and 
provides an option the check the data before importing it into TCA. Import loads 
the data into the TCA tables such as HZ_PARTIES, HZ_LOCATIONS, HZ_PARTY_
SITES, HZ_CONTACT_POINTS, and HZ_ORG_CONTACTS.

Event Registration
OMO event registration can also be executed from the list import. This imports data 
to the marketing tables and then does the event registration.

Lead Import
Oracle Sales Online lead import can also be done from list import. This process 
imports the data to the AS_IMPORT_INTERFACE table and then processes all the 
leads. It also populates TCA tables with the data.

Existence Checking
If implemented, existence checking checks the import record against existing 
records in TCA according to a schema outlined in Appendix H. Checks are 
performed on the Customer Name, Address, and Person contacts in this order. No 
existence checking is performed against Phone, Email, Web and Fax information. 
Implementing Existence Checking will reduce the number of duplicate records 
saved into TCA.

Prerequisites
SQL Loader, which is required to import files from the server location.

Steps

Step Required Description

1.  Create the Bin Directory Yes Creates a location for the SQL Loader control 
file.
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1. Create the Bin Directory. 

If a bin directory is not already present, create one under PRODUCT TOP 
($AMS_TOP) for the SQL Loader control file. This directory must have Read, 
Write and Execute privileges. This step is required to import data from a data 
file located on the server.

2. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. You can reduce 
the number of profiles found by entering first few letters of a profile name 
followed by the percent sign (%) as a wildcard.

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.

2.  Set System Profiles Yes Enter the paths for the Data File and Control 
File profiles.

3.  Set TCA Existence 
Checking System 
Profile Options

Optional Enter information in these System Profile 
Options if implementing TCA Existence 
Checking.

4.  Verify and Create 
Lookups for List Import

Optional Verify Lookups for List Import

5.  Run NFS Mount Optional Run NSF Mount if the concurrent manager 
server is different.

6.  Administration Setup Optional Set up Administration settings, including 
Deduplication Rules.

7.  Test Implementation of 
List Import

Yes Perform tests to verify the implementation of 
List Import is correct.

Step Required Description
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3. Set TCA Existence Checking System Profile Options.

See the table below for these options and their values. 

4. Verify and Create Lookups for List Import:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

Option Required Level Setting Effect/Limitation

AMS 
IMPORT 
CONTROL 
FILE PATH

Yes Site Control File 
Location

Enter the path for the bin directory: 
($AMS_TOP/bin)

Improper setup will cause the server 
side import to fail.

AMS 
IMPORT 
DATA FILE 
PATH

Yes Site Data File 
Location

Enter the path for the data file 
location 

Improper setup will cause the server 
side import to fail.

AMS HZ 
DEDUPE 
RULE

Optional Site Yes/No Indicates whether deduplication rules 
are in effect for records placed into 
TCA. 

Option Required Level Setting Effect/Limitation

HZ: Key 
Word Count

Optional Site Number of 
words

This number determines how many 
words in the customer name are used 
to generate the keys.

HZ: Address 
Key Length 

Optional Site Length of the 
Address

This determines the length of 
Address key.

HZ: Postal 
Code Key 
Length

Optional Site Length of the 
Postal Code

This determines the length of Postal 
Code key.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.
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See the table below for LOVs and their types, values and meanings.

5. Run NFS Mount. 

If the concurrent manager server is different from the server where your data is 
located and you want to import data from the server, run NFS Mount. This 
ensures that your data file directory is mounted to the concurrent manager 
server.

6. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing > Audience > Deduplication 
Rules.

c. Enter a Rule Name, Description and select a Type from: Import Consumers, 
Import Organizations or List. The Type determines when the rules will be 
applied.

d. Click Update.

e. Click the link of the rule just created.

f. Select a table column for this rule to check for duplicates.

g. Click Update. Select additional columns if required.

Key Type Values Meanings

AMS_ IMPORT_ TYPE System Customer

Event

Lead

Organizations, Persons and TCA data.

Event registration data. 

Leads data.

AMS_ IMPORT_ STATUS System New

Staged

Scheduled

Completed

Purged

Cancelled

Error

New Import

Entries are imported and available for 
viewing

Import is setup and ready to be 
completed at the scheduled time.

Import completed.

Imported entries have been purged from 
the Marketing Import Table.

The list import has been cancelled and 
may not be reactivated.

An error occurred during list import.
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h. Click the Deduplication Rules link to return to the Rules List.

7. Test Implementation of List Import

a. Verify that the bin directory is available under $AMS_TOP and it has Read, 
Write and Execute permissions. After running a test import, the control file 
(*.ctl) will be located in this directory.

b. Control file profile AMS IMPORT CONTROL FILE PATH is set to the 
proper value.

c. Data file profile AMS IMPORT DATA FILE PATH is set to the proper value.

d. If the concurrent manager server is different from the server where your 
data is location and you want to import data from the server, run NFS 
Mount. This ensures that your data file director is mounted to the 
concurrent manager server.

Known Issues or Conflicts
Performance may be slow if using complicated deduplication rules are used.

If importing more than 2000 records, the import file should be located on the server.

5.8 Implement Data Mining
Data mining in Oracle Marketing Online is used to analyze the performance of 
existing marketing activities, the results of this analysis can be used to create lists 
for use in future marketing initiatives.

Use
Oracle Marketing Online uses data mining technology to “learn” customer 
propensities based on their characteristics and past actions. Oracle Marketing 
Online uses this knowledge to make behavior predictions and generate lists based 
on those predictions. The generated lists are then used by marketing activities, 
including campaign schedules and event schedules, to improve customer targeting. 
Discoverer Workbooks may be created that select customers based on their data 
mining information.

Integration
Data mining uses the Trading Community Architecture (TCA), Interactions History, 
Accounts Receivable, Oracle Quoting-Forms, and Field Service as data sources for 
customer information.
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Prerequisites
Implement Oracle 9i Data Mining (ODM).

Steps

Step Required Description

1.  Set up the ODM 
Property File

Yes Create a file with property and value pairs to 
be used by the data mining Java program. The 
file should be created in a location accessible to 
the Java Concurrent Program.

2.  Set up ODM Data Input Yes The data source for ODM is in CRM tables. If 
the ODM schema and CRM schema are in 
different instances, a database link must be 
created to provide a path for ODM to fetch 
data from CRM. Data input views are used by 
the data mining engine to fetch data for model 
building and scoring.

3.  Set up the Link from 
CRM to ODM

Yes If the ODM output schema is in a different 
instance from the CRM schema, then a 
database link from the CRM to the ODM 
instance is needed to link the two schemas. 
CRM needs to access the ODM output schema 
to fetch scoring run results for processing. The 
setup includes setting values for the profile 
options AMS: Data Mining DB Link and AMS: 
Data Mining Engine Output Schema.

4.  Set Up Concurrent 
Manager Environment

Yes The data mining Java Concurrent Programs 
require ODM Java classes which are not 
installed by the standard CRM installation, so 
they must be manually configured in the 
CLASSPATH concurrent manager program. 
CLASSPATH is an environment variable 
containing directory information for java 
classes.

5.  Set System Profiles Yes Specify profile information.

6.  Set Up Concurrent 
Manager Programs

Yes Workflow Background Engine

AMS Expire Data Mining Models

AMS Update Data Mining Models

7.  Verify and create 
Lookups for Data 
Mining

Optional Verify Lookups for Data Mining.
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1. Set up the ODM Property File. 

Create and save a new property file with the following entries:

� miningServer.url=jdbc:oracle:thin:@<server>:<port>:<sid>

� miningServer.userName=<ODM username>

� miningServer.password=<ODM password>

� discretization.binnedBuildDataSchemaName=<schema used for binning 
data>

� applyInput.schemaName=<schema of apply input data>

� applyOutputResult.schemaName=<schema of apply output>

� InputData.DBLinkName=<ODM to CRM Database Link>

The file should not include the bullet points or any additional lines. The entries 
are described as:

� miningServer.url – the JDBC connection string for a thin client connection.

� miningServer.userName – the ODM username to use to connect to the data 
mining server.

� miningServer.password – the password used for the ODM user.

� discretization.binnedBuildDataSchemaName – the database schema in 
which the data mining engine writes binned data during the model 
building process.

� applyInput.schemaName – the database schema in which the input data for 
scoring is located.

� applyOutputResult.schemaName – the database schema in which the 
scoring output results are written.

� InputData.DBLinkName - The database link used to select input data from 
the CRM database to the ODM database.

After creating the property file, the profile option “AMS: Data Mining Engine 
Program Property File” must be set to the location of the file.

8.  Test Implementation of 
Data Mining

Yes Perform tests to verify the implementation of 
Data Mining is correct.

Step Required Description
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2. Set up ODM Data Input. 

If the ODM schema and CRM schema are in different database instances, create 
a database link in the ODM application schema to reference the CRM schema. 
The database link is needed for ODM to extract input data from the OMO data 
sources.

3. Set up the Link from CRM to ODM:

Create a Database Link in the CRM schema, which connects to the output 
schema of the ODM database. After creating the database link, set the values for 
the profile options: “AMS: Data Mining DB Link” and “AMS: Data Mining 
Engine Output Schema” (see Step 5 below).

4. Set up Concurrent Manager Environment: 

Configure the CRM mid-tier CLASSPATH. The ODM APIs depend on 9i JDBC 
drivers and are included in jar files installed by ODM. The jar files can be found 
under $ORACLE_HOME/dmt/jlib.

The following entries must be added to the CRM mid-tier CLASSPATH:

� odmapi.jar

� oputil.jar

The CLASSPATH can be set in the file $APPL_TOP/admin/adovars.env. In 
addition, modify the file to use JDK 2 by setting the value for the environment 
variable APPLJRE to indicate the executable of the runtime engine, usually 
<JDK 2 Directory>/bin/java. If APPLJRE does not exist, create an entry for it.

5. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.
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6. Set up Concurrent Manager Programs: 

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit New Request.

Option Required Level Setting Effect/Limitation

AMS: 
Marketing to 
ODM 
Database 
Link

Yes Site All database 
links in the 
database.

The scoring run result processing 
program will use the db link to fetch 
results.

AMS: Data 
Mining 
Engine 
Output 
Schema

Yes Site Free form text 
corresponding 
to the scoring 
output schema 
specified in 
Step 3.

The scoring run result processing 
program will use the scheme 
specified to fetch the results.

AMS: Data 
Mining 
Engine 
Program 
Property File

Yes Site Free form text 
corresponding 
to the location 
of the property 
file created in 
Step 1.

The Java Concurrent Program will 
use the property file indicated in the 
profile option value to invoke 
program settings by calling ODM 9i 
APIs.

Concurrent Manager Required Description

Workflow Background 
Engine AMS Models Build/ 
Score

Yes Choose item “AMS Models Build/Score” for 
the Workflow daemon to monitor data mining 
workflow requests. For data mining operations, 
a frequency of 30 minutes should be sufficient. 

Parameters:

Process Deferred: Yes

Process Timeout: Yes

Process Stuck: Yes

AMS Expire Data Mining 
Models

Yes Background process that monitors data mining 
models for expiration. A frequency of once a 
day should be sufficient.

AMS Update Data Mining 
Models

Optional Updates detail information collected on parties. 
The frequency should be the same as the BIC 
Summary Extraction process.
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7. Verify and Create Lookups for Data Mining:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_DM_ MODEL_ 
STATUS

System Available

Draft

Building

Scheduled

Scoring

Archived

Expired

Custom

Preview

Queued

Available

Draft

Building

Scheduled

Scoring

Archived

Expired

Custom

Preview

Queued

AMS_DM_ MODEL_ TYPE System Email

Telemarketing

DirectMail

Loyalty

Email Response

Telemarketing Response

Direct Mail Response

Loyalty/Retention
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8. Test Implementation of Data Mining:

a. Log into Oracle Marketing Online.

b. Navigate to the Analytics tab. The Model summary page should display.

c. Click the Scoring Runs subtab. The Scoring Runs summary page should 
display.

d. Click the Model subtab. Click Create. The Create Model page should 
display.

e. Enter required information and click Create. You will receive a confirmation 
message and the Model details page displays.

f. Select the Training Data item from the Side Navigation Menu and select 
data. 

g. Select the Build item from the Side Navigation Menu and submit a build 
request. Workflow should start for the model build process. Track the 
progress from the Model log entries on the Models summary page.

AMS_DM_ SCORE_ 
STATUS

System Draft

Scheduled

Scoring

Completed

Archived

Preview

Queued

Draft

Scheduled

Scoring

Completed

Archived

Preview

Queued

AMS_DM_ TARGET_ 
GROUP_ TYPE

System Business

Consumer

Organization Contacts

Persons

AMS_DM_ SOURCE_ TYPE System Standard

Cell

CSCH

DIWB

Generated List

Segment

Campaign Schedule

Discoverer Workbook

AMS_DM_ TARGET_ 
VALUE_ TYPE

System Binary

Categorical

Continuous

Binary

Categorical

Continuous

Key Type Values Meanings
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h. Select the Scoring Runs subtab. Click Create.

i. Enter required information, including selecting an available model from the 
Model LOV. Click Create to receive a confirmation. 

j. Click the Selections item from the Side Navigation Menu and select some 
data for scoring.

k. Select the Score item from the Side Navigation Menu and submit a scoring 
request. Workflow should start for the scoring run process. Track the 
progress from the scoring run log entries in Scoring Runs summary page.

5.9 Implement Products
Implementing Products gives Marketing Online a link to Oracle Inventory in order 
to tie various marketing objects to specific products or product families. The 
Product tab also gives the marketer the opportunity to enter new products, and 
price lists, or create new bundling of existing products.

Use
Products may be used with Campaigns, Events, Offers, and Deliverables as a 
limiting factor for those objects. 

Integration
Products are integrated with Oracle Advanced Pricing, Oracle Inventory,  Oracle 
Bill of Materials, and iStore.

Prerequisites
Complete the implementation steps required for inventory. Please refer to the Oracle 
Inventory Implementation Guide.

If planning to use the Store item on the Side Navigation Menu, make sure that 
iStore is implemented. The Store item displays the sections created in Store and 
assigned items to them. There is also a walk-in user Price List attached to the Store. 
The Multimedia item on the Side Navigation Menu uses the images uploaded in 
iStore and attaches them to the appropriate items.

Steps

Stem Required Description

1.  Set System Profiles Yes Enter System Profile Options.
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1. Set System Profiles:

a. Log into Forms as the Implementation User and select the System 
Administrator Responsibility. 

b. Navigate to Functions > Profile > System. 

c. Enter the profile name in the Profile Field and click Find. 

d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

2. Verify and Create Lookups for Products:

a. Log into Forms and select Oracle Inventory Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

2.  Verify and Create 
Lookups for Products

Yes Verify Lookups for Products.

3.  Test Implementation of 
Products

Yes Perform tests to verify the implementation of 
Products is correct.

Option Required Level Setting Effect/Limitation

AMS: Allow 
Inventory 
Item Update

Yes User Yes/No Indicates whether user from OMO 
application is allowed to update 
inventory item. Note: This profile is 
updatable only by the system 
administrator though it is a user level 
profile.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Stem Required Description
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See the table below for Lookups and their types, values and meanings.

Key Type Values Meanings

ITEM_TYPE Extensible AI

AOC

ATO

CONSULTING

EDU

FG

FRT

I

K

KIT

M

MEDIA

NRI

OC

OP

P

PF

PH

PL

POC

PTO

REF

RI

SA

SI

SW LIC

TRAIN

ATO Option Class

ATO item 

ATO model

Contracts - consulting

Contracts - Education

Contracts - KIT

Contracts - Media

Contracts - Software

License

Contracts - Training

Finished good

Freight

Inventory Type

Kit

Model

Non-recurring

Option Class

Outside Processing Item

PTO Option Class

PTO model

Phantom item

Planning 

Product Family

Purchased Item

Recurring

Reference Item

Subassembly supply item

INVENTORY_ ITEM_ 
STATUS_ CODE

User ACTIVE

INACTIVE

Active

Inactive
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3. Test Implementation of Products:

a. Log into the application and navigate to the home page. The user name 
should appear there.

b. Navigate to Products and click Create. Check the following LOVs for 
availability: Owner, Product Type, Master Organization and Unit of 
Measure.

c. Create an item from Oracle forms application. Log on using Inventory 
responsibility and create an item in Inventory. This will validate if 
inventory has been set up properly. If item creation fails at this stage, then 
Oracle Marketing Online cannot be used to create items.

4. Setup and Run Concurrent Manager Programs.

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent managers and descriptions.

Known Issues or Conflicts
Always compile the inventory system items flexfield and the inventory category 
flexfield after applying a patch.

Note: Compile the Inventory System Items Flexfield and the 
Inventory Category Flexfield if there has been a change in the 
flexfield structure, before running this concurrent manager 
program.

Concurrent Manager Required Description

AMS Load Inventory 
Categories

Yes Loads categories from the MTL schema to the 
AMS schema denormalized tables. This 
program should be run if and when a new 
category is created in Inventory.
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5.10 Implement Price Lists
Price Lists are used to price Products. Products can be added to multiple price Lists 
which can be in different currencies support a global pricing strategy. Price Lists can 
have eligibility defined so that customers who match the criteria alone eligible for 
the price.

Use
Events and deliverables that are created as inventory items can be added to a Price 
List. Price Lists can be attached to offers as qualifiers so that customers can get a 
discount on a specific price.

Integration
Oracle Quoting-Forms and Oracle Order Management will utilize the price lists 
setup in Oracle Marketing Online when an order is booked by the customer.

Steps

1. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.

Step Required Description

1.  Set System Profiles Yes Enter various System Profile Options for Price 
Lists.

2.  Verify and Create 
Lookups for Price Lists

Yes Verify Lookups for Price Lists.

3.  Test Implementation of 
Price Lists

Yes Perform tests to verify the implementation of 
Price Lists is correct.
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2. Verify and Create Lookups for Price Lists:

a. Log into Forms and select Oracle Inventory Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys.

See the table below for Lookups and their types, values and meanings.

Option Required Level Setting Effect/Limitation

QP: Item 
Validation 
Organization

Yes Respon
sibility

Select from 
Inventory 
Organizations 
set up in 
Inventory

Prices may be defined only for those 
products which will be available in 
the specified organization.

AMS: Allow 
Updates to 
QP Price 
Lists in 
OMO

Yes Respon
sibility

Yes/No Selecting Yes will allow Price lists 
created using Advanced Pricing to be 
edited in Oracle Marketing Online.

AMS Root 
Section for 
Price List 
Report

Yes Site Sections 
defined in the 
hierarchy Tab 
of iStore’s 
Merchant UI

Price list report available from the 
overview page will utilize the section 
set in this profile to determine the 
section hierarchy. Items can be 
grouped into sections. Sections in 
turn can be grouped into other 
sections, creating a hierarchical 
structure.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.
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3. Test Implementation of Price Lists.

a. Navigate to Products > Price Lists.

b. If Profile AMS: Allow Updates to QP Price Lists in OMO is set to Yes, then 
you should be able to update price lists created through the Advanced 
Pricing application.

5.11 Implement Deliverables
Deliverables are hard or soft, electronic, collateral that is transmitted to a customer, 
prospect or an event registrant, or attendee.

Use
Deliverables are utilized by both campaigns and events.

Integration
Deliverables are integrated into Oracle Inventory. When a deliverable is created as 
an inventory item, it is created as a collateral item. These collateral items are 
available to Oracle Telesales.

Deliverables created as inventory items may be priced using Oracle Pricing in 
Oracle Marketing Online.

Prerequisites
None

Key Type Values Meanings

AMS_ 
PRICE 
LIST_ 
STATUS

System Active

Draft

Rejected

Pending

Cancelled

Active

Draft

Rejected

Pending Budget Approval

Cancelled
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Steps

1. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.

2. Verify and Create Lookups for Deliverables:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

Step Required Description

1.  Set System Profiles Yes Enter various System Profile Options for 
Deliverables.

2.  Verify and Create 
Lookups for 
Deliverables

Optional Verify Lookups for Deliverables.

3.  Test Implementation of 
Deliverables

Yes Perform tests to verify the implementation of 
Deliverables is correct.

Option Required Level Setting Effect/Limitation

AMS: Item 
Validation 
Master 
Organization

Yes Site A valid Master 
Inventory 
Organization

When a deliverable is flagged as an 
inventory item, it is created in 
Inventory under the specified master 
organization.
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See the table below for Lookups and their types, values and meanings.

3. Test Implementation of Deliverables:

a. Log in to Oracle Marketing Online and navigate to the home page. The user 
name should appear there.

b. Click the Deliverables tab and select Create. Check if the owner and country 
fields are populated.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_DELIV_STATUS User Archived

Available

Cancelled

Denied_BA

New

Submitted_BA

Superseded

Expired

Denied_TA

Budget_Appr

Submitted_TA

Archived

Available

Cancelled

Denied - Budget Approval

New

Submitted - Budget Approval

Superseded

Expired

Denied - Concept Approval

Budget Approved

Submitted - Concept Approval

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

AMS_CAMP_FULFILL_ON System On_Invite On Invite

AMS_OBJECT_USAGE_
TYPE

System Created

Used_By

Created

Used By
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5.12 Implementing Marketing Intelligence
This Chapter describes how to implement Marketing Intelligence functionality that 
can be displayed on the home page of the Application.

Implementation Steps

Refresh Steps

Step Required Description

Set up Profile Options Yes Set up the two profile options:

AMS Marketing Calendar

AMS Default Currency Code

Define Marketing 
Calendar Periods

Yes The calendar periods must be defined for the 
Marketing Calendar for the fiscal year 
containing the date one year prior to the start 
date.

Exchange Rates Yes Exchange rates between transaction currencies 
and the default currency in AMS Default 
Currency Code must be set up.

Run Concurrent Manager 
Program BIM: Truncate all 
Facts

Yes This program is run only as needed to remove 
all facts loaded in previous refresh.

Run Concurrent Manager 
Program Request Set BIM: 
Load Marketing Facts for 
the First Time

Yes The program must be run once for each of the 
following marketing objects: campaigns, 
events, and budgets.

Run Concurrent Manager 
Program Request Set BIM: 
Initial Build

Yes This request set is run for four marketing 
objects: campaigns, events, budgets and key 
performance indicators.

Run Concurrent Manager 
Program Request Set BIM: 
Refresh Materialized 
Views

Yes This request set is run for five marketing 
objects: campaigns, events, budgets, key 
performance indicators, and marketing 
activities.

Step Required Description

Run Concurrent Manager 
Program Request Set BIM: 
Load Marketing Facts from 
Previous Refresh Date

Yes This request set is run daily on four marketing 
objects: campaigns, events, budgets and key 
performance indicators.
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5.12.1 Setting System Profile Options

Steps
1. Log into Forms under System Administrator responsibility.

2. Navigate to Profile > System.

3. Enter the profile name in the Profile Field and click Find.

4. Enter the appropriate value in the column corresponding to the level indicated.

5. Save your work.

See the table below for System Profile Options and their values.

5.12.2 Define Marketing Calendar Periods
Identify the Calendar associated with the profile AMS Marketing Calendar and 
define Periods on this calendar for the Fiscal Year, which contains the date one year 
prior to the start date of the first time facts load, to the current Fiscal Year. It is 
required that periods of type Month, Quarter, and Year should be defined. 

Run Concurrent Manager 
Program Request Set BIM: 
Refresh Materialized 
Views

Yes This request set is run for five marketing objects: 
campaigns, events, budgets, key performance 
indicators, and marketing activities.

Note: Estimated times are based on a sample data set. The actual 
time required will depend on the amount of data, number of 
processors used, among other factors.

Option Required Level Setting

AMS Marketing 
Calendar

Yes System Select the Marketing Calendar Set up in 
Financials > Calendars > Accounting

AMS Default 
Currency

Yes System Select defined currency

Step Required Description
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For example, the Fiscal Year starts from 1st June of every year. To load the facts from 
01-SEP-00, it is required to define the periods for the Marketing Calendar starting 
with the Fiscal Year containing the date 01-SEP-99 to the current Fiscal Year.

Steps
1. Log into Forms with System Administrator responsibility.

2. Navigate to Profile > System.

3. Use Find to locate the profile AMS: Marketing Calendar.

4. Note the calendar entered in this profile.

5. Switch responsibility to General Ledger Super User.

6. Navigate to Setup > Financials > Calendars > Accounting.

7. Locate the Calendar noted above and verify the required periods are entered.

5.12.3 Exchange Rates
Exchange rates need to be defined between the transaction currency and the default 
currency code associated to the profile AMS Default Currency. The rates must be 
defined between the currencies, from the date the transactions will be loaded. 

For example, if loading all the Campaigns which started on or after 01/SEP/00 
where the minimum approval date is 01/Mar/00, the currency exchange rates need 
to be defined from 01/Mar/00.

Currency Conversions
All the transactions amounts will be converted to the default currency code 
associated to the profile AMS Default Currency. All currencies used in transactions 
must have a conversion rate defined with the conversion rate type specified in the 
profile AMS Currency Conversion Type.

Steps to Add a Conversion Rate

1. Log into Forms for General Ledger Super User responsibility.

2. Navigate to Setup > Currencies > Rates > Daily.

3. Click Enter by Date Range to enter a range of dates the rate is applicable.

4. Select the From and To currencies.

5. Enter a From date and a To date.
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6. Set the type equal to the type specified in the profile AMS Currency Conversion 
Type.

7. Save your work.

5.12.4 Run Concurrent Program: BIM: Truncate all facts
This concurrent program removes previously loaded facts. It should be used only 
when the current data should be removed in its entirety.

Parameters
� Objects (select from: All, Campaigns, Events, Budgets)

� Confirm: Y

Effects and Limitations
� Truncates all facts loaded in previous refresh.

� Run only when needed.

5.12.5 Request Set: BIM: Load Marketing facts for the first time
Execute this Request Set only for the first time load.  This Request set consists of 
following concurrent programs.

Seq Concurrent Program Parameters
Est 
Time Comments

1 BIM: Load Marketing 
Facts for the  First 
Time

Object to Load: 
Campaign

Start Date: 01-SEP-00

End Dates: (SYSDATE)

2 Hrs., 

15 Mins

Loads all Campaign 
Facts 

2 BIM: Load Marketing 
Facts for the First 
Time

‘Object to Load: Event

Start Date: 01-SEP-00

End Dates: (SYSDATE)

6 Mins Loads all Event Facts

3 BIM:Load Marketing 
Facts for the  First 
Time

Object to Load: Budget

Start Date: 01-SEP-00

End Dates: (SYSDATE)

20 Mins Loads all Budgets Facts
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Steps
1. Switch responsibility to Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Choose BIM: Load Marketing facts for the first time from the LOV. The Program 
block will list the above concurrent programs. When programs are first listed, 
the Parameters column is blank for all programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where all the parameters are 
defaulted automatically.

7. Note that the Start and End dates are defaulted to the sysdate. Change the dates 
as desired and click OK. The Start Date should be the first date for which data 
should be shown.

8. Click on the Parameter column of the second row.

9. The system displays a Parameter window with all the parameters defaulted 
automatically to the values entered in the first row.

10. Click on the Parameter column of the third row.

11. The system displays a Parameter window with all the parameters defaulted 
automatically to the values entered in the previous row.

12. After verifying all the parameters, click Submit. The Request set will run and 
execute all the above concurrent programs sequentially. 

4 BIM:Load Key 
Performance 
Indicator Facts

1 Min Loads KPI facts

Note: This program should be run only once. If for any reason, a 
user intends to re-run this request set again, execute the Concurrent 
Program, BIM: Truncate all facts, before running the Concurrent 
Manager Program, BIM: Load Marketing facts for the first time.

Seq Concurrent Program Parameters
Est 
Time Comments
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5.12.6 Request Set: BIM: Initial build of Materialized Views
Execute this Request Set only for the first time.  This prepares the pre-built tables for 
all materialized views. 

This Request Set consists of the following concurrent programs:

Steps
1. Switch responsibility to Marketing Intelligence Collection Manager

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Choose BIM: Initial build of Materialized Views from the LOV. The Program 
block will list the above concurrent programs. Note that the Parameters column 
is blank for all the programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where the parameter, Number of 
Parallel Processors, is defaulted automatically to 8. Change the value for this 
parameter to 4 and click OK. Four processors is sufficient to run this Request 
Set.

7. Click on the Parameter column of the second row.

8. The system displays a Parameter window with the parameter, Number of 
Parallel Processors, defaulted automatically to 4.

9. Repeat the steps 5 and 6 for the third and fourth rows.

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Initial build of 
Campaigns Materialized 
Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Campaigns Materialized views

2 BIM: Initial build of Events 
Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Events Materialized Views

3 BIM: Initial build of Budgets 
Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Budgets Materialized views

4 BIM: Initial build of Key 
Performance Indicators 
Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Key Performance Indicators 
Materialized views
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10. After verifying all the parameters, click Submit. The Request set will run and 
execute all the above concurrent programs sequentially.

5.12.7 Request Set: BIM: Refresh Materialized Views
Builds the Materialized views for Campaigns, Events, Budgets, Key Performance 
Indicators and Marketing Activities. This Request Set should be run only after the 
facts are loaded, either by the Request Set: BIM: Load Marketing facts for the first 
time or by Request Set: BIM: Load Marketing facts from the previous refresh date.

This Request set consists of following concurrent programs.

Steps
1. Switch responsibility to Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Select BIM: Refresh Materialized Views from the LOV. The Program block will 
list the above concurrent programs. Note that the Parameters column is blank 
for all the programs.

5. Click on the Parameter column of the first row.

Note: This program has to be run only once and should not be run 
during subsequent loads.

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Refresh Campaign 
Materialized views

Number of Parallel 
Processors: 4

20 Mins Builds Campaign Materialized 
views

2 BIM: Refresh Events 
Materialized views

Number of Parallel 
Processors: 4

10 Mins Builds Events Materialized 
views

3 BIM: Refresh Budgets 
Materialized views

Number of Parallel 
Processors: 4

20 Mins Builds Budgets Materialized 
views

4 BIM: Refresh Key 
Performance Indicator 
Materialized views

Number of Parallel 
Processors: 4

5 Mins Builds KPI Materialized views

5 BIM: Refresh Marketing 
Activities Materialized 
views

Number of Parallel 
Processors: 4

5 Mins Builds Marketing Activities 
Materialized views
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6. The system displays a Parameter window, where the parameter Number of 
Parallel Processors is defaulted automatically to 8.

7. Change the value for this parameter to 4 and click OK. Four processors is 
sufficient to run this Request Set.

8. Click on the Parameter column of the second row.

9. The system displays a Parameter window with the parameter, Number of 
Parallel Processors, defaulted automatically to 4.

10. Repeat steps 8 and 9 for third, fourth, and fifth rows.

11. After verifying all the parameters, click Submit. The Request set will run and 
execute all the above concurrent programs sequentially.

5.12.8 Request Set: BIM: Load Marketing facts from previous refresh date
This request set will load all the marketing facts from the refresh date.

Execute this Request Set on a daily basis.

Note: This program has to be run each time after facts are loaded 
or refreshed.

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Campaign

End Date: (SYSDATE)

Number of Parallel 
Processors: 4

5 Mins Loads all Campaign Facts from 
the previous refresh date

2 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Event

End Date: (SYSDATE)

Number of Parallel 
Processors: 4

5 Mins Loads all Events Facts from the 
previous refresh date 

3 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Budget

End Date: (SYSDATE)

Number of Parallel 
Processors: 4

5 Mins Loads all Budget Facts from the 
previous refresh date 
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1. Switch responsibility to Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Select BIM: Load Marketing facts from previous refresh date from the LOV. The 
Program block will list the above concurrent programs. When the programs are 
listed, the Parameters column is blank for all the programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where all the parameters are 
defaulted automatically.

7. Note that the End date is defaulted to the sysdate. Change the date as desired 
and click OK.

8. Click on the Parameter column of the second row.

9. The system displays a Parameter window with all the parameters defaulted 
automatically. Note that the end date is defaulted to the value entered in the 
first row. Change the date as desired and click OK.

10. Click on the Parameter column of the third row.

11. The system displays a Parameter window with all the parameters defaulted 
automatically.

12. Note that the end date is defaulted from to the value entered in the first row. 
Change the date as desired and click OK.

13. After verifying all the parameters, click Submit. The Request Set will run and 
execute all the above concurrent programs sequentially. 

14. Note: that this program has to be run on a daily basis.

15. Run the Request Set: BIM: Refresh Materialized Views, above, to build the 
materialized views following the steps instructions listed above.

4 BIM: Load Key Performance 
Indicator facts from 
previous refresh date

5 Mins Loads all KPI Facts from the 
previous refresh date

Seq Concurrent Program Parameters Est Time Comments
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5.12.9 Troubleshooting tips for Request Sets
Error and debug messages are provided wherever possible. However, in certain 
situations where Rollup and Cube functions are used, error messages could not be 
tracked due to the limitations with PL/SQL. In situations where the log files of the 
concurrent program do not report a proper message, follow the techniques given 
below:

� First, verify that all Marketing calendar periods are defined. If not, define the 
periods of type Month, Quarter, and Year for each fiscal year.

� Verify if enough table space exists for BIM tables table space, indexes table 
space, and temp table space. This table space size can be determined by the 
local DBAs. 

� In case of failures in Request Set: BIM: Refresh Materialized Views, locate the 
spool file generated by each SQL file. The spool file is named after the 
executable listed in the concurrent log file. This file will be located in a directory 
specific to instance (which is managed by the local DBA).

For example, when Marketing activities are refreshed a log (spool) file is 
generated with the name of this concurrent program executable i.e., 
bimactld.log (executable name is bimactld.sql). 

See Configuring Bins, Reports and Charts in Appendix Q.

5.13 Implement Web Posting
Web Posting allows a particular content selection strategy to be executed depending 
on the conditions present. For example, if a registered user logs into a site, a 
particular posting is displayed, however, if a new user logs into the same site, a 
different posting may be displayed. Web Postings may be of two types: universal 
and rule based. With the universal type, everyone receives the same posting. With 
rule based Web Postings, conditions are analyzed and postings are displayed 
according to the conditions.

Use
Segments and Campaigns may be used during rule definition. Postings are 
integrated with Schedules and Products.

Note: This program should be run on a daily basis.
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Integration
Web Postings are integrated with Oracle iStore and Oracle Partners Online.

Prerequisites
Implement iStore prior to completing these steps if integrating with iStore. For 
additional information, please see the iStore Implementation Guide.

Implement Partners Online prior to completing these steps if integrating with 
Partners Online. For additional information, please see the Partners Online 
Implementation Guide.

Steps

1. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 

e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

Step Required Description

1.  Set System Profiles Yes Enter various System Profile Options for 
Events.

2.  Verify and Create 
Lookups for Web 
Postings

Optional Verify Lookups for Web Postings.

3.  Set up and Run 
Concurrent Manager 
Programs

Yes Web Execution: Refresh Minisite Items

Web Execution: Refresh Campaign Items

4.  Administration Setup Yes Set up parameters in the Administration tab. 
See Administering Marketing Online for more 
information.

5.  Test Implementation of 
Web Posting

Yes Perform tests to verify the implementation of 
Web Posting is correct.
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See the table below for System Profiles and their values.

2. Verify and Create Lookups for Web Postings:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups.

c. Use View > Find to locate the individual keys.

Option Required Level Setting Effect/Limitation

AMS Item 
Validation 
Organization

Yes Site User Defined Determines whether the Organization 
ID is used for items. 

AMS: 
Custom 
Condition 
Class

Optional Site Java class 
name of the 
custom 
condition

This class is invoked at runtime when 
custom conditions are implemented.

AMS: 
Default 
Product 
Stylesheet

Yes Site User defined Determines the default stylesheet file 
for Products.

AMS: 
Default 
Schedule 
Stylesheet

Yes Site User Defined Determines the default stylesheet file 
for Schedules.

AMS: OA 
Media

Optional Site Physical file 
path of 
media 
directory 
where the 
image files 
are stored.

This is used in the upgrade process to 
read the files from the media 
directory and store them in the 
database.

AMS: 
Posting 
Runtime 
Shopping 
Cart 
Currency

Yes Site Select from a 
list of values. 
USD is the 
default.

Determines the currency in which 
shopping cart amounts are measured.

AMS: 
Upgrade 
iMarketing

Optional Site Yes/No Used to determine whether to 
upgrade iMarketing data from the 
previous version.
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See the table below for Lookups and their types, values and meanings.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_POST_ CONTENT_ 
TYPES

System Product

Schedule

Product

Web Advertisement

AMS_POST_ STRATEGY_ 
TYPE

System Manual_ Selection

Product_ 
Relationship

Inferred_OP

Custom

Manually selected strategy

Strategy based on product relationship

Inferred based on Oracle Personalization

Custom strategy

AMS_POST_ PREDEF_ 
PROD_ CONTEXT

System Prod_viewed

Prod_in_cart

The product context for relationship 
based strategy.

AMS_PRIOR_ SORT_ 
ORDER

System Asc

Desc

Ascending

Descending

AMS_POST_ CATEGORY System Universal

Rulebased

Posting types: Universal or based on a 
rule.

AMS_POST_ STATUS System Active

Inactive

AMS_POST_ BUSPRIOR

(Business Priority)

System None

Random

Prod_list_ price

Campaign_ Start_
Date

Campaign_ End_
Date

Campaign_ Priority

None

Random (for all)

List Price (for products only)

Start Date, End Date, or Priority (for 
campaign schedules).
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3. Setup and Run Concurrent Manager Programs: 

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent managers and descriptions.

IBE_ RELATIONSHIP_
TYPES

Extensible Possible 
relationships 
between Products 
like Cross Sell, Up 
Sell. 

This is an iStore lookup type.

AMS_POST_ 
RELATIONSHIPS

System Promoting 
Relationship types 
not covered by iStore

Promoting is a relationship not covered 
by iStore, as in promoting a product.

AMS_POST_ COMP_ 
OPERATOR

System EQ

GTE

LTE

Equal to

Greater than or equal to

Less than or equal to

Used to compare shopping cart amount.

AMS_POST_ AUDIENCE_ 
TYPE

System S

L

Segment

List

AMS_POST_ CND_DATA_ 
TYPE

System Float

String

Data Types returnable by Custom 
Condition Class.

Concurrent Manager Required Description

Web Execution: Refresh 
Minisite Items

Yes This refreshes the denormalized table for 
minisites periodically to capture items in the 
iStore minisites.

Web Execution: Refresh 
Campaign Items

Yes Information about Campaigns is stored in 
multiple tables. To improve runtime 
performance, this program periodically collects 
required information on campaigns and places 
it into a single table.

Key Type Values Meanings
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4. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing.

c. Make the following selections, entering information as it pertains to Web 
Postings.

See the table below for Administration selections and their values.

5. Test Implementation of Web Posting:

a. Log into Oracle Marketing Online.

b. Navigate to the Execution tab. The Web Posting and Web Placement 
subtabs should be displayed.

c. Click the Web Posting subtab. The Posting Overview page should be 
displayed.

d. Click the Web Placement subtab. The Placement Overview page should be 
displayed.

Note: Both of these Concurrent Manager programs may need to 
be run when additional minisites or campaigns are created. These 
also need to be run when new items are created or when new items 
are assigned to minisites or campaigns.

Component Item Choices Effect

Execution Strategies User Created 
and Seeded

Any additional custom strategies that are 
needed are created here. A java class is 
required which contains the logic and code.

Execution Rules User Created Extend up to five conditions that can be used in 
rule definitions for a rule-based posting.

Note: If implementing iStore: After creating a posting and a 
placement, the jsp, amsWebPlacement.jsp, should be attached to the 
desired bins in iStore in order to display the posting in that bin.
Business Function Implementation 5-69



Implement Web Placement
5.14 Implement Web Placement
Placement is a component that associates a Posting and a style with a physical 
location on a real page. Placement can be defined for a site, page, and a location.

Use
Web Placements are integrated with Web Postings. Web Postings are in turn used as 
an execution media for campaigns.

Integration
Web Placements are integrated with Oracle iStore and Oracle Partners Online.

Prerequisites
Implement iStore prior to completing these steps if integrating with iStore. For 
additional information, please see the iStore Implementation Guide.

Implement Partners Online prior to completing these steps if integrating with 
Partners Online. For additional information, please see the Partners Online 
Implementation Guide.

Steps

1. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Navigate to Functions > Profile > System. 

c. Enter the profile name in the Profile Field and click Find. 

Step Required Description

1.  Set System Profiles Yes Enter various System Profile Options for Web 
Placement.

2.  Verify and Create 
Lookups for Web 
Placement

Optional Verify Lookups for Web Placement.

3.  Administration Setup Yes Set up parameters in the Administration tab. 

4.  Set up Guest User Yes Set up the Guest User.

5.  Test Implementation of 
Web Placement

Yes Perform tests to verify the implementation of 
Web Placement is correct.
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d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work. 

See the table below for System Profiles and their values.

2. Verify and Create Lookups for Web Placement:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

Option Required Level Setting Effect/Limitation

AMS: Merchant 
Party ID

Optional Site Choose from a 
list of Parties 
provided

This value determines the party ID 
of the current active merchant.

This sets the merchant ID for the 
creation of affiliate placements.

AMS: Server 
URL

Optional Site User Defined This value determines the runtime 
URL path of the server. Used to 
generate API details for affiliates 
during placement definition.

AMS: Oracle 
Personalization 
Enabled

Optional Site Yes/No This enables the use of Oracle 
Personalization. Before enabling 
this option, Oracle Personalization 
must already be implemented.

IBE: Use Web 
Placements

Yes Appli
cation

Yes/No Determines whether placements 
are displayed. Required only 
when implementing iStore.

PV: Enable Web 
Marketing

Optional Site 
(see 
effect 
col.)

Yes/No Determines when Placements are 
displayed in Partners Online. 
Required only when 
implementing Partners Online. 

Setting levels: Application 
(Partners Online) and 
Responsibility (Vendor Admin)
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See the table below for LOVs and their types, values and meanings.

3. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing.

c. Make the following selections, entering information as it pertains to Web 
Placement.

See the table below for Administration selections and their values.

4. Setup up Guest User.

The guest user is required and is set up as follows:

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_PLCE_ SITE_ 
CATEGORY

System Oracle_Applications

Other_Applications

Affiliates

Oracle Applications

Other Applications

Affiliates

AMS_PLCE_ LOCATION_ 
CODE

Extensible Left1, Left2…Left7

Right1, Right2 … 
Right7

Top

Bottom

Positions for placements

Component Item Choices Effect

Execution Sites User Created 
and Seeded

Create a new site here.

Execution Pages User Created 
and Seeded

Create new pages for a site.

Execution Styles User Created 
and Seeded

Create new styles for content type(s).
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a. Log into Forms with System Administrator responsibility.

b. Navigate to Settings > System > Advanced.

c. From the list of applications, select JTF.

d. Navigate using Next/Prev links until a page displays:

� Guest Partyname

� Guest password

� Guest Username

e. Set values as follows, if these values are already set you need not change 
them.

� Guest Partyname = IBEGUEST

� Guest Password = Password (user defined)

� Guest Username = ibeguest.

f. Save your work

g. Log out of Forms.

5. Test Implementation of Web Placement:

a. Log into Oracle Marketing Online.

b. Navigate to the Execution tab. The Web Placement subtab should be 
displayed.

c. Click the Web Placement subtab. The Placement Overview page should be 
displayed.

Stylesheets
The following stylesheets are seeded: 

Name Description File Name

Schedule banner Displays content having full banner, half 
banner, and short description attributes

amscpns1.xsl

Schedule micro image Displays content having micro bar images, 
short description and description attributes.

amscpnm3.xsl

Universal schedule Displays any type of content independent 
of any specific content attribute.

amspstng.xsl
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Known Issues or Conflicts
After attaching amsWebPlacement.jsp to bins in iStore, the Apache server must be 
bounced. The best practice is to perform all the required bin associations and then 
bounce the server.

5.15 Implement Claims
The claims tab is a major portion of the Trade Management functionality of 
Marketing Online. The claims tab allows for tracking, processing and resolution of 
claims made by retailers and distributors against product invoices. Customers may 
short pay an invoice for a variety of reasons, frequently without notice or 
supporting documentation. This short payment generates a deduction which must 
be tracked, investigated, and resolved.

Use
Claims are integrated with budgets, campaigns and offers for the purposes of 
tracking sources of short payments. 

Integration
Claims are integrated with Oracle Payables, Oracle Receivables, and Oracle General 
Ledger.

Product short description Displays a link to the product detail page 
along with a short description.

amsprod1.xsl

Product thumbnail image Displays a link to the product detail page 
along with a thumbnail image.

amsprod2.xsl

Product thumbnail image 
with shopping cart link

Displays a link to the product details page, 
a link to the shopping cart page along with 
a thumbnail image.

amsprod3.xsl

Product small image with 
shopping cart link

Displays a link to the product detail page, a 
link to the shopping cart page along with a 
small image.

amsprod4.xsl

Note: If implementing iStore: After creating a posting and a 
placement, the jsp, amsWebPlacement.jsp, should be attached to the 
desired bins in iStore in order to display the posting in that bin.

Name Description File Name
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Prerequisites
Oracle Payables, Oracle Receivables and Oracle General Ledger must be 
implemented. 

1. Oracle Receivables:

a. Log on with Oracle Receivables responsibility.

b. Navigate to Setups > System > System Options.

c. Verify the Name field has the name of a Set of Books populated in it and 
that the field is not updateable. 

This verifies that Oracle Receivables and General Ledger are implemented.

2. Oracle Payables:

a. Log on with Oracle Payables responsibility.

b. Navigate to Setups > Options > Payables.

c. Verify the Set of Books field has the name of a Set of Books populated in it 
and that the field is not updateable. 

This verifies that Oracle Payables is implemented.

Steps

Step Required Description

1.  Assign Receivable Role 
to Attribute Receivables 
Role in AMS: Claims 
Settlement Workflow

Yes This sets up workflow notification to Accounts 
Receivable for settlement of claims.

2.  Verify the Line 
Transaction Flexfield

Yes Used by Autoinvoice to import credit and 
debit memos.

3.  Create a Batch Source in 
Oracle Receivables

Yes Used by Autoinvoice to import credit memos 
and debit memo generated by Claims.

4.  Create an Aging Bucket 
in Oracle Receivables

Yes Aging Buckets are the time periods used to 
review and report on open claims.

5.  Create a Source in 
Oracle Payables

Yes Used by Payables Open Interface Import to 
create invoices.

6.  Set up Accounts in 
General Ledger

Yes Set up accounts that are used for claims 
management.
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1. Assign Receivable Role to Attribute Receivables Role in AMS: Claims 
Settlement Workflow.

After the claim settlement is approved as specified in the Approval Rules, the 
AMS: Claim Settlement Process will route the notification to an Oracle 
Receivables User to close the deduction as indicated in the notification. The 
Oracle Receivables User is identified by the Receivables Role. You can specify 
the Receivables Role by using Oracle Workflow Builder. See Roles in the Oracle 
Workflow Guide.

a. Open Workflow Builder.

b. Open AMS: Claims Settlement from the database.

c. Select File > Load Roles from database. 

d. Enter ‘Receivable Role’ in Find Roles and make a query.

e. Select the Receivable Role from the query results and add it to the loaded 
roles. 

f. Click OK.

g. Expand Item Type and Attribute for AMS: Claims Settlement. 

h. Double click on attribute ‘Receivables Role’.

i. Assign the Receivable Role to this attribute from the Value drop down 
menu under the default section. 

j. Save your work.

7.  Attach the Trade 
Management Request 
Group

Yes Required for running of trade management 
concurrent programs.

8.  Set System Profiles Yes Enter various System Profile Options for 
Events.

9.  Verify and Create 
Lookups for Claims

Yes Verify and create Lookups for claims.

10. Set up Concurrent 
Manager Programs

Yes Set up Concurrent Manager Programs for 
Claims.

10.  Administration Setup Yes Set up parameters in the Administration tab. 

11.  Test Implementation of 
Claims

Yes Perform tests to verify the implementation of 
Claims is correct.

Step Required Description
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2. Verify the Line Transaction Flexfield Context.

Verify the Line Transaction Flexfield context is set for Claims. This context will 
be used by Autoinvoice to import credit and debit memos:

a. Switch responsibility to System Administrator. 

b. Navigate to Application > Flexfields > Descriptive > Segments Screen.

c. Query on field “Title” with value Line Transaction Flexfield an available 
context of CLAIM.

3. Create a Batch Source in Oracle Receivables. 

A Transaction Batch Source is required to create debit memos and credit memos 
in Oracle Receivables. The settlement of a claim in the Claims module of Oracle 
Marketing Online may result in the creation of a debit or credit memo. 
AutoInvoice in Oracle Receivables will use the Transaction Batch Source to 
import the debit and credit memos from Claims. Use the guidelines below to set 
up the Transaction Batch Source. See Transaction Batch Source in the Oracle 
Receivables User Guide.

a. Type. It is required that you select “Imported” for Transaction Batch source.

b. Choose ID for each option under the Customer Information, Other 
Information, and Sales Credit Data Validation Tabs to indicate that the 
AutoInvoice validates the data for this batch source using an identifier. 

4. Create Aging Bucket definition in Oracle Receivables.

Aging buckets are time periods you use to review and report on open claims. 
Open claims include claims that in the statuses of Open, Complete, Pending 
Approval and Approved. Claims uses Oracle Receivables Aging Buckets for 
defining the buckets (See Aging Buckets under Chapter 2 of  Oracle Receivables 
User Guide.) Please follow the guidelines specified below for defining the aging 
buckets:

Buckets may have multiple bucket lines (time periods). Use the following 
bucket line types, available in Oracle Receivables (Oracle Receivables has more 
Types than those described below):

� Current

� Past Due

� Future
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Current: The usage of this type will age the claims outstanding or not yet 
resolved,  based on the Claim date. For example, from 0 to 10 days old will 
display claims which are 0 to 10 days past the claim date.

Past Due: The usage of this type will age the claims that are past due in the 
range specified in the line. Note that the Aging Analysis is based on the Due 
date specified on the claim. For example, from 10 to 20 days past due will 
display claims which are 10 to 20 days past the past due date.

Future: The usage of this type will age the claims that will be due in the future. 
Please note that the Aging Analysis is based on the  Due date specified on the 
claim. For example, from -10 days to -5 days will display claims which will 
become past due 5 to 10 days from the current date.

5. Create a Source in Oracle Payables. 

A Source is required for creating an invoice in Oracle Payables. When a claim is 
settled by issuing a check, this requires an invoice to be created in Oracle 
Payables. The Claims module will populate the payables invoice interface tables 
with the invoice details. See the Oracle Payables User Guide under the Lookups 
chapter.

6. Set up accounts in General Ledger.

See Oracle General Ledger Users Guide for more information:

a. Sales Expense account

b. Accrual Liability account

c. Receivables Clearing account

d. Vendor Clearing account

7. Attach the Trade Management Request Group.

Attach the Trade Management Request group to the responsibility used to 
perform Trade Management activities.

8. Set System Profiles:

a. Log into Forms and select System Administrator responsibility.

b. Log into Forms as the implementation user and select the System 
Administrator Responsibility. 

c. Navigate to Functions > Profile > System. 

d. Enter the profile name in the Profile Field and click Find. 
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e. Enter the appropriate value in the column corresponding to the level 
indicated.

f. Save your work. 

See the table below for System Profiles and their values.

9. Verify and Create Lookups for Claims:

a. Log into Forms and select Oracle Marketing Administrator responsibility.

b. Navigate to Functions > Setups > Lookups. 

c. Use View > Find to locate the individual keys. 

See the table below for Lookups and their types, values and meanings.

Option Required Level Setting Effect/Limitation

AMS: 
Implement 
Payables 

Yes Site Yes/No If set to Yes, “Check” is a settlement 
option available when settling claims.

AMS: 
Implement 
Contra 
Charge

Yes Site Yes/No If set to Yes, “Contra Charge” is a 
settlement option available when 
settling claims. Contra charges are 
used to track offsetting balances for 
creditors who are also debtors.

Note: System Type keys may not be changed, deleted or added to. 
Extensible Type keys may have their visible values changed. User 
Type keys may have additional keys added as well as their seeded 
values changed.

Key Type Values Meanings

AMS_CLAIM_ CLASS System Claim

Deduction

Claim

Deduction

AMS_CLAIM_ HISTORY_ 
EVENT

System Changes

Line

New

Split

Changes

Line

New

Split
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AMS_CLAIM_ PAYMENT_ 
METHOD

System Check

Credit_Memo

Debit_Memo

Check

Credit Memo

Debit Memo

AMS_CLAIM_STATUS System Approved

Cancelled

Closed

Complete

Duplicate

New

Open

Pending

Pending_Approval

Pending_Close

Rejected

Approved

Cancelled

Closed

Complete

Duplicate

New

Open

Pending

Pending Approval

Pending Close

Rejected

AMS_ DEDUCTION_ 
PAYMENT_ METHOD

System Adjustment

Chargeback

Contra_Charge

Credit_Memo

Debit_Memo

Reg_Credit_Memo

Write_Off

Adjustment

Chargeback

Contra Charge

On Account Credit

Debit Memo

Invoice Credit

Write Off

AMS_ CREATION_ SIGN System +

-

Positive

Negative

AMS_GL_ DATE_TYPE System Claim_Date

Due_Date

System_Date

Claim Date

Due Date

System Date

AMS_GL_ EVENT_ LINE_
TYPE

System Accrual_Liability

Expense_Account

Rec_Clearing

Ven_Clearing

Accrual Liability

Expense Account

Receivable Clearing Acct.

Vendor Clearing Account

Key Type Values Meanings
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10. Set up Concurrent Manager Programs:

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent managers and descriptions.

AMS_GL_ EVENT_ STATUS System Accounted

Accounted_With_
Error

Created

Accounted

Accounted with Error

Created a New Transaction

AMS_GL_ EVENT_TYPE System Accrual

Accrual_Adjustment

Contra_Charge

Settle_By_Credit

Settle_By_WO 

Settle_By_Check

Accrual Liability

Accrual Adjustment

Settle by Contra Charge

Settle by Credit Memo

Settle to Writing Off 

Settle by Payment Voucher

AMS_ HISTORY_ RULES_ 
OBJECT

System Claim Claim

AMS_ OBJECT_ CLASS System Invoice

Order

Order_line

PCHO

Invoice

Order

Order Line

Purchase Order

AMS_ PAYMENT_ STATUS System Incomplete

Interfaced

Paid

Pending

Incomplete

Interfaced

Paid

Pending

AMS_ REASON_ CODE_
TYPE

User Adjust_Reason

Invoicing_Reason

Adjustment Reason

Invoicing Reason

Key Type Values Meanings
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Concurrent Manager Required Description

AMS-TM: Claims Autopay Yes Autopay program is used to pay accruals on a 
regular basis to customers. Autopay can be set 
up to pay accruals based on a customer, 
budget, campaign or offer.

Parameters:

� Customer

� Budget

� Offer

� Campaign

AMS-TM: Claims Aging 
Population 

Yes Claims aging program populates the summary 
table for the claims aged by customer for an 
aging bucket. Aging will be run based on the 
system date. This program has to be run on a 
daily basis to get the daily aging analysis for 
the customers. 

Claims may be aged using a future type. This 
type will display claims that will become due, 
based on the Due Date, the specified number of 
days in the future.

Parameter: Aging bucket defined in Oracle 
Receivables

AMS-TM: Claims Settlement 
Fetcher 

Yes Settlement fetcher gets the settlement data 
created in receivables and payables after 
settling a claim. Claim settlement on a manual 
claims gets created through autoinvoice or 
payables invoice import. These are programs 
which run on a batch mode and after the actual 
payment gets created in receivables or 
payables, settlement fetcher has to be run to get 
the settlement data to be shown in claims.

Parameters: None
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AMS-TM: Transfer to 
General Ledger 

Yes Transfer to General Ledger is run to transfer 
the sub-ledger accounting entries created by 
claims/accruals into General Ledger 
accounting tables. 

Parameters:

� Selection Type (1-Batch Transfer)

� Set Of Books - Primary set of books 

� Transfer Reporting Books - Yes/No

� Batch Name - Name of batch for transfer

AMS-TM: Import Claims Yes Import Claims imports the data from interface 
tables into claims. This program runs through 
the standard validations for claims creation 
and rejects the claims that are not successful for 
import.

Parameters: None

AutoInvoice - Oracle 
Receivables

Yes AutoInvoice is an Oracle Receivables 
concurrent program used to create credit 
memos/debit memos in receivables. It is used 
for creating credit memos on settling manual 
claims. Claims settled with receivables 
payment method gets created with the batch 
source defined in system parameters. For more 
information on parameters and options see the 
Oracle Receivables Implementation Guide.

Payables Open Interface 
Import - Oracle Payables

Yes Payables open interface import is an Oracle 
Payables concurrent program used to create 
invoices in payables. It has to be run for the 
batch source defined in system parameters 
since all the claims settlement for payables get 
created with that batch source. For more 
information on parameters and options see the 
Oracle Payables Implementation Guide.

Note: These concurrent manager programs should be setup to run 
after use of Claims has commenced. They should not be run at the 
time of implementation.

Concurrent Manager Required Description
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11. Administration Setup:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing.

c. Make the following selections, entering information as it pertains to Claims.

See the table below for Administration selections and their values.

12. Test Implementation of Claims:

a. Log into Marketing Online.

b. Navigate to Administration > Marketing > Claims > System Parameters 
and verify if Set of Books field and all other required fields are populated.

Component Item Choices Effect

Claim Claim Type Claims types are required when creating 
claims and claim the LOV is based on the 
values from this page.

Claim History 
Rule

Select columns 
to be created in 
history.

When any of the columns selected for history 
creation changes, a snapshot of the claim gets 
created as a history record.

Claim Reasons Reasons are required when creating claims 
and reason LOV is based on values from this 
page.

Claim System 
Parameter

Enter information relative to claim 
management and payment. See section 6.18 
for a complete description of the System 
Parameter page.

Claim Trade 
Profile

Select or 
deselect 
checkbox

Determines whether Autopay will be in 
effect for the selected Vendor.

User defined Indicates how often Autopay will test to see 
if a payment is required.

Claim System 
Profile

List of vendors 
created in AP

Select a vendor to setup. Autopay will be run 
for the particular party/account based on the 
flag and will be run for the frequency 
mentioned with amount condition 
overriding the duration. For check payments 
vendor set in this profile will be used.
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c. Navigate to Claims. Create a new claim. Claim Owner, due date and GL 
date should default to the settings provided (noted above in step b) All 
LOVs should be populated with at least one value.

d. Settle the claim created above by issuing a Credit Memo and running 
AutoInvoice. If AutoInvoice runs successfully, a Credit Memo will be 
created in Oracle Receivables.
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6

Administration Set Ups

This chapter provides a list of Administration Setups. These actions should be taken 
after the setup of the various tabs within the application. See the table below for a 
list of the setups and whether they are required.

Step Required Description

6.1  Creating Marketing 
Mediums

Optional Create Marketing Mediums for campaign 
execution channels.

6.2  Creating Metrics Optional Create metrics for measuring marketing 
activities, costs, and results.

6.3  Creating Venues Optional Create Venues for Event locations.

6.4  Creating Categories Optional Create Categories for various marketing 
objects.

6.5  Creating Custom 
Setups

Required Create setups for various marketing objects to 
determine the available item on the Side 
Navigation Menu as well as indicating which 
objects require approval.

6.6  Creating Activities Optional Create Activities for marketing objects.

6.7  CreatingUser Status Optional Create Statuses to track the changes in 
marketing objects.

6.8  Creating Locking Rules Optional Create Locking Rules to select those fields 
which will be locked from update after 
creation of the marketing object.

6.9  Creating Mandatory 
Rules

Optional Create Mandatory Rules to select those fields 
which are required before a marketing object 
may be created.

6.10  Creating Approval 
Rules

Required Create Approval Rules for marketing objects 
and select the approvers.
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6.1 Creating Marketing Mediums
Marketing Mediums are used to set up execution channels for campaigns.

6.11  Creating Web Offer 
Queries

Optional Creates Web Offer Queries

6.12  Creating Date Sources Optional Create Data Sources to access data from TCA 
or outside data sources.

6.13  Creating Word 
Replacement Rules

Optional Create Word Replacement Rules in TCA. 
These assist in removing duplicate entries by 
creating standard word comparisons.

6.14  Creating Geography Optional Create Geography, both location types and 
geographic areas to specify the geographic 
structure for the organization. Note: Run the 
Concurrent Manager Program, Load 
Geographic Hierarchies, any time Geography 
is modified.

6.15  Creating Budget 
Adjustment Types

Optional Create Budget Adjustment types.

6.16  Creating Budget 
Thresholds

Optional Create Budget Thresholds to generate 
notifications based on budget utilization.

6.17  Creating Claim 
Actions

Optional Create Claim Actions to group one or more 
tasks together. Claim Actions used with 
Reasons. This is required for Trade 
Management.

6.18  Creating Reasons Optional Create Reasons for claims. This is required for 
Trade Management.

6.19  Creating Claim Types Optional Create Claim Types for Claims. This is 
required for Trade Management.

6.20  Creating System 
Parameters

Optional Create System Parameters for Claims. System 
Parameters contain GL account codes and 
additional information for the prosecution of 
claims. This is required for Trade 
Management.

6.21  Creating the Trade 
Profile Item for 
Organization and 
Account

Optional Creates the Trade Profile item in the Side Panel 
Menus of Sales Online’s Account page and 
Organization page.

Step Required Description
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Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Marketing Mediums.

2. Click Create.

3. Assign a Name to the marketing medium.

4. Select the Country where the marketing medium is located.

5. Select a Rating from the following: Excellent, Very Good, Good, Moderate, Bad.

6. Select an Activity which will use the marketing medium.

7. Select the person managing the marketing medium.

8. Select Active To and From Dates.

9. If applicable, select a Preferred Vendor to associate with the marketing medium.

10. If applicable, select a Party to associate with the marketing medium.

11. Enter a description.

6.2 Creating Metrics

Use
Metrics are how campaign costs, responses, revenues, and allocations are measured. 
Although costs and revenues are treated separately, costs are another form of 
metric.

Seeded Metrics
Please refer to Appendix K for a list of Seeded Metrics.

Steps
1. Navigate to Administration > Marketing > General > Metric.

2. Click Create. 

3. Enter a Name for the metric.

4. Leave enabled checked in order for the metric to be used.
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5. Select a Category from the Seeded List, or see Creating Categories for steps on 
how to create additional metric categories. 

� Allocation

� Cost

� Response

� Revenue

� Leads

� Opportunities

� Order Amount

� Registrants

� Attendees

� Cancellations

� Other

� Any

6. Select a Sub Category if one is available. Seeded sub categories, available for the 
Cost category only, are:

� Campaign Cost

� Deliverable Cost

� Distribution Cost

� Event Cost

� List Cost

� Miscellaneous Cost

7. Select a marketing object from the Used With drop down menu:

� Campaigns

� Campaign Schedules

� Deliverables

� Events

� Event Schedules
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� One-Off Event

� Programs (for historical purposes only, metrics are no longer available for 
programs)

� Any (Summary and Rollup metrics are restricted to the Any selection)

8. Select a Return Value, either a numeric value or a ratio.

9. Enter a Description for the Metric.

10. Under the Calculation section, select how the metric is to receive its input 
values. For more information, see Function Metrics.

� Values entered manually.

� Values roll up from lower level. A rollup metric receives its values from 
lower level marketing objects. A rollup metric must have the same category 
as all of its child metrics.

� Values summarize. Summary metrics total values at the marketing object 
level. Summary metrics may have subordinate metrics of any type 
(summary, manual, rollup or function). Summary metrics should be created 
to total the manual metrics at that marketing object level. The user does not 
assign summary metrics explicitly, but rather the summary metric is 
assigned automatically when its corresponding subordinate metric is 
assigned to a marketing object. Values of summary metrics can not roll up.

� Values calculate using a program. Enter the name of a custom PL/SQL 
function or stored procedure. The function must accept a numerical 
parameter of activity metric ID and return a numeric value. The stored 
procedure takes the marketing object type and the object id as its optional 
parameters and does not return any values. The function or stored 
procedure name must be the full name which includes the schema name, 
the package name, if any, and the module name.

� Values calculated using a metric. Only Revenue or Cost metrics may be 
selected. Click Go to display a list of metrics from which to choose. The 
metrics on the list are those of non-cost or non-revenue type which are used 
for the same type of marketing object. Once this type of metric is attached to 
a marketing object, the actual value will be the product of the unit value of 
itself and the actual value of the metric it uses to calculate. Users enter 
forecast values into this kind of metric.
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11. Select Summarize Metrics:

a. Summarize to Parent. Select a metric at the parent level. The value of the 
metric being created will roll up to this metric if the same metric is attached 
to parent and child marketing objects, respectively.

b. Summarize at Same Level. Select a summary metric at the same level for 
this metric. The value of the metric being created is summarized to this 
metric. However, both metrics will always be attached to the same 
marketing object.

12. Testing for Metric Implementation.

a. Navigate to Administration > Marketing > General > Metrics. Verify that 
seeded metrics are displayed. 

b. Click Create.

c. Enter values to create a new metric called “My Total Costs”. Use Costs as 
the Category, no Subcategory; Use With Any, Return Value of Numeric, 
Calculation Type of Summary, and no Summarize To. Click Create. Review 
the metric specifications on the Metric summary page.

d. Create a Rollup Metric called “My Rollup costs”. Use Costs as the Category, 
no Subcategory, Use With Any, Value of Numeric, Calculation type of 
Rollup from Lower Level, and select Summarize To At Same Level. Click 
Go and select the metric “My Total Costs”. Click Create. Review the metric 
specifications on the Metric summary page.

e. Edit “My Rollup Costs” by clicking on the hyperlink on the summary page. 
Select the “Summarize to, Of the Parent” field. Click Go and select the same 
Metric. Click Update.

f. Create a Manually Entered Metric in the same manner with the name “My 
Manual Costs”. Use Costs as the Category, no Subcategory, Use With 
Campaigns, Return Value of Numeric, Calculation type of Select 
Calculation type of Enter Value Manually. Select Summarize of the Parent 
and select “My Rollup Costs”. Also select Summarize at Same Level and 
select “My Total Costs”. Click Create.

g. Navigate to Campaigns. Select a campaign and select Costs and Revenues 
from the Side Navigation Menu. Create a new cost for the campaign by 
selecting the “My Manual Costs” metric and entering values in the forecast 
and actual columns. Optionally, enter Transaction Date and Description. 
Click Create.
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h. Click the Refresh button to total the values up in the summary metric. Note 
if the currency for the manual metric is different from the currency for the 
marketing object, the currency will be converted and displayed in the 
currency of the marketing object.

i. Test the view option by selecting Input Only and click Go. The display 
should show My Manual Costs without the hierarchy folders. Selecting 
Function Only or Rollup Only should not display any rows. (Unless values 
have been entered at the campaign schedule level, or other metrics were 
added previously.)

Metric Chart Prerequisites
In order for metric charts to display,  an X Server must be configured: 

1. To enable run-time image generation for charts on Unix, specify the X Server 
used to generate dynamic images. This server does not have to be a dedicated 
server for Applications; however, it does need to be accessible by the Apache 
server that calls it. This is done through "xhost +", or through a more secure 
"xauth" Unix command. A Windows NT Machine can be used that is running a 
Unix emulator like Exceed. See the man pages for "xhost" and "xauth" for more 
information. Note: This step is not required if you are installing the JTF 
framework on a Windows based operating system (Windows NT or Windows 
2000 ). To implement the Display Server identifier update <ORAHTTP_
TOP>/Jserv/etc/jserv.properties with the following changes: 

2. Add the following DISPLAY parameter immediately below the wrapper.bin 
variable.

wrapper.env=DISPLAY=<xserver-hostname>:<xserver-displayport> 

3. Replace <xserver-hostname> and <xserver-displayport> with the machine 
name and port number where the X Server is running. For example, 
'wrapper.env=DISPLAY=myxserver.mycorp.com:0'. 

This step is required if Apache Jserv is started in the Automatic mode. If Jserv is 
started in Manual mode then set the DISPLAY environment variable, either in 
the script that starts the jserv or on the shell that (re)starts Apache. 

setenv DISPLAY <xserver-hostname>:<xserver-displayport>

Known Issues or Conflicts
Currency values are rounded to the “Minimum Accountable Unit”, according to the 
GL definition. Internally metrics converts values to a “Functional Currency”. The 
functional value is converted from the entered currency to the functional currency. 
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Rounding occurs at this point, potentially losing precision. The functional value is 
stored with extended precision. That is, three extra digits of precision are stored. 
Summary and Rollup metrics convert the value to the currency used for the 
currency object, and rounded to the Minimum Accountable Unit. The value may 
have changed slightly due to the rounding.

The current release only supports a maximum of rollups of 50 levels of rollup in the  
marketing object hierarchy.

Notes 
1. Manual Metrics: 

� Select this type of metric to enter values manually.

� Only Cost and Revenue category metrics use currency, other metric 
categories are entered as integer values.

� When a currency value is entered, the amount is rounded according to the 
Minimum Accountable Unit as determined by the GL Currencies.

� Each metric is optionally assigned a Summary Metric, which totals values 
within the same marketing object. When the manual metric is assigned to 
the object, the summary metric is also assigned.

� The summary metric must have the same category as the manual metric, 
and have the same marketing object type.

� Each metric is optionally assigned a Rollup Metric, which totals value at the 
parent business object. When the values of a marketing object are refreshed, 
the rollup metric is either created at the parent level, or if the appropriate 
rollup metric exists, a link is made so the rollup can determine which values 
to total.

� Rollup Metric must have the same category as the manual metric.

� Each manual metric can be assigned to an object multiple times. A 
transaction date and description distinguishes each entry.

2. Function Metrics:

� User selects this metric to calculate the actual value via a custom PL/SQL 
function or stored procedure. Forecasted values are manually entered.

� Enter the name of the function to execute in the text field. Include any 
schema name or package in which the function is included.

� Do not include parentheses or parameters.
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� The PL/SQL function must have one numerical parameter being the 
activity metric ID.

� On execute, the function is passed the activity metric ID.

� The return value is updated as the transaction actual value.

� In the case of a currency, the return value must be in the default currency as 
defined in the activity metric record. See AMS_ActMetric_PVT.Default_
Func_Currency.

� Alternatively, a procedure entered into the text field is executed once each 
time the engine is run or the refresh button is clicked. The procedure takes 
the following fields:

� P_ARC_ACT_METRIC_USED_BY (the object type) optional.

� P_ACT_METRIC_USED_BY_ID (the object ID) optional.

� When the object type and object ID fields are NULL, then all the relevant 
activity metric records are updated for all marketing objects.

� When the object type and object ID are set, only the records for that object 
are updated.

� When implementing a procedure to use for metrics, use a bulk update to set 
the TRANS_ACTUAL_VALUE and FUNC_ACTUAL_VALUE 
appropriately. This maintains a high degree of performance for metric 
calculations. Currency conversions must be done explicitly by the 
procedure.

� Also, update the LAST_UPDATED_DATE, and increment the OBJECT_
VERSION_NUMBER.

� Make sure the currencies are converted according to the current date.

� Other functionality is the same as Manual Metrics.

3. Summary Metrics:

� Summary Metrics total values at the marketing object level.

� Values are not entered by the user, but are totaled from subordinate metrics 
of any type (summary, manual, rollup, or function).

� Cost or Revenue category displays the amount in the currency as 
determined by the marketing object. Refresh of the metrics at the marketing 
object level changes the summary metric.
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� Summary Metric is assigned automatically to the marketing object when 
the subordinate Manual metric is assigned. It can not be assigned to the 
marketing object by the user.

� Summary Metrics can not be rolled up to the parent level. This helps 
maintain the detail at each object level, while being able to summarize at 
each level.

� Summary Metrics always have a Used With field value of Any.

4. Rollup Metrics:

� Used to total values at successive marketing object levels.

� Values are totaled from the child marketing objects.

� Manual and Function Metrics are assigned to a Rollup Metric so the results 
can be propagated to parent marketing objects.

� Rollup Metrics may be assigned to themselves so that any hierarchical 
marketing object structure will collect all values from subordinate objects.

� Values cannot be entered. All values are totaled from the child level.

� Rollup Metrics always have a Used With field value of Any.

5. Variable Metrics:

� This is an extension of the Manual Metrics.

� The category can only be for Revenue or Cost metrics.

� Actual values are determined by multiplying a unit value times the number 
of units.

� To set up, create a non-cost or revenue metric as the multiplier with the 
calculation type of Manual.

� Select the calculation type of ‘Calculate Using Metric’.

� Click the ‘Go’ button display a list of non-cost or revenue metrics with the 
same ‘Used With’.

� Select one.

� When associating the metric to a business object, select variable metric from 
the cost item on the Side Navigation Menu.

� The corresponding non-cost or revenue metric is automatically generated 
when the variable metric is assigned to a marketing object. Deletion of one 
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of these pair of metrics for a marketing object causes the deletion of the 
other metric if business logic allows.

� Enter the unit value.

6. Metrics Concurrent Engine.

Set up the Concurrent Manager for Metrics:

a. Switch responsibility to Oracle Marketing Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

d. Select the Concurrent Manager Program: AMS - Metrics refresh program.

The Metrics Refresh Engine utilizes PL/SQL features to quickly and correctly, 
roll up values. Steps used to process the refresh are:

� A check is made to see if any rollup metrics are missing. That is a metric 
defined with a rollup parent, and the associated activity metric does not 
have a rollup parent. 

� If so, the rollup is created and the activity metric is updated to point to 
the new rollup metric. 

� Alternatively, if the rollup parent exists, the activity metric is update to 
point to the existing one.

� All activity metrics marked with a dirty flag (indicates values may not be 
correctly totaled) are read into memory.

� All parent activity metrics of the dirty metrics are also read into memory.

� Each node in the dirty tree is calculated from the leaf level up.

� Totals are kept in memory until the operation is completed.

� On completion, values are bulk updated into the activity metrics table and 
the dirty flag is reset.

� This process is split into two parts: Rollups and Summaries.

� An optional parameter, Update_History has been added. Set to Y or N to 
indicate whether metrics history should be updated.

7. Programs cannot have new manual and function metrics associated with them. 
However, Programs have been migrated from Rollup Campaigns, which did 
allow for manual and function metrics. Historical manual and function metrics 
are supported for Programs. These values may be modified, but new manual 
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and function metrics are no longer allowed. Programs allow for rolling up 
values from marketing objects.

6.3 Creating Venues
Venues are locations for Events.

Prerequsites
None

Steps
1. Navigate to Administration > Marketing > Venues.

2. Click Create.

3. Assign a Name to the venue.

4. Select a Venue Type.

5. Select Internal if the venue is internal to the organization.

6. Select Active if the venue is available to use for Events.

7. Enter a description.

8. Enter a capacity.

9. Enter an Area value and select a measurement.

10. Enter a Ceiling Height value and select a measurement.

11. Enter a Cost and select unit of time.

12. Select the Currency for the Cost entered above.

13. Enter Address information for the venue.

14. Enter any additional information.

6.4 Creating Categories

Use
Categories are used to group objects. They can be used as selection/search criteria 
to search on objects. In some objects like budgets, categories can be used to impose 
some business rules. Categories can be used in the following marketing functional 
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areas: Deliverables, Events (events, event schedules & one-off events), Budgets and 
Metrics. A few categories comes seeded with the product for deliverables and 
metrics. These may be expanded to fit the organization’s Business Rules.

Categories and Deliverables
Categories are used by deliverables to group them together. While creating a 
deliverable it is mandatory to choose the category to which it belongs. Examples of 
deliverable categories are: Collateral, Creative, or email. Additionally you can create 
sub-categories to define deliverable a further level of deliverables. For example, you 
can define greetings or confirmation as sub categories under the email category. 
Email is a special category of deliverables. These will be used by campaign 
schedules to send as email when attached through the Email content screen in 
campaign schedules 

Categories and Events
Categories are used with events to group or categorize them. Examples of event 
categories can be educational events or partnered events.

Categories and Metrics
Category is used by metrics to classify the metrics. You can have different categories 
of metrics such as cost, revenue, leads or opportunities. When you create a rollup or 
summary metrics, the system makes sure that metrics rollup or summary to the 
metrics of the same category, cost metrics rollups to cost metrics.

Categories and Budgets
Budgets use categories to integrate to GL (General Ledger). Budget categories can 
also be used to verify budget eligibility for campaign schedules. 

Link between Categories and Approval Rules
Approval rules for deliverables can be linked to deliverable categories.

Approval rule for budgets can be linked to budget categories. This would mean that 
all budgets that fall with that category would use that particular rule for approval 
when drawing money from those budgets.

Link between Categories and Custom Setups 
Custom setups for deliverables can be created for using deliverable categories. This 
means that all deliverables which use that category will use the custom setup 
created for the category attached.
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Prerequisites
None

Steps

1. Create Categories:

a. Log in to Oracle Marketing Online.

b. Navigate to Administration > Marketing > Setup > Categories. 

c. Click Create.

d. Enter a Category Name.

e. Select a Parent Category if desired.

f. Select the Enabled checkbox to make the Category available.

g. Select a marketing object from the Created For drop-down menu.

h. Enter a description.

i. In case of metrics or deliverables make sure the parent–child relationship is 
captured correctly.

j. In case of budgets define the following:

� Correct GL account codes for expense account and liability account. 
These accounts will be used for posting. The Sales/Expense/Charge 
Account and the Accrual Liability Account are account flexfields. When 
a posting is made to one of these two accounts, the numeric identifier 
for each component of the flexfield is obtained, through a workflow 
process, and the account number is created. If an account with that 
number does not already exist, it is created.

� Enter an appropriate prefix. These are used as a prefix for the budget 
numbers that are generated automatically.

Step Required Description

1.  Create Categories Yes Categories are required to create deliverables, 
metrics and budgets. It is optional for events. 

2.  Test Creation of 
Categories

Yes Test if categories have been created.
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� Enter valid activities. This is optional. (Note that activities can be 
created through the activity screen in Administration. Refer to the 
activity setup section on how to create activities.) Activities defined 
here will be used to evaluate budget eligibility of campaign schedules. 
For example, if campaign schedule X is using Activity A, Budget B is 
using category C. Then campaign schedule X can draw money from 
Budget B only if category C has activity A assigned to it. If Category C 
does not have any activities assigned to it. This would mean that this 
budget is open to all and not subject to activity restrictions. 
Organizations can use this functionality to restrict budgets for direct 
marketing, advertising or other activities.

k. Click Create.

2. Test Creation of Categories:

a. Navigate to the Deliverable tab and click Create. Verify that the Category 
and Subcategory fields display values in the drop down menu.

b. Navigate to the Budget tab and click Create. Check if the Category field 
displays values in the drop down menu.

c. Navigate to the Events tab and click Create. Create an event. Navigate to 
the Categories item on the Side Navigation Menu. Verify that Category 
field displays values in the drop down menu.

d. Navigate to the Administration > Marketing > General > Metrics. Verify 
that the Category field displays values in the drop down menu.

6.5 Creating Custom Setups

Use
The Custom Setup area within Administration dictates and drives how an 
organization will use marketing objects. Marketing objects for which custom setups 
may be created include Campaign, Campaign Schedule, Collection, Deal, 
Deliverables, Event, Event Schedule, Event Promotion, Offer, One-Off Event, Price 
List and Trade Promotion.

Note: Oracle Marketing Online contains seeded categories for 
deliverables and events. Disable categories that are not needed.
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Custom setups enable an organization to use marketing objects to suit the 
organization’s needs through customized, object specific Side Panel Menus.

A custom setup determines:

� which items appear on the Side Navigation Menu when an object is created or 
selected. 

� the fields to be shown in the static HTML object reports on the Marketing 
Portal. 

� which users may view the object.

� which items require budget and/or theme approval.

� the suffixes for source codes.

Terminology and Seeded Values
Side Navigation Menu. This is the vertical menu which appears on the left hand 
side of the page, once an object is created. Note: The side panel menu does not 
appear until you create a new object.

Menu Items. These are the smallest components on the Side Navigation Menu. The 
following menu items are seeded with the application:

� Main

� Messages

� Geographies

� Products

� Deliverables

� Budget

� Teams

Note: Updated custom setup types affect all Objects of that type 
within the application. The update is restricted to newly created 
objects of that type. For example, if a deliverable is associated with 
a Campaign and the deliverable Side Navigation Menu item is 
disabled on the ‘Custom setup’, the deliverable item for currently 
existing objects will not be visible to users. If the deliverable item is 
enabled again, then the associated deliverable will become 
available.
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� Contact Points

� Triggers

� Schedule 

� Offer

� Tasks

� Notes

Each of the menu items refer to a different page. Menu items are the functional 
areas within the application where data can be created or object details view. While 
some of the menu items have functional implications, others are used for 
information purposes only. The Main item is displayed when an object is first 
accessed.

Component Groups. Each of the menu items are logically grouped into various 
sections based on functionality. 

Component Groups include Planning, Execution, Tracking, Collaboration and 
Approval. Within each Component Group is a logical collection of menu items. An 
example is shown below: 

Planning

Main
Messages
Geographies
Partners
Products
Deliverables
Budgets

Execution

Schedules
Offers
Triggers

Tracking

Costs
Metrics

Collaboration
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Contact Points
Attachments
Notes
Tasks
Team

Approval

Theme
Budget

Steps for creating Custom Setups
Creating Custom Setups involves first creating the Custom Setup and then selecting 
the menu items associated with it. While some Custom Setups are seeded, others 
may be created.

1. Navigate to Administration > Marketing > Setup > Custom Setup.

2. Create a Setup Name.

3. Associate the custom setup with a marketing object.

4. Depending on the marketing object selected, additional fields such as Activity 
Type and Activity may appear. This indicates that the custom setup is valid for 
the specific combination. The selection of the Activity Type and Activity will 
modify the available Component Groups and Menu Items. For example, Direct 
Marketing - Email will have a different set of Component Groups and Menu 
Items as compared to Direct Marketing – Direct Mail. For more details, see 
Creating Activities.

The available combinations of Activity Type and Activity in the Create Custom 
Setup page depend on the definition of the organization’s Activities, Activity 
Types and Categories. In the case of Deliverables, the combination of Activity 
Type and Activity is based on the parent and child category. See Creating 
Categories. Custom Setups for Campaign Schedules depend on the relationship 
of Activity Type and Activity.

5. Associate the Custom Setup with one of the following marketing objects. This 
field is mandatory.

� Campaign 

Note: Activity Types for Events are defined in the Lookup AMS_
EVENT_TYPE. 
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� Campaign Schedule

� Collection

� Deal

� Deliverable

� Event

� Event Schedule

� Event Promotion

� Offer

� One-Off Event

� Price List

� Trade Promotion

6. Mark Active – Only Active custom setups will show up at object creation.

7. Set Suffix - The suffix set here is reflected when an object is created. The suffix 
can be alpha, numeric or a combination. The maximum number of characters in 
a suffix is 3. This field is optional.

8. Select Menu Items.

The option to select menu items appears when a custom setup is created.

The combination of menu items show up based on the Object, Activity Type 
and Activity combination. 

a. Select a Component Groups from those listed above.

b. Select a Display Sequence. This dictates the order in which the menu items 
are displayed within a component group.

c. Select Components. These are all the menu items available to be selected. 
These are seeded within the application. Menu items not shown are not 
available.

d. Available Attributes. Components may be selected or deselected on the 
basis of these checkboxes. Deselected menu items do not appear on the 
object side panel menu.

e. Mandatory. Once components are made mandatory, those components 
cannot be disabled. The only recourse would be to inactivate the custom 
setup and create a new one with modified components and criteria.
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f. Show in Reports. This checkbox will decide the attributes shown in the 
portals and for locked objects.

g. Approvals. Approvals can be selected or deselected for Theme and Budget. 
Objects using custom setup with ‘Theme’ and ‘Budget’ disabled do not go 
through approval process. Theme and Budget approval can be selected or 
deselected independent of each other. Please refer to Creating Approval 
Rules for more information on the approval process.

Custom setups are selected from the respective create object pages. While some 
custom setups are seeded, additional setups may be created or existing setups may 
be modified to meet the organization’s Business Rules.

6.6 Creating Activities

Use
The Activity page within the Administration tab manages the relationship between 
an Object’s Activity Type, Activity and available Marketing Medium. It is in this 
area where an Organization can specify the available Activity and Marketing 
Mediums combination for a given Activity Type. 

Activity Types are seeded and cannot be created. These values come from a system 
lookup. Activities can be created within the application and can be linked to an 
existing Activity Type. 

When an Activity Type is selected for a Object Create or Custom Setup, the 
Activities that has been created for the Activity Type will populate the Activity 
LOV.

The available Activity Types are:

� Advertising

� Direct Marketing

� In-Store

� Press and Analyst Relations

� Web Marketing

� Events

The seeded Activities for each Activity Type are:

Advertising
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Banner Ads
Billboards
Brochures/Booklets
Directories
Display Signs
Magazine
Motion Pictures
Netcast
Newspaper
Posters/Leaflets
Print Ads,
Radio
TV

Direct Marketing

Catalog
Direct Mail
Email
Fax
Magazine Insert
Telemarketing

In-store

Display
End-Aisle
Grounders
Kiosk
Menu Boards
Package-Inserts
Packaging-Outer
Point-of-Purchase Displays
Shelf
Shoparound

Press and Analyst Relations

Article
Briefing
Community Relations
Company Magazine
Crisis Communications
Internal Communications
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Investor Relations
Lobbying
Press Conference
Publications
Release
Tour

Web Marketing

Advertising
Promotions

Steps for creating an Activity
1. Navigate to Administration > Marketing > Setup > Activity.

2. Create a Activity Name.

3. Select an Activity Type.

4. Mark Active. Only Active Activities are available within the application.

5. Associate Marketing Medium (see Creating Marketing Mediums):

a. Click Go.

b. Select a Marketing Medium from the list of active Marketing Mediums 
displayed.

c. Select Active From and Active To dates. These dates should fall within the 
Active From and Active To dates of the Marketing Medium.

d. Marketing Medium shown up on the Object details page based on the 
Association of the Marketing Medium with the various activities in the 
create Activity screen. A single Marketing Medium may be associated with 
multiple Activities.

Note: The list of activities for event activity type will come from 
the lookup AMS_ACTIVITY_TYPE. You will not be able to add 
new activities here. You will be be able to add new activities 
through this lookup.

Note: Custom defined activities are not available for the Activity 
Type of Web Marketing.
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6.7 Creating User Statuses

Use
The User Status setup in the Administration tab enables configuration of the values 
of the object’s Status field. This helps usability and analysis of objects within the 
application. This functionality facilitates the extension of object statuses within the 
application.

Usage Example
Consider a Campaign with a System Status of Cancelled. The seeded User Status for 
Campaign with Status Cancelled is Cancelled. This means that when a Campaign’s 
Status moves to Cancelled, the UI Status field reflects the value Cancelled.

The User Status functionality allows organizations to extend this status of Cancelled 
to imply and record the cause of the cancellation. This can be done through the User 
Statuses.

The System Status can be extended using User Status to enhance the analysis and 
reporting functionality. One such method would be to add a cancellation reason to 
the Cancelled status. 

For example: 

� Cancelled – ROI Below Expectation 

� Cancelled – Competitor Campaign 

� Cancelled – Product Overlap 

� Cancelled – Executive Rejection

These User Statuses can provide users with information in addition to the seeded 
status. 

User Statuses can be created for the Campaign ‘Cancelled’ status to indicate the 
cause of the cancellation. The default user status will show on the object upon 
cancellation but the campaign can be later updated to reflect the appropriate reason.

User statuses can be created for the following seeded statuses:

Budget Sourcing Status
Budget Status
Campaign Schedule Status
Campaign Status
Claim Status
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Deliverable Status
List Import Status
List Status
Marketing Event Agenda Status
Marketing Event Registration Status
Marketing Event Speaker Status
Marketing Event Status
Model Status
Offer Status
Price List Statuses
Program Status
Score status
Segment Status

All the Enabled User Statuses will be available in the Campaign Status LOV. Seeded 
User Status Values are marked Enabled and Default. This means that the System 
Status Value will show up for objects as the Default value. 

System Status Values cannot be disabled. 

New User Status Values can be created. Once a new User Status is created for a 
combination of Activity and Status and marked enabled, the seeded System Status 
Value automatically looses its default flag. There cannot be two default User 
Statuses for given combination of Activity and Status. 

Steps for Creating User Statuses
1. Navigate to Administration > Marketing > Setup > User Status > Create.

2. Select a marketing object for the User Status For field.

3. Select a System Status for the marketing object.

4. Enter a User Status to replace the System Status for the marketing object.

5. Select the Enabled checkbox to make the User Status available.

6. In order to set this User Status as a default, the Default check box needs to be 
checked in the overview screen for one of the newly created User Status, if not, 

Notes: Multiple Users Statuses may be created and enabled for a 
particular System Status.

All the functionality and rules associated with the System Status 
will be applicable for the User Status created for that combination.
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the seeded User Status will be reflected on the Campaign. On update, the 
default value on the seeded User Status is automatically removed.

7. See Appendix N for a list of seeded User Status values and the marketing 
objects to which they apply. 

6.8 Creating Locking Rules
As marketing objects transition from one status to another, certain aspects of the 
marketing object must be locked to prevent modification in the future. The Locking 
Rules determine which fields are no longer updatable as a marketing object 
achieves a new status.

6.9 Creating Mandatory Rules
The Mandatory Rules help the user interface respond to object transitions. For each 
marketing object, certain attributes are required to define it. The Mandatory Rules 
dictate which attributes of a marketing object are required. 

6.10 Creating Approval Rules

Use
Approvals can be used for budget and concept approval of all objects created within 
the Oracle Marketing Online application. 

Marketing Objects include: Campaigns, Campaign Schedules, Events, Event 
Schedules, One-Off Events, Offers, Deliverables, Pricelists, and Claims.

Budget Lines Requests and Budget Transfer approvals used to approve finances or 
funds used by the Objects.

Root Budget Approvals are used for Approvals on ‘Budget’ creation.

Object Approval is used as a final approval after ‘Concept’ and ‘Budget Line’ 
Approval

Terminology
Concept Approval. This is done prior to approving any finances for the Object. The 
requirement of ‘Concept’ approval for any Object is based on the ‘Custom Setup’ 
used for creating the Object.
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Budget Line Approval. This refers to the method in which the money / expense 
associated with an ‘Object’ is approved. The requirement of ‘Budget Line’ approval 
for any Object is based on the ‘Custom Setup’ used for creating the Object. This 
approval is guided by the budget category used while creating the budget. 

Budget Approval. This is the final approval for an ‘Object’. This happens after the 
‘Theme’ and ‘Budget Line’ approvals are met. The execution of this approval 
depends on the budget ‘Threshold‘ being met. See Profile Option, AMS Threshold 
Percentage.

Budget Request Approval. This type of approval is related to the Budget Transfers. 
Budget transfers are used to transfer funds between two budgets. 

This approval is guided by the budget category used while creating the budget 
which the funds are being sourced from. Note: Child budget creation is also similar 
to the budget request approval. 

Root Budget Approval. When a Budget is created in the Application, It cannot go 
‘Active’ and be used by other objects without going through the ‘Root Budget 
Approval’. Any Budget without a parent is a ‘Root Budget’ 

The approvals functionality will enable an organization to control the use and 
approval processes for all objects and involved finances. 

A Typical Approval within Oracle Marketing Online will go through:

� Theme, Budget Line and Budget Approval for Objects.

� Root Budget, Budget Requests for the creation of Budgets and Budget 
Transfers.

Overview of the Approval Process
If the Custom Setup selected for the marketing object requires both theme and 
budget approval, this is how the approval process will proceed.

1. An object goes through Concept approval when the object’s status is changed 
by the user from New to Planned.

2. Upon the next running of the concurrent process, the Concept approval is sent 
to an approver based on Approval Rules. At this time the object’s status goes to 
Pending Theme Approval.

3. Approver approves the request.

4. On approval, the object’s status goes to Planned. 
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5. When the user changes the object’s status from Planned to Active, the object 
goes through Budget Line approval.

6. Upon the next running of the concurrent process, the Budget Line approval is 
sent to an approver based on Approval Rules. At this time the object’s status 
goes to Pending Budget Approval.

7. Once the threshold limit is reached, based on the AMS Threshold Percentage, 
the Budget approval is sent automatically. It does not require a concurrent 
process. At this time the object’s status is still at Pending Budget Approval.

8. The Budget approval is sent to an approver based on Approval Rules. 
Depending on the approval, the object’s status will go to Active or Rejected.

The table below summarizes the necessary steps to successfully create Approval 
Rules. Further information detailing the implementation procedures is provided in 
the sections following the table.

Steps

1. Set up Role Types.

The Role Types that need to be set up are 

� Default Marketing Approver

� Marketing Approver

Step Required Description

1.  Set up Role Types Yes Creates Role Types required for approval 
process.

2.  Set up Roles Yes Create Roles and assign to a users.

3.  Set System Profiles Yes Set values for AMS Threshold Percentage and 
AMS Source From Parent.

4.  Create Approval Rules Yes Create Approval Rules and assign Approvers 
to them.

5.  Set up Concurrent 
Manager Programs

Yes Sets up the Workflow Background Process

6.  Test Creation of 
Approval Rules

Yes Verify that the Approval Rules work.
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The Default Marketing Approver is the default approver of any new marketing 
object requiring approval. Marketing Approvers are approvers specified by the 
Approval Rules.

a. Log into Forms with CRM Administrator responsibility.

b. Navigate to Setup > Role Types

c. Use Find to check for the role type of AMSAPPR. If the role type does not 
exist, it must be created. If it does exist, skip to step i.

d. From Menus, select New to create a new line.

e. Under the Code column, enter AMSAPPR.

f. Under Meaning, enter Default Marketing Approver.

g. Under Description, enter Default Marketing Approver.

h. Save the record.

i. If more than one person in the organization will be approving marketing 
objects, create a role type called Marketing Approver.

j. Use Find to check for the role type of MKTGAPPR. If this role type does not 
exist, it must be created. If it does exist, skip to step 2.

k. From Menus, select New to create a new line.

l. Under the Code column, enter MKTGAPPR.

m. Under Meaning, enter Marketing Approver.

n. Under Description, enter Marketing Approver.

o. Save the record.

2. Set up Roles.

The role of Default Marketing Approver must be created and assigned to a user 
in order for Oracle Marketing Online to function properly. The Default 
Marketing Approver receives approval notification for any marketing object not 
meeting the criteria specified in the Approval Rules. 

Important Note: The Default Marketing Approver Role may only 
be assigned to one user. If more than one user receives this role, the 
approval process will fail. Note that the system will not prevent 
you from assigning the role to more than one user. 
6-28 Oracle Marketing Online Implementation Guide



Creating Approval Rules
a. Navigate to Setup > Roles.

b. Query to determine whether the role AMS_DEFAULT_APPROVER exists. If 
not, create it with the following steps. If it does exist, skip to step 3.

c. From Menus, select New to create a new line.

d. Under the Code column, enter AMS_DEFAULT_APPROVER.

e. Under Name Type, enter Default Marketing Approver.

f. Under Type, use the LOV to select Default Marketing Approver or the 
description you gave the Default Marketing Approver Role Type in Step 1.

g. Under Description, enter Default Marketing Approver Role.

h. Select the checkboxes Active and Manager.

i. Save your work.

j. Assign this role to a valid user. See Assigning a Role in User Setup.

3. Set System Profiles.

a. Switch responsibility to System Administrator.

b. Navigate to Functions > Profile > System.

c. Enter the profile name in the Profile field and click Find.

d. Enter the appropriate value in the column corresponding to the level 
indicated.

e. Save your work.

See the table below for System Profiles and their values.
 Administration Set Ups 6-29



Creating Approval Rules
4. Create Approval Rules.

The creation process involves first creating an Approval Rule and then assigning 
Approvers to the rule.

a. Navigate to Administration > Marketing > Setups > Approval Rules.

b. Click Create.

c. Enter a Name for the Approval Rule. 

d. Select an Approval Rule Type from the following:

� Object: Approval Type: Concept is for 'Concept Approval'.

� Budget Request - Approval Type: Budget is for 'Budget Line Approval' 
(this is for funds requested from a Budget). This is when you request 
funds from a budget. This is the rule that will apply for ‘Budget 
Transfers’ and Child Budgets. Note: Budget Requests for Transfers and 
Child Budgets will follow the above rule.

Option Required Level Setting Effect/Limitation

AMS 
Threshold 
Percentage

Yes Site Enter a value 
between 0 and 
100

For a marketing object with an Initial 
Estimated Amount (IEA) value 
entered into the Budget page for that 
object to go to Active status, it must 
obtain budget approval for this 
percentage of the IEA. During the 
initial stage, before the object status is 
Active, requests in excess of the IEA 
are not allowed. 

For example, an object with an IEA of 
$1,000 and an AMS Threshold 
percentage of 60, requires approval of 
$600 in order to become Active. The 
same object in an organization with 
an AMS Threshold of 100, requires 
approval of $1,000 to become Active.

AMS Source 
from Parent

Yes Site Yes/No Determines whether campaign 
schedules and event schedules are 
sourced from their parent campaigns 
and events (select Yes) or from 
budgets (select No). Campaigns and 
Events may only be sourced from 
budgets.
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� Budget Transfer is used while transferring funds from one budget to 
another.

� Root Budget - Approval Type: Budget is for 'Root Budget Approval'.

� Campaign/Event - Approval Type: Budget is for 'Overall Object 
Approval' (this is the third approval after the threshold is met). It is 
after this approval that the object’s status will go ‘Active’. 

e. Assign Approvers. Approvers can be assigned by Role, by User, function or 
a combination of all three. The functions in use will be functions such as 
'Object Owner', 'Parent Object Owner', or 'Budget Owner'. These are similar 
to approval roles but are different in the sense that they are dynamic based 
on each 'Object' and do not have to be assigned to a 'User'.

If the approval needs to be sent through a chain of approvers, The 
approvers need to be set in an order.

For example, an advertising budget for which there are three approvers for 
the ‘Budget Line Approval’. After the rule is created, the approvers need to 
be added to the rule in the order in which they are expected to approve. 
Approver with Order [1] will be the first approver followed by Approver 
with Order [2] and so forth.

Notes:

Approvals will go through in the following order for a typical 
approvals process depending on Custom Setup Types explained in 
Creating Custom Setup Types: Concept followed by Budget lines 
followed by 'Budget'/’Object’.

Approval Rules are exclusive to the Rule created. The approvals 
can be made more specific by using criteria like Priority, 
Organization, Business Unit, Amounts / other fields in the UI.

Budget Line Approvals do not have a Priority. Priority is assigned 
at an ‘Object’ level. This means that the ‘Priority ‘set for the object 
will determine how the budget line approvals flow.

Approval rules can be designed based on a single or a combination 
of criteria such as BU, Priority, Custom Setup, Activity, Amount 
based on the Marketing Object which are available in the Create 
Approval Rules Page.
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5. Set up Concurrent Manager Programs:

a. Log into Forms as the Implementation User.

a. Switch responsibility to System Administrator.

b. Navigate to Applications > Functions > Setups > Concurrent Requests.

c. Click Submit a New Request.

See the table below for concurrent managers and descriptions.

6. Test Creation of Approval Rules. 

a. Prerequisites: 

� Validate that the concurrent programs are up and running.

� Validate that the PHP is up and running.

� Identify the periodicity of the Workflow Background Process for Theme 
and Budget Line Approval.

b. Create Objects with Custom Setups requiring ‘Concept’ and ‘Budget’ 
Approval.

c. Create categories for Budgets and create a Budget using the Category.

Concurrent Manager Required Description

Workflow Background 
Process

Yes Parameters required:

� Set Item Type: AMS Marketing Approvals 
for Marketing Approvals or OMO Triggers 
for Triggers (select from available values).

� Minimum Threshold: Leave blank.

� Maximum Threshold: Leave blank.

� Process Deferred: Yes

� Process Timeout: Yes

The concurrent process is required to process 
the approvals. As mentioned earlier, there are 
three approval processes to complete: Concept, 
Budget Line and Budget.

The concurrent process is required for Concept 
and Budget Line approvals. Other approvals, 
Budget Request, Root Budget and Object 
approval, occur in real time.
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d. Create Approval Rule for Root Budget using the specified Category.

e. Send the Budget through for approval.

f. Check if the Budget is Active.

g. Associate this budget to the objects created.

h. Set approval rules for the various objects.

i. Send Objects through for approval and verify that the approvals go through 
as expected. 

j. Do the following steps at each stage:

� Check if the approval goes to the approver designated in the approval 
rule. 

� Validate if the person requesting the approval gets a notification of 
forward in the PHP.

� This is done by logging into the PHP as the approver.

k. On approval through the PHP, login to the UI and check to see if the Objects 
in use reflect the changes made in the PHP: is the budget line ‘Approved’, 
and has the Object ‘Concept’ approval gone through.

6.11 Creating Web Offer Queries

Background
The Concurrent Program "AMS Web Execution: Refresh Offer Parties and Products" 
utilizes the queries that are setup using this page. This step has to be performed 
only if new Qualifier Contexts or Attributes are setup in Advanced Pricing.  These 
queries will be used by the concurrent program to arrive at the list of parties eligible 
for the offer. These parties will be stored in AMS_OFFER_PARTIES denorm table. 
eMerchadising would utilize this table to make offer recommendations on iStore.

These queries are used by budget-offer validation and offer forecasting. The tables 
generated by Web Execution: Refresh Offer Parties and Products are used by 
eMerchandizing.

Defining Market Eligibilities in Offers involves setting up qualifier contexts, 
attributes and value sets in Advanced Pricing. The Application comes with  seeded 
Contexts (for example, Customer Group) and attributes (for example, Lists and 
Segments). For all the seeded attributes which resolve a party, there will be a 
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seeded web offer query. When a new attribute is added to a context, a web offer 
query has to be setup for that context - attribute combination. 

Here is an example of a Marketing Eligibility query using a qualifier context:

A qualifier Context - Attribute definition: The Qualifier Context = Customer Group, 
the Attribute = Lists, the Associated Value Set = AMS_LISTS, the Value Set Id 
Column = list_header_id,  and the Value Set Name Column = list_name.

A Web Offer Query for the above Context-Attribute combination would have these 
values:

Bind Condition Id Column: list_header_id  ( Same as Value as Set Id Column )

Bind Condition Name Column: list_name ( Same as Value Set Name Column )

The Bind Condition Id Column will be used when "=" or "<>" operator is used 
while setting up the market eligibility.

The Bind Condition Name Column will be used when "Between" operator is used 
while setting up the market eligibility.

To create a Product Eligibility query using a product context, substitute a product 
context as follows:

A Product Context - Attribute definition = Product Context : Item, the 
Attribute = iStore Section, the Associated Value Set = AMS_ISTORE_SECTION, the 
Value Set Id Column = section_id

Web Offer Query for the above Context-Attribute combination:

Bind Condition Id Column: section_id  ( Same as Value Set Id Column )

There is no need to setup  Bind Condition Name Column for a product eligibility 
query.

Requirements
In order to define a query correctly, the following requirements must be met:

� For a Marketing Eligibility query, the SQL statement must return only the 
party_id field. This SQL statement will be validated.

� For a Product Eligibility query, the SQL statement must return only the 
product_id field. This SQL statement will be validated.

� The Bind Condition Name Column and the Bind Condition ID Column must be 
valid names of columns of tables that are referenced in the SQL statement. If 
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multiple tables are referenced, please use a table reference format of table_
name.column_name for both of these fields.

� For a "Party Site" or "Customer Site" qualifier, the Bind Condition ID Column 
must use the column name or alias name of "party_site_id" or "site_use_id" 
respectively. If an alias is used, the literal "site" must be used.

� The combination of "Query For", "Context Name", and "Context Attribute" must 
be unique. The unique constraint is enforce at the API level.

� SQL Statements that query a variable from global packages must use a "*" in the 
select statement. For example, "select * from Table_Name". 

Steps to create a Web Offer Query
1. Navigate to Administration > Marketing > Setup > Web Offer Queries.

2. Click Create.

3. Enter the Query For field. Queries are for Market or Product Eligibility.

4. Enter the Context Name. This is the Qualifier Context. 

5. Enter the Bind Condition Name Column. This is the bind condition that creates 
a denormalized query.

6. Enter a Bind Condition ID Column. This is the bind condition id used to create 
a denormalized query.

7. Active. Select this checkbox to make the query active.

8. SQL Statement. This query associated with the context and attribute.

Steps to Update a Web Offer Query
1. Navigate to Administration > Marketing > Setup > Web Offer Queries

2. Click the context attribute of the query to be modified.

3. Enter or modify the value of the Bind Condition Name Column.

4. Enter or modify the value of the Bind Condition ID Column.

5. Select or deselect the Active checkbox.

6. Modify the SQL statement.

7. Click Update.
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Set up and Run Concurrent Manager Program
1. Switch responsibility to Oracle Marketing Administrator

2. Navigate to Applications > Functions > Setups > Concurrent Requests.

3. Click Submit a New Request.

See the table below for concurrent manager programs and their descriptions.

6.12 Creating Data Sources
Data Sources are setups for importing data from a variety of sources, including 
TCA.

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Audience > Data Sources.

2. Enter a Code which becomes the name of the data source setup.

3. Enter a List Source Name. This is the database which is the source of the data.

4. Enter the Object Name. The Object Name is the name of the object within the 
database which is providing the data.

5. Enter the Primary Key. The Primary Key is the unique identifier for each record 
within the Object Name.

6. Enter a Description.

7. Click Create.

8. Click the link for the Data Source just created.

Concurrent Manager Required Description

Web Execution: Refresh 
Offer Parties and Products

Yes This program loads offer party and product 
information into denormalized tables. This 
information will be used in validating budget 
eligibility and web offer recommendations. For 
the input parameter p_incremental_flag, enter 
Y to load only new information or N to reload 
all information.
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9. On the List Source Types page, enter the name of the Source Field, a 
Description of the Source Field, and a List field name for the field in the Import 
Table. 

10. Repeat, completing one row for each field in the data source object.

11. Click Update.

Seeded Data Sources
Oracle Marketing Online seeds two master data sources for B2C and B2B: Person_
list and organization_contact_list. 

For Person_list, the seeded sub type data sources are: 

� Person_phone1

� Person_phone2

� Person_phone3

� Person_phone4

� Person_phone5

� Person_phone6

� Person_account_list

� Fax

For Organization_contact_list, the seeded sub type data sources are: 

� Organization_phone1

� Organization_phone2

� Organization_phone3

� Organization_phone4

� Organization_phone5

� Organization_phone6

� Organization_list

� Organization_account_list

� Fax

Users may also define their own data sources, both master and sub type.
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6.13 Word Replacement Rules
Follow the steps below to add new words to TCA’s word replacement system.

Steps
1. Log into Forms.

2. Switch responsibility to Receivables Manager.

3. Navigate to Setup > Word Replacement Rules.

4. Select Form Name Word Replacement (ARXWRDRP.fmb).

5. Add new word replacements.

6. Save your work.

6.14 Creating Geography
Geography is created in two sections. First the Geographic Location Types are 
created and then Geographic Areas are created. Each Geographic Area has a 
Geographic Location Type associated with it.

Steps
1. Navigate to Administration > Marketing > Geography > Location Type.

2. For each of the levels, enter a Name for the type and a Description.

� Area 1 (top level)

� Area 2 (second level)

� Country

� C Region (regions within Country)

� State

� S Region (regions within State)

� City

� Postal Code

3. Click Update.

4. Navigate to Administration > Marketing > Geography > Geographic Area.
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5. Select a Parent Geographic Area. The Geographic hierarchy should be created 
from the top down.

6. Select a Type for the child area.

7. Enter the Name, Short Name (will be used for Source Code generation), Start 
and End Dates (End Date is optional) for each child geographic area.

8. Click Update.

9. Repeat for additional Geographic Areas.

6.15 Creating Budget Adjustment Types

Use
This feature enables the user to make adjustments to their checkbooks. A user will 
be able to adjust earnings previously committed to customers who have failed to 
meet agreed upon activity. This frees up funds from the committed column and 
allows the user to commit to these funds to other activities. Budget adjustments 
may also be used to recover non-utilized funds from cancelled budgets.

Adjustment types may be defined in advance and then used when making 
adjustments to budgets.

Prerequisites
Some budgets must be made active before proceeding to view the adjustment type 
in the budget adjustment screen.

Steps

1. Create Budget Adjustment Type.

Note: Run the Concurrent Manager Program, Load Geographic 
Hierarchies, any time Geography is modified.

Step Required Description

1.  Create Adjustment Type Yes Sets up different types of adjustments that 
may be applied to budgets.

2.  Test Budget 
Adjustments

Yes Test to see that budget adjustments are 
functional.
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a. Log in to Oracle Marketing Online.

b. Navigate to Administration > Marketing > Budget > Adjustment Types.

c. Create an Adjustment Type. For example, Cost Cutting. Provide the 
necessary information and enter valid start and end dates. Note, Creation 
Sign has no functionality attached to it right now. 

d. Select an Adjustment Type from the following. The transaction and 
validation logic of each type of adjustments is given below.

� Decrease Budget Commitments. A user can decrease a commitment if 
he has already committed for that activity. A validation would be done 
whether a committed amount exists for that activity or not. The 
adjustment amount would also be validated against the previously 
committed budget amount.

Budget Commitments can be decreased only to the extent of balance 
left after budget utilized. There can never be negative commitments 
and earnings.

� Decrease Budget Commitment and Utilization. In addition to the 
above validation the following earning validation would also be done. 

To post a negative earning against a budget a positive earning must 
exist. If no earning exists for the budget the user is going to get a error 
message. 

� Decrease Budget Utilization. The above validation for decrease 
earning would be applicable in this case also.

� Increase Budget Utilization. A user can increase earning against any 
budget.

2. Test Budget Adjustments.

a. Navigate to the Budget tab

b. Select an active budget.

c. Select the Checkbook item on the Side Navigation Menu.

d. Click Adjustment.

e. In the Adjustment Page click on Go next to Adjustment Type and select an 
adjustment.
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Known Issues or Conflicts
The field Creation Sign has no functionality attached to it in this release. 

6.16 Creating Budget Thresholds

Use
The Budget Threshold feature of Oracle Marketing Online Trade Management 
allows the user to monitor the status and balance of their budgets and provides 
warnings as budgets are depleted, thus reducing the likelihood that sales will over 
or under spend their discretionary trade promotion funds.

There are different types of thresholds. Thresholds may be based on the planned 
amount, committed amount, utilized amount, paid amount or budget balance. For 
example, if a budget has a quarterly threshold on a planned amount equal to 50% of 
the baseline budget and the user attempts to plan budget expenditures greater than 
50% of the baseline budget, he will receive a notification indicating that he had 
planned to spend no more than 50% of the baseline budget in that quarterly period.

Prerequisites
Some budgets must be made active before proceeding to budget threshold.

Steps

1. Create Budget Threshold:

a. Log in to Oracle Marketing Online.

Step Required Description

1.  Create Budget 
Threshold

Yes This sets up a budget threshold which may 
then be applied to a budget.

2.  Create Budget 
Threshold Rules

Yes Define the threshold rules which are applied 
to the budget.

3.  Test the Budget 
Threshold Rule

Yes Tests the Budget Threshold notification.

4.  Run Concurrent 
Manager Program

Yes Program checks budgets against budget 
thresholds for violations. Generates 
notifications of violations to budget and parent 
budget owners.
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b. Navigate to Administration > Marketing> Budget > Threshold.

c. Create a Budget Threshold. Provide the necessary information and enter 
valid start and end dates. 

2. Create Budget Threshold Rules:

a. Navigate to Administration > Marketing > Budget Threshold.

b. Select the above-created threshold and navigate to the details page. Create 
at least one threshold rule. For example, if you want to notify a owner 3 
times a week when the committed amount is greater than or equal to 50% 
of the budget amount enter the following values in the respective fields:

� Enter Start and End Dates.

� Select a Value Limit of Committed. The Value limit is the budget 
column on which the threshold is based: Planned, Committed, Utilized, 
Paid or Balance.

� Select an Operator of ‘>=’.

� Enter a Percent of 50.

� Select a Baseline of Budget Amount. The table below shows available 
choices based on the selected Value Limit.

� Enter a Frequency of 3.

� Select a Period Type of Week.

� Select Enabled.

3. Test the Budget Threshold Rule.

Value Limit Available Baseline choices

Planned Budget

Committed Budget

Planned

Utilized Committed

Budget

Paid Utilized

Budget

Balance Budget
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a. Navigate to Budget. 

b. Select an active budget.

c. Associate the above-created threshold to this budget. 

d. Navigate to Budget Details and commit more than 50% of the budget 
amount for this budget for a campaign or an event.

4. Run Concurrent Manager Program: AMS Validate Budget Threshold and 
Submit:

a. Log into Forms.

b. Switch to Oracle Marketing Administrator responsibility.

c. Navigate to Applications > Functions > Setups > Concurrent Requests.

d. Click Submit a New Request.

e. A notification should be sent to the owner of the budget which has violated 
the threshold rule, and the owner of that budget’s parent budget, if any. 

6.17 Creating Claim Actions
Create Claim Actions to create task templates to group one or more tasks. Actions 
in turn are associated with reasons. When a reason is specified on a claim, the user 
has a choice to indicate what actions should be performed in order to move the 
claim to the next step. After specifying the action and updating the claim, the 
system will automatically populate the tasks to be performed in order to complete 
the action. This enables predefining the process for claims resolution.

Steps
1. Navigate to Administration > Marketing > Claim > Actions.

2. Click Create.

3. Source Object will be specified as Marketing Claim.

4. Enter a Name for the Action.

5. Enter a Start and End Date. If an End Date is not specified the Action is valid 
from the Start Date and does not expire.

6. Enter a Description. 

7. Complete the Task Template table:
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a. Enter a Name.

b. Enter a Description

c. Select a Priority. Available Priorities are: Critical, Fast Track, High, Medium, 
Standard, Low, and Option.

d. Enter a Duration and select a Duration Type. Available Duration Types are: 
Hour, Day, Week, Year, Month, and Minute.

e. Select a Task Type, either General or Approval.

8. Click Update.

6.18 Creating Reasons
Reasons populate the Reason LOV on the Claim Details page. Each Reason has 
associated with it: a start and end date, a description, and a reason code, as well as 
one or more actions.

Steps
1. Navigate to Administration > Marketing > Reasons. 

2. Click Create.

3. Enter a Reason.

4. Enter Start and End Dates. If no End Date is specified, the Reason will never 
expire.

5. Enter a Description.

6. Claim Reasons are mapped to Reason Codes in Oracle Receivables. The Reason 
Codes in Oracle Receivables could be related to Invoice or Adjustments. Hence 
it is required to select the type of Reason Code the Claims Reason will be 
mapped to.

7. Based on the Reason Type, the choices for Reason Code that will be mapped to 
the Claims Reason. This mapping is used to derive the Reason Code to be 
passed to Oracle Receivables when the Claim/Deduction is settled.

8. Each claim reason may have one or more actions to be performed. Actions are a 
group of tasks to be performed to resolve the claim.

9. Click Update.
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Reason Codes
Invoicing Reason

A/R Error
Cancellation
Credit And Rebill
Duplicate Billing
Foreign
Free Product
Late Payment
Order Entry Error
Return
Sales Tax Error
Shipping And Handling
Wrong Freight
Wrong Tax Rate

Adjustment Reason

Charges
Discount
Endorsement
Exchange
Int Adjust
Offset
Refund
Service Termination
Small Amt Remaining
Tax
W/O Tax
Write Off

6.19 Creating Claim Types
Claims Types populate the Claim Type LOV found in the Claim Details page. Each 
claim type has associated with it particular GL accounts, and a start and end date.

Steps
1. Navigate to Administration > Marketing > Claim Type.

2. Click Create.

3. Enter a Name for the Claim Type.
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4. Enter a Description.

5. Select a Creation Sign, either Positive or Negative.

6. Enter Start and End Dates.

7. Specify the following accounts:

� Vendor Clearing Account. 

� Receivables Clearing Account.

8. Select a Transaction Type from the available list by clicking Go. A Transaction 
Type is required for AR Settlement, when claim payment method is Credit 
Memo, Debit Memo, Invoice Credit or Chargeback. 

9. Click Update.

6.20 Creating Claim System Parameters
The Claims Systems Parameters determine how the system will operate and 
respond.

The Claims System Parameters screen is divided into four sections: General, 
Accounting, Claim, and Autopay.

Steps
1. Select a set of books. Only one set of books is allowed for one organization.

2. Select an accounting method. Only one accounting method, accrual, is 
supported in Release 6. 

3. Select GL Accounting if General Ledger account should be run.

4. Select Post to GL if the Interface API should check for posting to GL.

5. Select Rounding if rounding should occur in GL.

6. Select a GL Date Type. This sets the Claim GL_DATE to one of the following:

� Claim Date

� Due Date

Note: The Accounting section will be displayed only if the system 
profile AMS: Show GL Accounts On Screen is set to yes.
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� System Date

7. Select account numbers for the following:

� Sales/Expense/Charge Account

� Accrual Liability Account

� Receivable Clearing Account

� Vendor Clearing Account

These accounts will be used by default for posting, if the account is not defined 
at the Category or Budget level. The Sales/Expense/Charge Account and the 
Accrual Liability Account are account flexfields. When a posting is made to one 
of these two accounts, the numeric identifier for each component of the flexfield 
is obtained, through a workflow process, and the account number is created. If 
an account with that number does not already exist, it is created.

8. Select a default Reason for a claim. Claims which are not manually created will 
receive the default Reason.

9. Select a Claim Type. Claims which are not manually created will receive the 
default Claim Type.

10. If the Days Due item is missing in the customer trade profile, this parameter 
will be used. The Claim due date will default to this future date.

11. Select an Exchange Type. If a claim is not created manually and the claim 
currency is other than the functional currency, this exchange type will be used.

12. Select a Default Owner for claims which are not entered manually (deductions, 
Autopay claims). If the Assignment Manager option is selected, the owner 
selected here will be omitted. The Default Owner will be taken if Territory 
Manager is not implemented or if it does not return a suggested default owner 
for the claim.

13. Select Assignment Manager Implemented to automatically assign a claim. If 
select, the claim owner will be defaulted to the winning resource derived from 
the claims territory implementation.

14. Select a Receivable Batch Source. The batch source is used to create transactions 
in Oracle Receivables that are used to settle claims.

15. Select a Debit Memo to be used for settlement of claims. The debit memo is 
used to create a debit memo in Oracle Receivables to settle a claim.

16. Select a Credit Memo to be used for settlement of claims. The credit memo is 
used to create a credit memo in Oracle Receivables to settle a claim.
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17. Select a Payables Source to be used for settlement of claims. Invoices created in 
payables will have the invoice source. This is used for running the Payables 
Open Interface Import program.

18. Select a Payables Payment Term to be used for settlement of claims. If a value is 
set, check payments made from claims will have this payment term.

19. Select the Autopay checkbox to run the Autopay feature. Determines if 
Autopay will be in effect for the selected vendor.

20. Select a default Reason for the Autopay claim record. This claim reason will be 
used for automatic payments of accruals and earnings.

21. Select a default Claim Type for the Autopay claim record. This claim type will 
be used for automatic payments of accruals and earnings.

22. Enter a number for the Frequency. This is the number of Frequency Units 
between Autopay runs.

23. Select a Frequency Unit from the following: Days, Months, Quarters, Weeks, or 
Years.

24. Click Update.

6.21 Creating Trade Profile Item for Account and Organization
Use these steps to add the Trade Profile item to the Side Navigation Menu for 
Account and Organization.

Steps
1. Log in under the Sales Online Super User responsibility.

2. Navigate to Administration > Sales > Menu Administration.

3. Select Organization from the Menu Name drop-down menu.

4. Enter a value in the Sequence column to place the Trade Profile Item in the Side 
Navigation Menu list. A value of 110 is recommended.

5. Enter a value of TRADE in the Attribute column.

Note: Oracle Receivables will be automatically reconfigured for 
Claims integration when information is supplied to one or both of 
the Debit Memo or Credit Memo fields.
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6. Enter Trade Profile in the Attribute Text column.

7. Selection a Function Name of AMS_ORGZN_TRADE from the list of values.

8. Click OK.

9. Select Organization from the Menu Name drop-down menu.

10. Enter a Sequence value to place the Trade Profile Item in the Side Navigation 
Menu list. A value of 110 is recommended.

11. Enter an Attribute of TRADE.

12. Enter Attribute Text of Trade Profile.

13. Selection a Function Name of AMS_ORGZN_TRADE from the list of values.

14. Click OK.
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7

User Setup

7.1 User Creation
Users of the Oracle Marketing Online application are created using the following 
steps.

Steps

1. Create an Employee.

a. Log into forms.

b. Select appropriate HRMS Manager Responsibility.

Note: You must perform these steps in this order shown. 

Step Required Description

1.  Create an Employee Yes

2.  Create a User Yes Creates the user with the necessary 
responsibilities. Users are then matched to 
employees.

3.  Set Profile Options Yes Set Profile Options for the User.

4.  Import Employees Yes Import employees into Resource Manager.

5.  Specify Roles and 
Groups

Yes Some roles are required for access to tabs.

6.  Run Concurrent 
Manager Program

Yes Updates denormalized tables with group 
information. Must be run after users are 
created to put them into Groups.
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c. Navigate to People > Enter & Maintain.

d. In the Find Person box, select New.

e. Enter the following information:

� Last Name and First Name

� Title (courtesy title: Mr., Ms.)

� Gender (will populate based on title, if possible)

� Type = Employee

� Social Security # (will be checked against existing SS#)

� Birth Date

f. Save your work. A confirmation will appear in the lower left corner of the 
window.

g. Click Assignment and enter the following:

� Organization

� Team/Group

� Location 

� Supervisor

h. If a dialog with Update and Correction buttons displays, select Correction 
to revise existing data and Update to create a new record.

i. Save your work. A confirmation will appear in the lower left corner of the 
window.

j. Select yes to use the new location

2. Creating a User.

a. Log into Forms under the SysAdmin login.

b. Navigate to Security > User > Define.

c. Create a new user.

d. Assign the employee created in Step 1 to the user. 

e. Assign appropriate responsibilities to the user.

3. Set Profile Options:

a. Navigate to Profile > System.
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User Creation
b. Enter user name just created.

c. Search for profile JTF_PRO%.

d. Set JTF_PROFILE_DEFAULT_APPLICATION = 530 in the User column.

e. Set JTF_PROFILE_DEFAULT_RESPONSIBILITY in the User column, using 
the appropriate responsibility ID code. 

f. Save your work.

4. Import Employees:

a. Change responsibility to CRM Administrator.

b. Navigate to Resource Manager > Maintain Resources > Import Resources.

c. Locate the employee just created. Enter employee’s name in the name fields 
and click Search.

d. Click Create Resource.

e. Click OK to accept default values.

f. Click Save Resource (record the transaction number).

g. Click Details.

5. Specify Roles and Groups.

See Defining Marketing Groups, below.

a. Navigate to Resource Manager.

b. Select the employee as the resource.

c. Click Details.

d. On the Roles tab:

� If the user is to have access to the Audience and/or Administration 
tabs, add a role type of Sales and a Role of Sales Representative.

� If the organization is implementing One to One Fulfillment, users: (a) 
must have JTF_FM_ADMIN role assigned to them, and (b) be assigned 
to the Fulfillment Resource Group. 

� If the user is the default approver for marketing objects, add a Role of 
Default Marketing Approver.
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User Creation
� If the user is an approver for marketing objects, add a Role of 
Marketing Approver. Note that multiple assignments of this Role are 
permissible.

e. On the Group tab, select a group with Usages of Sales and TeleSales and 
Oracle Marketing.

f. Make sure that the Group Member Role Sales Representative is associated 
to the above group on the resource details screen.

6. Run Concurrent Manager Program.

When finished entering users, run the Concurrent Manager Program, AMS 
Group Access Refresh. (See Set Up and Run Concurrent Manager Programs.)

7.1.1 Defining Marketing Groups

Steps
1. Under the CRM Administrator responsibility, navigate to Resource Manager > 

Maintain Resources > Groups.

The Define Groups window appears.

2. For each group in the hierarchy:

a. Enter the group name. 

Note: Only one user may be assigned the role of Default 
Marketing Approver.

Note: The Role you assign to an employee in Resource Manager 
has no relationship to the Role you assign the employee as a 
member of a group.

Tip: To create a hierarchy of groups, start at the bottom or the top 
of the hierarchy. This will make it easier to link each group either to 
the parent group or to its child groups.
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Optional Employee Setups
b. Enter an optional description. 

c. On the Parent Groups tab, enter the group, if any, that is above the current 
group in the group hierarchy.

d. On the Child Groups tab, enter the groups that are below the current group 
in the group hierarchy.

e. On the Usages tab, use the LOV to enter Oracle Marketing. You must 
make this entry for the group to be recognized by Oracle Marketing Online. 
In addition, if this group requires access to the Audience and/or 
Administration tabs, add Usages of Sales and TeleSales and Oracle 
Marketing.

f. Click Save on the toolbar.

Reference
For more information on using Resource Manager see Oracle CRM Foundation 
Components Concepts and Procedures, Release 11i, Using Resource Manager, Defining 
Resource Groups.

7.2 Optional Employee Setups
The following may be set through Forms, System Profiles or may be set by the user 
using the Profile icon in the application.

The following may be set by the user by navigating to Profile > Marketing Online > 
General.

Note: If the window is not blank you can create a new record by 
clicking New on the toolbar.

Note: You need not enter both parent and child groups. If you 
build your hierarchy by entering parent groups, then you need not 
enter child groups and vice versa. The missing groups are supplied 
by the application automatically. 
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User Security
7.3 User Security

Use
While the extent to which security is set will depend on the business process of the 
client, Oracle Marketing Online provides the flexibility to create security and access 
privileges at many different levels throughout the application, such as tab, subtab, 
side navigation bar, and items on the Side Navigation Menu.

The following are the common areas where security may be implemented: 

Levels
1. Menus. This can be set to limit a user’s access to specific tabs and subtabs. For 

example, business process may require that only a few key individual users 
have access to the administration tab. Or, that a security structure should exist 
whereby a user should have access to a specific tab, like Deliverables, but only 
access to one of the two subtabs. 

2. Functions. Whereas menus can be set to the limit access to tabs and subtabs, 
functions can be set to limit a user’s access within a tab/subtab. For example, a 
function could be set to limit the user’s access to the side navigation bar and 
one of the component groups such as Collaboration and one of its cue cards. 
Another use is the ability to limit what tasks the user may be able to perform. 
For example, a function could be set to limit the ability of user to create objects 
by removing the functionality associated with the create button.

Option Required Level Setting Effect/Limitation

AMS: Enable 
Tip Text

Optional User Yes/No Tip text will be displayed in the UI.

AMS Profile 
Search Set 
Size

Yes User Numeric Indicates the number of rows 
displayed in selection windows.

AMS User 
Country

Optional User Select from 
countries 
created in the 
Administration 
tab. 

Defaults new objects to this country 
when created.

AMS User 
Timezone

Optional User Select the 
timezone the 
user is in.

All activities scheduled by the user 
will be converted to and be 
executed at the system timezone.
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Security for Sales Online Pages
A common scenario may be where a security structure is set to use a 
combination of both functionalities; Menus and Functions. Consider the 
following: two responsibilities, X & Y, are created where responsibility X is 
meant to have access to budget tab and budget cue card and Y is not. As 
mentioned above, for responsibility Y, the menu and function, corresponding to 
the budget tab and cue card respectively, can be excluded.

In addition to menus and functions, additional types of security can be made 
through:

� AMS: Admin Group. This is a system profile, that when set, allows the 
resources that are part of this identified group to have full access to 
marketing objects regardless of whether or not they are associated to the 
specified object.

� Groups/Teams/Users can be given access to a marketing object via the 
Team item on the Side Navigation Menu under the Collaboration 
component group.

� Edit Metrics. When checked against a group/team/user, grants access to 
Budget, under the Planning component group, Cost and Revenues, under 
the Planning component group, and Metrics, under the Tracking 
component group, for the specified group/team/user.

7.4 Security for Sales Online Pages
Oracle Marketing Online uses pages from Oracle Sales Online on its Audience tab. 
In order to implement security for these pages, please refer to the Setting up Users, 
Security and Reporting Hierarchy, Setting up System Profile Options, Functional 
Area section of the Oracle Sales Online, Telesales and Field Sales Implementation 
Guide, for more information on the Access profile options.

These System Profile Options will determine what information is displayed on the 
Organization and Person subtabs in the Audience tab of Oracle Marketing Online.

Note: Menus and functions can be included or excluded when 
creating a responsibility through System Administrator 
Responsibility in Forms (Applications > Functions > Security > 
Responsibility > Define).
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 Post Implementation 
8

Post Implementation Steps

8.1 Setting up One to One Fulfillment
Required for campaigns utilizing email or fax execution.

8.2 Setting up Marketing Encyclopedia
Required for Encyclopedia subtab on the Home tab.

For more information about Marketing Encyclopedia, see Oracle Marketing 
Encyclopedia Concepts and Procedures.

8.3 Setting up Oracle Partners Online
Required for partner interactions.

Refer to the Oracle Partner Relationship Management Implementation Guide for 
information about setting up Partners.

8.4 Setting Up Scripting
Required for campaigns using telemarketing execution.

Follow the instructions in the Oracle Scripting Implementation Guide and Oracle 
Scripting Concepts and Procedures Guide to set up scripts.

8.5 Setting Up CRM Foundation Territory Manager
Useful, but not required, for implementing Trade Management.
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Setting Up Call Center / Advanced Outbound
Refer to the Implementing Territory Manager section of the Oracle CRM Foundation 
Implementation Guide for information about setting up territory management.

After the territory administrator has completed the territory setups as outlined in 
the CRM Foundation Implementation Guide and has run the "Generate Territory 
Package" and "Territory Denormalization Refresh", then run "Assign Territory 
Access". See Running Concurrent Manager Programs.

8.6 Setting Up Call Center / Advanced Outbound
Required for campaigns using telemarketing execution.

Follow the instructions in the implementation section of Oracle Predictive Concepts 
and Procedures and Oracle Telephony Manager Implementation Guide.

8.7 Setting up Interaction History
Optional. Tracks customer interactions with the organization.

Refer to the Implementing Interaction History section of the Oracle CRM Foundation 
Implementation Guide for information on setting up Interaction History.

8.8 Setting Up Descriptive Flexfields
Please refer to the Oracle Applications Flexfield Guide for detailed information about 
setting up descriptive flexfields.

8.9 Setting up Default Budgets

Option Required Level Setting Effect/Limitation

AMS: 
Default 
Budget for a 
Person

Yes User All Budgets 
which are 
owned by the 
user.

AMS: 
Default 
Partner 
Budget

Yes User User 
Determined
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Checking Post Installation Steps
8.10 Checking Post Installation Steps
Check for the following post installation steps on the Applications Database 
necessary for the Gateway.

� Check for Advanced Queues

� Verify the Unique Global Name

� Modify Oracle Applications Database Parameters

� Run snapshot log creation scripts

� Verify System Profile Option Values
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Acronyms

This appendix provides a list of acronyms used throughout this Guide. For 
additional information please see the Glossary in Appendix B.

AMS Prefix associated with Oracle Marketing Online.

AO Oracle Advanced Outbound. A product used to preprocess marketing 
campaigns for Oracle Telesales.

AP Accounts Payable.

AR Accounts Receivables.

B2B Business to Business, a commerce model.

B2B2C Business to Business to Consumer, a commerce model usually associated 
with Trade Management.

B2C Business to Consumer, a commerce model.

COGS Cost of Goods Sold.

CRM Customer Relationship Management.

CSV A comma delimited data file type.

DBA Database Administrator. The person within an organization primarily 
responsible for the deployment and maintenance of an Oracle database 
product.

DNC Do Not Call. A flag in marketing databases and lists indicating people 
who do not wish to be contacted.

ERP Enterprise Resource Planning.
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EUL The End User Layer is a user interface that is part of Oracle Discoverer. 
The EUL provides a methodology for questioning a database without 
having to know query language, or database terminology or structure.

GL General Ledger.

GRE Government Reporting Entity

GUI Graphical User Interface.

HTML HyperText Markup Language.

HR Human Resources.

HRMS Human Resources Management System.

ICX A Prefix associated with Oracle Discoverer.

JRE Java Runtime Environment.

JSP Java Server Page.

JTF CRM Foundation modules.

LOV The List of Values is a list that appears in various drop-down fields within 
OMO. These List of Values can be predefined or created from user entered 
information.

MES Marketing Encyclopedia System. 

ODM Oracle Data Mining.

OIC Oracle Incentive Compensation.

OMO Oracle Marketing Online.

OSO Oracle Sales Online.

OTS Oracle TeleSales.

PHP Personal Home Page where Workflow notifications may be found.

PIN Personal Identification Number.

QP Prefix associated with Oracle Advanced Pricing.

ROI Return on Investment.

SIC Standard Industry Code.

SQL Structured Query Language. Used to query databases.
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TCA Trading Community Architecture. Oracle's single customer database 
architecture for all types of customers.

TM Trade Management.

UI User Interface.

UOM Unit of Measure.

URL Universal Resource Locator is the full name or path of a web page or file 
location.
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B

Glossary of Terms

This appendix provides a Glossary of Terms used throughout this guide.

Activity Type
A general category for marketing activities of similar type.

Activity
An activity associated with a Campaign Schedule, Events and other objects.

Actuals
Actual costs using with Costs and Metrics.

Analytics
A group of tools used to predict purchasing behavior by analyzing customers’ 
response to a prior campaign.

Approval Rule
Rules used to automate and control the routing and sequence of approval requests. 

Attachment
A file or URL attached to a marketing object.

Audience
The audience tab provides functionality relating to List creation, management and 
the creation and management of information relation to parties external to the 
organization.
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Budget
The Budget tab provides a variety of Budget creation and management functions.

Budget Source
Term applied to the name of the budget funding a marketing object.

Budget Source Value
The amount being requested or approved from a Budget Source.

Business Rules
The rules and guidelines which govern how an organization uses the Oracle 
eBusiness Suite.

Business Unit
A grouping of users within the application, defining the organizational structure.

Campaign
A marketing effort comprising any number of different techniques for reaching 
Customers or Prospects.

Campaign Schedule
The marketing object that executes campaign activities.

Claim
A discrepancy between amount billed to a customer and the amount paid by a 
customer. Claims are used to track discrepancies to their basis and validate them.

Closed-Loop Marketing
The ability to plan, manage, execute and analyze marketing activities. Oracle, by 
virtue of its comprehensive marketing offering and integration to other Oracle 
applications—both CRM and ERP—is able to do this where other vendors simply 
are not.

Cost
A particular type of Metric used to track costs and expenses associated with 
Campaigns, Events and Offers.
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Customer
A prior purchaser of products or services.

Deduction
A Claim that originates with Accounts Receivable. This is generally the result of a 
short pay by the customer.

Deduplication
To remove duplicate records from a list, the entries are compared based on the 
deduplication rules specified in the administration tab.

Deliverable
A unit of marketing information to be given to a Customer or Prospect. Deliverables 
may be in hard form, e.g., a flyer or printed information, or in soft form, e.g., an 
electronic brochure or email attachment.

Discoverer
Oracle Discoverer is a data mining tool allowing users to query databases without 
knowing SQL.

Display Priority
An attribute of the posting’s content type used to prioritize the recommended 
content for display, based on supplied criteria.

eMerchandizing
A group of methodologies used to configure websites according to customer 
preferences and anticipated interests.

Event
As it relates to marketing, an Event is a marketing effort with a specific location, 
such as a conference, exhibit, seminar, or trade show. Events may be separate from, 
in addition to, or supported by Campaigns.

Event Promotion
A specific type of Campaign used for promoting an event.
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Event Schedule
A marketing object that executes Event activities.

Field
A unit of data. Data is stored in an array of records and fields. A field on a Page is 
where data is entered or selected from a LOV.

Forecast
Used to enter forecast costs or values for metrics.

Geography
Used to define the geographical breakdown and hierarchy used by an organization.

Interaction
A touchpoint with a customer or potential customer. Interactions may be recorded 
in Oracle Interaction History.

Home
The Home tab is the first tab the user sees when they log onto Marketing Online. 
The Home tab contains a number of bins and available reports as well as links in 
certain bins to recently accessed marketing objects.

Import
A function on the Audience tab which allows for importation of information into 
TCA.

Interaction
A touchpoint between the organization and a customer or prospect. Interactions 
may be tracked for later qualification and rating.

iStore
An Oracle product designed for producing commerce websites.

Lead
A qualified prospect for the sale of products or services. A lead may result from the 
prospect contacting the organization or by the organization contacting the prospect. 
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Link
A hyperlink to another Page.

List Import Table
A database table where records imported from a rented or purchased list are stored. 
These records may be added to TCA from the List Import Table.

List
A static list of customers, prospects, or both, along with various related information.

Market Segment
A subdivision of an audience defined by specific parameters. See Segment.

Marketing Object
A functional unit in Oracle Marketing Online. For example, campaign, event, 
deliverable, list, or message.

Marketing Medium
A channel for executing marketing activities. This can be different types of media, 
such as radio, television or print as well as delivery methods, such as email, fax and 
direct mail.

Merchandising Strategy
A mechanism used to select personalized content items for display on a Web site. 
Merchandising strategies include strategies from Oracle Personalization, static 
cross-sells, specific list of content items, and others.

Message
A slogan used for marketing purposes.

Metric
A measuring device used to track Campaigns and Events. Metrics may measure 
responses, revenue or other statistics.

Multi Org
Used to describe the capacities of Oracle products to accommodate multiple 
organizations in multiple countries with differing currencies and languages.
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Note
A note may be attached to almost any marketing object for many different 
purposes. Notes, once attached, are not deleteable.

Note Type
These are organization-defined types to used to categorize notes.

Object
See Marketing Object.

Offer
The incentive bundled with a product or service in a campaign. It may be monetary 
or non-monetary based. An example of a monetary offer is a 20% discount for 
signing up Cellular service. A non-monetary offer may be the free guide to 
retirement planning given with a subscription to Money magazine.

One-Off Event
A One-Off Event is a "single" event which occurs just once.

Owner
The owner of a Marketing Object.

Page
A HTML page viewed in a browser.

Performance Matrix
A report containing detailed information about a model’s ability to make accurate 
predictions of customer behavior.

Personalize
A function that allows a user to customize many different pages to accommodate 
his specific needs.

Placement
The association of a Web location (defined by a site, a page and a page location), a 
posting and a display style.
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Posting
An object that represents the way personalized content is retrieved. Postings can be 
Universal, i.e., the same strategy for selecting content is applied to all the visitors, or 
Rule-based, i.e., different strategies apply to different situations that are described 
by the rules conditions.

Posting Rule
A set of conditional statements, merchandising strategy and a rule priority. The 
merchandising strategy is triggered if all conditional statements are true.

Product
A product or service which can be associated with a Marketing Object.

Product Family
A group of products or services which can be associated with a Marketing Object.

Profile
A profile is a set of pages where a user’s information for interaction with the 
application is stored. For example, name, password, number rows of information 
displayed in a table, or size of lookup pages.

Program
A group of Campaigns and/or Events that are grouped together.

Prospects
Prospective customers who have not previously purchased products or services.

Record
A collection of related Fields. All of the fields in a Record contain data relating to a 
single item.

Response
Any communication received back from a customer or prospect. Responses may be 
saved in Oracle Interaction History.

Rollup Cost
A cost metric that is composed of other cost metrics.
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Rollup Metric
A metric that is composed of other metrics.

Schedule
Execution vehicle of a campaign or event within Oracle Marketing Online. For 
example, a campaign may have an email schedule, and telemarketing schedule and 
direct mail schedule which roll up to the campaign; an event may have a briefing, 
web seminar, or conference that roll up to it.

Segment
A set of criteria used to extract a list of Customers or Prospects or both from a 
database.

Source Code
A code associated with various marketing objects in OMO. Source codes are utilized 
by many interrelated products for relating Interactions, purchases and responses 
back to the Campaign or Event that generated them.

Status
Statuses are assigned to various marketing objects to let users and the system know 
the state of the object. Changes in status may be affected by the user or may be 
affected by the system, particularly those status changes requiring approval.

Structured Query Language (SQL)
Sometimes pronounced "Sequel", Structured Query Language is a standard for 
querying, or asking questions of, a database.

Subtab
Some tabs have further divisions called subtabs. Subtabs, if any, are displayed 
horizontally underneath the tabs.

Summary Page
Summary pages, which are a list of marketing objects, appear under many tabs and 
subtabs. To view a marketing object's details, click the object's name.

Tab
Main divisions within the user interface of Oracle Marketing Online.
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TCA or Trading Community Architecture
Oracle's single customer database architecture for all types of customers.

Trade Management
Marketing functionality used to track the Business to Business to Consumer 
relationship. 

Venue
A location for an Event.

View
A listing of Marketing Objects generally displayed on the Summary Page of a tab.

Workbook
A collection of one or more Worksheets generated by Oracle Discoverer.

Workflow
Oracle Workflow is a foundation product using to track and relay approvals and 
notifications according to Business Rules.

Worksheet
A spreadsheet of Customers or Prospects, or both, extracted from a database by 
Oracle Discoverer.
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Summary of System Profile Options

This appendix provides a table of the system profile options used by Oracle 
Marketing Online. 

Option Required Level Setting Effect/Limitation

AMS Admin 
Group

Yes Site Select from 
any group 
defined in JTF 
Resource 
Groups

Resources that are part of this group 
will have full access to all 
campaigns, events, and other 
marketing objects. Note that this 
should be a single level group.

AMS: Allow 
committed 
budget to 
exceed total 
budget

Optional All Yes/No When set to Yes, the committed 
amount for the budget may exceed 
its total budget amount.

AMS: Allow 
Inventory Item 
Update

Yes User Yes/No Indicates whether user from OMO 
application is allowed to update 
inventory item. Note This profile is 
updatable only by the system 
administrator though it is a user 
level profile.

AMS: Allow 
Recalcula-
tion of 
Committed 
Budget

Optional All Yes/No When set to Yes will perform 
recalculation of commitment of 
offers.

AMS: Allow 
Updates to QP 
Price Lists in 
OMO

Yes Respon
sibility

Yes/No Selecting Yes will allow Price lists 
created using Advanced Pricing can 
be edited in Oracle Marketing 
Online.
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AMS: Auto 
Register for 
Events upon 
cancellation

Yes Site Yes/No This is used to determine if the 
attendee can be moved from the 
waiting list to registered status if a 
spot is available

AMS Call 
Center Enabled

Not valid for release 6.

AMS Campaign 
Display Version

Not valid for release 6.

AMS: Choose 
Date Qualifier 
Regions

Yes Site Show All

Show Header 
Dates 

Show only 
Date Qualifiers

This profile is used in the Trade 
Deal Offer User Interface.

Based on the setting, the user may 
either enter date qualifiers or 
Header Dates or both.

AMS: Copy 
Event Details to 
Event Schedules

Yes Site Yes/No This is used to allow details of 
parent Event to be copied to the 
schedule

AMS Currency 
Conversion

Yes Site Select from 
conversions 
defined in GL, 
such as 
Corporate or 
Spot.

This is the exchange rate used for 
converting transactional amounts 
into the default currency.

AMS: Custom 
Condition Class

Optional Site Java class 
name of the 
custom 
condition

This class is invoked in the runtime 
when custom conditions are 
implemented.

AMS Data Entry 
Rows

Not valid for release 6.

AMS Data 
Mining DB Link

Yes Site All database 
links in the 
database.

The scoring run result processing 
program will use the db link to fetch 
results.

AMS: Data 
Mining Engine 
Output Schema

Yes Site Free form text 
corresponding 
to the scoring 
output schema 
specified in 
Step 3.

The scoring run result processing 
program will use the scheme 
specified to fetch the results.

Option Required Level Setting Effect/Limitation
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AMS: Data 
Mining Engine 
Program 
Property File

Yes Site Free form text 
corresponding 
to the location 
of the property 
file created in 
Step 1.

The Java Concurrent Program will 
use the property file indicated in the 
profile option value to invoke 
program settings by calling ODM 9i 
API’s.

AMS Date 
Format

Not valid for release 6.

AMS Default 
Bucket for 
discount rules

Yes Site Values from 
Advanced 
Pricing 
Lookup 
PRICING_
GROUP_
SEQUENCE

The value set here will be used as 
the default value for buckets in the 
discount rules.

AMS Default 
Budget for a 
Person

Yes User All Budgets 
which are 
owned by the 
user.

AMS Default 
Campaign 
Custom Setup 
Type for Fully 
Accrued 
Budgets

Not valid for release 6.

AMS Default 
Currency Code

Yes Site Select from 
currencies 
defined in 
FND_ 
CURRENCIES

This becomes the default functional 
currency. All transactions will be 
converted and stored in this 
currency. This will be the default 
currency for Currency LOV.

AMS Default 
Home Page

Not valid for release 6.

AMS: Default 
Offer Formula

Optional Site Available 
pricing 
formulas in 
Advanced 
Pricing

This option handles discount rules 
for product categories when the 
Unit of Measure is not specified.

AMS: Default 
Offer Stylesheet

Yes Site User defined Not valid for release 6.

Option Required Level Setting Effect/Limitation
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AMS Default 
Owner 
Assigned to 
Claim

Not valid for release 6.

AMS: Default 
Period in Days 
for recalculating 
committed 
budget

Optional All Number of 
Days

The number of days between 
performing committed budget 
calculations.

AMS: Default 
Phase for Line 
level discounts

Yes Site Available 
values are 
derived from 
event phase 
setup in 
Advanced 
Pricing

This value will be used as the 
default value for phase for all 
discount rules with a discount level 
of Line.

AMS: Default 
Phase for Line 
Group level 
discounts

Yes Site Available 
values are 
derived from 
event phase 
setup in 
Advanced 
Pricing

This value will be used as the 
default value for phase for all 
discount rules with a discount level 
of Group of Lines.

AMS: Default 
Phase for Order 
level discounts

Yes Site Available 
values are 
derived from 
event phase 
setup in 
Advanced 
Pricing

This value will be used as the 
default value for phase for all 
discount rules with a discount level 
of Order.

AMS: Default 
Product 
Stylesheet

Yes Site User defined Determines the default stylesheet 
file for Products.

AMS: Default 
Schedule 
Stylesheet

Yes Site User Defined Determines the default stylesheet 
file for Schedules.

AMS Default 
Task Rule

Not valid for release 6.

AMS Default 
Task Status 

Optional Site Depends on 
JTF Task 
Statuses

If nothing is entered here, tasks will 
default to ’unassigned’.

Option Required Level Setting Effect/Limitation
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AMS Default 
Team for User

Not valid for release 6.

AMS Default 
Time Out Used 
for Tasks

Not valid for release 6.

AMS Default 
Transaction 
(Receivables) 
Batch Source

Not valid for release 6.

AMS: Default 
value for Print 
on Invoice Flag

Yes Site Yes/No Used as a default for all discount 
rules.

AMS: Default 
value for 
Product 
Preference

Yes Site User Defined Used as a default for all discount 
rules.

AMS : Email 
Footer Banner

Optional User Image File and 
Path

Image for the email footer of an 
email blast. 

AMS : Email 
Header Banner

Optional User Image File and 
Path

Image for the email header of an 
email blast.

AMS: Enable 
Tip Text

Optional User Yes/No Tip text will be displayed in the UI.

AMS: Grace 
Period in Days

Yes User User/Org 
determined 
number of 
days

When automatic reconciliation of 
budgets is performed, this grace 
period is checked. If the marketing 
object is older than the ending date 
plus the grace period, any 
remaining funds associated with the 
marketing object are returned to the 
budgets they were drawn from.

This also sets the number of days 
after the completion of a campaign 
for the concurrent manager to delete 
the target group entries from the 
AMS_ LIST_ENTRIES table default 
is 30 days.

AMS HZ 
Dedupe Rule

Optional Site Yes/No Indicates whether deduplication 
rules are in effect for records placed 
into TCA. 

Option Required Level Setting Effect/Limitation
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AMS Implement 
Assignment 
Manager for 
Claims

Not valid for release 6.

AMS: 
Implement 
Contra Charge

Yes Site Yes/No If set to Yes, “Contra Charge” is a 
settlement option available when 
settling claims. Contra charges are 
used to track offsetting balances for 
creditors who are also debtors.

AMS: 
Implement 
Payables 

Yes Site Yes/No If get to Yes, “Check” is a settlement 
option available when settling 
claims.

AMS Import 
Control File 
Path

Yes Site Control File 
Location

Path for the bin directory ($AMS_
TOP/bin)

Improper setup will cause the 
server side import to fail.

AMS Import 
Date File Path

Yes Site Data File 
Location

Path for the data file location 

Improper setup will cause the 
server side import to fail.

AMS: Item 
Validation 
Master 
Organization

Yes Site A Valid Master 
Inventory 
Organization

When a deliverable is flagged as an 
inventory item, it is created in 
Inventory under the specified 
master organization.

AMS Item 
Validation 
Organization

Yes Site User Defined Determines whether the 
Organization ID is used for items. 

AMS: List 
Workbook B2B 
Marketing 

Optional Site User Defined Workbook name convention prefix 
for B2B workbooks. The default is 
B2B. No convention prefix will 
result in more workbooks than you 
need in the LOV.

AMS: List 
Workbook B2C 
Marketing

Optional Site User Defined Workbook name convention prefix 
for B2C workbooks. The default is 
B2C. No convention prefix will 
result in more workbooks than you 
need in the LOV.
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AMS Lowest 
Importance 
Level for Task 
Notifications

Not valid for release 6.

AMS Marketing 
Calendar

Yes Site Calendar 
entered in 
section 4.1.2

Where the calendar created in 4.1.2 
is linked to the application.

AMS: Marketing 
to ODM 
Database Link

Yes Site All database 
links in the 
database.

The scoring run result processing 
program will use the db link to fetch 
results.

AMS: Merchant 
Party ID

Yes Site Choose from a 
list of Parties 
provided

This value determines the party ID 
of the current active merchant.

AMS News 
Items per 
Company

Not valid for release 6.

AMS Number of 
items in Bin

Not valid for release 6.

AMS Numeric 
Format

Not valid for release 6.

AMS: OA Media Optional Site Physical file 
path of media 
directory 
where the 
image files are 
stored.

This is used in the upgrade process 
to read the files from the media 
directory and store them in the 
database.

AMS: Oracle 
Personalization 
Enabled

Optional Site Yes/No This enables the use of Oracle 
Personalization. Before enabling 
this option, Oracle Personalization 
must already be implemented.

AMS: Posting 
Runtime 
Shopping Cart 
Currency

Yes Site Select from a 
list of values. 
USD is the 
default.

Determines the currency in which 
shopping cart amounts are 
measured.

AMS: Prefix to 
Registration 
Confirmation 
Code

Optional Site User Defined Characters for the Event 
Registration Confirmation Code.
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AMS Pricelist 
Header Name 
for Events

Yes Site User defined 
entry

Enter the name of the default price 
list for events

AMS Profile 
Search Set Size

Yes User Numeric Indicates the number of rows 
displayed in selection windows.

AMS: 
Relationship 
Type for Buying 
Group

Yes Site Any valid 
relationship 
type created in 
TCA

Used to establish a hierarchical 
group of customers in TCA. For 
example, if value is set to 
subsidiaries then all parties who 
share this relationship will be part 
of a buying group. These are used 
as qualification criteria for offers.

AMS Root 
Section for Price 
List Report

Yes Site Sections 
defined in the 
hierarchy Tab 
of iStore’s 
Merchange UI

Price list report available from the 
overview page will utilize the 
section set in this profile to 
determine the section hierarchy. 
Items can be grouped into sections. 
Sections in turn can be grouped into 
other sections, creating a 
hierarchical structure.

AMS: Server 
URL

Yes Site User Defined This value determines the runtime 
URL path of the server. Used to 
generate API details for affiliates 
during placement definition.

AMS: Should 
Call to 
Inventory 
Modules be 
Made

Obsolete as of Release 7.

AMS: Should 
call to Pricing 
Modules be 
Made

Obsolete as of Release 7.

AMS: Show GL 
Accounts On 
Screen

Yes User Yes/No Default is Yes. If Yes is selected the 
Sales/ Expense Account field and 
the Accrual Liability Account field 
appear in the Create Budget page.

AMS Source 
Code Date 
Format

Yes Site Any valid date 
format

Used in the generation of source 
codes.
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AMS Source 
Code Sequence 
Length

Yes Site Maximum 
field length is 
30.

Source Code includes Geography 
code, Month code, Activity code, 
Source code digits and Suffix. See 
Source Codes in Appendix L.

AMS: Source 
from Parent 
Object

Yes Site Yes/No Determines whether campaign 
schedules and event schedules are 
sourced from their parent 
campaigns and events (Yes) or from 
budgets (No). Campaigns and 
Events, themselves, may only be 
sourced from budgets.

AMS Stock 
Symbols

Not valid for release 6.

AMS System 
Timezone

Yes Site Select the 
timezone the 
central server 
is in.

Timezones are defined in HZ_
TIMEZONES.

AMS Threshold 
Percentage

Yes Site Enter a value 
between 0 and 
100

For a marketing object with an 
Initial Estimated Amount (IEA) 
value entered into the Budget page 
for that object to go to Active status, 
it must obtain budget approval for 
this percentage of the IEA. During 
the initial stage, before the object 
status is Active, requests in excess 
of the IEA are not allowed. 

AMS Time 
Format

Not valid for release 6.

AMS: UOM 
Area

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, area in square feet).

AMS: UOM 
Length

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, length in feet).

AMS: UOM 
Quantity

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, units in each).

AMS: UOM 
Time

Yes Site Depends on 
UOM Setup

If not set correctly, will not be 
displayed for fields that use UOM 
(for example, time in minutes).
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AMS Upgrade 
Complete

Optional Site Yes/No Yes means no upgrade and No 
means will upgrade data.

AMS: Upgrade 
iMarketing

N Site Yes/No Used to determine whether to 
upgrade iMarketing data from the 
previous version.

AMS User 
Country

Yes User Select from 
valid countries

Defaults new objects to this country 
when created.

AMS User 
Timezone

Optional User Select the 
timezone the 
user is in.

All activities scheduled by the user 
will be converted to and be 
executed at the system timezone.

AMS: Validation Optional User 0-100 This profile option affects the 
validation severity at the database 
level. A value of 100 (Maximum 
value of 100) would cause the APIs 
to validate the passed data very 
stringently.

HZ: Address 
Key Length 

Optional Site Length of the 
Address

This determines the length of 
Address key.

HZ: Key Word 
Count

Optional Site Number of 
words

This number determines how many 
words in the customer name are 
used to generate the keys.

HZ: Postal Code 
Key Length

Optional Site Length of the 
Postal Code

This determines the length of Postal 
Code key.

IBE: Use Web 
Placements

Yes Appli
cation

Yes/No Determines whether placements are 
displayed. Required only when 
implementing iStore.

ICX: Discoverer 
End User Layer

Yes Site User Defined EUL prefix for Discoverer, Usually 
EUL4

ICX: Discoverer 
Launcher

Yes Site User Defined URL to launch Discoverer Web 
version

ICX: Discoverer 
Use Viewer

Optional Site Yes/No Whether to use viewer instead Web 
Discoverer. Defaulted to No.

ICX: Discoverer 
Viewer 
Launcher

Yes Site User Defined URL to launch Discoverer viewer
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JTF Home Page 
File Name

Optional Site or 
Appli
cation

User Defined. Enter a file name of the jsp file (for 
example, jtfhomepage.jsp). If no 
value is supplied, a generic 
information page is displayed. If a 
file is supplied it will be displayed 
on the home page.

OSO: Minimum 
search string 
length

Optional Site or 
User

User Defined The default setting is 0. This profile 
determines the number of 
characters that must be entered 
before performing a search. 

OSO: Search 
Lead Wildcard

Optional Any Yes/No If Yes, the wildcard (%) will be 
allowed as the first character in a 
search string. If No, and the 
wildcard is entered as the first 
character, the system will give the 
user an error message.

QP: Accrual 
UOM Class

Yes Site UOM Classes 
as set up in 
Inventory

Used by accrual offers. All accrual 
units will fall under this UOM class. 
For example, frequent flyer miles.

QP: Item 
Validation 
Organization

Yes Respon
sibility

Select from 
Inventory 
Organizations 
as set up in 
Inventory

Offers can be defined only for those 
products which will be available in 
the specified organization. Required 
for all offers.

Prices may be defined only for those 
products which will be available in 
the specified organization.

QP: Source 
System Code

Yes Respon
sibility

Possible 
Source 
Systems that 
can define 
offers

Offers created using this 
relationship are tagged with this 
system source code and will be used 
to determine update privileges of 
offers within the pricing module.

Task Manager: 
Default assignee 
status

Optional Appli
cation

User Defined Specifies the default assignee status 
when creating or assigning a task. 

Task Manager: 
Default Priority

Optional Appli
cation

User Defined Specifies the default task priority 
when creating a task.

Task Manager: 
Default Task 
Status

Optional Appli
cation

User Defined Required for implementing a task 
transition rule. This profile option 
must be set to the initial status of 
the rule.
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Task Manager: 
Owner type for 
a task

Optional Appli
cation

User Defined Specifies the default task type when 
creating a task.
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Summary of Lookup Se
D

Summary of Lookup Settings

This appendix provides a table of Lookup settings used by Oracle Marketing 
Online. 

Key Type Values Meanings

AGGREGATE_BY System YEAR

MONTH

QTR

INCREMENT

Year

Month

Quarter

Increment

AMS_ ACCESS_ TYPE System Group

User

Group

User

AMS_ ACCRUAL_ BASIS System Customer

Sales

Customer

Sales

AMS_ ADJUSTMENT_
TYPE

Extensible Decrease_ 
Committed

Decrease_ Comm_ 
Earned

Decrease_ Earned

Standard

Decrease Committed Amount

Decrease Committed and Earned 
Amounts

Decrease Earned Amount

Increase Earned Amount

AMS_ BUDGET_ SOURCE_ 
STATUS

System Approved

Closed

New

Pending

Rejected

Approved

Closed

Planning

Pending

Rejected
ttings D-1



AMS_ BUDGET_ TRANS_
TYPE

User Credit

Debit

Credit

Debit

AMS_CAMP_FULFILL_ON System On_Invite On Invite

AMS_CAMP_ RELATED_ 
EVENT

System EONE

EVEH

EVEO

One-Off Event

Event

Event Schedule

AMS_ CAMPAIGN_
PURPOSE 

Extensible Awareness

Lead

Lead_ Maturation

Sales_ Readiness

Awareness

Lead Generation (?)

Lead Maturation

Sales Readiness

AMS_ CAMPAIGN_ 
SCHEDULE_STATUS

System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

New

On_Hold

Submitted_ BA

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

New

Active, but locked

Pending Budget Approval
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AMS_ CAMPAIGN_ 
STATUS

System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Planning

Submitted_Budget 
Approval

Submitted_Theme 
Approval

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Theme Approval

New

Active, but locked

Planned

Submitted for Budget Approval

Submitted for Theme Approval

AMS_CLAIM_ CLASS System Claim

Deduction

Claim

Deduction

AMS_CLAIM_ HISTORY_ 
EVENT

System Changes

Line

New

Split

Changes

Line

New

Split

AMS_CLAIM_ PAYMENT_ 
METHOD

System Check

Credit_Memo

Debit_Memo

Check

Credit Memo

Debit Memo
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AMS_CLAIM_STATUS System Approved

Cancelled

Closed

Complete

Duplicate

New

Open

Pending

Pending_Approval

Pending_Close

Rejected

Approved

Cancelled

Closed

Complete

Duplicate

New

Open

Pending

Pending Approval

Pending Close

Rejected

AMS_ CONTACT_ POINT_
TYPE

Extensible Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Address

Email

Fax

Inbound Script

Outbound Script

Phone

Website

AMS_ CONTACT_ POINT_
TYPE

Extensible Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Address

Email

Fax

In bound Script

Outbound Script

Phone

Website

AMS_ CONTENT_ TYPE Extensible HTML

Text

HTML

Text

Used for email schedules

AMS_ CREATION_ SIGN System +

-

Positive

Negative
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AMS_ DEDUCTION_ 
PAYMENT_ METHOD

System Adjustment

Chargeback

Contra_Charge

Credit_Memo

Debit_Memo

Reg_Credit_Memo

Write_Off

Adjustment

Chargeback

Contra Charge

On Account Credit

Debit Memo

Invoice Credit

Write Off

AMS_DELIV_STATUS User Archived

Available

Cancelled

Denied_BA

New

Submitted_BA

Superceded

Expired

Denied_TA

Budget_Appr

Submitted_TA

Archived

Available

Cancelled

Denied - Budget Approval

New

Submitted - Budget Approval

Superceded

Expired

Denied - Concept Approval

Budget Approved

Submitted - Concept Approval

AMS_DELIVERY_MEDIA_
TYPE

Extensible I SEMINAR

ON_SITE

SEMINAR

WEB

I Seminar

On Site

Seminar

Web
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AMS_DM_ MODEL_ 
STATUS

System Available

Draft

Building

Scheduled

Scoring

Archived

Expired

Custom

Preview

Queued

Available

Draft

Building

Scheduled

Scoring

Archived

Expired

Custom

Preview

Queued

AMS_DM_ MODEL_ TYPE System Email

Telemarketing

DirectMail

Loyalty

Custom

Email Response

Telemarketing Response

Direct Mail Response

Loyalty

Custom

AMS_DM_ SCORE_ 
STATUS

System Draft

Scheduled

Scoring

Completed

Archived

Preview

Queued

Draft

Scheduled

Scoring

Completed

Archived

Preview

Queued

AMS_DM_ SOURCE_ TYPE System Standard

Cell

CSCH

DIWB

Generated List

Segment

Campaign Schedule

Discoverer Workbook

AMS_DM_ TARGET_ 
GROUP_ TYPE

System Business

Consumer

Organization Contacts

Persons

AMS_DM_ TARGET_ 
VALUE_ TYPE

System Binary

Categorical

Continuous

Binary

Categorical

Continuous
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AMS_EVENT_AGENDA_ 
STATUS

System Confirmed

Unconfirmed

Confirmed

Unconfirmed

AMS_EVENT_
ATTENDANCE_FAILURE

System Agenda_Change

Disaster

Personal_Emergency

Schedule_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Natural Disaster

Personal Emergency

Schedule Conflict

Speaker Change

Venue Change

Work Emergency

AMS_EVENT_CANCEL_ 
REASON

System Disaster

Insufficient_Reg

Postponed

Schedule_Conflict

Speaker_ 
Unavailable

Venue_Unavailable

Natural Disaster

Insufficient Registration

Postponed

Schedule Conflict

Speaker not available

Venue not avaialble

AMS_EVENT_CERT_ 
CREDIT_ TYPE

System General

Seed

General

Seed

AMS_EVENT_DAY System Five

Four

Three

Two

One

5

4

3

2

1

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

AMS_EVENT_LEVEL System Main

Sub

Main

Sub
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AMS_EVENT_PAYMENT_ 
STATUS

System Comp

Free

Invoiced

Paid

Refunded

Complimentary

Free

Invoiced

Paid

Refunded

AMS_EVENT_ PURPOSE User Organization 
defined values

Purpose for the event.

AMS_EVENT_REG_
CANCEL_REASON

System Agenda_Change

Cost

Personal_Emergency

Price_Change

Sch_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Cost

Personal Emergency

Price Change

Scheduling Conflict

Speaker Change

Venue Change

Work Emergency

AMS_EVENT_REG_
SOURCE

System Call_Center

External

On_Site

Partner

Web

Call Center

External

On Site

Partner

Web

AMS_EVENT_REG_
STATUS

System Cancelled

Enrolled

Registered

Targeted

Waitlisted

Cancelled

Enrolled

Registered

Targeted

Waitlisted

AMS_EVENT_RESOURCE_ 
TYPE

System AMS_People People

AMS_EVENT_ 
SCHEDULE_ OBJECTIVE

User Organization 
defined values

Objective for the event.
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AMS_EVENT_SPEAKER_ 
STATUS

System Booked

Cancelled

Confirmed

Scheduled

Booked

Cancelled

Confirmed

Scheduled

AMS_EVENT_STATUS System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Submitted_ BA

Submitted_TA

Planning

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Concept Approval

New

Active, but locked

Pending Budget Approval

Pending Concept Approval

Planning

AMS_EVENT_STREAM_ 
TYPE

System A

B

C

D

A

B

C

D
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AMS_EVENT_TYPE

(Event Activities)

System Briefing

Conference

Exhibition

Hospitality

Internal_Event

Launch

Seminar

Speaking_ 
Engagement

Sponsorship_Event

Trade_Show

Web_Seminar

Workshop

Briefing

Conference

Exhibition

Hospitality

Internal Event

Launch

Seminar

Speaking 
Engagement

Sponsorship

Trade Show

Web Seminar

Workshop

AMS_EVENT_WAITLIST_ 
ACTION

System First_Come_First First Come First Served

AMS_FUND_ SOURCE System CAMP

EVEH

EVEO

FUND

CSCH

DELV

EONE

OFFR

PTNR

OPTN

VEND

USER

Campaign

Event

Event Schedule

Budget

Campaign Schedule

Deliverable

One Off Event

Offer

Partner

Other Partner

Vendor

Person
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AMS_FUND_ STATUS System Active

Archived

Cancelled

Closed

Draft

On_Hold

Pending

Rejected

Active

Archived

Cancelled

Closed

Draft

On Hold

Pending Approval

Rejected

AMS_FUND_ TYPE System Fixed

Fully_ Accrued

Fixed

Fully Accrued

AMS_GL_ DATE_TYPE System Claim_Date

Due_Date

System_Date

Claim Date

Due Date

System Date

AMS_GL_ EVENT_ LINE_
TYPE

System Accrual_Liability

Expense_Account

Rec_Clearing

Ven_Clearing

Accrual Liability

Expense Account

Receivable Clearing Acct.

Vendor Clearing Account

AMS_GL_ EVENT_ STATUS System Accounted

Accounted_With_
Error

Created

Accounted

Accounted with Error

Created a New Transaction

AMS_GL_ EVENT_TYPE System Accrual

Accrual_Adjustment

Contra_Charge

Settle_By_Credit

Settle_By_WO 

Settle_By_Check

Accrual Liability

Accrual Adjustment

Settle by Contra Charge

Settle by Credit Memo

Settle to Writing Off 

Settle by Payment Voucher

AMS_ HISTORY_ RULES_ 
OBJECT

System Claim Claim

Key Type Values Meanings
    Summary of Lookup Settings D-11



AMS_ IMPORT_ STATUS System New

Staged

Scheduled

Completed

Purged

Cancelled

Error

New Import

Entries are imported and available for 
viewing

Import is setup and ready to be 
completed at the scheduled time.

Import completed.

Imported entries have been purged from 
the Marketing Import Table.

The list import has been cancelled and 
may not be reactivated.

An error occurred during list import.

AMS_ IMPORT_ TYPE System Customer

Event

Lead

Organizations, Persons and TCA data.

Event registration data. 

Leads data.

AMS_LIST_ ACT_TYPE User Employee List

List

Target group list selection type

AMS_LIST_ DEDUP_ TYPE User List

Import Consumers

Import 
Organizations

Type of Deduplication Rules to be 
applied.

AMS_LIST_GENERATION_ 
TYPE

System Incremental

Standard

Update

Update No Purge

New entries added, old entries not 
deleted, entries not updated

All old entries deleted, new entries 
added

New entries added, old entries not 
meeting criteria deleted, entry 
information updated

New entries added, old entries retained, 
entry information updated

AMS_LIST_ ROW_ 
SELECT_ TYPE

System Nth Record

Random

Standard

How to select rows during list 
generation. Standard is top down 
selection.
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AMS_LIST_ SEGMENT_ 
STATUS

User Archived

Available

Cancelled

Draft

Expired

Archived

Available

Cancelled

Draft

Expired

AMS_LIST_ SEGMENT_ 
TYPE

System Workbook

SQL

Two types of segments supported. Based 
on a Discoverer workbook or an SQL 
statement.

AMS_LIST_ SELECTION_ 
ACTION

System Include

Exclude

Intersect

How each selection is added to the list. 
Exclude means that all entries that exist 
in the excluded list are removed from the 
current list. Intersect causes the current 
list to become a list of only those entries 
which are on the intersected list and the 
current list.

AMS_LIST_ SELECTION_ 
TYPE

System Segment

Workbook

Import List

List

SQL

Segment

Workbook

Import List

List

SQL

AMS_LIST_ STATUS System Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating
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AMS_LIST_ TYPE System Manual List

Standard List

Suppression List

Target Group

List of possible list types. Note where 
these appear in the program.

AMS_ LUMPSUM_ 
DISTRIBUTION_ TYPE

System %

Amt

Qty

Percent

Amount

Quantity

AMS_ MASTER_ OBJECT_ 
TYPE

System Camp

CSCH

EONE

EVEH

Campaign

Campaign Schedule

One-Off Event

Event

AMS_ MEDIA_ TYPE System Broadcast

Deal

Direct_Marketing

Events

Internet

In_Store

Public_Relations

Trade_Promotion

Advertising

Deal

Direct Marketing

Events

Web Marketing

In Store

Press and Analyst Relations

Trade Promotions

AMS_ OBJECT_ CLASS System Invoice

Order

Order_line

PCHO

Invoice

Order

Order Line

Purchase Order

AMS_OBJECT_USAGE_
TYPE

System Created

Used_By

Created

Used By

AMS_OFFER_ DEAL_ 
CUSTOMER_ TYPES

Extensible Buyer

Customer

List

Segment

Buyer Group

Customer

List

Segment

AMS_OFFER_ LUMPSUM_ 
PAYMENT

System Accrue

Check

Accrue

Issue Check
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AMS_OFFER_ STATUS System Active

Closed

Draft

Rejected

Closed

Pending

Pending_Active

Archived

Cancelled

Completed

Terminated

Onhold

Active

Closed

Draft

Budget Rejected

Closed

Pending budget approval

Pending Active

Archived

Cancelled

Completed

Terminated

On hold

AMS_OFFER_ TYPE System OID

Lumpsum

Order

Accrual

Off_Invoice

Deal

Terms

Promotional Goods

Lump sum

Order value

Accruals

Off Invoice

Trade Deal

Terms Upgrade

AMS_OFFER_LUMP_
CUST_ TYPES

System Buyer

Customer

Buyer

Customer

AMS_ PARTNER_ 
HOLDING_ TYPE

(Holding Owner)

System PTNR

VEND

Partner

Vendor

Only used when Partners Online is 
implemented.

AMS_ PAYMENT_ STATUS System Incomplete

Interfaced

Paid

Pending

Incomplete

Interfaced

Paid

Pending
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AMS_PLCE_ LOCATION_ 
CODE

Extensible Left1, Left2…Left7

Right1, Right2 … 
Right7

Top

Bottom

Positions for placements

AMS_PLCE_ SITE_ 
CATEGORY

System Oracle_Applications

Other_Applications

Affiliates

Oracle Applications

Other Applications

Affiliates

AMS_POST_ AUDIENCE_ 
TYPE

System S

L

Segment

List

AMS_POST_ BUSPRIOR

(Business Priority)

System None

Random

Prod_list_ price

Campaign_ Start_
Date

Campaign_ End_
Date

Campaign_ Priority

None

Random (for all)

List Price (for products only)

Start Date, End Date, or Priority (for 
campaign schedules).

AMS_POST_ CATEGORY System Universal

Rulebased

Posting types: Universal or based on a 
rule.

AMS_POST_ CND_DATA_ 
TYPE

System Float

String

Data Types returnable by Custom 
Condition Class.

AMS_POST_ COMP_ 
OPERATOR

System EQ

GTE

LTE

Equal to

Greater than or equal to

Less than or equal to

Used to compare shopping cart amount.

AMS_POST_ CONTENT_ 
TYPES

System Product

Schedule

Offer

Product

Web Advertisement

Web Offer

AMS_POST_ PREDEF_ 
PROD_ CONTEXT

System Prod_viewed

Prod_in_cart

The product context for relationship 
based strategy.

Key Type Values Meanings
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AMS_POST_ 
RELATIONSHIPS

System Promoting 
Relationship types 
not covered by iStore

Promoting is a relationship not covered 
by iStore, as in promoting a product.

AMS_POST_ STATUS System Active

Inactive

AMS_POST_ STRATEGY_ 
TYPE

System Manual_ Selection

Product_ 
Relationship

Inferred_OP

Custom

Manually selected strategy

Strategy based on product relationship

Inferred based on Personalization

Custom strategy

AMS_ PRICE LIST_ STATUS System Active

Draft

Rejected

Pending

Cancelled

Active

Draft

Rejected

Pending Budget Approval

Cancelled

AMS_PRIOR_ SORT_ 
ORDER

System Asc

Desc

Ascending

Descending

AMS_ PRIORITY System Fast_Track

High

Standard

Fast Track

High

Standard

AMS_ PRODUCT_ LEVEL System Product

Family

Product

Product Family

AMS_ PROGRAM_ 
OBJECTIVE

User User Defined

AMS_ PROGRAM_ STATUS System Active

Archived

Cancelled

Completed

New

On_Hold

Active

Archived

Cancelled

Completed

New

Active, but locked

Key Type Values Meanings
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AMS_QP_ ARITHMETIC _
OPERATOR

System %

Amt

Lumpsum

Newprice

Percent

Amount

Lump sum

New Price

AMS_QP_ VOLUME_ TYPE System Pricing_Attribute10

Pricing_Attribute12

Quantity

Amount

AMS_QUARTERS System Q1

Q2

Q3

Q4

Q1

Q2

Q3

Q4

AMS_ REASON_ CODE_
TYPE

User Adjust_Reason

Invoicing_Reason

Adjustment Reason

Invoicing Reason

AMS_ ROLLUP_ TYPE Extensible Coll

Deal

ECAM

EVCAM

Partner

RCAM

TRDP

Collection

Deal

Campaign

Event Promotions

Partner

Program

Trade Promotion

AMS_ SCHEDULE_ 
OBJECTIVE

User User Defined

AMS_ TRANSFER_ 
REASON

User Sourcing Initial Sourcing

AMS_ TRANSFER_ TYPE Extensible Release

Reserve

Transfer

Request

Utilized

Release

Reserve

Transfer

Request

Utilized

AMS_ TRIGGER_ CHK_ 
METRIC_ TYPE

System Actual

Forecast

Actual Value

Forecast Value

Key Type Values Meanings
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AMS_ TRIGGER_ CHK_
TYPE

System DIWB

Metric

Static_Value

Workbook

Metric

Static Value

AMS_ TRIGGER_ 
FREQUENCY_TYPE

System Daily

Hourly

Monthly

None

Quarterly

Weekly

Yearly

The frequency of trigger checking

AMS_ TRIGGER_ TYPE System Metric_Metric

Metric_Value

Metric_ Workbook

Metric to Metric type trigger

Metric to Value type trigger

Metric to Workbook type trigger

AMS_ UTILIZATION_ 
TYPE

System Accrual

Adjustment

Sales_ Accrual

Utilized

Accrual

Adjustment

Sales Accrual (refers to the salesperson)

Utilized

AMS_VALUE_ LIMIT Extensible Balance

Committed

Paid

Planned

Utilized

Balance

Committed

Paid

Planned

Utilized

AMS_YEARS System 1995

1996

1997

1998

1999

2000

2001

2002

1995

1996

1997

1998

1999

2000

2001

2002
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IBE_ RELATIONSHIP_
TYPES

Extensible Possible 
relationships 
between Products 
like Cross Sell, Up 
Sell. 

This is an iStore lookup type.

INVENTORY_ ITEM_ 
STATUS_ CODE

User ACTIVE

INACTIVE

Active

Inactive

Key Type Values Meanings
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ITEM_TYPE Extensible AI

AOC

ATO

CONSULTING

EDU

FG

FRT

I

K

KIT

M

MEDIA

NRI

OC

OP

P

PF

PH

PL

POC

PTO

REF

RI

SA

SI

SW LIC

TRAIN

ATO Option Class

ATO item 

ATO model

Contracts - consulting

Contracts - Education

Contracts - KIT

Contracts - Media

Contracts - Software

License

Contracts - Training

Finished good

Freight

Inventory Type

Kit

Model

Non-recurring

Option Class

Outside Processing Item

PTO Option Class

PTO model

Phantom item

Planning 

Product Family

Purchased Item

Recurring

Reference Item

Subassembly supply item

Key Type Values Meanings
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 Summary of Administration S
E

Summary of Administration Setups

This appendix provides a table of the Administration Setups used by Oracle 
Marketing Online. The Components are listed in Side Navigation Menu item order.

Component Item Choices Effect

General Marketing 
Medium

User Created Create the marketing mediums that will be 
used in campaign schedules and relate each 
to the appropriate activity.

Depending on the Activity type and the 
Activity used by the campaign schedule, 
these marketing mediums will populate the 
LOV in the campaign schedules page.

General Metric User created 
and seeded

Create the metrics that will be used for 
tracking campaigns and campaign 
schedules. These metrics will be available 
in the LOV of campaigns and campaign 
schedules. See Implementing Metrics.

General Venues User Created Create the venues that will be used in event 
schedules.

Setup Custom 
Setup

User created 
and seeded

Create the custom setups that will be used 
for campaigns, events and other objects. 
These choices will populate the setup type 
LOVs.

Setup Activity User created 
and seeded

Create the activities that will be used for 
various marketing objects. These choices 
will populate the activity LOV.

Setup User Status User created 
and seeded

Create the user statuses that will be used 
for various marketing objects.
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Setup Locking 
Rule

User created 
and seeded

Create the locking rules that are determined 
by the organization’s Business Rules. Fields 
specified here will be locked for update at 
the statuses specified. 

Setup Mandatory 
Rule

User created 
and seeded

Create the mandatory rules that are 
determined by the organization’s Business 
Rules. Fields specified here are must be 
completed during object creation.

Setup Approval 
Rule

User created Create the approval rules budget and 
theme approvals for campaigns, budgets 
and other objects. 

Geography Geographic 
Area

User created 
and seeded

Create the geographic areas that will be 
used by Marketing Online, if required. 
After creating the Geographic Areas, log 
into Forms and run the concurrent manager 
program Load Geographic Hierarchies. 
This must be done each time the geographic 
areas are updated.

Claim Reasons Reasons are required when creating claims 
and reason LOV is based on values from 
this page.

Claim Claim Type Claims types are required when creating 
claims and claim the LOV is based on the 
values from this page.

Claim System 
Parameter

Select a Set of 
Books from the 
LOV.

The set of books will be used for all 
functional-transactional currency 
conversion and posting to GL for all 
marketing objects. This should not be 
changed once implemented.

Claim System 
Parameter

Post to GL Yes 
or No

If set to Yes general ledger accounting will 
be done for all budget adjustments and 
accruals.

Claim System 
Parameter

GL Account 
Codes

Enter the account code for the accrual 
liability account. This account will be used 
by default for posting to accrual liability 
account if not defined at fund category, 
fund or by the accounting engine.

Claim System 
Parameter

Select or 
deselect Auto 
Assignment  
checkbox

If selected, claim owners will be defaulted 
to the winning resource derived from 
claims territory implementation.

Component Item Choices Effect
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Claim System 
Parameter

Select or 
deselect

If autopay flag selected, when autopay 
engine is run, this claim type and reason 
will be used and run for the frequency 
mentioned for all customers unless defined 
in trade profile.

Claim System 
Parameter

List of claim 
types and 
reasons

Claim System 
Parameter

Select from 
transaction 
types of class 
Credit Memo 
defined in 
Oracle 
Receivables

The credit memo is used to create a credit 
memo in Oracle Receivables to settle a 
claim.

Claim System 
Parameter

User defined 
number of days

Claim due date will be default to this future 
date.

Claim System 
Parameter

Select from 
transaction 
types of class 
Debit Memo 
defined in 
Oracle 
Receivables

The debit memo is used to create a debit 
memo in Oracle Receivables to settle a 
claim.

Claim System 
Parameter

List of 
Resources of 
type 
“Employee” and 
“Partner”

Claims not created manually (deductions, 
autopay claims) will have the owner 
assigned to them as defined here. Default 
owner will be taken if Territory Manager 
not implemented or if it does not return a 
suggested default owner for the claim.

Claim System 
Parameter

Select an 
exchange rate 
from GL

This conversion type will be used when not 
specified during creation of a claim.

Claim System 
Parameter

User 
determined

Enter a number and select a Frequency Unit 
from: Days, Months, Quarters, Weeks, Year.

Claim System 
Parameter

Claim date, Due 
date, System 
date

GL Date will default to the select date type.

Claim System 
Parameter

List of payment 
terms defined in 
AP

If a value is set, check payments made from 
claims will have this payment term.

Component Item Choices Effect
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Claim System 
Parameter

List of values 
defined for 
lookup type 
‘SOURCE’ in 
ap_lookups

Invoices created in payables will have the 
invoice source. Used for running Payables 
Open Interface Import program.

Claim System 
Parameter

Select or 
deselect Post to 
GL Flag

If selected GL accounting will post to GL.

Claim System 
Parameter

GL Account 
Codes

Enter the account code for the receivable 
clearing account. This account will be used 
by default for posting to the receivable 
clearing account if not defined at fund 
category, fund or by the accounting engine.

Claim System 
Parameter

Select from the 
Batch Sources of 
type “Import” 
defined in 
Oracle 
Receivables

The batch source is used to create 
Transactions in Oracle Receivables that are 
used to settle claims.

Claim System 
Parameter

GL Account 
Codes

Enter the account code for the 
sales/expense account. This account will be 
used by default for posting to expense 
account if not defined at fund category, 
fund or by the accounting engine. 

Claim System 
Parameter

List of claim 
types and 
reasons defined 
in Admin > 
Claim

This claim type and reason will be used for 
all automatic payments of accruals and 
earnings.

Claim System 
Parameter

GL Account 
Codes

Enter the account code for the vendor 
clearing account. This account will be used 
by default for posting to the vendor 
clearing account if not defined at fund 
category, fund or by the accounting engine.

Claim Trade 
Profile

Select or 
deselect 
checkbox

Determines whether Autopay will be in 
effect for the selected Vendor.

Claim Trade 
Profile

User defined Indicates how often Autopay will test to see 
if a payment is required.

Component Item Choices Effect
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Claim Trade 
Profile

List of vendors 
created in AP

Select a vendor to setup. Autopay will be 
run for the particular party/account based 
on the flag and will be run for the 
frequency mentioned with amount 
condition overriding the duration. For 
check payments vendor set in this profile 
will be used.

Claim History 
Rule

Columns 
updateable in 
claim, general, 
lines and 
settlement

When any of the columns selected for 
history creation changes, a snapshot of the 
claim gets created as a history record.

Execution Strategies User Created 
and Seeded

Any additional custom strategies that are 
needed are created here. A java class is 
required which contains the logic and code.

Execution Conditions User Created Extend up to five conditions that can be 
used in rule definitions for a rule-based 
posting.

Execution Sites User Created 
and Seeded

Create a new site here.

Execution Pages User Created 
and Seeded

Create new pages for a site.

Execution Styles User Created 
and Seeded

Create new styles for content type(s).

Component Item Choices Effect
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Summary of Request Sets and Concurrent Manager Prog
F

Summary of Request Sets and Concurrent

Manager Programs

This appendix provides a table of the Request Sets and Concurrent Manager 
Programs used by Oracle Marketing Online.

Request Sets
Request sets are sets of concurrent manager programs which may be executed as a 
group. If desired, any concurrent manager program which is part of a request set 
may be executed individually.

For more information on the particular concurrent manager programs which are 
part of a request set, see the table of concurrent manager programs.

Request Set Name Concurrent Manager Programs

BIM: Load Marketing 
Facts for the First Time

BIM: Load Marketing Facts for the First Time, Object to Load: 
Campaign

BIM: Load Marketing Facts for the First Time, Object to Load: 
Event

BIM: Load Marketing Facts for the First Time, Object to Load: 
Budget

BIM: Load Key Performance Indicator Facts

BIM: Initial Build of 
Materialized Views

BIM: Initial Build of Campaign Materialized Views

BIM: Initial Build of Event Materialized Views

BIM: Initial Build of Budget Materialized Views

BIM: Initial Build of Key Performance Indicators Materialized 
Views
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Concurrent Manager Programs

BIM: Refresh 
Materialized Views

BIM: Refresh Campaign Materialized Views

BIM: Refresh Event Materialized Views

BIM: Refresh Budget Materialized Views

BIM: Refresh Key Performance Indicators Materialized Views

BIM: Refresh Marketing Activities Materialized Views

BIM: Load Marketing 
Facts from Previous 
Refresh Date

BIM: Load Marketing Facts from Previous Refresh Date, Object 
to Load: Campaign

BIM: Load Marketing Facts from Previous Refresh Date, Object 
to Load: Event

BIM: Load Marketing Facts from Previous Refresh Date, Object 
to Load: Budget

BIM: Load Key Performance Indicator Facts from Previous 
Refresh Date

Concurrent 
Manager Required Description

Activate Event 
Schedules

Yes This will pick up all the Event Schedules which are in 
Available status and for which the start date has passed 
and its Event is active and make the Schedule Active.

AMS Activate 
Schedule

Optional This will pick up all the Campaign Schedules which are in 
Available status and for which the start date has passed 
and its Campaign is active and make the Schedule Active.

AMS Expire 
Data Mining 
Models

Yes Background process that monitors data mining models to 
see if they have expired. A frequency of once a day should 
be sufficient.

AMS: Generate 
Suppression 
list

Optional Updates and maintains organization defined suppression 
lists. This is in addition to seeded suppression lists.

AMS Group 
Access Refresh

Yes Updates denormalized tables with group information. 
Should be run on a periodic basis according the 
organization’s Business Rules.

AMS Load 
Inventory 
Categories

Yes Loads categories from the MTL schema to the AMS 
schema denormalized tables. This program should be run 
if and when a new category is created in Inventory.

Request Set Name Concurrent Manager Programs
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AMS - Metrics 
refresh 
program

Optional Refreshes Metrics. There is an optional parameter to record 
metrics history.

AMS Portal 
Cache Daemon

Yes Populates the Marketing subtab on the Home tab.

AMS: Purge 
Imported List

Optional During the import process, the user may specify an 
expiration date or number of uses for a list. This program 
removes those entries whose expiration date has passed or 
number of uses reached.

Optional Parameter: force_purge_flag. This parameter 
indicates whether to purge a record regardless of the 
associated campaign status. The default value is No.

AMS: Purge 
Target Group

Optional After a target group has been generated and used, this 
program lets a user purge the list entries. 

AMS: Refresh 
Party Market 
Segments

Optional Generates a list of parties in the segment. This program 
also updates the size information for all segments so a 
history of segment sizes may be maintained.

AMS Team 
Access Refresh

Yes Updates denormalized tables with team information. 
Should be run on a periodic basis according to the 
organization’s Business Rules.

AMS-TM: 
Funds Accrual 
Engine

Yes Ability to calculate budget utilization and earnings based 
on ship confirmed orders (provided the offer’s phase is set 
to ‘Ship’, else the accruals will be calculated at the phase 
the offer is applied). 

In case of Fully Accrued type of Budgets with accrue to is  
‘customer’, Budget, Committed and Earned columns are to 
be updated with the accrued amount. But in case of 
budgets with accrue to ‘Sales’, only Budget column will 
have to be updated. Committed and Earned should not be 
populated. This allows users to transfer money from Fully 
accrued budget to any other Fixed Budgets. If max cap is 
specified against the Fully accrued budget, the budget can 
be accumulated only to the level of max cap. 

Parameters: None.

AMS-TM: 
Import 
Territory 
Hierarchy

Yes This concurrent program uploads the hierarchy data from 
jtf_territories to AMS schema to be able to perform budget 
allocation to that territory hierarchy. The concurrent 
program expects a hierarchy id meaning which particular 
hierarchy the user wants to import.

Parameters: Hierarchy Id

Concurrent 
Manager Required Description
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AMS-TM: 
Release 
Committed 
Budget 
Amount After 
Grace Period

Yes A budget has been committed for an offer or any other 
activity. The Activity or offer date has ended or the offer is 
going to be closed or canceled. There might be a situation 
that the budget has not been utilized completely. This 
feature can be implemented through a concurrent process 
would return back the unused committed amount back to 
the sourcing budget. If there is a grace period, release of 
committed amount from a fixed type fund would take 
place whenever a offer is closed or canceled after the 
attainment of the grace period. 

Parameters: p_object_type (Object Type, for example, 
CAMP, OFFR, EVEH)

AMS-TM: 
Validate 
Budget 
Thresholds

Yes Threshold Alert provides the feature to monitor over 
spending or under spending from time to time. The 
concurrent program performs the automatic process of 
verification and notifies the owner of the budget on over & 
under utilization.

Parameters: None

AMS-TM 
Utilize 
Lumpsum 
Offers

Yes A user initiated background process that will account 
budget utilizations against lumpsum offer whenever the 
offer start date arrives rather than on offer approved or 
created date. 

In case when the Offer is active on the date when Offer 
was created, then the budget utilization will be updated 
immediately.

AMS-TM: 
Claims Aging 
Population 

Yes Claims aging program populates the summary table for 
the claims aged by customer for an aging bucket. Aging 
will be run based on the system date. This program has to 
be run on a daily basis to get the daily aging analysis for 
the customers. 

Claims may be aged using a future type. This type will 
display claims that will become due, based on the Due 
Date, the specified number of days in the future.

Parameter: Aging bucket defined in Oracle Receivables

Concurrent 
Manager Required Description
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AMS-TM: 
Claims 
Autopay

Yes Autopay program is used to pay accruals on a regular 
basis to customers. Autopay can be set up to pay accruals 
based on a customer, budget, campaign or offer.

Parameters:

� Customer

� Budget

� Offer

� Campaign

AMS-TM: 
Claims 
Settlement 
Fetcher 

Yes Settlement fetcher gets the settlement data created in 
receivables and payables after settling a claim. Claim 
settlement on a manual claims gets created through 
autoinvoice or payables invoice import. These are 
programs which run on a batch mode and after the actual 
payment gets created in receivables or payables, settlement 
fetcher has to be run to get the settlement data to be shown 
in claims.

Parameters: None

AMS-TM: 
Import Claims 

Yes Import Claims imports the data from interface tables into 
claims. This program runs through the standard 
validations for claims creation and rejects the claims that 
are not successful for import.

Parameters: None

AMS-TM: 
Perform 
Recalculated 
Commitment 
for Offers

Optional Performs recalculation of committed budget for offers.

AMS-TM: 
Transfer to 
General 
Ledger 

Yes Transfer to General Ledger is run to transfer the sub-ledger 
accounting entries created by claims/accruals into General 
Ledger accounting tables. 

Parameters:

� Selection Type (1-Batch Transfer)

� Set Of Books - Primary set of books 

� Transfer Reporting Books - Yes/No

� Batch Name - Name of batch for transfer

Concurrent 
Manager Required Description
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AMS Update 
Data Mining 
Models

Optional Updates detail information collected on parties. The 
frequency should be the same as the BIC Summary 
Extraction process.

AutoInvoice - 
Oracle 
Receivables

Yes AutoInvoice is an Oracle Receivables concurrent program 
used to create credit memos/debit memos in receivables. It 
is used for creating credit memos on settling manual 
claims. Claims settled with receivables payment method 
gets created with the batch source defined in system 
parameters. For more information on parameters and 
options see the Oracle Receivables Implementation Guide.

BIM: Load 
Marketing 
Facts for the 
First Time

Optional Loads all Campaign Facts for the first time. Repeat for each 
object: Campaign, Event, Budget.

Parameters:

Object to Load: Campaign

Start Date

End Date

Part of the Request Set:  BIM: Load Marketing Facts for the 
First Time

BIM: Load Key 
Performance 
Indicator Facts

Optional Loads KPI Facts.

Part of the Request Set:  BIM: Load Marketing Facts for the 
First Time

BIM: Initial 
build of 
Campaigns 
Materialized 
Views

Optional Prepares pre-built tables for Campaign Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized 
Views

BIM: Initial 
build of Events 
Materialized 
Views

Optional Prepares pre-built tables for Events Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized 
Views

Concurrent 
Manager Required Description
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BIM: Initial 
build of 
Budgets 
Materialized 
Views

Optional Prepares pre-built tables for Budgets Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized 
Views

BIM: Initial 
build of Key 
Performance 
Indicators 
Materialized 
Views

Optional Prepares pre-built tables for Key Performance Indicators 
Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized 
Views

BIM: Refresh 
Campaign 
Materialized 
Views

Optional Builds Campaigns Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Refresh Materialized Views

BIM: Refresh 
Events 
Materialized 
Views

Optional Builds Events Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Refresh Materialized Views

BIM: Refresh 
Budgets 
Materialized 
Views

Optional Builds Budgets Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Refresh Materialized Views

BIM: Refresh 
Key 
Performance 
Indicators 
Materialized 
Views

Optional Builds Key Performance Indicators Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Refresh Materialized Views

BIM: Refresh 
Marketing 
Activities 
Materialized 
Views

Optional Builds Marketing Activities Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Refresh Materialized Views

Concurrent 
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BIM: Load 
Marketing 
Facts from 
previous 
refresh date

Optional Loads all facts from the previous refresh date. Repeat for 
each object: Campaign, Event, Budget.

Parameters:

Object to Load: Campaign

End Date

Number of Parallel Processors: 4

Part of the Request Set: Load Marketing Facts from 
previous refresh date

BIM: Load Key 
Performance 
Indicator facts 
from previous 
refresh date

Optional Loads all KPI facts from the previous refresh Date.

Initial Build of 
Campaigns 
mvs 

Obsolete in Release 7.

Replaced by BIM: Initial Build of Campaigns Materialized 
Views.

Initial Build of 
Events mvs

Obsolete in Release 7.

Replaced by BIM: Initial Build of Events Materialized 
Views.

Initial Build of 
Funds mvs

Obsolete in Release 7.

Replaced by BIM: Initial Build of Budgets Materialized 
Views.

Load 
Geographic 
Hierarchies

Yes This program must be run each time that the geographies 
are changed.

Marketing 
Facts Load

Obsolete in Release 7.

Replaced by BIM: Load Marketing Facts for the First Time.

Marketing 
Materialized 
views prebuilt 
tables (AMS)

Obsolete in Release 7.

Replaced by BIM: Initial Build of Materialized Views

Marketing 
Materialized 
views Refresh 
(AMS)

Obsolete in Release 7.

Replaced by BIM: Refresh Materialized Views

Concurrent 
Manager Required Description
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Payables Open 
Interface 
Import - 
Oracle 
Payables

Yes Payables open interface import is an Oracle Payables 
concurrent program used to create invoices in payables. It 
has to be run for the batch source defined in system 
parameters since all the claims settlement for payables get 
created with that batch source. For more information on 
parameters and options see the Oracle Payables 
Implementation Guide.

Refresh of 
Campaigns 
mvs

Obsolete in Release 7.

Replaced by BIM: Refresh Campaigns Materialized Views.

Refresh of 
Events mvs

Obsolete in Release 7.

Replaced by BIM: Refresh Events Materialized Views.

Refresh of 
Funds mvs

Obsolete in Release 7.

Replaced by BIM: Refresh Budgets Materialized Views.

Web 
Execution: 
Refresh 
Campaign 
Items

Yes Information about Campaigns is stored in multiple tables. 
To improve runtime performance, this program 
periodically collects required information on campaigns 
and places it into a single table.

Web 
Execution: 
Refresh Offer 
Parties and 
Products

Yes This program loads offer party and product information 
into denormalized tables. This information will be used in 
validating budget eligibility and web offer recommen- 
dations. For the input parameter p_incremental_flag, enter 
Y to load only new information or N to reload all 
information.

Web 
Execution: 
Refresh 
Minisite Items

Yes This refreshes the denormalized table for minisites 
periodically to capture items in the iStore minisites.

Workflow 
Background 
Engine AMS 
Models Build/ 
Score

Yes Choose item “AMS Models Build/Score” for the Workflow 
daemon to monitor data mining workflow requests. For 
data mining operations, a frequency of 30 minutes should 
be sufficient. 

Workflow 
Background 
Process

Yes Starts the Workflow engine.

Concurrent 
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Workflow 
Background 
Process

Yes Parameters required:

� Set Item Type: AMS Marketing Approvals for 
Marketing Approvals or OMO Triggers for Triggers 
(select from available values).

� Minimum Threshold: Leave blank.

� Maximum Threshold: Leave blank.

� Process Deferred: Yes

� Process Timeout: Yes

The concurrent process is required to process the 
approvals.

Concurrent 
Manager Required Description
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 List Import F
G

List Import Fields

This appendix provides tables of all of the List Import table fields used by Oracle 
Marketing Online. Please see the chapter on Implement List Import for more 
information on these tables.

List Import Fields
The following sections describe the fields which can be used in list import. There 
are four sections B2B List Import, B2C List Import, Event Import and Lead Import. 

B2B List Import

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

ADDRESS_LINES_
PHONETIC

VARCHAR2(150)

ADDRESS1 VARCHAR2(150) Required every time if 
address is required.

ADDRESS2 VARCHAR2(150)

ADDRESS3 VARCHAR2(150)

ADDRESS4 VARCHAR2(150)

ANALYSIS_FY VARCHAR2

APARTMENT_FLAG VARCHAR2

BEST_TIME_CONTACT_
BEGIN

DATE

BEST_TIME_CONTACT_
END

DATE
ields G-1



List Import Fields
CATEGORY_CODE VARCHAR2

CEO_NAME VARCHAR2(50)

CITY VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘CITY’

COUNTRY VARCHAR2(60) Select territory_short_
name, territory_code, 
description from fnd_
territories_vl

Required only if any of 
address columns are 
provided in the data 
file.

COUNTY VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘COUNTRY’

CREATED_BY NUMBER Yes Populated by the list 
import program.

CREATION_DATE DATE Yes Populated by the list 
import program.

CURR_FY_POTENTIAL_
REVENUE

NUMBER

DECISION_MAKER_
FLAG

VARCHAR2(1)

DEDUPE_KEY VARCHAR2(150) Populated by the list 
import program.

DEPARTMENT VARCHAR2(60)

DUNS_NUMBER NUMBER

EMAIL_ADDRESS VARCHAR2(150)

EMPLOYEES_TOTAL NUMBER

FISCAL_YEAREND_
MONTH

VARCHAR2(30)

FLOOR VARCHAR2

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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GSA_INDICATOR_FLAG VARCHAR2

HOUSE_NUMBER VARCHAR2

IMPORT_LIST_HEADER_
ID

NUMBER Yes Auto Generated

IMPORT_SOURCE_LINE_
ID

NUMBER Yes Auto Generated

IMPORT_SUCCESSFUL_
FLAG

VARCHAR2(1)

JGZZ_FISCAL_CODE VARCHAR2

JOB_TITLE VARCHAR2(60)

LAST_ORDERED_DATE DATE

LAST_UPDATE_DATE DATE Yes Populated by the list 
import program.

LAST_UPDATE_LOGIN NUMBER Yes Populated by the list 
import program. 

LAST_UPDATED_BY NUMBER Yes Populated by the list 
import program.

LEGAL_STATUS VARCHAR2(30)

LINE_OF_BUSINESS VARCHAR2(30)

MISSING_STATEMENT VARCHAR2

NEXT_FY_POTENTIAL_
REVENUE

NUMBER

OBJECT_VERSION_
NUMBER

NUMBER Yes Populated by the list 
import program.

ORGANIZATION_
NAME_PHONETIC

VARCHAR2

OVERSEAS_ADDRESS_
FLAG

VARCHAR2

PARTY_NAME VARCHAR2(150) Yes This is a required 
column for B2B type 
data.

PERSON_FIRST_NAME VARCHAR2(150)

PERSON_LAST_NAME VARCHAR2(150)

PERSON_MIDDLE_
NAME

VARCHAR2(60)

PERSON_NAME_SUFFIX VARCHAR2(30)

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-3
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PERSON_TITLE VARCHAR2(60)

PHONE_AREA_CODE VARCHAR2(10)

PHONE_COUNTRY_
CODE

VARCHAR2(10)

PHONE_EXTENTION VARCHAR2(20)

PHONE_NUMBER VARCHAR2(40) Required if any of the 
phone information is 
provided.

PO_BOX_NUMBER

POSTAL_CODE VARCHAR2(60) Select min(p.from_
postal_code), 

Max(p.to_postal_code) 
from

Ar_postal_code_
ranges_v p,

Ar_location_values a 
where

p.location_segment_id 
= a.location_segment_
id and a.location_
segment_qualifier

= ‘CITY’ and 
a.location_segment_
value like ‘X%’

POSTAL_PLUS4_CODE

PROVINCE VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘PROVINCE’

RURAL_ROUTE_
NUMBER

VARCHAR2

RURAL_ROUTE_TYPE VARCHAR2

SECONDARY_SUFFIX_
ELEMENT

VARCHAR2

SIC_CODE VARCHAR2

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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B2C List Import

SIC_CODE_TYPE VARCHAR2

SITE_USE_TYPE VARCHAR2

STATE VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘STATE’

STREET VARCHAR2

STREET_NUMBER VARCHAR2

STREET_SUFFIX VARCHAR2

SUITE VARCHAR2

TAX_NAME VARCHAR2

TAX_REFERENCE VARCHAR2(50)

TIME_ZONE VARCHAR2150) Numeric value 
indicating the number 
of hours from 
Greenwich mean time.

TOTAL_NUM_OF_
ORDERS

NUMBER

TOTAL_ORDERED_
AMOUNT

NUMBER

YEAR_ESTABLISHED NUMBER(4)

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

ADDRESS_LINES_
PHONETIC

VARCHAR2

ADDRESS1 VARCHAR2(150) Required every time if 
address is required.

ADDRESS2 VARCHAR2(150)

ADDRESS3 VARCHAR2

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-5
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ADDRESS4 VARCHAR2

APARTMENT_FLAG VARCHAR2

BEST_TIME_CONTACT_
BEGIN

DATE

BEST_TIME_CONTACT_
END

DATE

CITY VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘CITY’

COUNTRY VARCHAR2(60) Select territory_short_
name, territory_code, 
description from fnd_
territories_vl

Required only if any of 
address columns are 
provided in the data 
file.

COUNTY VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘COUNTRY’

CREATED_BY NUMBER Yes Populated by the list 
import program.

CREATION_DATE DATE Yes Populated by the list 
import program.

DEDUPE_KEY VARCHAR2(150) Populated by the list 
import program.

EMAIL_ADDRESS VARCHAR2(150)

FLOOR

GENDER VARCHAR2(30)

HOUSE_NUMBER

HOUSEHOLD_INCOME NUMBER

IMPORT_LIST_HEADER_
ID

NUMBER Yes Auto Generated

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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IMPORT_SOURCE_LINE_
ID

NUMBER Yes Auto Generated

IMPORT_SUCCESSFUL_
FLAG

VARCHAR2(1)

LAST_UPDATE_DATE DATE Yes Populated by the list 
import program.

LAST_UPDATE_LOGIN NUMBER Yes Populated by the list 
import program. 

LAST_UPDATED_BY NUMBER Yes Populated by the list 
import program.

OBJECT_VERSION_
NUMBER

NUMBER Yes Populated by the list 
import program.

OVERSEAS_ADDRESS_
FLAG

VARCHAR2

PERSON_FIRST_NAME VARCHAR2(150) Yes This is a required 
column in the data file 
for B2C type of data 

PERSON_LAST_NAME VARCHAR2(150) Yes This is a required 
column in the data file 
for B2C type of data

PERSON_MIDDLE_
NAME

VARCHAR2(60)

PERSON_NAME_SUFFIX VARCHAR2(30)

PERSON_PRE_NAME_
ADJUNCT

PERSON_TITLE VARCHAR2(60)

PHONE_AREA_CODE VARCHAR2(10)

PHONE_COUNTRY_
CODE

VARCHAR2(10)

PHONE_EXTENTION VARCHAR2(20)

PHONE_NUMBER VARCHAR2(40) Required if any of the 
phone information is 
provided.

PO_BOX_NUMBER VARCHAR2

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-7
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POSTAL_CODE VARCHAR2(60) Select min(p.from_
postal_code), 

Max(p.to_postal_code) 
from

Ar_postal_code_
ranges_v p,

Ar_location_values a 
where

p.location_segment_id 
= a.location_segment_
id and a.location_
segment_qualifier

= ‘CITY’ and 
a.location_segment_
value like ‘X%’

POSTAL_PLUS4_CODE

PROVINCE VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘PROVINCE’

RURAL_ROUTE_
NUMBER

VARCHAR2

RURAL_ROUTE_TYPE VARCHAR2

SALUTATION VARCHAR2

SECONDARY_SUFFIX_
ELEMENT

VARCHAR2

SITE_USE_TYPE VARCHAR2   

STATE VARCHAR2(60) Select distinct location_
segment_description, 
location_segment_
user_value from ar_
location_values where 
location_segment_
qualifier = 

‘STATE’

STREET VARCHAR2

STREET_NUMBER VARCHAR2

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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List Import Fields
Event List Import

STREET_SUFFIX VARCHAR2

SUITE VARCHAR2

TIME_ZONE VARCHAR2150) Numeric value 
indicating the number 
of hours from 
Greenwich mean time.

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

ACTIVE_FLAG VARCHAR2(1)

ATTENDANCE_
FAILURE_REASON

VARCHAR2(30) AMS_EVENT_
ATTENDANCE_
FAILURE_CODE 
LOOKUP

ATTENDANCE_RESULT_
CODE

VARCHAR2(30)

ATTENDANT_
ACCOUNT_ID

NUMBER CUSTOMER_
ACCOUNT_ID

ATTENDANT_
CONTACT_ID

NUMBER Yes CONTACT_ID

ATTENDANT_
LANGUAGE

VARCHAR2(30)

ATTENDANT_PARTY_ID NUMBER PARTY_ID

ATTENDED_FLAG VARCHAR2(1)

ATTRIBUTE_CATEGORY VARCHAR2(30)

ATTRIBUTE1 VARCHAR2(150)

ATTRIBUTE10 VARCHAR2(150)

ATTRIBUTE11 VARCHAR2(150)

ATTRIBUTE12 VARCHAR2(150)

ATTRIBUTE13 VARCHAR2(150)

ATTRIBUTE14 VARCHAR2(150)

ATTRIBUTE15 VARCHAR2(150)

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-9
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ATTRIBUTE2 VARCHAR2(150)

ATTRIBUTE3 VARCHAR2(150)

ATTRIBUTE4 VARCHAR2(150)

ATTRIBUTE5 VARCHAR2(150)

ATTRIBUTE6 VARCHAR2(150)

ATTRIBUTE7 VARCHAR2(150)

ATTRIBUTE8 VARCHAR2(150)

ATTRIBUTE9 VARCHAR2(150)

AUTO_REGISTER_FLAG VARCHAR2(1)

CANCELLATION_CODE NUMBER

CANCELLATION_
REASON_CODE

VARCHAR2(30) AMS_EVENT_REG_
CANCEL_REASON 
LOOKUP

CONFIRMED_FLAG VARCHAR2(1)

CREATED_BY NUMBER Yes Populated by the list 
import program.

CREATION_DATE DATE Yes Populated by the list 
import program.

DATE_REGISTRATION_
PLACED

DATE

DESCRIPTION

EVALUATED_FLAG VARCHAR2(1)

EVENT_OFFER_ID NUMBER Yes AMS_EVENT_
OFFERS_ALL_B

IMPORT_LIST_HEADER_
ID

NUMBER Yes Auto Generated 

IMPORT_SOURCE_LINE_
ID

NUMBER Yes Auto Generated

IMPORT_SUCCESSFUL_
FLAG

VARCHAR2(1) Populated by the list 
import program.

INBOUND_CHANNEL_
ID

NUMBER

INBOUND_MEDIA_ID NUMBER

INVITE_ONLY_
OVERRIDE_FLAG

VARCHAR2(1)

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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LAST_REG_STATUS_
DATE

DATE Date when the 
registration closed.

LAST_UPDATE_LOGIN NUMBER Yes Populated by the list 
import program.

LAST_UPDATED_BY NUMBER Yes Populated by the list 
import program.

MAX_ATTENDEE_
OVERRIDE_FLAG

VARCHAR2(1)

OBJECT_VERSION_
NUMBER

NUMBER Yes Populated by the list 
import program.

ORDER_HEADER_ID NUMBER

ORDER_LINE_ID NUMBER

ORIGINAL_
REGISTRANT_
CONTACT_ID

NUMBER Yes

OWNER_USER_ID NUMBER Yes

PAYMENT_STATUS_
CODE

VARCHAR2(30)

PROGRAM_
APPLICATION_ID

NUMBER

PROGRAM_ID NUMBER

PROGRAM_UPDATE_
DATE

DATE

PROSPECT_FLAG VARCHAR2(1)

REG_SOURCE_TYPE_
CODE

VARCHAR2(30) AMS_EVENT_REG_
SOURCE_TYPE 
LOOKUP

REGISTRANT_
ACCOUNT_ID

NUMBER Yes CUSTOMER_
ACCOUNT_ID

REGISTRANT_
CONTACT_ID

NUMBER Yes CONTACT_ID

REGISTRANT_PARTY_ID NUMBER Yes PARTY_ID

REGISTRATION_ 
GROUP_ID

NUMBER Yes

REGISTRATION_
SOURCE_ID

NUMBER

REQUEST_ID NUMBER

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-11



List Import Fields
Lead List Import

SALESREP_ID NUMBER

SECURITY_GROUP_ID NUMBER

SOURCE_CODE VARCHAR2(30) Yes AMS_EVENT_
OFFERS_ALL_B

SYSTEM_STATUS_CODE VARCHAR2(30) AMS_EVENT_REG_
STATUS LOOKUP

TARGET_LIST_ID NUMBER

USER_STATUS_ID NUMBER Yes AMS_USER_STATUS 
LOOKUP

WAITLISTED_PRIORITY VARCHAR2(30)

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

ACCEPT_FLAG

ACTIVE_FLAG VARCHAR2(1)

ADDRESS_EFFECTIVE_
DATE

VARCHAR2

ADDRESS_KEY VARCHAR2 Stores the Address Key 
generated

ADDRESS_LINES_
PHONETIC

VARCHAR2

ADDRESS_STYLE VARCHAR2

ADDRESSEE VARCHAR2

ASSIGN_DATE VARCHAR2

ASSIGN_SALES_GROUP_
ID

VARCHAR2

ASSIGN_TO_PERSON_ID VARCHAR2

ASSIGN_TO_
SALESFORCE_ID

VARCHAR2

ATTENDANCE_
FAILURE_REASON

VARCHAR2(30) AMS_EVENT_
ATTENDANCE_
FAILURE_CODE 
LOOKUP

Table Column / 
Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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ATTENDANCE_RESULT_
CODE

VARCHAR2(30)

ATTENDANT_
ACCOUNT_ID

NUMBER CUSTOMER_
ACCOUNT_ID

ATTENDANT_
CONTACT_ID

NUMBER Yes CONTACT_ID

ATTENDANT_
LANGUAGE

VARCHAR2(30)

ATTENDANT_PARTY_ID NUMBER PARTY_ID

ATTENDED_FLAG VARCHAR2(1)

ATTRIBUTE_CATEGORY VARCHAR2(30)

ATTRIBUTE1 VARCHAR2(150)

ATTRIBUTE10 VARCHAR2(150)

ATTRIBUTE11 VARCHAR2(150)

ATTRIBUTE12 VARCHAR2(150)

ATTRIBUTE13 VARCHAR2(150)

ATTRIBUTE14 VARCHAR2(150)

ATTRIBUTE15 VARCHAR2(150)

ATTRIBUTE2 VARCHAR2(150)

ATTRIBUTE3 VARCHAR2(150)

ATTRIBUTE4 VARCHAR2(150)

ATTRIBUTE5 VARCHAR2(150)

ATTRIBUTE6 VARCHAR2(150)

ATTRIBUTE7 VARCHAR2(150)

ATTRIBUTE8 VARCHAR2(150)

ATTRIBUTE9 VARCHAR2(150)

AUTO_ASSIGNMENT_
TYPE

VARCHAR2

AUTO_REGISTER_FLAG VARCHAR2(1)

BUDGET_AMOUNT NUMBER

BUDGET_AMOUNT_1 NUMBER

BUDGET_AMOUNT_2 NUMBER

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-13
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BUDGET_AMOUNT_3 NUMBER

BUDGET_AMOUNT_4 NUMBER

BUDGET_AMOUNT_5 NUMBER

BUDGET_STATUS_CODE VARCHAR2

CANCELLATION_CODE NUMBER

CANCELLATION_
REASON_CODE

VARCHAR2(30) AMS_EVENT_REG_
CANCEL_REASON 
LOOKUP

CHANNEL_CODE VARCHAR2

CLOSE_REASON VARCHAR2

CNT_PNT_CONTENT_
SOURCE_TYPE

VARCHAR2 This is a mandatory 
column in HZ_
CONTACT_POINTS, 
but if not given, default 
it to ‘USER_ENTERED’

CNT_PNT_TIME_ZONE VARCHAR2

CONFIRMED_FLAG VARCHAR2(1)

CONTACT_KEY VARCHAR2 Stores the Contact Key 
generated

CONTACT_NUMBER VARCHAR2

CONTACT_PARTY_ID NUMBER

CONTACT_ROLE_CODE VARCHAR2

CONTENT_SOURCE_
TYPE

VARCHAR2 This is a mandatory 
column in HZ_
LOCATIONS, but if not 
given, default it to 
‘USER_ENTERED’

CREATED_BY NUMBER Yes Populated by the list 
import program.

CREATION_DATE DATE Yes Populated by the list 
import program.

CURRENCY_CODE VARCHAR2

CUSTOMER_KEY VARCHAR2 Stores the customer 
Key generated

DATE_REGISTRATION_
PLACED

DATE

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
G-14 Oracle Marketing Online Implementation Guide 



List Import Fields
DECISION_MAKER_
FLAG

VARCHAR2

DECISION_TIMEFRAME_
CODE

VARCHAR2

DELETED_FLAG VARCHAR2

DEPARTMENT VARCHAR2

DEPARTMENT_CODE VARCHAR2

DESCRIPTION VARCHAR2

DESCRIPTION VARCHAR2

DO_NOT_EMAIL_FLAG VARCHAR2 If 'Y' then no emails 
sent to Contact.

DO_NOT_FAX_FLAG VARCHAR2 If 'Y' then no fax sent to 
Contact.

DO_NOT_PHONE_FLAG VARCHAR2 If 'Y' then no phone 
calls to Contact.

DUNS_NUMBER VARCHAR2

EMAIL_FORMAT VARCHAR2

EVALUATED_FLAG VARCHAR2(1)

EVENT_OFFER_ID NUMBER Yes AMS_EVENT_
OFFERS_ALL_B

FA_LOCATION_ID NUMBER

FAX_AREA_CODE VARCHAR2

FAX_COUNTRY_CODE VARCHAR2

FAX_EXTENSION VARCHAR2

FAX_NUMBER VARCHAR2

FLOOR VARCHAR2

GROUP_TYPE VARCHAR2

GSA_INDICATOR_FLAG VARCHAR2

HOUSE_NUMBER VARCHAR2

HQ_BRANCH_IND NUMBER

IMPORT_FLAG NUMBER

IMPORT_LIST_HEADER_
ID

NUMBER Yes Auto Generated 

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-15
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IMPORT_SOURCE_LINE_
ID

NUMBER Yes Auto Generated

IMPORT_SUCCESSFUL_
FLAG

VARCHAR2(1) Populated by the list 
import program.

INBOUND_CHANNEL_
ID

NUMBER

INBOUND_MEDIA_ID NUMBER

INCUMBENT_PARTNER_
PARTY_ID

NUMBER Partner specific 

INCUMBENT_PARTNER_
RESOURCE_ID

NUMBER Partner specific 

INTEREST_TYPE_ID_1 NUMBER

INTEREST_TYPE_ID_2 NUMBER

INTEREST_TYPE_ID_3 NUMBER

INTEREST_TYPE_ID_4 NUMBER

INTEREST_TYPE_ID_5 NUMBER

INVENTORY_ITEM_ID_1 NUMBER

INVENTORY_ITEM_ID_2 NUMBER

INVENTORY_ITEM_ID_3 NUMBER

INVENTORY_ITEM_ID_4 NUMBER

INVENTORY_ITEM_ID_5 NUMBER

INVITE_ONLY_
OVERRIDE_FLAG

VARCHAR2(1)

JGZZ_FISCAL_CODE VARCHAR2

JOB_TITLE_CODE VARCHAR2 Stores the job title code

KEEP_FLAG VARCHAR2

KNOWN_AS VARCHAR2

KNOWN_AS2 VARCHAR2

KNOWN_AS3 VARCHAR2

KNOWN_AS4 VARCHAR2

KNOWN_AS5 VARCHAR2

LANGUAGE VARCHAR2

LANGUAGE_NAME VARCHAR2

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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LAST_ORDERED_DATE VARCHAR2

LAST_REG_STATUS_
DATE

DATE Date when the 
registration closed.

LAST_UPDATE_LOGIN NUMBER Yes Populated by the list 
import program.

LAST_UPDATED_BY NUMBER Yes Populated by the list 
import program.

LEAD_NUMBER VARCHAR2

LEAD_RANK_ID NUMBER Stores the sales lead 
rank id.   Need not 
supply if supplied will 
get validated

LOAD_ERROR_MESSAGE VARCHAR2 Currently, not used. To 
find the error messages, 
query from as_lead_
import_errors

LOC_DESCRIPTION VARCHAR2

LOC_HIERARCHY_ID NUMBER

LOC_VALIDATED_FLAG VARCHAR2

LOCATION_DIRECTIONS VARCHAR2

LOCATION_ID NUMBER Location Id to which 
address info is mapped

MAIL_STOP VARCHAR2

MAILSTOP VARCHAR2

MAX_ATTENDEE_
OVERRIDE_FLAG

VARCHAR2(1)

MIDDLE_INITIAL VARCHAR2

MISSION_STATEMENT VARCHAR2

NET_WORTH VARCHAR2 free text format

NEW_CON_FLAG VARCHAR2 << DO NOT 
POPULATE >>  if 1 - 
new contact, 0- existing 
Contact

NEW_LOC_FLAG VARCHAR2 << DO NOT 
POPULATE >>  if 1 - 
this is a new location. If 
0- this is already 
existing.

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-17
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NEW_PARTY_FLAG VARCHAR2 << DO NOT 
POPULATE >>  If 1 - 
party is newly created. 
If 0, existing party is 
used.

NEW_PS_FLAG VARCHAR2 << DO NOT 
POPULATE >>  if 1 - 
new PS, if 0 - PS 
already existing

NEW_REL_FLAG VARCHAR2 << DO NOT 
POPULATE >>  if 1 - 
new relationship, 0- 
existing Rel

OBJECT_VERSION_
NUMBER

NUMBER Yes Populated by the list 
import program.

OFFER_ID NUMBER

OFFER_ID_1 NUMBER

OFFER_ID_2 NUMBER

OFFER_ID_3 NUMBER

OFFER_ID_4 NUMBER

OFFER_ID_5 NUMBER

ORDER_HEADER_ID NUMBER

ORDER_LINE_ID NUMBER

ORG_CNT_COMMENTS VARCHAR2

ORG_CNT_TITLE VARCHAR2

ORGANIZATION_ID_1 NUMBER

ORGANIZATION_ID_2 NUMBER

ORGANIZATION_ID_3 NUMBER

ORGANIZATION_ID_4 NUMBER

ORGANIZATION_ID_5 NUMBER

ORGANIZATION_
NAME_PHONETIC

VARCHAR2

ORIG_SYSTEM_CODE VARCHAR2 Source application code 
where the lead 
originated example 
OTN

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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ORIG_SYSTEM_
REFERENCE

VARCHAR2 May be populated as 
<orig_system_code > 
<identifier> example 
OTN10100

ORIGINAL_
REGISTRANT_
CONTACT_ID

NUMBER Yes

OWNER_USER_ID NUMBER Yes

PARENT_PROJECT VARCHAR2

PARTIES_VALIDATED_
FLAG

VARCHAR2

PARTY_ID NUMBER Party Id to which the 
customer info is 
mapped

PARTY_NUMBER VARCHAR2

PARTY_REFERENCE_
USE_FLAG

VARCHAR2

PARTY_SITE_ID NUMBER Party Site Id to which 
the party and location 
info is mapped

PARTY_SITE_NAME VARCHAR2

PARTY_SITE_NUMBER VARCHAR2 Can be populated 
ONLY when profile 
"HZ Generate Party 
Number" set to 'N'

PARTY_TYPE VARCHAR2

PAYMENT_STATUS_
CODE

VARCHAR2(30)

PERSON_FIRST_NAME_
PHONETIC

VARCHAR2

PERSON_IDEN_TYPE VARCHAR2

PERSON_IDENTIFIER VARCHAR2

PERSON_LAST_NAME_
PHONETIC

VARCHAR2

PERSON_NAME_SUFFIX VARCHAR2

PERSON_PREVIOUS_
LAST_NAME

VARCHAR2

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
 List Import Fields G-19
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PHONE_CALLING_
CALENDAR

VARCHAR2

PHONE_COUNTRY_
CODE

VARCHAR2

PHONE_ID NUMBER DO NOT POPULATE

PO_BOX_NUMBER VARCHAR2

LOCATION_POSITION

POSTAL_PLUS4_CODE VARCHAR2

PRIMARY_CONTACT_
FLAG

VARCHAR2

PRIMARY_CONTACT_
PER_ROLE_TYPE

VARCHAR2 'Y' or 'N' 

PRIMARY_INTEREST_
CODE_ID_1

NUMBER

PRIMARY_INTEREST_
CODE_ID_2

NUMBER

PRIMARY_INTEREST_
CODE_ID_3

NUMBER

PRIMARY_INTEREST_
CODE_ID_4

NUMBER

PRIMARY_INTEREST_
CODE_ID_5

NUMBER

PRIMARY_PER_TYPE VARCHAR2 'Y' or 'N'

PRM_ASSIGNMENT_
TYPE

VARCHAR2

PRM_EXEC_SPONSOR_
FLAG

VARCHAR2 Partner specific 

PRM_IND_
CLASSIFICATION_CODE

VARCHAR2 Partner specific

PRM_PRJ_LEAD_IN_
PLACE_FLAG

VARCHAR2 Partner specific 

PRM_SALES_LEAD_TYPE VARCHAR2 Partner specific

PROGRAM_
APPLICATION_ID

NUMBER

PROGRAM_
APPLICATION_ID

NUMBER ] DO NOT POPULATE

PROGRAM_ID NUMBER

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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PROGRAM_ID ] Concurrent process 
generated

PROGRAM_UPDATE_
DATE

DATE

PROGRAM_UPDATE_
DATE

DATE ]

PROMOTION_CODE VARCHAR2 If given and 
promotion_id is not 
provided, then this will 
be transferred to 
promotion_id.

PROMOTION_ID NUMBER If given, this is used for 
creating the sales lead 
header.

PROSPECT_FLAG VARCHAR2(1)

PS_USES_COMMENTS VARCHAR2

QUALIFIED_FLAG VARCHAR2

QUANTITY_1 NUMBER

QUANTITY_2 NUMBER

QUANTITY_3 NUMBER

QUANTITY_4 NUMBER

QUANTITY_5 NUMBER

RANK VARCHAR2

RAW_PHONE_NUMBER VARCHAR2

REG_SOURCE_TYPE_
CODE

VARCHAR2(30) AMS_EVENT_REG_
SOURCE_TYPE 
LOOKUP

REGISTRANT_
ACCOUNT_ID

NUMBER Yes CUSTOMER_
ACCOUNT_ID

REGISTRANT_
CONTACT_ID

NUMBER Yes CONTACT_ID

REGISTRANT_PARTY_ID NUMBER Yes PARTY_ID

REGISTRATION_GROUP_
ID

NUMBER Yes

REGISTRATION_
SOURCE_ID

NUMBER

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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REJECT_REASON_CODE VARCHAR2

REL_PARTY_ID NUMBER Relationship’s party ID 
to which the 
relationship is mapped.

REQUEST_ID NUMBER

REQUEST_ID NUMBER ]

ROLE_LEVEL VARCHAR2

SALES_LEAD_ID NUMBER << DO NOT 
POPULATE >> Sales 
Lead ID to which the 
sales lead info is 
mapped.

SALES_TAX_GEOCODE VARCHAR2

SALES_TAX_INSIDE_
CITY_LIMITS

VARCHAR2

SALESREP_ID NUMBER

SCORECARD_ID NUMBER

SECONDARY_INTEREST_
CODE_ID_1

NUMBER

SECONDARY_INTEREST_
CODE_ID_2

NUMBER

SECONDARY_INTEREST_
CODE_ID_3

NUMBER

SECONDARY_INTEREST_
CODE_ID_4

NUMBER

SECONDARY_INTEREST_
CODE_ID_5

NUMBER

SECURITY_GROUP_ID NUMBER

SECURITY_GROUP_ID NUMBER

SHORT_DESCRIPTION VARCHAR2

SIC_CODE_TYPE VARCHAR2

SITE_USE_TYPE VARCHAR2 This is a mandatory 
column for HZ_
PARTY_SITE_USES. 
But if not given, it will 
be defaulted to ‘BILL_
TO’

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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SOURCE_CODE VARCHAR2(30) Yes AMS_EVENT_
OFFERS_ALL_B

SOURCE_PROMOTION_
ID_1

NUMBER

SOURCE_PROMOTION_
ID_2

NUMBER

SOURCE_PROMOTION_
ID_3

NUMBER

SOURCE_PROMOTION_
ID_4

NUMBER

SOURCE_PROMOTION_
ID_5

NUMBER

STREET VARCHAR2

STREET_NUMBER VARCHAR2

STREET_SUFFIX VARCHAR2

SUITE VARCHAR2

SYSTEM_STATUS_CODE VARCHAR2(30) AMS_EVENT_REG_
STATUS LOOKUP

TARGET_LIST_ID NUMBER

TAX_NAME VARCHAR2

TIME_ZONE VARCHAR2

TOTAL_NUM_OF_
ORDERS

NUMBER

TOTAL_ORDERED_
AMOUNT

NUMBER

UOM_CODE_1 NUMBER

UOM_CODE_2 NUMBER

UOM_CODE_3 NUMBER

UOM_CODE_4 NUMBER

UOM_CODE_5 NUMBER

URGENT_FLAG VARCHAR2

USER_STATUS_ID NUMBER Yes AMS_USER_STATUS 
LOOKUP

VEHICLE_RESPONSE_
CODE

VARCHAR2

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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WAITLISTED_PRIORITY VARCHAR2(30)

Table Column /
 Field in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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How Existence Checking in OMO is

Supported

How Existence Checking in OMO is Supported
Existence Checking is done by using fuzzy keys and Word Replacement Rules. 
Refer to the TCA documentation for more information on fuzzy keys and word 
replacement rules.

List import program use the following algorithm to create any TCA entity

If Locations not exists then create Location. If Party not exists then create Party. If 
Part Site not exists for combination of above Party and Location then create Party 
Site. If Contact Party not exists then create Contact party. If Relationship of type 
CONTACT not exists between Party and Contact Party then create Org Contact, 
Relationship and Contact Roles. If Contact Points do not exist then create Contact 
Points.

Customer
Existence checking is done using customer_key in HZ_PARTIES. This key is 
generated by TCA APIs while creating the customer. List Import program populate 
the AMS_IMP_SOURCE_LINES table with dedupe keys for all records to be 
imported. If it finds a match on the HZ_PARTIES then it uses the matching 
customer otherwise it creates a new customer using TCA API. As mentioned above 
if there are multiple records with the same customer key then the import record is 
created for the customer having highest party_id.

Any word replacement rules are defined in TCA then those rules will be applied to 
the customer name in the table while populating the key in AMS_IMP_SOURCE_
LINES table.
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Address
In the TCA customer model, the address consists of the party site in HZ_PARTY_
SITES and location in HZ_LOCATIONS. Locations is a physical address, such as 500 
Oracle Parkway, Redwood Shores, CA 94065. The Party Site is a logical name 
associated with a location. For example, the Party Site - "Head Quarters" can be 
associated with a location 500 Oracle Parkway. Multiple party sites can point to the 
same location. For example, 500 Oracle Parkway can be both "Head Quarters" and 
"Human Resources". The list import program check whether the location exists in 
HZ_LOCATIONS or not as well as whether the party site for the combination of 
location and customer exists in HZ_PARTY_SITES. 

If a matching record is found in HZ_LOCATIONS then it uses the matching location 
otherwise it creates a new location using TCA API. As mentioned above if there are 
multiple records with the same address key then it takes the location having highest 
location_id. 

Once the location_id is created, the program finds out whether a party site exists for 
the combination of this location_id and party_id. If such party site already exists 
then it takes that party_site_id. If not then a new party site is created using TCA 
API. 

Contact
In TCA, the contact is stored as a party of type "PERSON" in HZ_PARTIES and a 
relationship is created between the customer and contact in HZ_RELATIONSHIPS. 
The list import program checks whether the contact exists in HZ_PARTIES (as a 
party of type “PERSON") as well as it checks whether a relationship of type 
"Contact" exists between the customer and contact in HZ_RELATIONSHIPS. The 
existence checking is done using customer_key in TCA table (HZ_PARTIES). Refer 
to the above section on customer.

Note that if relationship of any other type exists then List import program will 
create a new relationship. If a contact with same first name and last name (thus 
same party_name in HZ_PARTIES) exists in table then list Import will not create a 
new contact in TCA tables. It will just create a new relationship if one does not 
exists and attach the list to that contact.

Contact Points
List import creates Phone, Email, WEB, and Fax. No existence checking is done 
here.
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other Applications

Web Execution can be Implemented by other Applications
Web Execution may be implemented by other application through JSP pages or 
through HTML Pages. Here is an example, followed by some preliminary steps 
which are common to implementation by either method.

Example
For example, suppose a campaign schedule is to be displayed on the Home page

� Site = ‘MYSITE’

� Page = ’HOME’

� Location(s) = TOP_CENTER and UPPER_RIGHT. 

Preliminary Steps
1. Define a Site in the Site definition screen (OMOlogin > Administration > 

Marketing > Execution > Sites) with a Programmatic Access Name for the site. 
In our example, the Programmatic Access Name for the site is ‘MYSITE’.

2. Define a Page for the above defined Site in the Page definition screen 
(OMOlogin > Administration > Marketing > Execution > Pages) with a 
Programmatic Access Name for the page. In our example, the Programmatic 
Access Name for the page is ‘HOME’.

3. Create two new locations with location codes ‘TOP_CENTER’ and ‘UPPER_
RIGHT’ in LOV lookups. These location codes are specified during the 
Implementing Web Placement section.

4. Define posting (OMOlogin > Execution > Web Postings).
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5. Define a Placement in the Placement definition screen (OMOlogin > Execution 
> Web Placements).

Web Execution Implementation through JSP Pages
In order to implement Web Execution through jsp pages, follow steps below. 

1. Set site and page attributes

a. These should be set at the top of the User Application jsp.

b. Set ‘site’ and ‘page’ attributes of page context with the corresponding 
programmatic access names 

c. In our scenario, following would be code snippet for this step

-------------------------------------------
<%
pageContext.setAttribute("site", “MYSITE”, PageContext.REQUEST_SCOPE);
pageContext.setAttribute("page", “HOME”, PageContext.REQUEST_SCOPE);
%>
-------------------------------------------
2. Set location and include amsWebPlacement.jsp where the recommendation is 

intended to be displayed. Repeat this step at every location where you want the 
recommendation to appear. 

a. Set Location attributes of page context.

b. Include file amsWebPlacement.jsp 

c. In our scenario, following would be code snippets for this step 

-------------------------------------------
pageContext.setAttribute("location", “TOP_RIGHT”, PageContext.REQUEST_SCOPE);
<jspinclude page="amsWebPlacement.jsp" flush="true" />
-------------------------------------------

-------------------------------------------
pageContext.setAttribute("location", “UPPER_RIGHT”, PageContext.REQUEST_SCOPE);
<jspinclude page="amsWebPlacement.jsp" flush="true" />
-------------------------------------------

Note: The jsp scope should always be ‘REQUEST’ scope, 
otherwise the recommendation will not be displayed.
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Notes
� Above Step 1 should be done only once in a jsp.

� Above Step 2  should be repeated at every location where you intend to see a 
recommendation.

� Following are the seeded locations. New locations can be created in Location 
Lookup Types screen.

� LEFT1, LEFT2, LEFT3, LEFT4, LEFT5, LEFT6, LEFT7

� RIGHT1, RIGHT2, RIGHT3, RIGHT4, RIGHT5, RIGHT6, RIGHT7

� TOP, BOTTOM

Web Execution Implementation through HTML Pages
Web Execution can be implemented for HTML applications as well. For this method 
of implementation, a URL should be invoked with all required name-value 
parameters. This URL could be invoked through a javascript from a HTML page. 
The invoked URL will get back the recommendations. 

Follow these steps to form the URL to be invoked.

1. http//<server name><port number>/OA_
HTML/amsWebPlacementLink.jsp?site=<Defined Programmatic Access Name 
of Site>&page=<Defined Programmatic Access Name of 
Page>&location=<Location code defined in location lookups>

Note: This amsWebPlacement.jsp will ultimately display a HTML 
code.

Note: The jsp to be used for HTML Applications is 
amsWebPlacementLink.jsp.
Integrating Marketing Web Execution with other Applications I-3



Web Execution Implementation through HTML Pages
2. The API that could be embedded in the HTML code would look something like 
following

-------------------------------------------
<!-- BEGIN Web Placements Tag -->
<script language="JavaScript"
src="http//www.mysite.com:8000/OA_
HTML/amsWebPlacementLink.jsp?site=MYSITE&page=HOME&location=TOP_CENTER">
</script>
<noscript>
</noscript>
<!-- END Web Placements Tag -->
-------------------------------------------
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Implementing a Custom Strategy and
Custom Condition for Web Execution

Implementing a Custom Strategy
To define a Custom Strategy, you have first write a Java class that implements the 
interface ‘Fireable’. Two sample Custom Strategy Java Classes called 
“oracle.apps.ams.execution.SampleCustomProdSelector” and 
“oracle.apps.ams.execution.SampleCustomSchedSelector” are shipped with source 
code as an example.

A typical Java class may look like as follows 

/*Sample Java class of Custom Strategy selecting a list of
Products.
*/

package oracle.apps.ams.content;

/* JDK */
import java.sql.SQLException;
import java.math.BigDecimal;

/* JDBC */
import oracle.jdbc.driver.OracleConnection;
import java.sql.Connection;
import java.sql.ResultSet;
import java.sql.PreparedStatement;
import oracle.jdbc.driver.OracleCallableStatement;
import oracle.jdbc.driver.OracleTypes;
import oracle.sql.ARRAY;
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/* JTF */
import oracle.apps.fnd.common.VersionInfo;
import oracle.apps.jtf.aom.transaction.TransactionScope;
import oracle.apps.jtf.util.GeneralUtil;

/* OMO */
import oracle.apps.ams.execution.Fireable;
import oracle.apps.ams.execution.ExecutionContext;
import oracle.apps.ams.execution.RuntimeAppCtx;
import oracle.apps.ams.posting.strategy.StrategyUtil;
import oracle.apps.ams.common.PostingSQLUtil;
import oracle.apps.ams.common.ContentCollector;
import oracle.apps.ams.common.FastVector;
import oracle.apps.ams.common.AMSLogger;

/* OSO */
import oracle.apps.asf.util.OSOException;

/**
 ** The sample Custom Strategy class
*/

public class SampleCustomProdSelector implements Fireable
{
  public static final String RCS_ID = "$Header: SampleCustomProdSelector.java
    115.2 2002/01/10 23:38:07 asaha noship $" ;
  public static final boolean RCS_ID_RECORDED =
    VersionInfo.recordClassVersion(RCS_ID, "oracle.apps.ams.content");
  public static final String _THISCLASS = "SampleCustomProdSelector";

  /**
   * Tries to find the Products that have been added within last 30 days from
   * sysdate. So, if you added 3 such Products and max allowed is 2, 2 of them
   * will be returned.
   */

  public void fire(  ExecutionContext p_objContext //the runtime Context
                   , String p_strContentType  //the Content Type to be returned
                     - 'Product' in this case
                   , ContentCollector p_ccContentIds //returned Product Ids
                   , FastVector p_fvParamNames  //strat param names - not
                     required for Sample strategy
                   , FastVector p_fvParamValues //strat param values - not
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                     required for Sample strategy
                   , String p_strBusPrior //Business Priority to sort output by
                     - not used in this example
                   , String p_strBusPriorOrder //Priority Order of sorting - 
                     ASC or DESC
                   , FastVector p_fvFilters //Filters to apply if any - not
                     meaningful in this example
                   , int p_intMaxAllowed  //max returnable from this Strategy
                  )
    throws SQLException, OSOException, Exception
  {
    String l_strMethodName = "fire";

    //log the Entry into this method
    AMSLogger.log(_THISCLASS
                  , l_strMethodName
                  , "Enter"
                  , AMSLogger.DEBUG
                  );

    //get the Runtime Application Context
    RuntimeAppCtx re = p_objContext.m_objRuntimeAppCtx;

    //declare the variables
    Connection conn = null;
    PreparedStatement pstmt = null;
    ResultSet rs = null;
    String  xret;
    int xmsgCnt;
    String xmsgData = "";

    BigDecimal tempbd;
    String temp;

    try
    {
      //first get a Database Connection
      conn = 
(oracle.jdbc.driver.OracleConnection)TransactionScope.getConnection();

      //then prepare the query
      StringBuffer sb = new StringBuffer();
      sb.append(" select inventory_item_id");
      sb.append(" from mtl_system_items_kfv");
      sb.append(" where organization_id = ?");
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      sb.append(" and NVL(start_date_active, sysdate) >= sysdate-30");
      sb.append(" and NVL(end_date_active, sysdate) >= sysdate");
      sb.append(" and web_status = 'PUBLISHED'");
      sb.append(" and rownum <= ?");

      //get the prepared statement from the connection object
      pstmt = conn.prepareCall( sb.toString());

      //orgId is required for all Product recommendations - so should
      //get it from the Runtime Execution Context
      tempbd = re.getItemValidationOrgId();
      //log it to outout log file
      AMSLogger.log(_THISCLASS
                    , l_strMethodName
                    , "Org Id : "+tempbd
                    ,  AMSLogger.DEBUG);
      //set orgid in prepared statement
      if(tempbd == null)
        pstmt.setNull(1, java.sql.Types.NUMERIC);
      else
        pstmt.setInt(1, tempbd.intValue());

      //set max count in prepared statement
      pstmt.setInt(2, p_intMaxAllowed);

      //get the output result set
      rs = pstmt.executeQuery();

      //iterate through the result set
      while(rs.next())
      {
        temp = rs.getString(1);
        p_ccContentIds.addContent(new BigDecimal(temp));
      }
    }
    finally
    {
      try
      {
        if(pstmt != null)
        {
          //close all prepared statements otherwise memory leaks will occur
          pstmt.close();
          pstmt = null;
        }
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        if(rs != null)
        {
          //close all resulesets otherwise memory leaks will occur
          rs.close();
          rs = null;
        }
        if(conn != null)
          TransactionScope.releaseConnection( conn );
      }
      catch(Exception e)
      {
      }
    }
    //log the Exit from this method
    AMSLogger.log(_THISCLASS
                  , l_strMethodName
                  , "Exit"
                  , AMSLogger.DEBUG);
  }

  /**
   * @return Strategy Type
   */
  public String getStrategyType()
  {
    //return this String as defined in the interface Fireable
    return CUSTOM_STRATEGY_TYPE;
  }

}

The above class recommends Products that have been added with active start date 
within last month. Once you write your own Java class,  register it under 
Administration > Strategy. You have to know for what Content Type you are 
defining your Custom Strategy. Once your Custom Java Class is registered under a 
name, it can be used in Universal or Rule Based Postings if Strategy Types are 
“Custom”.
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Implementing a Custom Condition
To use the extended ruleconditions, you have first write a Java class that 
implements the interface ‘CustomCondition’. The following sample class is shipped 
with the product. This class show how to get the information about the city of the 
current user.

This class needs to be registered in the system as a "site" level profile value. The 
name of the profile is AMS: Custom Condition Class.

package oracle.apps.ams.execution;

/* JTF*/
import oracle.apps.fnd.common.VersionInfo;
import oracle.apps.jtf.aom.transaction.TransactionScope;

/* JDBC */
import oracle.jdbc.driver.OracleConnection;
import java.sql.Connection;
import java.sql.ResultSet;
import java.sql.PreparedStatement;
import oracle.jdbc.driver.*;
import oracle.sql.*;

/* OMO */
import oracle.apps.ams.common.AMSLogger;

/**
 * Should implement CustomCondition.
 */
public class SampleCustomCondition implements CustomCondition
{
  public static final boolean RCS_ID_RECORDED =
  VersionInfo.recordClassVersion(RCS_ID, "oracle.apps.ams.execution");
 public static final String _THISCLASS = 
"oracle.apps.ams.execution.SampleCustomCondition";

/*
 This example method returns the city in which
 the user resides. For instance, this could be used
 with the extended conditions to check if the user
 is a resident of say, San Francisco.
*/

 public String[] getValues(ExecutionContext p_objContext)
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 {
   String l_strMethodName = "getValues";

   //log the Entry into this method
   AMSLogger.log(_THISCLASS
         , l_strMethodName
         , "Enter"
         , AMSLogger.DEBUG
);

  //get the Runtime Application Context
  // this is a required step.
  RuntimeAppCtx re = p_objContext.m_objRuntimeAppCtx;

  //declare the variables
  // to connect to the database to get user information.

  Connection conn = null;
  PreparedStatement pstmt = null;
  ResultSet rs = null;
  String[] values = new String[5];

  try
  {
   //first get a Database Connection
   conn = (oracle.jdbc.driver.OracleConnection)TransactionScope.getConnection();

   //then prepare the query
   StringBuffer sb = new StringBuffer();

   //Query
   // User information is stored in hz_parties table/view

   sb.append("select city from hz_parties");
   sb.append(" where party_id = ?");

   //get the prepared statement from the connection object
   pstmt = conn.prepareCall( sb.toString());

   // re.getPartyId() returns the party id of the user.
   pstmt.setBigDecimal(1, re.getPartyId());

   // execute the query
   rs = pstmt.executeQuery();
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   if(rs.next())
   {
    values[0] = rs.getString("city");
   }
   else
   {
    values[0] = "";
   }

   //log the Exit from this method
   AMSLogger.log(_THISCLASS
          , l_strMethodName
          , "Exit"
          , AMSLogger.DEBUG);

   return values;
  }
  catch(Exception e)
  {
   // In case of an exception log the exception
   // to see what went wrong
   AMSLogger.log(_THISCLASS
          , l_strMethodName
          , AMSLogger.ERROR
          , e
          );
}
  finally
  {
   try
   {
    if(pstmt != null)
    {
     //close all prepared statements to avoid memory leaks
     pstmt.close();
     pstmt = null;
    }
    if(rs != null)
    {
     //close all resultsets to avoid memory leaks
     rs.close();
     rs = null;
    }
    if(conn != null)
     TransactionScope.releaseConnection( conn );
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   }
   catch(Exception e)
   {
   }
  }
  //log the Exit from this method
  AMSLogger.log(_THISCLASS
         , l_strMethodName
         , "Exit"
         , AMSLogger.DEBUG);
   return null; 

  }

}

This class returns the "city" of the current user as the first value of an array of 5 
strings. For this to work, you have to register information about this value under 
Administration > Marketing > Execution > Conditions as a value of type "STRING".
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Seeded Metrics
The following metrics are seeded in the Oracle Marketing Online application

Metric 
Id Metric Name Object Calculation Type

Metric 
Parent Id

Summary 
Metric Id

1 Total Cost - Campaign Any Summary

2 Total Direct Cost - 
Campaign

Any Summary 1

3 Deliverable Cost - 
Campaign

Any Rollup 58 2

4 Event Cost - Campaign Any Rollup 59 2

5 Rolled-up Cost - 
Campaign

Any Rollup 60 2

6 Total Indirect Cost - 
Campaign

Any Rollup 61 1

7 Total Revenue - 
Campaign

Any Summary

8 Rolled-up Revenue - 
Campaign

Any Rollup 63 7

9 Total Response - 
Campaign

Any Summary

10 Campaign Response Campaign Manual 65 9

11 Rolled-up Response - 
Campaign

Any Rollup 65 9
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12 Total Cost - Campaign 
Schedule

Any Summary

13 Total Direct Cost - 
Campaign Schedule

Any Summary 12

14 Deliverable Cost - 
Campaign Schedule

Any Rollup 58 13

15 Event Cost - Campaign 
Schedule

Any Rollup 59 13

16 Direct Cost Campaign Schedule Manual 60 13

17 Total Indirect Cost - 
Campaign Schedule

Any Rollup 61 12

18 Total Revenue - 
Campaign Schedule

Any Summary

19 Revenue Campaign Schedule Manual 63 18

20 Total Response - 
Campaign Schedule

Any Summary

21 Response Campaign Schedule Manual 65 20

22 Total Cost - Event Any Summary

23 Total Direct Cost - 
Event

Any Summary 22

24 Deliverable Cost - 
Event

Any Rollup 58 22

25 Campaign Cost - Event Any Rollup 59 23

26 Rolled-up Cost - Event Any Rollup 60 23

27 Total Indirect Cost - 
Event

Any Rollup 61 22

28 Total Revenue - Event Any Summary

29 Rolled-up Revenue - 
Event

Any Rollup 63 28

30 Total Response - Event Any Summary

31 Event Response Any Rollup 65 30

32 Rolled-up Response - 
Event

Any Rollup 65 30

Metric 
Id Metric Name Object Calculation Type

Metric 
Parent Id

Summary 
Metric Id
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33 Total Cost - Event 
Schedule

Any Summary

34 Total Direct Cost - 
Event Schedule

Any Summary 33

35 Deliverable Cost - 
Event Schedule

Any Rollup 58 34

36 Campaign Cost - Event 
Schedule

Any Rollup 59 34

37 Direct Cost Event Schedule Manual 60 34

38 Total Indirect Cost - 
Event Schedule

Any Rollup 61 33

39 Total Revenue - Event 
Schedule

Any Summary

40 Revenue Event Schedule Manual 63 39

41 Total Response - Event 
Schedule

Any Summary

42 Response Event Schedule Manual 65 41

43 Total Cost - Deliverable Any Summary

44 Total Direct Cost - 
Deliverable

Any Summary 43

45 Creative Cost Deliverable Manual 58 44

46 Other Cost Deliverable Manual 58 44

47 Postage Cost Deliverable Manual 58 44

48 Total Indirect Cost - 
Deliverable

Any Rollup 61 43

49 Total Revenue - 
Deliverable

Any Summary

50 Revenue Deliverable Manual 63 49

51 Total Response - 
Deliverable

Any Summary

52 Response Deliverable Manual 65 51

53 Other Cost Campaign Manual 60 2

54 Other Cost Event Manual 60 23

Metric 
Id Metric Name Object Calculation Type

Metric 
Parent Id

Summary 
Metric Id
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55 Allocation Campaign Allocation

56 Total Cost Any Summary

57 Total Direct Cost Any Summary 56

58 Deliverable Cost - 
Program

Any Rollup 58 57

59 Event Cost - Program Any Rollup 59 57

60 Rolled-up Cost - 
Program

Any Rollup 60 57

61 Total Indirect Cost - 
Program

Any Rollup 61 56

62 Total Revenue Any Summary

63 Rolled-up Revenue - 
Program

Any Rollup 63 62

64 Total Response Any Summary

65 Rolled-up Response - 
Program

Any Rollup 65 64

66 Campaign Response Program Manual 65 64

67 Other Cost Program Manual 60 57

68 Allocation Program Allocation

69 Total Cost - One-Off 
Event

Any Summary

70 Total Direct Cost - 
One-Off Event

Any Summary 69

71 Deliverable Cost - 
One-Off Event

Any Rollup 58 70

72 Campaign Cost - 
One-Off Event

Any Rollup 60 70

73 Direct Cost One Off Event Manual 60 70

74 Total Indirect Cost - 
One-Off Event

Any Rollup 61 69

75 Total Revenue - 
One-Off Event

Any Summary

76 Revenue One Off Event Manual 63 69

Metric 
Id Metric Name Object Calculation Type

Metric 
Parent Id

Summary 
Metric Id
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77 Total Response - 
One-Off Event

Any Summary

78 Response One Off Event Manual 65 77

81 Total Leads Any Summary

82 Campaign Schedule 
Leads

Any Rollup 82 81

83 Campaign Schedule 
Leads

Campaign Schedule Function 82 81

84 Event Schedule Leads Event Schedule Function 86 81

85 One-Off Event Leads One Off Event Function 87 81

86 Event Schedule Leads Any Rollup 86 81

87 One-Off Event Leads Any Rollup 87 81

91 Total Opportunities Any Summary

92 Campaign Schedule 
Opportunities

Any Rollup 92 91

93 Campaign Schedule 
Opportunities

Campaign Schedule Function 92 91

94 Event Schedule 
Opportunities

Event Schedule Function 96 91

95 One-Off Event 
Opportunities

One Off Event Function 97 91

96 Event Schedule 
Opportunities

Any Rollup 96 91

97 One-Off Event 
Opportunities

Any Rollup 97 91

101 Total Orders Amount Any Summary

102 Campaign Schedule 
Orders Amount

Any Rollup 102 101

103 Event Schedule Orders 
Amount

Event Schedule Function 106 101

104 One-Off Event Orders 
Amount

One Off Event Function 107 101

105 Campaign Schedule 
Orders Amount

Campaign Schedule Function 102 101

Metric 
Id Metric Name Object Calculation Type

Metric 
Parent Id

Summary 
Metric Id
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106 Event Schedule Orders 
Amount

Any Rollup 106 101

107 One-Off Event Orders 
Amount

Any Rollup 107 101

121 Total Registrants Any Summary

122 Event Schedule 
Registrants

Any Rollup 122 121

123 Event Schedule 
Registrants

Event Schedule Function 122 121

124 One-Off Event 
Registrants

One Off Event Function 125 121

125 One-Off Event 
Registrants

Any Rollup 125 121

131 Total Attendees Any Summary

132 Event Schedule 
Attendees

Any Rollup 132 131

133 Event Schedule 
Attendees

Event Schedule Function 132 131

134 One-Off Event 
Attendees

One Off Event Function 135 131

135 One-Off Event 
Attendees

Any Rollup 135 131

141 Total Cancellations Any Summary

142 Event Schedule 
Cancellations

Any Rollup 142 141

143 Event Schedule 
Cancellations

Event Schedule Function 142 141

144 One-Off Event 
Cancellations

One Off Event Function 145 141

145 One-Off Event 
Cancellations

Any Rollup 145 141

Metric 
Id Metric Name Object Calculation Type

Metric 
Parent Id

Summary 
Metric Id
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Discoverer Setup

Discoverer EUL Creation
Use the following command line to create a 4i EUL. This takes care of the create 
database user and the necessary APPS grants all in one step. The language of the 
EUL must be set for all APPS EUL's!

Open a DOS window, go to the directory where your Discoverer Admin edition is 
installed (example) d\orant\discvr4 and run

     dis4adm.exe 
          /CREATE_EUL 
          /APPS_MODE 
          /CONNECT system/manager@tst115rw 
          /USER eul4_us 
          /PASSWORD eul 
          /DEFAULT_TABLESPACE user_data 
          /TEMPORARY_TABLESPACE temp 
          /SET_EUL_LANGUAGE US 
          /APPS_GRANT_DETAILS apps/apps 
          /SHOW_PROGRESS

If the schema has been created already you can also use 

     dis4adm.exe 
          /CREATE_EUL 
          /APPS_MODE 
          /CONNECT eul4_us/eul@tst115rw 
          /SET_EUL_LANGUAGE US 
          /APPS_GRANT_DETAILS apps/apps 
          /SHOW_PROGRESS
Setup L-1
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Discoverer EUL Import
A customer will import the eex files into the EUL using ad utility adupdeul, a shell 
script running on the NT box where Discoverer Admin is installed. 

Prerequisites
MKS Toolkit is required to run the shell script on NT. The utility is available on any 
Discoverer 4.1.36 or above version.

Steps
1. Start the Korn Shell (MKS Toolkit)

2. From the NT box where Discoverer Admin is installed map the $AU_
TOP/discover directory or copy the eex files to the NT box and specify this 
directory as 'topdir' directory when running the utility 

3. APPS User/Responsibility must be specified for import. The imported 
workbooks will be saved under the specified APPS User. 

4. On the new EUL make sure the APPS User does have full access privileges to 
use Discoverer Admin Edition. 

5. Use the parameter file so that you don't have to specify all values on the 
command line. 

Usage 

      sh adupdeul.sh 
                   connect=<username/password{@<two_task>} 
                      resp=<APPS responsibility name> 
                    gwyuid=<APPS GWYUID> 
                    fndnam=<APPS FNDNAM> 
                  secgroup=<APPS responsibilty security group> 
                    topdir=<top level directory where discoverer 
                                            files are available> 
                 eulprefix=<EUL prefix (for ex EUL4 for EUL4_US)> 
                  language=<NLS language code> 
                   eultype=<OLTP|EDW>                   default OLTP 
               {   parfile=<name of parameter file>             } 
               {      mode=<COMPLETE or DRIVER> default DRIVER> } 
               {    driver=<list of driver files to be loaded 
                            separated by a "," (comma)> } 
               {   exedir=<directory where discoverer executables are 
                           located> } 
               {   logfile=<log file name, default adupdeul.log> } 
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Discoverer Setup
 Example
1. Copy the directory $AU_TOP/discover/US to C\bblock\import\au_

top\discover\US 

2. With Admin Edition connect as EUL owner EUL4_US/EUL@mydb and grant 
privileges for Admin Edition to apps user SYSTEST

3. In Korn Shell CD C\bblock\import 

4. Specify parameter values in a parameter file, for example 

         parfile.lst 
         eulprefix=EUL4 
         exedir=D/orant/discvr4 
         mode=COMPLETE 
         topdir=C/bblock/import/au_top/discover 
         eultype=OLTP 
         fndnam=APPS 
         gwyuid=APPLSYSPUB/PUB 
         resp="Business Views Setup" 
         secgroup="Standard" 
5. Start the full import, all eex files in the topdir 

         sh adupdeul.sh 
         connect    = systest/welcome98@mydb
         parfile   = parfile.lst 
         language  = US 
         logfile   = imp_010314_EUL4_US_mydb.log 

Or start the import for just the files of specified ARU copy file drivers 

         sh adupdeul.sh 
         connect    = systest/welcome98@mydb
         parfile   = parfile.lst 
         language  = US 
         mode      = DRIVER 
         driver    = c1641981.drv 
         logfile   = imp_010314_EUL4_US_mydb.log 

6. For the first time to import, we suggest you to use mode=COMPLETE

ICX Profile Settings
Set the following ICX profiles in Oracle Applications at the responsibility level
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Discoverer Setup
ICX _PROFILE ICX_DISCOVERER_LAUNCHER 
URL that points to the Web Discoverer Server

Example

http//machinename.domain/diswb4/html/discolaunch.htm?Connect=[APPS
_SECURE]

ICX _PROFILE ICX_DISCOVERER_VIEWER_LAUNCHER 
URL that points to the Discoverer Viewer

Example

http//machinename.domain/discoverer4i/viewer?cs=[APPS_SECURE]

ICX_PROFILE ICX_DEFAULT_EUL
This in combination with the language code make up the EUL owner at 
runtime.

Example EUL4 (not EUL4_US)
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Marketing Source Codes
Source codes are unique identifiers for the following marketing objects campaigns, 
campaign schedules, events, event schedules, and offers. Source codes play a very 
important role in marketing. The customer, most often, interacts with the CRM 
application, such as telesales, istore, using a source code. Source codes are stored 
with orders to track the effectiveness of an event, campaign or offer. 

Source Code Schema
Each marketing object has a column referencing the source code. This source code is 
unique throughout the application. Given a source code, it can be traced back to its 
marketing object by looking at the AMS_SOURCE_CODES table. The following 
table shows source code references

Table Object ID Fields Source Code fields

AMS_CAMPAIGNS_VL CAMPAIGN_ID source_code

AMS_CAMPAIGN_
SCHEDULES_VL

SCHEDULE_ID source_code

AMS_EVENT_HEADERS_VL EVENT_HEADER_ID source_code

AMS_EVENT_OFFERS_VL EVENT_OFFER_ID source_code

AMS_OFFERS_VL OFFER_ID

QP_LIST_HEADER_ID

offer_code
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Marketing Source Codes
The Table definition for the AMS_SOURCE_CODE table is: 

AMS_SOURCE_CODES SOURCE_CODE_ID source_code

arc_source_code_for

source_code_for_id

related_source_code

related_source_object

related_source_id

Column Name Field Type Description

SOURCE_CODE_ID NUMBER Unique identifier for the source 
code table

SOURCE_CODE VARCHAR2(30) Unique identifier for all the 
marketing objects. Source codes 
are communicated to the 
customers.

SOURCE_CODE_FOR_ID NUMBER FK to the marketing object to 
which the source code points to.

ARC_SOURCE_CODE_FOR VARCHAR2(30) Four letter code that points to a 
marketing object (EVEH = Event 
headers, EVEO = Event schedules, 
EONE = One-Off Events, CAMP = 
Campaigns, CSCH = Campaign 
Schedules, OFFR = Offers)

ACTIVE_FLAG VARCHAR2(1) Flag to indicate if the source code 
is active or not.

RELATED_SOURCE_CODE VARCHAR2(30) Source code of the related object. 
This is used in case of event 
promotions. The customer is 
interested in the related event that 
the campaign is promoting rather 
than the campaign itself.

RELATED_SOURCE_
OBJECT

VARCHAR2(30) Four letter code that points to the 
related marketing object (EVEH = 
Event headers, EVEO = Event 
schedules, CAMP = Campaigns, 
CSCH = Campaign Schedules, 
OFFR = Offers)

Table Object ID Fields Source Code fields
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Source Code Construction
Source codes are constructed various components. The maximum number of 
characters in a source code is 30 characters. It will be composed of any or all of the 
following. The Geography Code comes from the geographic area code entered into 
geography. The Suffix comes from the source code suffix field in Custom Setups.

� Geography Code

� Month Code

� Activity Code

� Source Code digits (maximum number equals 30 - total of other components)

� Suffix

RELATED_SOURCE_ID NUMBER FK to the marketing object to 
which the related source code 
points to.

Column Name Field Type Description
 Marketing Source Codes M-3
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Seeded User Statuses

User Statuses can be created across the application for a combination of Activity 
and Status. The Application is seeded with the following User Statuses. These user 
statuses can be modified or extended to meet the organization’s Business Rules. 

The seeded User Status values are as follows:

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name

Budget Sourcing Status APPROVED Approved Approved

Budget Sourcing Status CLOSED Closed Accounting Closed

Budget Sourcing Status NEW Planning Planning

Budget Sourcing Status PENDING Pending Pending Approval

Budget Sourcing Status REJECTED Rejected Rejected by Approver

Budget Status ACTIVE Active Active

Budget Status ARCHIVED Archived Archived

Budget Status CANCELLED Cancelled Cancelled

Budget Status CLOSED Closed Closed

Budget Status DRAFT Draft Draft

Budget Status ON_HOLD On Hold On Hold

Budget Status PENDING Pending Approval Pending Approval

Budget Status REJECTED Rejected Rejected

Campaign Schedule Status ACTIVE Active Active

Campaign Schedule Status ARCHIVED Archived Archived

Campaign Schedule Status AVAILABLE Available Available

Campaign Schedule Status CANCELLED Cancelled Cancelled

Campaign Schedule Status CLOSED Closed Closed
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Campaign Schedule Status COMPLETED Completed Completed

Campaign Schedule Status DENIED_BA Budget Rejected Denied Budget Approval

Campaign Schedule Status NEW New New

Campaign Schedule Status ON_HOLD Active Locked On Hold

Campaign Schedule Status SUBMITTED_BA Pending Budget Approval Pending Budget Approval

Campaign Status ACTIVE Active Active

Campaign Status ARCHIVED Archived Archived

Campaign Status AVAILABLE Available Available

Campaign Status CANCELLED Cancelled Cancelled

Campaign Status CLOSED Closed Closed

Campaign Status COMPLETED Completed Completed

Campaign Status DENIED_BA Denied - Budget Approval Budget Denied

Campaign Status DENIED_TA Denied - Theme Approval Theme Denied

Campaign Status NEW New New

Campaign Status ON_HOLD On-hold On Hold

Campaign Status PLANNING Planning Planned

Campaign Status SUBMITTED_BA Submitted - Budget 
Approval

Pending Budget approval

Campaign Status SUBMITTED_TA Submitted - Theme 
Approval

Pending Theme approval

Claim Status APPROVED Approved Approved

Claim Status CANCELLED Cancelled Cancelled

Claim Status CLOSED Closed Closed

Claim Status COMPLETE Complete Complete

Claim Status DUPLICATE Duplicate Duplicate

Claim Status NEW New New

Claim Status OPEN Open Open

Claim Status PENDING Pending Pending

Claim Status PENDING_
APPROVAL

Pending Approval Pending Approval

Claim Status PENDING_CLOSE Pending Close Pending Close

Claim Status REJECTED Rejected Rejected

Deliverable Status ARCHIVED Archived Archived

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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Deliverable Status AVAILABLE Available Final Loaded

Deliverable Status BUDGET_APPR Budget Approved Budget Approval

Deliverable Status CANCELLED Cancelled Cancelled

Deliverable Status DENIED_BA Denied - Budget Approval Budget Denied

Deliverable Status DENIED_TA Denied - Concept Approval Denied Concept Approval

Deliverable Status EXPIRED Expired Expired

Deliverable Status NEW New New

Deliverable Status SUBMITTED_BA Submitted - Budget 
Approval

Pending Budget approval

Deliverable Status SUBMITTED_TA Submitted - Concept 
Approval

Pending Concept Approval

Deliverable Status SUPERCEDED Superceded Superceded

List Import Status COMPLETED Completed Completed

List Import Status ERROR Error Error

List Import Status NEW New New

List Import Status PURGED Purged Purged

List Import Status SCHEDULED Scheduled Scheduled

List Import Status STAGED Staged Staged

List Status ARCHIVED Archived Archived

List Status AVAILABLE Available Available

List Status CANCELLED Cancelled Cancelled

List Status DRAFT Draft Draft

List Status EXECUTED Executed Executed

List Status EXECUTING Executing Executing

List Status GENERATING Generating Generating

List Status LOCKED Locked Locked

List Status SCHEDULED Scheduled Scheduled

List Status VALIDATED Validated Validated

List Status VALIDATING Validating Validating

Marketing Event Agenda Status CONFIRMED Confirmed Confirmed

Marketing Event Agenda Status UNCONFIRMED Unconfirmed Unconfirmed

Marketing Event Registration 
Status

CANCELLED Cancelled Cancelled

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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Marketing Event Registration 
Status

ENROLLED Enrolled Enrolled

Marketing Event Registration 
Status

REGISTERED Registered Registered

Marketing Event Registration 
Status

TARGETED Targeted Targeted

Marketing Event Registration 
Status

WAITLISTED Waitlisted Waitlisted

Marketing Event Speaker Status BOOKED Booked Booked

Marketing Event Speaker Status CANCELLED Cancelled Cancelled

Marketing Event Speaker Status CONFIRMED Confirmed Confirmed

Marketing Event Speaker Status SCHEDULED Scheduled Scheduled

Marketing Event Status ACTIVE Active Active

Marketing Event Status ARCHIVED Archived Archived

Marketing Event Status AVAILABLE Available Available

Marketing Event Status CANCELLED Cancelled Cancelled

Marketing Event Status CLOSED Closed Closed

Marketing Event Status COMPLETED Completed Completed

Marketing Event Status DENIED_BA Denied Budget Approval Budget Denied

Marketing Event Status DENIED_TA Denied Theme Approval Theme Denied

Marketing Event Status NEW New New

Marketing Event Status ON_HOLD On Hold On Hold

Marketing Event Status PLANNING Planning Planned

Marketing Event Status SUBMITTED_BA Submitted Budget Approval Pending Budget approval

Marketing Event Status SUBMITTED_TA Submitted Theme Approval Pending Theme approval

Model Status ARCHIVED Archived Archived

Model Status AVAILABLE Available Available

Model Status BUILDING Building Building

Model Status CUSTOM Custom Custom

Model Status DRAFT Draft Draft

Model Status EXPIRED Expired Expired

Model Status QUEUED Queued Queued

Model Status SCHEDULED Scheduled Scheduled

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
N-4 Oracle Marketing Online Implementation Guide 



Model Status SCORING Scoring Scoring

Offer Status ACTIVE Active Active

Offer Status ARCHIVED Archived Archived

Offer Status CANCELLED Cancelled Cancelled

Offer Status CLOSED Closed Closed

Offer Status COMPLETED Completed Completed

Offer Status DRAFT Draft Draft

Offer Status ONHOLD On Hold On-Hold

Offer Status PENDING Pending Budget Approval Submitted - Budget Approval

Offer Status PENDING_ACTIVE Pending Active Pending Active

Offer Status REJECTED Budget Rejected Rejected - Budget Approval

Offer Status TERMINATED Terminated Terminated

Price List Statuses ACTIVE Active Active

Price List Statuses CANCELLED Cancelled Cancelled

Price List Statuses DRAFT Draft Draft

Price List Statuses PENDING Submitted For Approval Submitted For Approval

Price List Statuses REJECTED Rejected Rejected

Program Status ACTIVE Active Active

Program Status ARCHIVED Archived Archived

Program Status CANCELLED Cancelled Cancelled

Program Status COMPLETED Completed Completed

Program Status NEW Draft Draft

Program Status ON_HOLD On Hold On Hold

Score status ARCHIVED Archived Archived

Score status COMPLETED Completed Completed

Score status DRAFT Draft Draft

Score status QUEUED Queued Queued

Score status SCHEDULED Scheduled Scheduled

Score status SCORING Scoring Running

Segment Status ARCHIVED Archived Archived

Segment Status AVAILABLE Available Available

Segment Status CANCELLED Cancelled Cancelled

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
 Seeded User Statuses N-5



Limitation
It is important to note that the addition of a high number of user statuses would 
mean that the number of values seen in the drop down for an Object’s Status will 
also increase.

Segment Status DRAFT Draft Draft

Segment Status EXPIRED Expired Expired

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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Customer Attributes used for Data Mining

The table below lists the customer attributes used by Oracle Marketing Online to 
build predictive models. 

Note: On average, if more attributes are populated in the 
database, Oracle Marketing Online has a higher likelihood of 
producing accurate modeling results.

No. Attribute Name Description Source
Target 
Audience

1 Age Person’s age Derived from HZ_PERSON_
PROFILES. DATE_OF_BIRTH 
and current date.

Persons

2 Gender Person’s gender code HZ_PERSON_PROFILES. 
GENDER

Persons

3 Ethnicity Person’s stated 
ethnicity

HZ_PERSON_PROFILES. 
DECLARED_ETHNICITY

Persons

4 Marital Status Person’s marital status HZ_PERSON_PROFILES. 
MARITAL_STATUS

Persons

5 Personal Income Personal income HZ_PERSON_PROFILES. 
PERSONAL_INCOME

Persons

6 Head of 
Household

Head of household 
indicator

HZ_PERSON_PROFILES. 
HEAD_OF_HOUSEHOLD_
FLAG

Persons

7 Household Income Household income HZ_PERSON_PROFILES. 
HOUSEHOLD_INCOME

Persons
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8 Household Size Household size HZ_PERSON_PROFILES_
HOUSEHOLD_SIZE

Persons

9 Rent Indicator Indicates whether the 
residence is rented or 
owned

Transform on HZ_PERSON_
PROFILES. RENT_OWN_IND

Persons

10 Apartment 
Indicator

Indicates whether the 
residence is an 
apartment

HZ_LOCATIONS. 
APARTMENT_FLAG

Persons

11 Degree Received Person’s highest 
degree received

HZ_EDUCATION. DEGREE_
RECEIVED

Persons

12 Days Since 
Attended School

Days since the most 
recent date that the 
person attended 
school

MAX (HZ_EDUCATION. 
LAST_DATE_ATTENDED)

Persons

13 School Type The classification of 
the educational 
organization.  For 
example, High School, 
College, University, 
Professional School.  
Note that the name is 
culturally dependent.

HZ_EDUCATION. TYPE_OF_
SCHOOL

Persons

14 Interest in Art 
Indicator

Indicates if party is 
interested in arts

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘ART’

Persons

15 Interest in Books 
Indicator

Indicates if party is 
interested in books

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘BOOKS’

Persons

16 Interest in Movies 
Indicator

Indicates if party is 
interested in movies

HZ_PERSON_INTEREST 
INTEREST_TYPE_CODE = 
‘MOVIES’

Persons

17 Interest in Music 
Indicator

Indicates if party is 
interested in music

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘MUSIC’

Persons

18 Interest in Theater 
Indicator

Indicates if party is 
interested in theater

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘THEATER’

Persons

No. Attribute Name Description Source
Target 
Audience
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19 Interest in Travel 
Indicator

Indicates if party is 
interested in travel

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘TRAVEL’

Persons

20 Interest in Drink 
Indicator

Indicates if party 
drinks

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘DRINK’

Persons

21 Interest in Smoke 
Indicator

Indicates if party 
smokes

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE = 
‘SMOKE'

Persons

22 Interest in Other 
Indicator

Indicates other 
interests of the party

HZ_PERSON_INTEREST. 
INTEREST_TYPE_CODE <> 
'ART', 'BOOK'S, 'MOVIES', 
'MUSIC', 'THEATER', 
''TRAVEL', 'DRINK', ' SMOKE'.

Persons

23 Employment 
Indicator

Indicates whether the 
person is currently 
employed

TRUE if HZ_EMPLOYMENT_
HISTORY. END_DATE = Null

Persons

24 Years Employed The number of years 
that the person has 
been employed

Difference between HZ_
EMPLOYMENT_HISTORY. 
BEGIN_DATE and current date 
(for record where HZ_
EMPLOYMENT_HISTORY. 
END_DATE = Null)

Persons

25 Occupation The formal name for 
the position at that 
place of employment

HZ_EMPLOYMENT_HISTORY. 
EMPLOYED_AS_TITLE  (for 
record where HZ_
EMPLOYMENT_HISTORY. 
END_DATE = Null), else  - 
UNEMPLOYED

Persons

26 Military Branch Branch of military in 
which the person 
served

HZ_EMPLOYMENT_HISTORY. 
BRANCH

Persons

27 Residence Type Type of residence HZ_PARTY_SITE_USES. SITE_
USE_TYPE

Persons

28 Resident Length The length of time in 
which the person lived 
at the location

HZ_PARTY_SITE_USES. 
BEGIN_DATE and END_DATE 
for SITE_USE_TYPE = 
RESIDES_AT

Persons

29 Country Country of residence HZ_PARTIES. COUNTRY Persons

No. Attribute Name Description Source
Target 
Audience
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30 State State of residence. HZ_PARTIES. STATE Persons

31 Province Province of residence HZ_PARTIES. PROVINCE Persons

32 County County of residence HZ_PARTIES. COUNTY Persons

33 Zip Code Postal code of 
residence

HZ_PARTIES. POSTAL_CODE Persons

34 Net Profit Net profit before tax HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘PROFIT_BEFORE_TAX’)

Organization 
Contacts

35 Capital Amount Capital amount HZ_FINANCIAL_NUMBERS. 
[FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
IN (‘ISSUED_CAPITAL’, ‘PAID_
IN_CAPITAL’, ‘NOMINAL_
CAPITAL’, ‘AUTHORIZED_
CAPITAL’)]

Organization 
Contacts

36 Capital Type 
Indicator

Capital type indicator HZ_FINANCIAL_NUMBERS. 
FINANCIAL_NUMBER_NAME 
(where FINANCIAL_
NUMBER_NAME in (‘ISSUED_
CAPITAL’, ‘PAID_IN_
CAPITAL’, ‘NOMINAL_
CAPITAL’, ‘AUTHORIZED_
CAPITAL’))

Organization 
Contacts

37 Accounts 
Receivable

Accounts receivable HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘ACCOUNTS_RECEIVABLE’)

Organization 
Contacts

38 Retained Earnings Retained earnings HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘RETAINED_EARNINGS’)

Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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39 Paydex Score per 
Year

Paydex score for the 
last year

HZ_ORGANIZATION_
PROFILES. PAYDEX_SCORE

Organization 
Contacts

40 Paydex Score 3 
Month Ago

Paydex score 3 months 
ago

HZ_ORGANIZATION_
PROFILES. PAYDEX_THREE_
MONTHS_AGO

Organization 
Contacts

41 Industry Paydex 
Median

Industry Paydex 
Median

HZ_ORGANIZATION_
PROFILES. PAYDEX_NORM

Organization 
Contacts

42 Global Failure 
Score

Global Failure Score HZ_ORGANIZATION_
PROFILES. GLOBAL_
FAILURE_SCORE

Organization 
Contacts

43 D&B Score Dunn and Bradstreet 
Score for the 
organization

HZ_ORGANIZATION_
PROFILES. DB_RATING

Organization 
Contacts

44 Out of Business 
Indicator

Indicates if 
organization is out of 
business

HZ_ORGANIZATION_
PROFILES. OOB_IND

Organization 
Contacts

45 Number of 
Employees

Number of employees HZ_ORGANIZATION_
PROFILES. EMPLOYEES_
TOTAL

Organization 
Contacts

46 Legal Status Indicates legal status HZ_ORGANIZATION_
PROFILES. LEGAL_STATUS

Organization 
Contacts

47 Year of 
Establishment

Year of establishment HZ_ORGANIZATION_
PROFILES. YEAR_
ESTABLISHED

Organization 
Contacts

48 SIC Code SIC Code HZ_ORGANIZATION_
PROFILES. SIC_CODE

Organization 
Contacts

49 Minority Business 
Indicator

Indicates whether the 
business is minority 
owned

HZ_ORGANIZATION_
PROFILES. MINORITY_
OWNED_IND

Organization 
Contacts

50 Small Business 
Indicator

Indicates is this is a 
small business

HZ_ORGANIZATION_
PROFILES. SMALL_BUS_IND

Organization 
Contacts

51 Women Owned 
Indicator

Indicates whether the 
business is women 
owned

HZ_ORGANIZATION_
PROFILES. WOMAN_OWNED_
IND

Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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52 Import-Export 
Business

Indicates whether the 
business is an 
import/export 
business

In HZ_ORGANIZATIONS, if 
either IMPORT_IND or 
EXPORT_IND are true, then 
true

Organization 
Contacts

53 Gross Annual 
Income

Gross annual income HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘GROSS_INCOME’)

Both Persons 
and 
Organization 
Contacts

54 Debt to Income 
Ratio

Gross long term debt HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘LONG_TERM_DEBT’)

Both Persons 
and 
Organization 
Contacts

55 Net Worth Net worth HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘NET_WORTH’)

Both Persons 
and 
Organization 
Contacts

56 Total Assets Total assets HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘TOTAL_ASSETS’)

Both Persons 
and 
Organization 
Contacts

57 Total Debt 
Outstanding

Total outstanding debt HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘LONG_TERM_DEBT’)

Both Persons 
and 
Organization 
Contacts

58 Gross Annual Sales Gross annual sales HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘SALES’)

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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59 Current Assets Current assets HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘TOTAL_CURRENT_
ASSETS’)

Both Persons 
and 
Organization 
Contacts

60 Current Liabilities Current liabilities HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_
CURRENCY where 
FINANCIAL_NUMBER_NAME 
= ‘TOTAL_CURR_
LIABILITIES’)

Both Persons 
and 
Organization 
Contacts

61 Credit Check Indicates whether a 
credit check is 
required

HZ_CUSTOMER_PROFILES. 
CREDIT_CHECKING through 
HZ_CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

62 Tolerance Percentage over credit 
limit that this 
customer can exceed 
before action is taken

HZ_CUSTOMER_PROFILES. 
TOLERANCE through HZ_
CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

63 Discount Terms 
Indicator

Indicates whether to 
allow discount terms

HZ_CUSTOMER_PROFILES. 
DISCOUNT_TERMS through 
HZ_CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

64 Dunning Letters 
Indicator

Indicates whether to 
send dunning letters 
to this customer when 
invoices, debit memos 
or chargebacks 
become past due

HZ_CUSTOMER_PROFILES. 
DUNNING_LETTERS through 
HZ_CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

65 Interest Charges 
Indicator

Indicates whether to 
charge this customer 
interest

HZ_CUSTOMER_PROFILES. 
INTEREST_CHARGES through 
HZ_CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

66 Send Statements 
Indicator

Indicates whether to 
send statements to this 
customer

HZ_CUSTOMER_PROFILES. 
SEND_STATEMENTS through 
HZ_CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
 Customer Attributes used for Data Mining O-7



67 Credit Hold 
Indicator

Indicates whether to 
put a hold on this 
customer’s credit

HZ_CUSTOMER_PROFILES. 
CREDIT_HOLD through HZ_
CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

68 Credit Rating Credit rating HZ_CUSTOMER_PROFILES. 
CREDIT_RATING through HZ_
CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

69 Risk Code Risk code HZ_CUSTOMER_PROFILES. 
RISK_CODE through HZ_
CUST_ACCOUNTS

Both Persons 
and 
Organization 
Contacts

70 Days of Interest 
Period

Number of days to 
which the interest rate 
refers

HZ_CUSTOMER_PROFILES. 
INTEREST_PERIOD_DAYS 
through HZ_CUST_
ACCOUNTS

Both Persons 
and 
Organization 
Contacts

71 Days of Payment 
Grace

Maximum number of 
overdue days allowed 
before action is taken

HZ_CUSTOMER_PROFILES. 
PAYMENT_GRACE_DAYS 
through HZ_CUST_
ACCOUNTS

Both Persons 
and 
Organization 
Contacts

72 Days Since Last 
Event

Days since last event 
attended

MAX (AMS_EVENT_OFFERS_
VL. EVENT_START_DATE) 
where PARTY_ID in (AMS_
EVENT_REGISTRATIONS. 
ATTENDANT_PARTY_ID)

Both Persons 
and 
Organization 
Contacts

73 Number of Times 
Targeted

Number of times 
targeted

AMS_LIST_HEADERS_VL. 
SENT_OUT_DATE is not Null 
AND party is in AMS_LIST_
ENTRIES. PARTY_ID

Both Persons 
and 
Organization 
Contacts

74 Last Targeted 
Channel Code

The most recent 
channel targeted

Derived using AMS_
CAMPAIGN_SCHEDULES_VL, 
AMS_LIST_HEADERS_VL, and 
AMS_LIST_ENTRIES fields

Both Persons 
and 
Organization 
Contacts

75 Times Targeted 
per Month

Number of times 
targeted per month

Derived using AMS_LIST_
HEADERS_VL. SENT_OUT_
DATE (if not Null) and party in 
AMS_LIST_ENTRIES. PARTY_
ID for last month

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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76 Times Targeted in 
3 Months

Number of times 
targeted in the last 
three months

Derived using AMS_LIST_
HEADERS_VL. SENT_OUT_
DATE (if not Null) and party in 
AMS_LIST_ENTRIES. PARTY_
ID for last 3 months

Both Persons 
and 
Organization 
Contacts

77 Times Targeted in 
6 Months

Number of times 
targeted in the last six 
months

Derived using AMS_LIST_
HEADERS_VL. SENT_OUT_
DATE (if not Null) and party in 
AMS_LIST_ENTRIES. PARTY_
ID for last 6 months

Both Persons 
and 
Organization 
Contacts

78 Times Targeted in 
12 Months

Number of times 
targeted in the last 
twelve months

Derived using AMS_LIST_
HEADERS_VL. SENT_OUT_
DATE (if not Null) and party in 
AMS_LIST_ENTRIES. PARTY_
ID for last year

Both Persons 
and 
Organization 
Contacts

79 Days Since Last 
Targeted

The most recent date 
the party was targeted

Derived using MAX (AMS_
LIST_HEADERS_VL. SENT_
OUT_DATE) where party in 
AMS_LIST_ENTRIES. PARTY_
ID

Both Persons 
and 
Organization 
Contacts

80 Average Discount 
Offered

Average discount 
offered

Derived using AMS_ACT_
OFFERS and AMS_
CAMPAIGN_SCHEDULES_VL 
fields

Both Persons 
and 
Organization 
Contacts

81 Number of Types 
Discount Offered

Number of types of 
discounts offered

Derived using AMS_ACT_
OFFERS And AMS_
CAMPAIGN_SCHEDULES_VL 
fields

Both Persons 
and 
Organization 
Contacts

82 Number of 
Targeted by Email

Number of times a 
party has been 
targeted by email

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_MEDIA_VL

Both Persons 
and 
Organization 
Contacts

83 Number of 
Targeted by Direct 
Mail

Number of times a 
party has been 
targeted by direct mail

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_MEDIA_VL

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
 Customer Attributes used for Data Mining O-9



84 Number of 
Targeted by 
Telemarketing

Number of times a 
party has been 
targeted by 
telemarketing

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_MEDIA_VL

Both Persons 
and 
Organization 
Contacts

85 Number of 
Targeted by Offer 
Type 1

Number of times a 
party has been 
targeted by offers of 
type ’Accrual’

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_ACT_OFFERS

Both Persons 
and 
Organization 
Contacts

86 Number of 
Targeted by Offer 
Type 2

Number of times a 
party has been 
targeted by offers of 
type ’Lumpsum’

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_ACT_OFFERS

Both Persons 
and 
Organization 
Contacts

87 Number of 
Targeted by Offer 
Type 3

Number of times a 
party has been 
targeted by offers of 
type ’Order’

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_ACT_OFFERS

Both Persons 
and 
Organization 
Contacts

88 Number of 
Targeted by Offer 
Type 4

Number of times a 
party has been 
targeted by offers of 
type ’Off_Invoice’

Derived using AMS_LIST_
ENTRIES, AMS_LIST_
HEADERS_ALL, AMS_
CAMPAIGN_SCHEDULES_B, 
AMS_ACT_OFFERS

Both Persons 
and 
Organization 
Contacts

89 Days Since First 
Contact

Dance since the initial 
contact

Derived using MIN (AMS_
LIST_HEADERS_VL. SENT_
OUT_DATE) where SENT_
OUT_DATE is not Null, and 
AMS_LIST_ENTRIES fields

Both Persons 
and 
Organization 
Contacts

90 Average Talk Time Average talk time BIC_PARTY_SUMM. AVG_
TALK_TIME

Both Persons 
and 
Organization 
Contacts

91 Average Order 
Amount

Average (mean) order 
amount

BIC_PARTY_SUMM. ORDER_
AMT divided by ORDER_NUM

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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92 Average Units per 
Order

Average (mean) units 
per order

BIC_PARTY_SUMM. ORDER_
QTY divided by ORDER_NUM

Both Persons 
and 
Organization 
Contacts

93 Total Order 
Amount Last Year

Total order amount 
over the past year

SUM (BIC_PARTY_SUMM. 
ORDER_AMT) over the past 
year

Both Persons 
and 
Organization 
Contacts

94 Total Order 
Amount Last 9 
Months

Total order amount 
over the past nine 
months

SUM (BIC_PARTY_SUMM. 
ORDER_AMT) over the past 9 
months

Both Persons 
and 
Organization 
Contacts

95 Total Order 
Amount Last 6 
Months

Total order amount 
over the past six 
months

SUM (BIC_PARTY_SUMM. 
ORDER_AMT) over the past 6 
months

Both Persons 
and 
Organization 
Contacts

96 Total Order 
Amount Last 3 
Months

Total order value over 
the past three months

SUM (BIC_PARTY_SUMM. 
ORDER_AMT) over the past 3 
months

Both Persons 
and 
Organization 
Contacts

97 Total Number of 
Orders Last Year

Total number of 
orders over the past 
year

SUM (BIC_PARTY_SUMM. 
ORDER_QTY) over the past year

Both Persons 
and 
Organization 
Contacts

98 Total Number of 
Orders Last 9 
Months

Total number of 
orders over the past 
nine months

SUM (BIC_PARTY_SUMM. 
ORDER_QTY) over the past 9 
months

Both Persons 
and 
Organization 
Contacts

99 Total Number of 
Orders Last 6 
Months

Total number of 
orders over the past 
six months

SUM (BIC_PARTY_SUMM. 
ORDER_QTY) over the past 6 
months

Both Persons 
and 
Organization 
Contacts

100 Total Number of 
Orders Last 3 
Months

Total number of 
orders over the past 
three months

SUM (BIC_PARTY_SUMM. 
ORDER_QTY) over the past 3 
months

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
 Customer Attributes used for Data Mining O-11



101 Days Since 
Account 
Established

Days since account 
was established

HZ_CUST_ACCOUNTS. 
ACCOUNT_ESTABLISHED_
DATE

Both Persons 
and 
Organization 
Contacts

102 Days Since 
Account 
Termination

Days since account 
termination

HZ_CUST_ACCOUNTS. 
ACCOUNT_TERMINATION_
DATE

Both Persons 
and 
Organization 
Contacts

103 Days Since 
Account 
Activation

Days since account 
was activated

HZ_CUST_ACCOUNTS. 
ACCOUNT_ACTIVATION_
DATE

Both Persons 
and 
Organization 
Contacts

104 Days Since 
Account 
Suspended

Days since account 
was suspended

HZ_CUST_ACCOUNTS. 
SUSPENSION_DATE

Both Persons 
and 
Organization 
Contacts

105 Number of Service 
Requests Last Year

Number of service 
requests for the past 
year

SUM (BIC_PARTY_SUMM. 
SRS_LOGGED) over the past 
year

Both Persons 
and 
Organization 
Contacts

106 Number of Service 
Requests Last 6 
Months

Number of service 
requests for the last six 
months

SUM (BIC_PARTY_SUMM. 
SRS_LOGGED) over the last 6 
months

Both Persons 
and 
Organization 
Contacts

107 Number of Service 
Requests Last 3 
Months

Number of service 
requests for the last 
three months

SUM (BIC_PARTY_SUMM. 
SRS_LOGGED) over the last 3 
months

Both Persons 
and 
Organization 
Contacts

108 Number of Service 
Requests Last 
Month

Number of service 
requests for the last 
month

BIC_PARTY_SUMM. SRS_
LOGGED

Both Persons 
and 
Organization 
Contacts

109 Average Resolve 
Days Last Year

Average days for 
resolution (of a service 
request) over the past 
year

BIC_PARTY_SUMM. AVG_SR_
RESL_TIME over the past year

Both Persons 
and 
Organization 
Contacts

110 Average Resolve 
Days Last 6 
Months

Average days for 
resolution (of a service 
request) over the past 
six months

BIC_PARTY_SUMM. AVG_SR_
RESL_TIME over the last 6 
months

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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111 Average Resolve 
Days Last 3 
Months

Average days for 
resolution (of a service 
request) over the past 
three months

BIC_PARTY_SUMM. AVG_SR_
RESL_TIME over the last 3 
months

Both Persons 
and 
Organization 
Contacts

112 Average Resolve 
Days Last Month

Average days for 
resolution (of a service 
request) over the last 
month

BIC_PARTY_SUMM. AVG_SR_
RESL_TIME

Both Persons 
and 
Organization 
Contacts

113 Number of Orders 
Delivered

Number of orders 
fulfilled

BIC_PARTY_SUMM. ORDER_
LINES_DELIVERED

Both Persons 
and 
Organization 
Contacts

114 Number of Order 
Ontime

On-time delivery rate 
(% of order lines 
where shipped date is 
on or before order 
request date)

BIC_PARTY_SUMM. ORDER_
LINES_ONTIME

Both Persons 
and 
Organization 
Contacts

115 Number of Orders Total items ordered 
(all-time)

BIC_PARTY_SUMM. ORDER_
QTY_CUML

Both Persons 
and 
Organization 
Contacts

116 Order Recency Order recency in days 
- days between the last 
order date and the last 
date of the period, as 
defined in GL periods

BIC_PARTY_SUMM. ORDER_
RECENCY

Both Persons 
and 
Organization 
Contacts

117 Payments Number of payments BIC_PARTY_SUMM. 
PAYMENTS

Both Persons 
and 
Organization 
Contacts

118 Returns Number of returns 
(order returns)

BIC_PARTY_SUMM. RETURNS Both Persons 
and 
Organization 
Contacts

119 Returns by Value Monetary value of 
returns

BIC_PARTY_SUMM. RETURN_
BY_VALUE

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
 Customer Attributes used for Data Mining O-13



120 Returns by Value 
Percent

Percent of returns 
relative to the number 
of orders

BIC_PARTY_SUMM. RETURN_
BY_VALUE_PCT

Both Persons 
and 
Organization 
Contacts

121 Ontime Payments Average number of 
invoices paid on or 
before due date

BIC_PARTY_SUMM. ONTIME_
PAYMENTS

Both Persons 
and 
Organization 
Contacts

122 Ontime Shipped 
Percent

Percent of order lines 
shipped where the 
shipped date is on or 
before the order 
request date

BIC_PARTY_SUMM. ONTIME_
SHIP_PCT

Both Persons 
and 
Organization 
Contacts

123 Closed Service 
Requests

Total number of 
closed service requests

BIC_PARTY_SUMM. CLOSED_
SRS

Both Persons 
and 
Organization 
Contacts

124 Cost of Goods Sold Cost of goods sold – 
calculated by 
multiplying cost by 
number of units sold

BIC_PARTY_SUMM. COGS Both Persons 
and 
Organization 
Contacts

125 Number of 
Contracts 
Cumulative

Cumulative total 
number of contracts

BIC_PARTY_SUMM. 
CONTRACTS_CUML

Both Persons 
and 
Organization 
Contacts

126 Contracts Amount Total amount specified 
in the contracts

BIC_PARTY_SUMM. 
CONTRACT_AMT

Both Persons 
and 
Organization 
Contacts

127 Contracts Duration Average duration of 
new contracts from the 
point of creation or 
renewal

BIC_PARTY_SUMM. 
CONTRACT_DURATION

Both Persons 
and 
Organization 
Contacts

128 Number Inactive 
Contracts

Total number of 
contracts inactivated

BIC_PARTY_SUMM. 
INACTIVE_CONTRACTS

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
O-14 Oracle Marketing Online Implementation Guide 



129 Number Open 
Contracts

Total number of active 
contracts

BIC_PARTY_SUMM. OPEN_
CONTRACTS

Both Persons 
and 
Organization 
Contacts

130 Number New 
Contracts

Total number of new 
contracts

BIC_PARTY_SUMM. NEW_
CONTRACTS

Both Persons 
and 
Organization 
Contacts

131 Number Renewed 
Contracts

Total number of 
contracts renewed

BIC_PARTY_SUMM. 
RENEWED_CONTRACTS

Both Persons 
and 
Organization 
Contacts

132 Total Escalated 
Service Requests

Total escalated service 
requests

BIC_PARTY_SUMM. ESC_SRS Both Persons 
and 
Organization 
Contacts

133 First Call Closure 
Rate

First call closure rate BIC_PARTY_SUMM. FIRST_
CALL_CL_RATE

Both Persons 
and 
Organization 
Contacts

134 Number of 
Complaints

Number of complaints 
or escalated calls

BIC_PARTY_SUMM. NO_OF_
COMPLAINTS

Both Persons 
and 
Organization 
Contacts

135 Number of 
Interactions

Total number of 
interactions

BIC_PARTY_SUMM. NO_OF_
INTERACTIONS

Both Persons 
and 
Organization 
Contacts

136 Number of 
Transfers

Number of transfers 
before resolution

BIC_PARTY_SUMM. NO_OF_
TRANSFERS

Both Persons 
and 
Organization 
Contacts

137 Number of Open 
Service Requests

Total number of open 
service requests

BIC_PARTY_SUMM. OPEN_
SRS

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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138 Percent of Calls 
Rework

Percent of calls 
requiring rework

BIC_PARTY_SUMM. PERCT_
CALL_REWORK

Both Persons 
and 
Organization 
Contacts

139 Products Number of products 
ordered

BIC_PARTY_SUMM. 
PRODUCTS

Both Persons 
and 
Organization 
Contacts

140 Referrals Total number of 
referrals

BIC_PARTY_SUMM. 
REFERALS

Both Persons 
and 
Organization 
Contacts

141 Number of 
Reopened Service 
Requests

Total number of 
reopened service 
requests

BIC_PARTY_SUMM. 
REOPENED_SRS

Both Persons 
and 
Organization 
Contacts

142 Sales Total number of 
closed sales

BIC_PARTY_SUMM. SALES Both Persons 
and 
Organization 
Contacts

143 Total Service 
Requests Response 
Time

Total response 
(assigned) time of 
service requests 
(average number of 
days between service 
requests open and 
assigned)

BIC_PARTY_SUMM. TOTAL_
SR_RESPONSE_TIME

Both Persons 
and 
Organization 
Contacts

144 Percent First 
Closed Service 
Requests

Percent of service 
requests closed on the 
first call

BIC_PARTY_SUMM. AVG_
CLOSED_SRS

Both Persons 
and 
Organization 
Contacts

145 Number Average 
Complaints

Average number of 
complains

BIC_PARTY_SUMM. AVG_
COMPLAINTS

Both Persons 
and 
Organization 
Contacts

146 Average Hold 
Time

Average hold time BIC_PARTY_SUMM. AVG_
HOLD_TIME

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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147 Average Service 
Employment 
Length

Average length of 
employment of service 
reps on service 
requests logged

BIC_PARTY_SUMM. AVG_
LEN_OF_EMP

Both Persons 
and 
Organization 
Contacts

148 Average Transfers 
per Service 
Requests

Average number of 
transfers for each 
service request

BIC_PARTY_SUMM. AVG_
TRANSFERS_PER_SR

Both Persons 
and 
Organization 
Contacts

149 Average Workload Average workload of 
service reps (average 
number of service 
requests per service 
rep)

BIC_PARTY_SUMM. AVG_
WORKLOAD

Both Persons 
and 
Organization 
Contacts

150 Number of Calls Total number of calls BIC_PARTY_SUMM. CALLS Both Persons 
and 
Organization 
Contacts

151 Average Call 
Length

Average length of a 
call

BIC_PARTY_SUMM. CALL_
LENGTH

Both Persons 
and 
Organization 
Contacts

152 Profitability Total actual revenue 
minus costs of good 
sold divided by total 
actual revenue

BIC_PARTY_SUMM. 
PROFITABILITY

Both Persons 
and 
Organization 
Contacts

No. Attribute Name Description Source
Target 
Audience
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 Configuring Business Intelligence Bins, Reports and C
P

Configuring Business Intelligence Bins,

Reports and Charts

The following table shows the available Bins, Reports and Charts:

Name Type Description

Campaign Effectiveness Bin Summarizes the total number of 
leads and lead amount created 
against campaigns during the 
period

Event Effectiveness Bin Summarizes the total number of 
registrations, leads and lead amount 
created against events during the period

Marketing Activities Bin Summarizes the number of active 
campaign and event schedules for a 
given period

Marketing Budgets Bin Summarizes the amount of budget 
committed, utilized and balance for a 
given period

Response to Lead (Key Metrics) Bin Summarizes the Key Performance 
Indicators from Marketing Online and 
other modules

Budget Utilization (Budget by Total 
Amount)

Report Summarizes budget utilization 
information

Budgets by Activity Report Summarizes budget information per 
activity.

Budgets by Business Unit Report Summarizes budget information per 
business unit
harts P-1



Budgets by Campaign Report Summarizes budget information per 
campaign

Campaign Cost, Revenue and ROI Report Summarizes costs, revenues and return 
on investments per campaign

Campaign Cost and Revenue Report Summarizes costs and revenues per 
campaign

Campaign to Order Report Summarizes order information per 
campaign

Campaigns by Activity Report Summarizes campaign information per 
activity

Campaigns by Budget Amount Report Summarizes budget information per 
campaign

Campaigns by Leads and Opportunities Report Summarizes lead and opportunity 
information per campaign

Event Cost and Revenue Report Summarizes cost and revenue 
information per event

Event Cost, Revenue and ROI Report Summarizes costs, revenues and return 
on investments per event.

Events by Budget Amount Report Summarizes budget information per 
event

Event by Event Type Report Summarizes budget and event 
information per event type

Events by Leads and Opportunities Report Summarizes leads and opportunities 
information per event

Events by Registrants Report Summarizes registration information 
per event

Budget Utilization by Business Unit Chart Summarizes the top ten budgets by 
Business Unit

Budget Utilization by Category Chart Summarizes the top ten budgets by 
Category

Campaigns by Leads Chart Summarizes the top ten campaigns by 
leads

Campaign by Opportunity Chart Summarizes the top ten campaigns by 
opportunities

Name Type Description
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BIN: Campaign Effectiveness
BIN: Campaign Effectiveness

Name 
Campaign Effectiveness

Business Purpose 
This bin summarizes the total number of Leads and Lead Amounts created against 
Campaigns during the period.

Columns

Events by Attendance Chart Summarizes the top ten events by 
attendance

Events by Registrations Chart Summarizes the top ten events by 
registrations

Events by Leads Chart Summarizes the top ten events by leads

Leads and Cost per Lead Chart Summarizes the number of leads to their 
cost.

Note: This is all leads except Dead leads.

Period Period is displayed based on the option chosen in parameter 
‘Aggregate by’. The period displayed is hyper linked to the following 
drill down reports :
� Campaigns by Leads and Opportunities

� Campaigns by Activity

� Campaigns by Budget Amount

� Campaign by Orders

The reports inherit the Bin parameters and their values. However, the 
user has the choice of changing the parameters on the report. 

Lead Total number of leads created against the campaigns during the 
period. This excludes dead leads.

Lead Amount The sum of Lead amount of all leads created against the campaigns 
during the period.

Name Type Description
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BIN: Event Effectiveness
Parameters

BIN: Event Effectiveness

Name
Event Effectiveness

Business Purpose
This bin summarizes the total number of Registrations, Leads and Lead Amounts  
created against Events during the period.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default 
is set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’.

Aggregate By Data can be aggregated by period. Default is Quarter.
� Month  - Aggregates by Month defined in GL Calendar 

associated with the profile option ‘AMS Marketing Calendar’.

� Quarter  - Aggregates by Quarter defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

� Year  - Aggregates by Fiscal Year defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Note: This is all leads except Dead leads.
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BIN: Event Effectiveness
Columns

Parameters

Period Period is displayed based on the option chosen in parameter 
‘Aggregate by’. . The period displayed is hyper linked to the following 
drill down reports :
Events by Leads and Opportunities
Events by Event type
Events by Budget Amount
Events by Registrants

The reports inherit the Bin parameters and their values. However, the 
user has the choice of changing the parameters on the report. 

Registration Total number of registrations created against the events during the 
period.

Lead Total number of leads created against the events during the period. 
This excludes dead leads. 

Lead Amount The sum of Lead amount of all leads created against the events during 
the period. 

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Aggregate By Data can be aggregated by period. Default is Quarter.
� Month  - Aggregates by Month defined in GL Calendar associated 

with the profile option ‘AMS Marketing Calendar’.

� Quarter  - Aggregates by Quarter defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

� Year  - Aggregates by Fiscal Year defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.
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BIN: Marketing Activities
BIN: Marketing Activities

Name
Marketing Activities

Business Purpose
This bin summarizes the number of active Campaign and Event Schedules for a 
given period.

Columns

Parameters

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Period Period is displayed based on the option chosen in parameter 
‘Aggregate by’. 

Count The number of active Campaign and Event Activities at the start of the 
period.

Started The number of Campaign and Event Activities activated during the 
period. 

Ended The number of Campaign and Event Activities that ended during the 
period. 

Change The change from previous value to current value. Formula: ((Current - 
Previous) / Previous) * 100

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.
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BIN: Marketing Budgets
BIN: Marketing Budgets

Name
Marketing Budgets

Business Purpose
This bin summarizes the amount of Budget committed, utilized and balance for a 
given period. Note that only those budgets, which have a presence in the given time 

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Aggregate By Data can be aggregated by period. Default is Quarter.
� Month  - Aggregates by Month defined in GL Calendar associated 

with the profile option ‘AMS Marketing Calendar’.

� Quarter  - Aggregates by Quarter defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

� Year  - Aggregates by Fiscal Year defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

� Incremental ( Day, Week, Month, Quarter, Year )

Aggregated as follows: 

� Day is 24 hours prior to Last Refresh Date/Time. 

� Wk is 7 days prior to Last Refresh Date/Time (Rolling 7 
Days). 

� Mth is from start of current month to Last Refresh 
Date/Time. 

� Qtr is from start of current fiscal quarter to Last Refresh 
Date/Time. 

� Yr is current fiscal quarter plus previous 3 fiscal quarters 
(Rolling 4 Quarters). 

Examples: 
� Day  9-Nov-01 to 10-Nov-01 

� Wk   4-Nov-01 to 10-Nov-01 

� Mth  1-Nov-01 to 10-Nov-01 

� Qtr   1-Sep-01 to 10-Nov-01 

� Yr    1-Dec-00 to 10-Nov-01 0
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BIN: Marketing Budgets
period, is considered for calculating these figures. For example, a budget is active 
for a period of 3 months starting from ’01-Mar-2001’ to ’31-May-2001’. This budget 
is considered for calculating the total committed, utilized and balance amounts only 
for months of March, April and May 2001. 

Columns

Parameters

Period Period is displayed based on the option chosen in parameter 
‘Aggregate by’. The period displayed is hyperlinked to the following 
drill down reports: 
� Budgets by  Utilization

� Budgets by Activity

� Budgets by Campaign

� Budgets by Business Unit

The reports inherit the Bin parameters and their values. However, the 
user has the choice of changing the parameters on the report. 

Committed The sum of all the budget commitments or approvals made during the 
period.

Utilized The sum of all the budgets utilization occurred during the period. 
Budget utilization is recorded only the Actual costs are posted to 
Budgets. 

Balance The sum of the balance of all the budgets which have a presence 
during the period. 

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’
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BIN: Marketing Budgets
Aggregate By Data can be aggregated by period. Default is Quarter.
� Month  - Aggregates by Month defined in GL Calendar associated 

with the profile option ‘AMS Marketing Calendar’.

� Quarter  - Aggregates by Quarter defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

� Year  - Aggregates by Fiscal Year defined in GL Calendar 
associated with the profile option ‘AMS Marketing Calendar’.

� Incremental ( Day, Week, Month, Quarter, Year )

Aggregated as follows: 

� Day is 24 hours prior to Last Refresh Date/Time. 

� Wk is 7 days prior to Last Refresh Date/Time (Rolling 7 
Days). 

� Mth is from start of current month to Last Refresh 
Date/Time. 

� Qtr is from start of current fiscal quarter to Last Refresh 
Date/Time. 

� Yr is current fiscal quarter plus previous 3 fiscal quarters 
(Rolling 4 Quarters). 

Examples: 
� Day  9-Nov-01 to 10-Nov-01 

� Wk   4-Nov-01 to 10-Nov-01 

� Mth  1-Nov-01 to 10-Nov-01 

� Qtr   1-Sep-01 to 10-Nov-01 

� Yr    1-Dec-00 to 10-Nov-01 

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
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BIN: Response to Lead (Key Metrics)
BIN: Response to Lead (Key Metrics)

Name
Response to Lead

Business Purpose
This bin summarizes the Key Performance Indicators from Marketing Online and 
other modules.

Columns

Note: When budget facts are loaded, the program will consider 
pre-approval transactions. When preapproval transactions are 
considered, there may be time periods for which there is no data. 
The summarized data may not have information in the comparative 
period and thus may not be able to display a positive or negative 
value in the form of an arrow.

Key Metrics Key Metrics: 
� Leads,

� ‘A’ Lead Ratio

� Cost per Lead

� Revenue per Lead 

Each key metric is a hyperlink to drilldown detail reports specific to 
each key metric. Currently Leads and ‘A’ Lead Ratio do not drill down 
to any reports. However, Cost per Lead and Revenue per Lead drill to 
the following reports:
� Campaign Cost and Revenue

� Event Cost and Revenue

The reports inherit the Bin parameters and their values. However, the 
user has the choice of changing the parameters on the report. 
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BIN: Response to Lead (Key Metrics)
Value � Leads Shows the total amount of all leads during the period.  
(NOTE:  This is all leads except Dead leads ).

� 'A' Lead Ratio Shows the percentage of 'A' (top) quality leads of 
all leads during the period. ( NOTE:  This is all leads except Deal 
leads. ) The Value is calculated by dividing the number of all 'A' 
quality leads during the period by the total number of leads.

� Cost per Lead Shows the budgetary cost of generating all leads 
during the period. The Value is calculated by dividing the budget 
of all current Campaign and Events during the period by the total 
number of leads. Equally allocated per “active” day.

� Revenue per Lead Shows the booked revenue ratio as a result of 
all leads that were generated during the period The Value is 
calculated by dividing the booked revenue associated with all 
leads during the period by the total number of leads.

Change � Leads : The Change is calculated by comparing the total number 
of leads for the current period with the total number of leads for 
the previous refresh period. E.g. if on October 1 there were 1,000 
leads and on November 1 there were 1,200, to get the % Change, 
take ((1,200 - 1,000)/1,000) * 100. The negative(-) or positive (+) 
signs indicate if the change is up or down from the previous 
period. 

� 'A' Lead Ratio  : The Change is calculated by comparing the 'A' 
quality lead ratio for the current period with the 'A' quality lead 
ratio for the previous refresh period. 

� Cost per Lead  : The Change is calculated by comparing the cost 
per lead ratio for the current period with the cost per lead ratio for 
the previous refresh period.

� Revenue per Lead : The Change is calculated by comparing the 
revenue per lead for the current period with the revenue per lead 
for the previous refresh period. 

Status The Status column is common across all Key Metrics. The indicator 
arrow images mean the following:
� Green Up - Indicates data increasing over the comparison period 

and that for this attribute, an increase is good.

� Green Down - Indicates data decreasing over the comparison 
period and that for this attribute, a decrease is good.

� Red Up - Indicates data increasing over the comparison period 
and that for this attribute, an increase is bad.

� Red Down - Indicates data decreasing over the comparison period 
and that for this attribute, a decrease is bad.
 Configuring Business Intelligence Bins, Reports and Charts P-11



BIN: Response to Lead (Key Metrics)
Status Arrows

Parameters

Column
From Prev 
Period

Green
Up

Green 
Down Red Up

Red 
Down

Leads Increase X

Leads Decrease X

A Leads Increase X

A Leads Decrease X

Cost/Lead Increase X

Cost/Lead Decrease X

Revenue/Lead Increase X

Revenue/Lead Decrease X

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units.  Default 
is set to ‘All’.
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REPORT: Budget Utilization (Budget by Total Amount)
REPORT: Budget Utilization (Budget by Total Amount)

Name
Budget Utilization

Business Purpose
This report summarizes Budget utilization information.

Columns

Fixed Calculation 
Period

Data can be aggregated by period. Default is Quarter.
� Daily  -  Last 24 hours ( Last refresh date )

� Weekly  -  Start of week to current date, up to 7 days. Week begins 
on a Sunday.

� Monthly  -  Start of month, up to 30 days.

� Quarterly  -  Start of current quarter, up to current date.

� Yearly  -  Start of current fiscal year, up to current date.

Examples:
� Daily  9-Nov-01 to 10-Nov-01 

� Weekly 4-Nov-01 to 10-Nov-01 

� Monthly 1-Nov-01 to 10-Nov-01 

� Quarterly 1-Sep-01 to 10-Nov-01 

� Yearly 1-Jun-01 to 10-Nov-01 

Budget Name Budget name

Total This represent total budget minus holdback.

Planned Sum of planned amount. Planned amount is any amount for which 
new campaigns or offers are in Waiting or Approval stage.

Committed Sum of committed amount. Committed amount is any amount for 
campaigns with an Approval status.

Utilized Sum of the amount of total budget earned or used.

Balance Sum of the amount of funds available for further activity. Balance = 
Budget –  Committed 
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REPORT: Budgets by Activity
Parameters

REPORT: Budgets by Activity

Name
Budgets by Activity

Business Purpose
This report summarizes Budget information per Activity.

Columns

Paid Sum of paid amount. Paid amount is the total paid on the promotion, 
amounts deducted on the face of the invoice, rendered checks and 
submitted credit memos.

Category A category in which the budget falls.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units.  Default 
is set to ‘All’.

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Activity Activity name.

Number of 
Budgets

The number of budgets currently opened for this Activity.
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REPORT: Budgets by Business Unit
Parameters

REPORT: Budgets by Business Unit

Name
Budgets by Business Unit

Business Purpose
This report summarizes Budget information per Business Unit.

Columns

Approved Budget 
Amount

The total budget amount allocated to the Activity by approved budget 
lines

Awaiting 
Approval Budget 
Amount

The total budget amount is the combined total amount for Pending 
and Planned for the Activity

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Business Unit Business Unit name.

Number of 
Budgets

The number of budgets currently opened for this business unit.
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REPORT: Budgets by Campaign
Parameters

REPORT: Budgets by Campaign

Name
Budgets by Campaigns

Business Purpose
This report summarizes Budget information per Campaign.

Total This represent total budget

Planned Sum of planned amount. Planned amount is any amount for which 
new campaigns or offers are in Waiting or Approval stage.

Committed Sum of committed amount. Committed amount is any amount for 
campaigns with an Approval status.

Utilized Sum of the amount of total budget earned or used.

Paid Sum of paid amount. Paid amount is the total paid on the promotion, 
amounts deducted on the face of the invoice, rendered checks and 
submitted credit memos.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
P-16 Oracle Marketing Online Implementation Guide 



REPORT: Campaign Cost, Revenue and ROI
Columns

Parameters

REPORT: Campaign Cost, Revenue and ROI

Name
Campaign Cost, Revenue and ROI

Business Purpose
This report summarizes Costs, Revenues and Return on Investments per Campaign.

Campaign Name Campaign name.

Number of 
Budgets

The number of budgets currently opened for this Campaign.

Approved Budget 
Amount

The total budget amount allocated to the Activity by approved budget 
lines.

Awaiting 
Approval Budget 
Amount

The total budget amount is the combined total amount for Pending 
and Planned for the Activity

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
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REPORT: Campaign Cost, Revenue and ROI
Columns

Parameters

Campaign Campaign name.

Actual Cost Period to-date cost  -  The cumulative amount of the approved budget 
for the period.

Forecasted Cost From Metrics value. Summarize schedule cost and the parent cost.

Cost Variance ((actual – forecast) / forecast) * 100

Actual Revenue Booked order amount in Quoting/Order Capture.

Forecasted 
Revenue

From Metrics value. Summarize schedule revenue and the parent 
revenue.

Revenue Variance ((actual – forecast) / forecast) * 100

Actual ROI ((actual revenue - actual cost) /  actual cost ) * 100

Forecasted ROI ((forecast rev - fore cost) /  forecast cost ) * 100

ROI Variance ((actual - forecast) / forecast) * 100

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Period Data can be aggregated by period. Default is Current Quarter.
� A list of all fiscal Years

� A list of all quarters
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REPORT: Campaign Cost, Revenue and ROI
REPORT: Campaign Cost and Revenue

Name
Campaign Cost and Revenue

Business Purpose
This report summarizes Costs and Revenues per Campaign.

Columns

Campaign Campaign Name.

Total Cost Period-to-date cost - The cumulative amount of the approved budget 
for the period.

Total Revenue Period-to-date revenue - The cumulative amount of revenue for the 
period. This is booked order in the CRM schema for actual revenue.

Response Count The sum of positive responses for the period.

Cost Per 
Response

Total approved budget amount for the campaigns for the activity 
divided by the number of cumulative responses.

Revenue Per 
Response

The sum of the revenue for that period divided by the number of 
responses for that period.

Response Lead 
Count

Total number of leads created against the campaigns during the 
period. This excludes dead leads.

Cost per Lead The sum of Period-to-date cost divided by the sum of lead count.

Revenue per Lead The sum of the revenue for that period divided by the sum of leads for 
that period.

Order Count The number of booked orders.

Cost per Order The total booked order amount divided by the number of orders 
booked. 

Revenue per 
Order

The sum of the revenue for that period divided by the sum of orders 
for that period.
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REPORT: Campaign to Order
Parameters

REPORT: Campaign to Order

Name
Campaigns to Orders

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’.

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Fixed Calculation 
Period

� Data can be aggregated by period. Default is Quarter.

� Daily  -  Last 24 hours ( Last refresh date )

� Weekly  -  Start of week to current date, up to 7 days. Week begins 
on a Sunday.

� Monthly  -  Start of month, up to 30 days.

� Quarterly  -  Start of current quarter, up to current date.

� Yearly  -  Start of current fiscal year, up to current date.

Examples:  
� Daily  9-Nov-01 to 10-Nov-01 

� Weekly 4-Nov-01 to 10-Nov-01 

� Monthly 1-Nov-01 to 10-Nov-01 

� Quarterly 1-Sep-01 to 10-Nov-01 

� Yearly 1-Jun-01 to 10-Nov-01 
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REPORT: Campaign to Order
Business Purpose
This report summarizes Order information per Campaign.

Columns

Parameters

Campaign Name Campaign name.

Total Responses Sum of responses, collected in Interaction History, based on the 
aggregate. 

Converted to 
Leads

Sum of responses converted to a lead based on aggregate.
( ( open + closed leads) / total responses ) * 100

Open Leads Total number of leads created against the campaigns which are open 
during the period.

Close Leads Sum of Leads closed based on aggregate. All closed leads regardless of 
qualified/unqualified.

Converted to 
Orders

Sum of Leads converted to orders based on aggregate.
( ( total orders of all statuses ) / ( open + closed leads ) ) * 100

Orders Booked The dollar amount of the sum of orders booked based on the 
aggregate.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
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REPORT: Campaigns by Activity
REPORT: Campaigns by Activity

Name
Campaigns by Activity

Business Purpose
This report summarizes Campaign information per Activity.

Columns

Parameters

Activity Activity name.

Count This is the number of Campaigns associated to this activity during the 
period.

Target Audience The total target audience for this Activity during the period.

Lead Total number of leads created against the campaigns during the 
period. This excludes dead leads. 

Lead Amount The sum of Lead amount of all leads created against the campaigns 
during the period.

Opportunities Total number of opportunities created against the campaigns during 
the period. 

Opportunity 
Amount

The sum of opportunity amount of all opportunities created against 
the campaigns during the period.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in JTF locations with location type 
‘COUNTRY’. User can choose a Country or ‘All’ for all Country. 
Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. Default 
is set to ‘All’.
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REPORT: Campaigns by Budget Amount
REPORT: Campaigns by Budget Amount

Name
Campaigns by Budget Amount

 Business Purpose
This report summarizes Budget information per Campaign.

Columns

Parameters

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Campaign Name Campaign name.

Activity Type Activity Type name.

Activity Activity name.

Business Unit Business Unit name.

Approved Budget 
Amount

The total budget amount allocated to the Activity by approved budget 
lines

Awaiting 
Approval Budget 
Amount

The total budget amount is the combined total amount for Pending 
and Planned for the Activity

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.
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REPORT: Campaigns by Leads and Opportunities
REPORT: Campaigns by Leads and Opportunities

Name
Campaigns by Leads and Opportunities

Business Purpose
This report summarizes Lead and Opportunity information per Campaign.

Columns

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Campaign Name Campaign name.

Targeted 
Customers

The total target audience for this Activity during the period.

Lead Total number of leads created against the campaigns during the 
period. This excludes dead leads. 

Lead Amount The sum of Lead amount of all leads created against the campaigns 
during the period.

Opportunities Total number of opportunities created against the campaigns during 
the period. 

Opportunity 
Amount

The sum of opportunity amount of all opportunities created against 
the campaigns during the period.
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REPORT: Event Cost and Revenue
Parameters

REPORT: Event Cost and Revenue

Name
Event Cost and Revenue

Business Purpose
This report summarizes Cost and Revenue information per Event.

Columns

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Event Event Name

Total Cost Period-to-date cost - The cumulative amount of the approved budget 
for the period.

Total Revenue Period-to-date revenue - The cumulative amount of revenue for the 
period. This is booked order in the CRM schema for actual revenue.

Registration 
Count

The sum of registrations for the period.

Cost per 
Registration

Total approved budget amount for the events for the activity divided 
by the number of cumulative registrations.
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REPORT: Event Cost and Revenue
Parameters

Revenue per 
Registration

The sum of the revenue for that period divided by the sum of 
registrations for that period.

Lead Count Total number of leads created against the campaigns during the 
period. This excludes dead leads.

Cost per Lead The sum of Period-to-date costs divided  by the sum of Lead Count.

Revenue per Lead The sum of the revenue for that period divided by the sum of leads for 
that period.

Order Count The number of booked orders.

Cost Per Order The total booked order amount divided by the numbers of orders 
booked.

Revenue per 
Order

The sum of the revenue for that period divided by the sum of orders 
for that period.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
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REPORT: Event Cost, Revenue and ROI
REPORT: Event Cost, Revenue and ROI

Name
Event Cost, Revenue and ROI

Business Purpose
This report summarizes Costs, Revenues and Return on Investments per Event.

Columns

Fixed Calculation 
Period

Data can be aggregated by period. Default is Quarter.
� Daily  -  Last 24 hours ( Last refresh date )

� Weekly  -  Start of week to current date, up to 7 days. Week begins 
on a Sunday.

� Monthly  -  Start of month, up to 30 days.

� Quarterly  -  Start of current quarter, up to current date.

� Yearly  -  Start of current fiscal year, up to current date.

Example:  Current date is November 10, 2001
� Daily  9-Nov-01 to 10-Nov-01 

� Weekly 4-Nov-01 to 10-Nov-01 

� Monthly 1-Nov-01 to 10-Nov-01 

� Quarterly 1-Sep-01 to 10-Nov-01 

� Yearly 1-Jun-01 to 10-Nov-01 

Actual Cost Period to-date cost  -  The cumulative amount of the approved budget 
for the period.

Forecasted Cost From Metrics value. Summarize schedule cost and the parent cost.

Cost Variance ((actual – forecast) / forecast) * 100

Actual Revenue Booked order amount in Quoting/Order Capture.

Forecasted 
Revenue

From Metrics value. Summarize schedule  revenue and the parent 
revenue.

Revenue Variance ((actual – forecast) / forecast) * 100

Actual ROI ((actual revenue - actual cost) /  actual cost ) * 100
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REPORT: Events by Budget Amount
Parameters

REPORT: Events by Budget Amount

Name
Events by Budget Amount

Business Purpose
This report summarizes Budget information per Event

Columns

Forecasted ROI ((forecast rev - fore cost) /  forecast cost ) * 100

ROI Variance ((actual - forecast) / forecast) * 100

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Period Data can be aggregated by period. Default is Current Quarter.
� A list of last 4 fiscal Years

� A list of last 16 quarters

Event Event name.

Type Event Type name.
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REPORT: Events by Event Type
Parameters

REPORT: Events by Event Type

Name
Events by Event Type

Business Purpose
This report summarizes Budget and Event information per Event Type.

Columns

Business Unit Business Unit name.

Approved Budget 
Amount

The total budget amount allocated to the Event by approved budget 
lines.

Awaiting 
Approval Budget 
Amount

The total budget amount is the combined total amount for Pending 
and Planned for the Event.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Event Type Event Type name.

Number of Events The number of Events associated with this Event Type.
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REPORT: Events by Leads and Opportunities
Parameters

REPORT: Events by Leads and Opportunities

Name
Events by Leads and Opportunities

Business Purpose
This report summarizes Leads and Opportunities information per Event.

Approved Budget 
Amount

The total budget amount allocated to the Event by approved budget 
lines.

Awaiting 
Approval Budget 
Amount

The total budget amount is the combined total amount for Pending 
and Planned for the Event.

Registrants The sum number of registrations for this event type for the period.

Attendees The sum number of attendees for this event type for the period.

Cancellations The sum number of cancellations for this event type for the period.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
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REPORT: Events by Registrants
Columns

Parameters

REPORT: Events by Registrants

Name
Event by Registrants

Business Purpose
This report summarizes Registration information per Event

Event Event name.

Leads Total number of leads created against the campaigns during the 
period. This excludes dead leads. 

Lead Amount The sum of Lead amount of all leads created against the campaigns 
during the period.

Opportunities Total number of opportunities created against the campaigns during 
the period. 

Opportunity 
Amount

The sum of opportunity amount of all opportunities created against 
the campaigns during the period.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions
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CHART: Budget Utilization by Business Unit
Columns

Parameters

CHART: Budget Utilization by Business Unit 

Name
Budget Utilization by Business Unit

Business Purpose
This chart summarizes the top ten Budgets by Business Unit.

Columns

Event Name Event name.

Registrants The sum number of registrations for this event type for the period.

Attendees The sum number of attendees for this event type for the period.

Cancellations The sum number of cancellations for this event type for the period.

Region Lists all Regions defined by geographic area Region (geographic area 
location 2). User may choose a region or ‘All’ for all Regions. Default is 
set to ‘All’.

Country Lists all Countries defined in geographic area Country. User may 
choose a Country or ‘All’ for all Country. Default is set to ‘All’.

Business Unit Lists all business units defined in HR Organizations with type ‘BU’. 
User can choose a business unit or ‘All’ for all business units. . Default 
is set to ‘All’

Scale by Scale the amount columns by user choice. Available options:
� Units

� Hundreds

� Thousands

� Millions

Budget Budget information.
P-32 Oracle Marketing Online Implementation Guide 



CHART: Campaigns by Leads
Parameters

CHART: Budget Utilization by Category

Name
Budget Utilization by Category

Business Purpose
This chart summarizes the top ten Budgets by Category.

Columns

Parameters

CHART: Campaigns by Leads

Name
Campaign by Leads

Business Purpose
This chart summarizes the top ten Campaigns by Leads.

Columns

Business Unit Business Unit name.

No parameters available at this time.

Budget Budget information.

Category Category name.

No parameters available at this time.

Campaign Campaign name.
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CHART: Campaign by Opportunity
Parameters

CHART: Campaign by Opportunity  

Name
Campaign by Opportunity

Business Purpose
This chart summarizes the top ten Campaigns by Opportunities.

Columns

Parameters

CHART: Events by Attendance

Name
Events by Attendance

Business Purchase
This chart summarizes the top ten Events by Attendance.

Columns

Leads The number of leads to Campaign..

No parameters available at this time.

Campaigns Campaign Name

Opportunities Opportunities

No parameters available at this time.

Events Event name.
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CHART: Events by Leads
Parameters

CHART: Events by Registrations

Name
Events by Registrations

Business Purpose
This chart summarizes the top ten Events by Registrations

Columns

Parameters

CHART: Events by Leads

Name
Events by Leads

Business Purpose
This chart summarizes the top ten Events by Leads

Columns

Attendance The number of attendees to the Event.

No parameters available at this time.

Event Event name.

Registration The number of registrations to the Event.

No parameters available at this time.

Event Event name.
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CHART: Leads and Cost per Lead
Parameters

CHART: Leads and Cost per Lead

Name
Leads and Cost per Lead

Business Purpose
This Chart summarizes the number of Leads to their Cost.

Columns

Parameters

Leads The number of leads to Event.

No parameters  available at this time.

Cost Per Lead

Leads

No parameters available at this time.
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A
Account Payable, 5-61
Accounting Calendar, 4-2
Accounting Calendar Types, 4-2
Accounts Payable, 2-3, 4-17, 5-61, 5-64
Accounts Receivable, 2-3, 4-17, 5-36, 5-61, 5-63
Accrual Liability Account, 6-41
Accrual Liability account, 5-8, 5-65
Accrual UOM Class, 5-22
Activate Schedule, 5-6
Activities, 6-19
Activity, 6-17, B-1
Activity Type, 6-19, B-1
Activity Types, 6-19
Address Key Length, 5-34
Admin Group, 4-19
Administration, iv-xiv
Administration Options, 3-2
Administration Setup, 4-22, 5-3, 5-6, 5-14, 5-20, 

5-35, 5-56, 5-59, 5-70
Administration tab, 4-14
Advanced Outbound, 2-3, 8-2
Advanced Outbound Concepts and Procedures 

Guide, iv-xvi
Advanced Pricing, 2-2
Advanced Pricing Implementation Guide, iv-xvi
Advanced Pricing User Guide, iv-xvi
Advanced Search, 1-15
Advertising, 6-19
AMS, 1-21, 3-2, 3-3, 3-4, 4-3, 4-14, 4-18, 4-19, 4-20, 

4-21, 4-29, 5-3, 5-6, 5-9, 5-12, 5-13, 5-15, 5-16, 
5-22, 5-27, 5-30, 5-33, 5-35, 5-37, 5-38, 5-39, 5-40, 
5-44, 5-47, 5-48, 5-50, 5-53, 5-58, 5-62, 5-63, 5-65, 

5-68, 5-69, 6-10, 6-25, 6-26, 6-28, 6-30, 6-37, 6-41, 
7-4, 7-6, 7-7, 8-2

See also Profile Options
Analytical Reports, 1-2, 1-4
Analytics, B-1
AO

See Oracle Advanced Outbound
AP, 1-19, 5-71, E-3

See also Accounts Payable
Apache, 2-1
Approval, 6-16
Approval Process Overview, 6-25
Approval Rules, 1-3, 1-13, 5-62, 6-24, 6-28, 6-29, 

6-30
Approvals, 6-18, 6-29
AR, 1-18, 1-19, 6-40

See also Accounts Receivables
Assign Approvers, 6-29
Assigning Attributes, 4-7
Attachment, B-1
Attributes, 4-7, 6-18
Audience, B-1
Audience tab, 4-14
Auto Assignment, 6-42
Auto Register for Events Upon Cancellation, 5-15
AutoInvoice, 5-63, 5-64
AutoInvoice - Oracle Receivables, 5-69
Autopay, 6-42

B
B2B, 5-27, 5-31, 6-32, A-1, C-5, G-1, G-3
B2B2C, A-1
B2C, 5-27, 5-31, 6-32, A-1, C-5, G-1, G-5, G-7
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BI Beans, 2-1
Bin Directory, 5-32
Budget, 1-2, 1-6, 4-29, 5-8, 5-9, 5-14, 6-12

Allocation, 1-7
Categories, 1-7
Checkbook, 1-7, 1-9
Management, 1-17
Threshold, 1-7
Utilization, 1-4

budget, 6-15
Budget Adjustment, 6-34
Budget Adjustments

Decrease Budget Commitment and 
Utilization, 6-35

Decrease Budget Commitments, 6-34
Decrease Budget Utilization, 6-35
Increase Budget Utilization, 6-35

Budget Approval, 6-24
Budget Line Approvals, 6-29
Budget Lines Requests, 6-24
Budget Request Approval, 6-24
Budget Threshold, 6-36
Budget Threshold Rule, 6-37
Budget Thresholds, 6-35
Budget Transfer, 6-29
Budget Transfer approvals, 6-24
Business Function Implementation, iv-xiv
Business Groups, 4-6
Business Rules, 6-19, B-1

C
Call Center, 8-2
Campaign, 1-10, 5-2, 5-3, 5-7, 5-14, 5-43, 5-52, 6-14, 

6-24, B-2
Event Association, 1-10

Campaign Approvals, 6-29
Campaign Planning

Event Association, 1-3
Pin Code, 1-3
Triggers, 1-3

Campaign Schedule, 5-2, 5-25, 5-52, 6-14, 6-24
Campaign Status, 6-23
Categories, 6-11, 6-13, 6-14

Approval Rules, 6-12

Budgets, 6-12
Custom Setups, 6-12
Deliverables, 6-12
Events, 6-12
Metrics, 6-12

Claim, 5-64, B-2
Claim Actions, 6-38
Claim Settlement Process, 5-62
Claim Type, 5-70, 6-42, 6-43
Claims, 5-61, 5-65, 5-70, 5-71, 6-24
Claims Aging Population, 5-68
Claims Autopay, 5-68
Claims Settlement, 5-63
Claims Settlement Fetcher, 5-69
Claims Settlement Workflow, 5-62
Claims System Parameters, 6-41
CLASSPATH, 5-39
Closed-Loop Marketing, B-2
Collaboration, 6-16
Collection, 6-14
Component Group, 6-18
Component Groups, 6-16
Components, 6-18
Concept Approval, 6-24
Concurrent Manager, 3-2, 4-14, 4-18, 4-21, 4-25, 

4-29, 5-6, 5-12, 5-29, 5-38, 5-40, 5-55, 5-56, 5-68, 
6-30, 7-4

concurrent manager, 4-20, 4-22, 5-13, 5-35, 5-70
Concurrent Manager Programs

Group Access Refresh, 4-14
Confirmation Messages, 1-15
Contact Group, 1-2, 1-5
Control Group, 1-2, 1-5
Copy Event Details to Event Schedules, 5-16
Cost, B-2
Costs, 1-6
Country Filter, 1-14
Credit Memo, 6-42
CRM

See Customer Relationship Management
CRM Foundation Implementation Guide, iv-xvi
CRM Foundation Technical Reference 

Manual, iv-xvi
CSV, 1-19, A-1
Currency Conversion Rate Types, 4-4
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Currency Conversion Rates, 4-3
Currency Conversion Type, 4-19
Custom Condition Class, 5-53
Custom Setups, 6-14, 6-17
Custom setups, 6-19
Customer, B-2
Customer Relationship Management, iv-xvi
Customer Resource Management, iv-xiii, iv-xiv, 

iv-xv, iv-xvi, 1-1, 1-8, 2-2, 4-5, 4-13, 4-14, 4-15, 
4-16, 4-17, 4-21, 5-25, 5-36, 5-38, 6-26, 7-3, 7-4, 
7-5, 8-1, 8-2, B-2, M-1

D
Data Mining, 5-36, 5-40, 5-42
Data Mining Engine Output Schema, 5-39
Data Mining Engine Program Property File, 5-40
Data Sources, 6-31
Database Administrator, A-1
Database Link in the CRM Schema, 5-38
DBA, A-1
Deal, 6-14
Debit Memo, 6-42
Decrease Budget Commitment and 

Utilization, 6-35
Decrease Budget Commitments, 6-34
Decrease Budget Utilization, 6-35
Deduplication, B-2
Default Budgets, 8-2
Default Currency Code, 4-19
Default Marketing Approver, 6-26, 6-27
Default Product Stylesheet, 5-53
Default Schedule Stylesheet, 5-53
Deliverable, 5-14, 5-43, 5-50, 5-51, 6-12, 6-14, 6-24, 

B-2
Deliverables, 6-13
Dependencies

Required, 2-2
Dependencies, Conditional for TM, 2-2
Dependency Components, 4-15
Direct Marketing, 6-20
Discoverer, 1-2, 5-29, 5-30, B-2
Discoverer End User Layer, 5-26
Discoverer Launcher, 5-26
Discoverer Use Viewer, 5-27

Discoverer Viewer Launcher, 5-27
Display Sequence, 6-18
DNC

See Do Not Call
Do Not Call, A-1
Documentation Accessibility, iv-xiv

E
eBusiness, iv-xiv, 1-1
Email, 1-3

Content Composition, 1-11
Mail Merge, 1-11
Preview, 1-11

Employee, 7-1
Create, 4-12

Employee Setups, Optional, 7-5
Employees, Import, 7-3
Enabling Additional Currencies, 4-3
End User Layer, 5-26, 5-29, C-9, L-1, L-2, L-3, L-4
Enterprise Resource Planning, iv-xiii, iv-xvii, 

iv-xviii, 1-1, 1-8, 4-6, A-1, B-2
ERP, A-1
EUL

See End User Layer
Event, 4-29, 5-7, 5-8, 5-14, 5-16, 5-21, 5-25, 5-43, 

6-12, 6-14, 6-24, B-2
Registration, 1-11

Event Approvals, 6-29
Event Planning, 1-11
Event Promotion, 6-14
Event Registration, 1-3
Event Schedule, 5-14, 5-15, 5-52, 6-14, 6-24
Event, One-Off, 6-14
Execution, 6-16
Execution Channels, 6-2
Expire Data Mining Models, 5-40

F
Field, B-3
Field Service, 5-36
Flexfield, 5-63

Line Transaction, 5-63
Flexfield Guide, iv-xv
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Flexfields, 8-2
Foundation Components, 4-15
Fulfillment Resource Group, 5-7
Function Metrics, 6-7
Funds Accrual Engine, 5-12

G
General Ledger, 1-3, 1-9, 1-17, 2-2, 2-3, 4-2, 4-19, 

5-8, 5-9, 5-14, 5-61, 5-64, 5-71, 6-2, 6-7, 6-12, 6-13, 
6-40, 6-41, C-2, C-7, E-2, E-3, E-4

Set of Books, 4-4
General Ledger Data Type, 6-41
General Ledger Super User, 4-2
Generate Suppression list, 5-30
Geographic Area, 6-33
Geographic Hierarchies, 4-21
Geographic Location Type, 6-33
Geography, 6-33
GL

See General Ledger
Grace Period, 4-20
GRE, 4-8, A-2
Group Access Refresh, 4-14, 4-21, 7-4
Group By, 5-30
Group Member Role

Sales Representative, 4-14
Groups, 7-3

Usages
Sales, 4-14
TeleSales, 4-14

Groups, Define, 7-4
Guest User, 5-59
GUI, iv-xv, A-2

H
History Rule, 5-70
Home Page, 1-4, 4-23
Home Page Components, 4-24
Home Page File Name, 4-20
HR

See Human Resources
HRMS

See Oracle HRMS

HRMS Manager Responsibility, 7-2
HTML, iv-xiv, 2-2, 5-4, 6-15, A-2, B-4, D-3, I-1, I-3
html, L-4
Human Resources, 2-3, 3-5, 4-4, 4-7, 4-8
Human Resources Organization, 4-7
HZ Dedupe Rule, 5-33

I
ICX, 5-26, 5-27, 5-29, A-2, C-9, L-3, L-4
Implement Contra Charge, 5-65
Implement Payables, 5-65
Implementation Sequence, 3-4
Implementation User, 4-1, 4-11, 4-13
Import Claims, 5-69
Import Control File Path, 5-33
Import Date File Path, 5-33
Import Employees, 4-14
Import Territory Hierarchy, 5-13
Increase Budget Utilization, 6-35
Initial Build of Campaigns, 4-26
Initial Build of Events, 4-27
Initial Build of Funds, 4-27
Install Base, 2-3
In-store, 6-20
Insufficient Privileges, 4-23
Integration Points, 2-3
Interaction, B-3
Interaction History, 2-3, 8-2
Interactions History, 5-36
InterMedia, 2-1
Inventory, 2-3

Attributes, 1-8
Category Support, 1-8

iStore, 2-3
Item Validation Master Organization, 5-50
Item Validation Organization, 5-22, 5-53

J
Java Developer Kit, 2-1
Java Runtime Environment, A-2
Java Server Page, 4-20, A-2, C-9, I-1, I-2, I-3, I-4
JInitiator, 2-1
JRE, A-2
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JSP, 4-20, A-2, C-9, I-1, I-2, I-3, I-4
JTF, 4-19, 4-20, 5-59, A-2, C-1, C-3, C-9, J-5
JTF Home Page File Name, 4-20

K
Key Word Count, 5-33

L
Leads, 1-4
Legal Entity, 4-7
Link, B-3
List, 1-2, 1-6, 5-14, 5-25, 5-27, 5-30, B-3

Management, 1-4
Trackable Pin Code, 1-10

List Export, 1-2, 1-5, 1-12
List Import, 1-2, 1-5, 5-31, 5-34, 5-35
List Import Table, B-3
List Import Types, 5-31

Event Registration, 5-31
Existence Checking, 5-32
Lead Import, 5-32

List of Values, 4-7, 4-8, 4-15, 4-17, 4-19, 4-22, 5-7, 
5-14, 5-21, 5-24, 5-27, 5-42, 5-70, 6-19, 6-23, 6-27, 
6-39, 6-40, 7-5, B-3, C-3, C-5, E-1, E-2, I-1

List Workbook B2B Marketing, 5-27
List Workbook B2C Marketing, 5-27
Load Geographic Hierarchies, 4-21
Locations, 4-6
Locking Rule, 1-14
Locking Rules, 1-4, 6-23
Lookups, 3-2, 4-24, 5-3, 5-9, 5-16, 5-23, 5-27, 5-34, 

5-40, 5-44, 5-48, 5-50, 5-54, 5-58, 5-65
Extensible, 3-2
System, 3-2
User, 3-2

LOV
See List of Values

M
Mandatory Attribute, 6-18
Mandatory Field, 1-14
Mandatory Fields, 1-3

Mandatory Rules, 6-24
Manual Metrics, 6-7
Marketing Approver, 6-26
Marketing Calendar, 4-2
Marketing Common Components, 4-18
Marketing Encyclopedia, iv-xvi, 2-3, 8-1
Marketing Facts Load, 4-25
Marketing Materialized views prebuilt tables, 4-29
Marketing Materialized views Refresh, 4-29
Marketing Medium, 6-21, B-3
Marketing Mediums, 6-2
Marketing Object, B-3
Marketing to ODM Database Link, 5-39
Menu Items, 6-15
Merchandising Strategy, B-3
Merchant Party ID, 5-58
Message, B-3
Messages, 5-14
Metric, B-4
Metrics, 1-2, 6-12, 6-13

Programs, 6-10
Metrics Concurrent Engine, 6-10
Minimum search string length, 4-20
Multi Org Responsibilities, 4-9
Multi-Channel Execution, 1-11
Multiple Components to Same Responsibility, 4-23
Multiple Currencies, 3-3

Budget, 3-3
Campaign, 3-3
Claims, 3-4
Deliverable, 3-3
Event, 3-3
Offer, 3-3

N
NFS Mount, 5-35
Note Types, 4-16
Notes, 2-2

O
OA Media, 5-53
Object Approval, 6-24
Obsolete in this Release
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iMarketing, 1-20
Obsolute in this Release

Marketing Online, 1-19
ODM

See Oracle Data Mining
ODM Data Input, 5-38
ODM Property File, 5-37
odmapi.jar, 5-39
Offer, 5-21, 5-23, 5-24, 5-25, 5-43, 6-14, 6-24, B-4

Management, 1-8
Reuse, 1-9

Offer Management, 1-3
Offer Types, 1-9
Offers, 1-9
OIC

See Oracle Incentive Compensation
OMO, 5-38

See Oracle Marketing Online
One to One Fulfillment, 2-2, 5-7, 8-1
One to One Fulfillment Concepts and Procedures 

Guide, iv-xvii
One-Off Event, 6-14, 6-24
Operating Unit, 4-7
Opportunities, 1-4
oputil.jar, 5-39
Orace Inventory, 5-15
Oracle 8 Enterprise Edition, 2-1
Oracle 9i Data Mining, 5-36
Oracle Advanced Pricing, 2-3, 4-17, 5-15, 5-21, 5-43
Oracle Bill of Materials, 5-43
Oracle Data Mining, 5-36, 5-37, 5-38, 5-39, 5-40, 

C-2, C-5
Oracle Database Server, 2-1
Oracle Discoverer, 2-1, 5-25, 5-31
Oracle HRMS, iv-xvi, 2-2, 3-5, 4-1, 4-4, 4-5, 4-6, 4-7, 

4-12, 4-13, 7-2
Oracle Inventory, 2-2, 4-9, 5-21, 5-43, 5-49
Oracle Inventory Guide, iv-xvi
Oracle iStore, 4-17, 5-2, 5-52, 5-57, B-3
Oracle Marketing Administrator, 4-13, 4-21, 4-24, 

4-25, 5-3, 5-6, 5-9, 5-12, 5-16, 5-23, 5-27, 5-29, 
5-34, 5-40, 5-50, 5-54, 5-55, 5-58, 5-65, 5-68

Oracle Marketing Online, 5-31, 5-38, 5-44, 5-47, 
5-48, B-5, C-1, H-1, J-5

Oracle MetaLink, iv-xvii

Oracle Order Management, 2-3, 5-2, 5-21, 5-46
Oracle Partners Online, 5-25, 5-52, 5-57, 8-1
Oracle Personalization Enabled, 5-58
Oracle Quoting-Forms, 5-21, 5-36, 5-46
Oracle Sales Online, 4-20, 5-2, 5-21, 5-31, C-9
Oracle Scripting, 2-3, 8-1
Oracle TeleSales, 5-2, 5-15, 5-21, 5-25
Oracle Telesales, 5-49
Oracle Territory Manager, 2-3
Oracle University, iv-xvii
Oracle WebDB, 2-1
Oracle9i Data Mining, 2-1
Order Quoting-Forms, 5-15, 5-21
Orders, 1-4
Organization Types, 4-5
Organizations, 4-6
OSO

See Oracle Sales Online
OTS

See Oracle TeleSales
Overview, iv-xiv, 3-1
overview, iv-xiii
Owner, B-4

P
Page, B-4
Partner Relationship Management, 2-3
Payables Open Interface Import - Oracle 

Payables, 5-70
Payables Payment Term, 6-42
Payables Source, 6-42
Performance Matrix, B-4
Personal Home Page, 6-31
Personalized View, 1-14
Personalized Views, 1-3
PHP

See Personal Home Page
PIN, 1-3, 1-10, A-2
Placement, B-4
Planning, 6-16
Portal Cache Daemon, 4-21
Post Implementation, iv-xiv
Post Installation, 8-3
Postal Code Key Length, 5-34
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Posting, B-4
Posting Rule, B-4
Posting Runtime Shopping Cart Currency, 5-53
Preferred Vendor, 6-3
Prefix to Registration Confirmation Code, 5-16
Press and Analyst Relations, 6-20
Price List, 5-46, 5-48, 6-14
Pricelist, 6-24
Pricing, 1-8, 1-9
Product, 1-2, 1-7, 1-8, 1-9, B-4
Product Family, B-5
Products, 5-43, 5-44, 5-46, 5-52
Profile Options, 3-1, 3-2, 4-13, 7-3

Application, 3-1
Responsibility, 3-1
User, 3-1

Profile Search Set Size, 4-19
Program, 5-2, 5-3, 5-7, B-5
Programs, 1-10, 5-14
Prospects, B-5
Purge Imported List, 5-30
Purge Target Group, 5-30

Q
QP, 5-22, 5-23, 5-47, 5-48, A-2, C-1, C-9, C-10

R
Rapid Install, iv-xv
Reasons, 5-70, 6-39
Receivable Batch Source, 6-42
Receivable Clearing Account, 6-41
Receivables Clearing account, 5-65
Record, B-5
Refresh of Campaigns, 4-27
Refresh of Events, 4-28
Refresh of Funds, 4-28
Refresh Party Market Segments, 5-30
Relationship Type for Buying Group, 5-22
Release Committed Budget Amount After Grace 

Period, 5-13
Rented lists, 5-30
Reports Security, 4-23
Resource Manager, 2-2, 4-14, 4-15

Response, B-5
Responsibilities

General Ledger Super User, 4-2
ROI, 1-1, 1-2, 1-4, 1-15, 6-22, A-2
Role

Receivable, 5-62
Role Types, 6-26
Roles, 6-27, 7-3
Rollup Cost, B-5
Rollup Metric, B-5
Rollup Metrics, 6-9
Root Budget, 6-29
Root Budget Approval, 6-25
Root Budget Approvals, 6-24
Rounding, 6-41

S
Sales Credit Data Validation, 5-64
Sales Expense Account, 6-41
Sales Expense account, 5-8, 5-65
Sales Online, iv-xvi
Schedule, B-5
Search Lead Wildcard, 4-20
Security, 1-15
Security for Sales Online Pages, 7-7
Segment, 1-2, 1-4, 1-6, 5-52, B-5

Hierarchy, 1-6
Server URL, 5-58
Set of Books, 4-4
Should Call to Inventory Modules be Made, 5-16, 

5-50
Should Call to Pricing Modules be Made, 5-16, 

5-50
Show GL Accounts on Screen, 5-9
Show in Reports, 6-18
SIC, 1-6, A-2
Side Navigation Menu, 6-15
Single Component to Multiple 

Responsibilities, 4-23
Source Code, B-5
Source Code Date Format, 4-19
Source Code Sequence Length, 4-19
Source Codes, 6-15
Source from Parent, 6-28
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Source from Parent Object, 5-9
Source System Code, 5-23
SQL, 5-28, 5-30, 5-32, 6-5, 6-7, 6-8, 6-10, A-2, B-2, 

B-6, D-15, D-16
sql, J-3, J-5
SQL Loader, 5-32
Status, B-6
Structured Query Language, B-6
Stylesheets, 5-60
Subtab, B-6
Suffix, 6-18
Summary Data Export, 1-14
Summary Metrics, 6-8
Summary Page, B-6
Support, iv-xvii
Suppression Filters, 1-2, 1-5
Synonyms, 5-38
System Administrator’s Guide, iv-xv
System Parameter, 5-70
System Parameters, 6-41
System Profiles, 4-15, 4-18, 5-8, 5-15, 5-22, 5-26, 

5-33, 5-39, 5-43, 5-47, 5-49, 5-52, 5-57, 5-65, 6-27
System Status, 6-22, 6-23

T
Tab, B-6
Task Manager, 2-2, 4-15
Task Template, 6-38
Tasks, 2-2
TCA, B-6

See Trading Community Architecture
TCA Best Practices White Paper, 5-30
Team Access Refresh, 4-21
Telemarketing, 1-3, 1-12
Territory Manager, 2-3, 8-1
Theme Approval, 6-15
Threshold, 1-7
Threshold Percentage, 6-28
Timezone, System, 4-18
Tip Text, 1-15
TM

See Trade Management
Tracking, 6-16
Trade Management, 1-15, 5-8, 5-12, 5-13, 5-68, 5-69, 

B-6, F-2, F-3, F-4
Budget Management, 1-17
Claims Management, 1-18
Funds Accrual Engine, 5-12
Import Territory Hierarchy, 5-13
Release Committed Budget Amount After Grace 

Period, 5-13
Trade Planning, 1-16
Utilize Lumpsum Offers, 5-13
Validate Budget Thresholds, 5-13

Trade Profile, 5-70
Trade Promotion, 6-14
Trading Community Architecture, 1-1, 1-5, 1-19, 

5-22, 5-25, 5-30, 5-31, 5-32, 5-33, 5-34, 5-36, 6-2, 
6-31, 6-43, B-3, B-6, C-4, C-6, D-4, H-1, H-2

Training, iv-xvii
Transfer to General Ledger, 5-69
Trigger, 1-10

U
UI, 4-23, 4-24, 4-27, 4-28, 4-29, 4-30, 5-47, 6-21, 6-29, 

6-31, 7-6, A-2, C-3, C-6, F-7, F-8
Unit of Measure, 4-10, 4-19, 5-22, C-8, C-9

Area, 4-19
Length, 4-19
Quantity, 4-19
Time, 4-19

Units of Measure, 4-10
UOM, 4-19

See Unit of Measure
Update Data Mining Models, 5-40
Upgrade Complete, 4-20
Upgrade iMarketing, 5-53
URL, 1-15, 1-21, 5-26, 5-27, 5-58, A-3, B-1, C-6, C-9, 

I-3, L-4
Use Web Placements, 5-58
User, 7-2
User Creation, 7-1
User Security, 7-6
User Setup, iv-xiv
user setup, 4-1
User Status, 6-21, 6-23
Utilize Lumpsum Offers, 5-13
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V
Validate Budget Threshold, 6-37
Validate Budget Thresholds, 5-13
Validation, 4-20
Variable Metrics, 6-9
Vendor Clearing Account, 6-41
Vendor Clearing account, 5-65
Venue, B-6
Venues, 6-11
View, B-6

W
Web Execution

Refresh Campaign Items, 5-56
Refresh Minisite Items, 5-56

Web Marketing, 6-20
Web Merchandising Strategies, 1-12
Web Placement, 1-3, 1-12, 5-57, 5-58, 5-60, B-4
Web Posting, 1-3, 1-12, 1-13, 5-51, 5-56, B-4
Web Postings, 5-54, 5-57
Web Recommendation Prioritization, 1-12
Word Replacement Rules, 6-43
Workbook, B-6
WorkFlow, 2-1
Workflow, 1-4, 1-13, 2-2, 4-21, 5-63, 6-30, B-7
Workflow Background Engine AMS Models Build 

Score, 5-40
Workflow Background Process, 4-21
Worksheet, B-7
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